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Let’s not kid ourselves: The most widely used
piece of software for statistics is Excel.

Brian D. Ripley

“Statistical Methods Need Software: A View
of Statistical Computing.” Opening lecture
Royal Statistical Society 2002, Plymouth
(September 2002).



Preface

Abstract MS Excel, the most widely available spreadsheet on MS Windows ma-
chines, is often used for data collection, manipulation, and storage. Elementary and
medium-complexity mathematical and statistical functions are included with Excel.
More advanced and highly reliable statistical analysis in Excel requires an add-in
package. R is one of the best statistics programs available. It is an extensible sys-
tem of software facilities for data manipulation, statistical analysis, and graphical
display. With RExcel, the entire R environment (including more than a thousand
contributed packages) can be treated as an extension of Excel.

This book is a supplementary text to any introductory course in statistics. The
book supports the instructor by giving students step-by-step screenshots showing
access to state-of-the-art statistical computations in R directly from the menu bar in
Excel.

The book can also be used as a computational introduction by data analysts who
already have basic statistical skills.

R is a program for statistical analysis and graphical display of data.

R is one of the best programs for statistical analysis and graphical display of data.
It is maintained and distributed by an international team of statisticians and com-
puter scientists working in universities and industry. R is one of the major tools
used in statistical research and in applications of statistics in science, social science,
economics, and business. R used in both academia and industry.

Among other things, R has

e data handling and storage facilities.
e a suite of operators for calculations on arrays, in particular matrices.
e alarge, coherent, integrated collection of intermediate tools for data analysis.

vii



viii Preface

e graphical facilities for data analysis and display either directly at the computer
or on hardcopy.

e a well-developed, powerful, and effective programming language (called S) that
includes conditionals, loops, user-defined functions (including recursive func-
tions), functions for creating complex data structures, and input and output fa-
cilities. (Indeed, most of the system-supplied functions are themselves written in
the S language.)

o A large selection of demonstration datasets used in the illustration of many sta-
tistical methods.

Excel is the most widely used spreadsheet program.

Microsoft Excel® [Microsoft, 2008a] is the most widely available spreadsheet. En-
tering data, cleaning data, and simple data processing (including simple statistics)
are very easily done on spreadsheets. As a consequence, much statistical data is
available as, or even created in, Excel worksheets.

Spreadsheets have a different paradigm for representing mathematical formu-
las than statistical (and mathematical) programming languages. The spreadsheet
paradigm is much more visual and action-oriented than the functional or proce-
dural paradigm of statistical programming languages. This problem of different
paradigms can be overcome. In this book, we illustrate some of the ways the two
paradigms can be made to work with each other. [Neuwirth and Arganbright, 2004]
discuss in detail how to represent the development and structure of spreadsheets in
printed form and how spreadsheets can be used to do serious mathematical work.

Excel is easy to use, but statisticians have found it has some deficiencies in the
area of numerical precision. Statistical software is usually perceived as difficult to
learn. This can be a major obstacle for potential users of advanced statistical meth-
ods. As this book shows, using R within Excel allows access to both the easy-to-use
tools for data entry and manipulation available in Excel and the power and precision
of the advanced statistical methods available via R.

RExcel is an interface program that uses R as an add-in to Excel.

RExcel is an add-in to Excel on MS Windows [Microsoft, 2008b] machines that
allows the use of R as a “helper application” for Excel. Data can be transferred
between Excel and R (in both directions), and Excel can call R functions to perform
calculations and then transfer the results to Excel.

RExcel offers the following features:

e allows the use of R functions in Excel cell formulas, effectively controlling R
calculations from Excel’s automatic recalculation mechanism.
e connects R dataframes and Excel data lists.
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e handles missing data.

e allows the creation of a standalone RExcel application that hides R almost com-
pletely from the user and uses Excel as the main interface to R. (Instructions are
given in RExcel’s help file.)

e if R Commander [Fox et al., 2007] is available, RExcel optionally places the
Remdr menus on an Excel menu bar. Any menu item integrated into the Remdr
menu using an Remdr plugin will also be available on the RExcel Remdr menu.

e works with the statconn (D)COM server (previously called R(D)COM server)
server, turning R into an (invisible) background server for Excel.

e works with the rcom package, turning R into a (visible) foreground server for
Excel. Using this configuration, the user can access the same instance of R either
from Excel or from the command line in an R GUI Console window.

e supports R processes running under the control of RServerManager. R server is
attached to Excel from a server pool. Different instances of Excel (running on
different machines) may access the same R process with the same data. We do
not use this capability in this book.

The RExcel interface is described in [Baier and Neuwirth, 2007]. RExcel is built
on the the rcom and statconn (D)COM (previously called R(D)COM) packages,
which we use for communication between R and the Microsoft Office software
[Baier, 2007]. Basic information on the installation of R, RExcel, and Rcmdr is in
Appendix A. Full information on RExcel is available at http://rcom.univie.ac.at/.

Rcmdr is an R package that provides GUI menu access to R.

Remdr (R Commander) is a platform-independent menu interface to R. The menu
items implemented by Remdr are primarily designed for introductory courses. They
can be extended by the Rcmdr plugin facility to provide a clickable graphical user
interface (GUI) to any statistical procedure coded in R.

Audience

There are two audiences for this book:

1. students learning statistics.
2. people analyzing data.
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Students

Introductory courses in statistics, and introductory statistics components of courses
in all other subjects, require access to a software system for the collection and anal-
ysis of data.

This book is a supplementary text for an introductory course in statistics. We
include examples of all the standard data analysis techniques that are introduced in
such courses. We also include some of the elementary probability examples from
those courses.

Many examples are structured parallel to similar presentations for other software
that appears in such texts. The outline for such examples is as follows:

1. Read data into Excel from a textbook CD.

2. Put data into R from the RExcel menu.

3. Construct standard analysis tables and graphs from the Rcmdr menu installed in
the Excel menu bar.

4. Cut and paste the tables and graphs into a document describing the results of the
analysis.

We have two worksheets, using Excel and R only, that are used to illustrate the
fundamental concepts of hypothesis testing, the construction and interpretation of
confidence intervals, and the ideas behind least-squares fitting. We have several
other worksheets that are used to illustrate data transfer between R and Excel and to
illustrate additional statistical techniques.

Data Analysts

See the Students section above for an introduction to the use of RExcel and Remdr
to access many of the analysis and graphical capabilities of R. It is possible to write
additional menu items to access specialized functions written in R directly from the
Remdr menu installed in the Excel menu bar. See the RExcel and Remdr documen-
tation for details.

Updates and Additional Information

RExcel has a Wiki at http://rcom.univie.ac.at/.

Update material for this book will be available from the book’s website at
Springer http://www.springer.com/978-1-4419-0051-7.

A video on RExcel, including both the material in this book and additional ma-
terial, is available at http://rcom.univie.ac.at/RExcelDemo/.
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Notes to Readers

Notation

Much of this book is focused on the the use of a clickable menu to access the statis-
tical functions in R. We use several typographical conventions to describe the menus
and the formulas.

Description Sample font

Menu items sans serif font

Cascading menus Menu item » Submenu name
File name typewriter font

Pathname in Excel c:\path\with\backslash\filename.xls

Pathname in R c:/path/with/forwardslash/filename.R
Excel formula sans serif font
R formula typewriter font

Mathematical notation Standard math notation (using math italic font)

_X—Ho
- s

7

t

Xiii
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We use the following terminology to describe clicking in Excel.

click Press the Left mouse button.
right-click Press the Right mouse button.
menu bar Clickable horizontal list at the top of the Excel window.

In Excel 2003, each item expands to a menu.
In Excel 2007, each item expands to a toolbar in the
Ribbon.

toolbar Specialized menu.

RExcel-Rcmdr toolbar In Excel 2007, the RExcel-Remdr toolbar appears on the
Ribbon when we click

Add-ins » RExcel » RCommander » with Excel menus

In Excel 2003, the RExcel-Rcmdr toolbar appears below
the standard toolbars when we click

RExcel » RCommander » with Excel menus

Ribbon Excel 2007 only. A set of clickable icons and menus that
appears below the menu bar and depends on which menu
bar item has been clicked.

menu List of clickable actions that appears on a taskbar or menu
bar or when you hover the mouse on an active item.

context menu Menu that appears when you right-click on any Excel
object, for example, a spreadsheet cell. Its appearance and
list of items depend on the current context. RExcel adds
several items to the standard Excel context menu for
spreadsheet cells when R and Remdr are running.

Presentation

Classroom Usage

The default font size for the Remdr window works well for a single user on a com-
puter screen. The Remdr default font size is too small for classroom projection. We
therefore wrote the Tools » Large Font for Projectors (HH) menu item to increase the
font size in the Remdr window and to change the default plotting character to solid
dots (denoted by the number 16).

The R and Remdr default for presentation of hypothesis test results includes stars
to indicate the level of significance. The stars can be turned on or off with the Tools
» R Options (HH) menu item.
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The Tools » Options. .. menu item opens a dialog box for control of font sizes and
other Remdr options and for a few R options.

Any other R options can be controlled by typing R commands in the Remdr
Script Window.

R Version

Most of the screenshots in this book were taken with R 2.8.1. Some of our screen-
shots show earlier version numbers, the version of R current at the time the screen-
shot was taken. R has scheduled releases of new versions about four times a year.
Version 2.9.1 was the current version as we went to press.

Writing Reports

Reports designed to be read on paper have different conventions than output de-
signed to be read on a computer screen. Screen images are normally inappropriate
in reports. The tables and graphs themselves, not emulated screen images of the
tables and graphs, are required for paper reports.

This book is a user manual for a set of computer programs. The graphs here are
screen images to show exactly what you type or click and exactly what you will see
in response on the screen.

A written report on your job is not a computer manual. A written report needs to
show graphs, not screenshots of windows showing graphs. See Figs. 4.21 and 4.22
for illustrations of the two different formats.

Computer Notation and Mathematics Notation

Computer arithmetic, both Excel and R, uses notation that is similar to standard
math notation. The notations are not identical, and you are required to know both
and to use them correctly. They don’t mix in the same formula. Computer nota-
tion in the R language is always in the Courier font because spacing, especially the
alignment of tables on the decimal point, makes that assumption. Computer tables
designed for Courier that are printed in Times Roman usually do not align and are
therefore very difficult to read.
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Number written out and

Concept Math notation Computer aligned at decimal point
Font Math Italic Courier Times Roman
Multiplication  x *

Power a’ a"b

Small numbers 1.23 x 10712 1.23e-12 0.00000000000123

Big numbers  4.56 x 103 4.56e+08 456000000.000

The computer notation with the letter “e” is standard in almost all computer pro-
grams (in particular, both R and Excel). It means, as illustrated in the table above,
“times 10 to the power”. It is written in ordinary-size type on the line. It is not a
subscript, nor is it a superscript. It has nothing to do with the base of the natural
logarithms. It is a historical artifact left over from the time when computer input
and output devices were teletypes with only one font and no special characters. It is
absolutely necessary to understand how to read it.

Statements written in the R language and in math notation distinguish be-
tween lowercase and uppercase letters. There are frequent examples of both “X”
and “x” appearing in the same formula with different meanings [for example,
E(X)=3",xf(x;) is the mean of a discrete probability distribution]. Names of
functions in Excel formulas are case-insensitive, and in many cases Excel changes
between uppercase and lowercase when formulas are entered.

Alignment of Decimal Points in Tables

Good: Correct: Wrong:
Same precision Decimal points Decimal points
in each column aligned unaligned

12.34 567.890000 12.34 567.89 12.34  567.89
4320 98.760000 432  98.76 432 98.76

443.00  8.765432 443. 8.765432 443. 8.765432
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Rounding

Intermediate numbers in a calculation should not be rounded. Only the final answer
may be rounded. For example, the full-precision numbers lead to rejection of the
null hypothesis at the oo = .025 one-sided level and the rounded values lead to non-
rejection.

4.2222 = .46444
] 1.960959
4.22 = .464

] 1.95808

>
[1
>
[1

Data values and simple summaries should not be displayed with more precision
than is justified. For example, if the data values are recorded with one decimal po-
sition, then it makes sense to report two decimal positions for the mean and the
standard deviation, but not three. Computing programs (including R and Excel) do
not always determine and display the appropriate number of digits.



XVviii Notes to Readers

Output Appearance—Width

Tables from computer output (and, actually, most tables) are designed to be read as
well-defined rows and columns. For legibility, they must be presented as designed.
Many word processing systems interfere with legibility by changing the font or
spacing of a table pasted into the word processor. This illustration shows the effects
of folding lines that the word processor thinks are too long. The single line of in-
terpretation of the significance stars, which is easily read in the correctly aligned
table, becomes difficult to read in the incorrectly folded table when the symbols and
p-values no longer alternate.

Correct width—columns are aligned.

Coefficients:
Estimate Std. Error t value Pr(>|t])
(Intercept) 576.799 514.020 1.122 0.264576
Space 90.605 6.477 13.990 < 2e-16 *xx
Water 9.657 2.412 4.004 0.000122 *xxx
Signif. codes: 0 'xxx’ 0.001 %%’ 0.01 "+’ 0.05 ".” 0.1 " " 1

‘Width too narrow for this table—each row is folded. The visual first column includes
items from the last column of the intended alignment. Thus, in this example, it looks
like Pr(>|t|), (Intercept), 0.264576, ... are in the same column. The
usual repair is to decrease the margins or decrease the font size.

Coefficients:
Estimate Std. Error t value
Pr(>|t]|)
(Intercept) 576.799 514.020 1.122
0.264576
Space 90.605 6.477 13.990
< 2e-16 **x*
Water 9.657 2.412 4.004

0.000122 xxx

Signif. codes: 0 ’‘*xx’ 0.001 "%%’ 0.01
'«’ 0.05 . 0.1 7 1

Output Appearance—Font and Spacing

Tables from R computer output are designed to look right in a monowidth font such
as Courier. They are often illegible in a proportional font such as Times Roman. For
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legibility, they must be presented as designed. In MS Word, programs and transcripts
must be highlighted and then explicitly placed into Courier.

Here is an example of the issue. The Courier rendition is consistent with the
design of the output by the program designer. The Times Roman is exactly the
same text dropped into an environment that is incorrectly attempting to space it
in accordance with English-language typesetting rules.

Courier (correct spacing) Times Roman (incorrect spacing)
> summary (Long) > summary(Long)
v group y group

Min. :-2.000 A:l12 Min. :-2.000 A:12

lst Qu.: 3.217 B:12 1st Qu.: 3.217 B:12

Median : 5.150 C:12 Median : 5.150 C:12

Mean : 5.815 Mean : 5.815

3rd Qu.: 8.700 3rd Qu.: 8.700

Max . :13.090 Max. :13.090

Input Notation—Case

R is a case-sensitive system. Uppercase (ABC) and lowercase (abc) letters are not
the same. Variable names and function names in R must be written with the correct
case if they are to be understood by the program.

Excel is not case-sensitive. Cell formulas written in lowercase (al1:c12) letters
will be converted to uppercase (A1:C12) when they are displayed.

Nonsense Notation

As instructors, we often see nonsensical statements on student papers. This is one
of the most flagrant:

Nonsense: o/2 = .025 = 1.96
Correct: 2,5 = Zgp5 = 1.96

The nonsense statement claims that .025 and 1.96 have the same value. The correct
statement shows the relationship, through the normal table, of the two values.
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Basic Writing

1. Organization. Introduction, sections, summary, placement of tables and figures
in text, automatic numbering and referencing of tables and figures.

2. Mechanics. Appropriate ways to cut tables and graphs from R and to paste them
into documents.

3. Style. Styles for writing simple homework analyses, case reports, and technical
reports.

4. Distribution media. We emphasize that reports designed to be read on paper
have different conventions than output designed to be read on a computer screen.
Screen images are normally inappropriate in reports. The tables and graphs them-
selves, not emulated screen images of the tables and graphs, are required for
paper reports.

Internationalization

All examples in this book have been developed on Windows systems running in
an English language locale. When both R and Excel use the same locale, they will
behave consistently in their use of decimal notation and/or time conventions. For
example, English locales use the period “.” for the decimal indicator and many Eu-
ropean locales use the “,”.

When R and Excel are using different locales, there may be strange interpreta-
tions of input values.

R (and therefore Remdr) uses the operating system’s information. See the R help
file ?1locales and ?1localeconv for further information.

Excel uses information on the Windows Start » Control Panel » Regional and
Language Options » Regional Options » Customize. .. dialog boxes and on the Excel
Tools » International tab.

RExcel has a worksheet function RNumber which, when dealing with numbers as
strings, always does the right thing in conversion.
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Chapter 1
Getting Started

Abstract Once RExcel has been installed on your computer (see Appendix A for
details), it can be started by clicking the RExcel with RCommander or RExcel2007
with RCommander icon. The icon is initially placed on your Desktop by the RExcelln-
staller. It may have been copied or moved by your lab manager to your Start menu,
or to a menu reached from the Start menu. It is possible to start Excel first and then
start R and Remdr from the RExcel menu. Most of our illustrations show screenshots
from Excel 2007 on Windows. Everything works with Excel 2003 or Excel 2002 on
Windows, with only minor differences in the appearance of the menus.

In this chapter, we present several alternate starting scenarios. Most users will
need only one of them. RExcel can be started from the RExcel icon or from a run-
ning Excel window. Rcmdr can be started from Excel or from an R window.

1.1 Starting RExcel with the RExcel Icon

The easiest way to start is to use the RExcel icon in Fig. 1.1. On a personal machine,
the icon is normally on the Desktop. On a university laboratory machine, the icon
may have been moved by the lab manager to the Quick Launch toolbar, or to a menu
accessible from the Start menu.

——my

Rl (R

RExcel with RExcel2007
RCommander with
RCommander

Fig. 1.1 Double-click the RExcel with RCommander (Excel 2003 or 2002) or the
RExcel2007 with RCommander icon on the Desktop to get Fig. 1.2.

R.M. Heiberger, E. Neuwirth, R Through Excel, Use R, 1
DOI 10.1007/978-1-4419-0052-4 1,
© Springer Science+Business Media, LLC 2009
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c!_.. ™ R R Bookl - Microsoft Excel .= x

| Home | Insert Page Layout Formulas Data Review View Developer | Add-Ins :@ -

ﬁ # | Calibri 2 o B U | = = General * A S Insert - ¥ = ﬂ [ﬁ ‘
Past |n N “AA Av' @ |s. " sty s Sort & Find &
'aste — es a i
& [ ][& - A (|a8is%8 I || B Format - 2' Filter= Select~ |
Clipboard ™ | Font || Atignment = Number I\ | Cells | Editing | |

TR

Fig. 1.2 Excel 2007 opens with the Home tab expanded into the Ribbon. Click the
Add-Ins tab to get Fig. 1.3.

[O H9- - Bookl - Microsoft Excel
Home Insert Page Layout Formulas Data Review View D

| Scipt Window
RExcel ~ R File = Edit = Data ~ Statistics ~ Graphs ~ Models - Distributions - Tools ~ Help ~
Dataset: Mo active dataf - | Model: Mo active mode ~
.Mer]yjumnmpd;“ Custom Toolbars
| Put R Var - @ I |
Pl A | w8 | ¢ | o | e | F | & H | 1
4]
2|
3 ‘ DOutput Window
4 | Ii

Fig. 1.3 The R Commander menu is now visible on the Excel 2007 Add-Ins Rib-
bon. The R Commander window has opened on the right.

EA Microsoft Excel
Edit Help
DEdas SRY S BBR-F -~ = -4 @l -8B 2 @ & %
HEnuEea % e ”MtEFHAP-EAJ AER.
Az ab| | = |F ® |

Eile Wiew Insert Format  Jools [Data  S-PLUS  Window  RExcel Type a question For help

. EDatasst: [o active data -|Modsl: [No active mod: -]

R Commander
Script Window

Fig. 1.4 Excel 2003 and 2002 open with the R Commander menu on the menu bar.
The R Commander window has opened on the right.
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1.2 Starting RExcel from a Running Excel Window

Sometimes we start Excel first, either by clicking the Excel icon or by double-
clicking an x1s or x1sx file. We then start RExcel and Remdr after the Excel
session is running. There are two steps: RExcel » R Start, followed by RExcel »
RCommander » with Excel menus. See Figs. 1.5-1.9 for Excel 2007 and Figs. 1.10-
1.12 for Excel 2003 and 2002.

1.2.1 Starting RExcel from a Running Excel 2007 Window

!._" 'g\ A9 - o 5 Bookl - Microsoft Excel - =2 X
—’) Home Insert Page Layout Formulas Data Review View Developer Addlns | @ - o X

=51 K| Calibri i - ||=

= = General - A S Insert - ¥ ~ A? L?a
J-—iﬁ |B I U~ AT ==~ |||% - % 9| % Delete ~ jvz _
Pafte T | [EE || - é | _._Il@.‘l |58 5%/ Styvles I_’_;j Format = || (2~ éiTtr:r&; SF;T:C&
Clipboard = Font (Fi Alignment {F Mumber T Cells Editing
5 Cowsl

A B c D E F G H I 1 !
i 1]

Fig. 1.5 Excel opens with the Home tab expanded into the Ribbon. Click the Add-
Ins tab to get the RExcel menu in Fig. 1.6.

\\ [ Bl ¥ Bookl - Microsoft Excel _ m x
o
—) Home Insert Page Layout Farmulas Data Review View Developer Addns | @) — = X

RExcel = |

Menu Commands|

| [Rexceija1 - ¢ £ ¥
A B | ¢ D E F G H I L | K
al 1
-

Fig. 1.6 The Add-Ins Ribbon opens with the Menu Commands box listing the in-
stalled add-ins. If you have additional add-ins installed, you may have additional
menu items above or below the RExcel item. Click the RExcel item to get Fig. 1.7.



4 1 Getting Started

(=1 (e ) ¢ Bookl - Microsoft Excel _ = x

Home Insert Page Layout Formulas Data Review View Developer Add-Ins |® - X

RExcel ']

R Start |

,
o
o =< 1L

= =

Copy Code

Debug R |

2R e el s ovtn s fwn

Error Log

Options k

Set R server
RExcel Help
R Help

Demo Worksheets v |

@@

R.and.Excel Warksheets

About RExcel

Fig. 1.7 Click R Start on the RExcel menu.
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Fig. 1.8 There is no visible change after R has started. Click the RExcel item again,
and then click the RCommander » with Excel menus item to get Fig. 1.9.
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Home Insert Page Layout Farmulas Data Review View D Sieript Window
RExcel ~ H File = Edit = Data = Statistics = Graphs ~ Models ~ Distributions = Tools ~ Help ~
Dataset: Mo active dataf > Model: | No active mode ~
Menu Commands Custom Toolbars
[ [ putrvar ~ @ |
A | B | C D | E | F | G H | 1
1
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3 Output WWindow
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Fig. 1.9 The R Commander menu is now on the Excel Add-Ins Ribbon. The R
Commander window has opened on the right.

1.2.2 Starting RExcel from a Running Excel 2003 Window

E3 Microsoft Excel - Book1 E]@

File Edit Wiew Insert Format  Tools Data  Window  S-PLUS | RExcel | Help 8 X
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Debug R
Etrar Log
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12 @ RExcel Help
ﬁ % RHep
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16 R.and.Excel Worksheets
:]Ig R About RExcel

Fig. 1.10 In Excel 2003, click RExcel » R Start.



1 Getting Started

E3 Microsoft Excel - Book1
] Ble Edt Yew Insert Formet Tools Data SPLUS  Window

et SRV BRI Cloge R
iﬁ Y @ » M Run Code
- & Get R Yalue
A | B [ ¢ [ b | E Put R Yar

e N

et R autput
Set R working dir
Load R file

Copy Cade
Debug R

Etror Log

Qptions

B RExcel Help
% RHep

RExcel | Help Type a question far help

-8 X
@, 2
HIAR R,

v
m

J K

v |

| RCommander

with Excel menus

Dema Worksheets
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R About RExcel
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Fig. 1.11 There is no visible change after R has started. Click RExcel » RComman-
der » with Excel menus. This opens the Remdr window and places the Remdr menu
on the Excel toolbar.
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Fig. 1.12 Initial full-screen appearance of Excel 2003 with the Rcmdr window on
the right. The RExcel menu item is on the main menu. The Remdr menu toolbar is
on the main Excel toolbar. See Fig. 2.2 for more detail.
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1.3 Starting R Commander Without Excel

Remdr was designed as a graphical interface to R for all operating systems on which
R runs. The startup on Windows without Excel, or on Apple Macintosh (on which
the interprocess communication method is different from Windows and therefore
the RExcel interface doesn’t work), or Unix-alikes (for which Excel isn’t available)
is described in this section.

When Remdr is started directly from R, the Recmdr menu is on the R Commander
window. When we start Remdr from Excel, we usually move the Remdr menu to the
Excel window.

We illustrate starting Remdr from the RGui window on Windows. The startup is
similar on Macintosh or Unix-alike.

ﬁ Internet Explorer J My Documents

‘.;_') Windnm] Location: C:\Program FilesiR1R-2.8. 11bin i

All Programs p

Fig. 1.13 Start R from the Start menu or from the R icon.



8 1 Getting Started

= R Console
File Edit Misc Packages Help
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'citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
'help.start () ' for an HTML browser interface to help.
Type 'gi)' to guit R.

Loading reguired package: room
[1] TRUE
> library(Rcmdr)I

Fig. 1.14 Enter library (Rcmdr) in the R Console to open Remdr in Fig. 1.15.
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Lowiing Eequized packaget ok
Pemde VeEaion 3.3
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Fig. 1.15 The Remdr window opens with the Remdr menu. (When RExcel is active,
we moved the Remdr menu to the Excel menu bar.) The Remdr menu in this location
has exactly the same properties as the Rcmdr menu in Excel illustrated in Fig. 1.9.
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R Commander.

File Edit Data Statistics Graphs Models Distributions BEES Help

;:Rmh Data set: | <Mo active dataset> | | Edit data set || View o

Script Window

odel=

Load Remdr plu
Options. ..

Load Plug-ins [:h'_- [E

Plug-ins {pick one or more)
F.crndrPlugin.epack
RcmdrPlugin. Expart
RemdrPlugin. FactaMineR

RomdrPlugin HH
RemdrPlugin. IPSUR
RerndrPlugin.orloca
RemdrPlugin. SurvivalT
RimdrPlugin, TeachingDemos

[ 0K l [ Cancel ] [ Help ]

Fig. 1.16 On computers without Excel, we need to click the Tools » Load Remdr
plug-in(s)... and RemdrPlugin.HH from the Rcmdr menu to get the additional HH
[Heiberger, 2008a] menu items.
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1.4 Window Arrangement

In our illustrations in Figs. 1.3, 1.4, 1.9, and 1.12, we show both the Excel and the R
Commander windows. We recommend that they both be visible and that neither be
allowed to entirely cover the other. When the R Commander window is hidden, the
default behavior is that it does not automatically come to the top when the Remdr
menu in Excel writes to it. Similarly, the Graphics window may be hidden. When
a new graph is drawn, the Graphics window does not automatically come to the
top. Should a window be hidden, it is easily found with the Taskbar or use of the
Alt-Tab key. There is an option on RExcel » Options to change the behavior. Check
RCommander gets focus with output and then RExcel will bring either the Commander
window or the Graphics window, as appropriate, to the top.

1.5 Graphics History

The R Graphics Device window has an option to record all graphs produced in a
session. You can page up and down through the complete set. You may save them
to a file. See Fig. 1.17 to see how to turn graphics history on.

I R Graphics: Device 2 {ACTIVE)

et from variable. ..

Fig. 1.17 We recommend you turn Graphics Device history on. From the Graphics
Device menu, click History » Recording to put the checkmark in place.
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1.6 Quitting RExcel

i 1\ =] i Bookl [Compatibility Mode] - Microsoft Excel e
_‘) Home  [nsert Pagelayout  Formulas Data Review  View Developer Add-Ins @ - 7 x
RExcel ~ R ‘F\Ie 'iEd\l' Data - Statistics ~ Graphs ~ Models - Distributions ~ Tools ~ Help -
Dst Open script file... o active modé
Save script..,
Menu Commands Save script as.. ustam Toolbars
| a1 Save output..

A B Save output as.., E F G H 1 J K L M N

_| Save Rworkspace...

Save Rworkspace as...

Exit b From Commander

From Commander and R

[ S P T

Fig. 1.18 When you have finished, quit R from the Remdr menu File » Exit » From
Commander and R. Remdr will ask you to confirm quitting and about saving output
and script files. Click OK to quit. You probably want to save the output. You might
want to save the script file.

R will not ask about saving the Graphics window. You need to determine whether
to save individual graphs. We recommend in Section 1.5 that you open the graphics
window with recording on. This means you can page up and down through the
graphs your created in the current session.

R will ask you about saving the workspace image. You will normally click No.

When you have quit R, then quit Excel. Excel will ask about saving changes you
made to your workbooks. You shouldn’t change textbook data files or workbooks
that are part of the RExcel package. Whether you should save your own workbooks
is your decision. It depends on whether the workbook is your primary data reposi-
tory or just a scratchpad for calculations.



Chapter 2
Using RExcel and R Commander

Abstract We review the complete set of Remdr menu items, including both the
action menu items and the active Dataset and model items. We illustrate the output
graphs and tables associated with a least-squares fit. We show the R Commander
window and the RGUI Console window.

2.1 Appearance

Users will normally have only one version of Excel installed on their computer. Most
illustrations in this book use the most recent, Excel 2007. The RExcel behavior is
identical in both Excel 2003 and Excel 2007. The Rcmdr behavior is identical in
both Excel versions and without Excel.

The RExcel and Remdr menus in Excel 2007 (Fig. 2.1) and Excel 2003 (Fig. 2.2)
and on the R Commander window (Fig. 2.3) have slightly different appearances.

The RExcel menu is an item on the Menu Commands box of the Add-Ins tab of
Excel 2007. The RExcel menu is an item on the main menu of Excel 2003.

The Remdr menu is a toolbar on the Ribbon of the Add-Ins tab of Excel 2007
and is a toolbar on the main toolbar of Excel 2003. The Recmdr menu is a toolbar on
the Remdr window when Excel is not running.

The content and behavior of the RExcel menu in Fig. 2.4 are identical in both ver-
sions of Excel. The content and appearance of the Remdr menu are almost identical
in all three settings. The Remdr » Edit menu item does not appear in current releases
of RExcel because it is not needed in the Excel setting. (It is shown on some of our
earlier screenshots.) We display each item on the menus in the upcoming figures.

R.M. Heiberger, E. Neuwirth, R Through Excel, Use R, 13
DOI 10.1007/978-1-4419-0052-4 2,
© Springer Science+Business Media, LLC 2009
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On)\\ 9~ @5 )+ Microsoft Excel - = X

[+

Home Insert Page Layout Formulas Data Review View Developer | Add-Ins "@

RExcel ~ R File ~ Data ~ Statistics ~ Graphs ~ Models ~ Distributions ~ Tools ~ Help ~
Dataset: | No active dataf Model | No active mode
Menu Commands Custom Toolbars

Fig. 2.1 RExcel and Rcmdr menus on the Add-Ins tab in Excel 2007.

E3 Microsoft Excel

! File Edit Miew Insert Format Tools Data Window RExcel Help
R File ~ Dats ~ Statistics ~ Graphs ~ Models ~ Distributions ~ Tools ~ Help = » = : B |

Fig. 2.2 RExcel and Remdr menus in Excel 2003.

R Commander
File Edit Data Statistics Graphs Models Distributions Tools Help

:aRmb Data set: [ <Mo active dataset> | Edit data set | View data set| Model | <Mo active model>

Script Window

Fig. 2.3 Rcmdr menu on the R Commander window when Remdr has been started
from RExcel by clicking the with separate menus menu item (see Fig. 1.11) or di-
rectly from R (see Fig. 1.15).
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Close R

Bun Code

Get R Value »
Put R Var L
Get R gutput

Set R working dir
Load R file

Copy Code
Debug R

Error Log

Options

RExcel Help

R Help

Stop RCommander

Demo Worksheets »
RthroughExcel Worksheets
About RExcel

Fig. 2.4 RExcel menu. This is the main menu for starting and stopping the interface
between Excel and R. This menu can also be used for communicating between R
and Excel. We will usually use the Context menu (right-click menu) in Excel (Fig.
2.14) for communication between the two programs.
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- - Microsoft Excel = e

Home Insert Pagelayout Formulas Data Review View Developer iAdd-Ens| @

RExcel ~ |R| File ~ Data ~ Statistics ~ Graphs ~ Models ~ Distributions ~ Tools ~ Help ~

| Datasat: |No active dataf ~ | Model: |No active mode -

Menu Commands Custom Toolbars

Fig. 2.5 R button. When you type commands to R directly (in either the Rcmdr
script window or the R Console), as distinct from clicking in the Rcmdr menu in
Excel, then Excel, R, and the Remdr menu can get out of phase. Clicking the R
button resynchronizes them.

-

[ N T B Microsoft Excel - B X

Home Insert Pagelayout Formulas Data Review View Developer | Add-ns| @

RExcel ~ R File =| Data ~ Statistics ~ Graphs ~ Models ~ Distributions ~ Tools * Help ~

| Dat Change working directory... € mode -

| Open script file...
| Menu Commands | Save script... Ibars

|

| co6 Save script as...

@ Bookd Save output...
T i ] Save output as... T |

Save R workspace... R | R [

Exit |

1
2 | Save R workspace as...
3

Fig. 2.6 Rcmdr File menu. We normally do not use this menu.
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Ca) 9 - @l )¢ Microsoft Excel - B X
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Home Insert Pagelayout Formulas Data Review View Developer |Add-lns| (7
RExcel = R File - | Data ~| Statistics ~ Graphs = Maodels ~ Distributions ~ Tools = Help =
Dataset: | I New data set... |
I Load data set... |
| Menu Commands | B | import data v | J
| C6 hd Data in packages » : |
— ) :
@ Bookd Active data set
I il I Manage variables in active data set » I
| a | =n c | H

Fig. 2.7 Rcmdr Data menu. This menu is very helpful for bringing data into R and
for restructuring the data after it is already in R.
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- - Microsoft Excel - B X
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| c6 v C"f " Proportions »
i >
I]’—!-_E] Bookd Variances
e I Nonparametric tests  » [ I
P A | B |uue F G H
1 Dimensional analysis *
2 Fit models »

Fig. 2.8 Rcmdr Statistics menu. This is the workhorse menu for computations and
analysis.
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Fig. 2.9 Rcmdr Graphs menu. This is the workhorse menu for graphs.
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Fig.2.10 Rcmdr Models menu. This menu allows follow-up display of results from
analyses calculated in the Statistics menu.

Microsoft Excel i — S

wut Formulas Data Review View Developer IAdd-Ins|@

r Statistics ~ Graphs ~ Models ~ |-Distributions "I Tools ~ Help

re dataf ~ | Model: | No active mod)|

Continuous distributions »

Discrete distributions 4

Custom Toolbars.

£

|

Normal distribution

t distribution
Chi-squared distribution
F distribution
Exponential distribution
Uniform distribution
Beta distribution
Cauchy distribution
Logistic distribution
Lognormal distribution
Gamma distribution
Weibull distribution
Gumbel distribution

Fig. 2.11 Rcmdr Distributions menu. The normal, ¢, F, chi-squared, and other ta-
bles are accessible from the Continuous distributions menu shown here. The binomial
and other tables are accessible from the Discrete distributions menu.
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Excel -
ata Review View Developer | Add-ns @
5 = Models = Distributions ~ ITools *|Help ~

No active mode ~ Load package(s)...

Load Remdr plug-in(s)...
tom Toolbars Options...

Large Font for Projectors (HH)
R options (HH)

Fig. 2.12 Rcmdr Tools menu. The Options... item provides access to display options
(font size, for example) for the Remdr window. Remdr plug-ins are a mechanism
that permits people other than the author of Remdr to provide additional menu items
on the Remdr menu bar.

Excel -
ata Review View Developer | Add-Ins | (@

5 = Models - Distributions = Tools = |Help %

No activer

Commander help
Introduction to the R Commander

tom Toolbars Help on active data set (if available

About Remdr

Fig. 2.13 Recmdr Help menu. The Introduction to the R Commander is the best refer-
ence.
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Fig. 2.14 Excel Context menu (right-click menu) displayed when RExcel is active
and Remdr is loaded. This menu is the primary tool used to communicate between
Excel and R.
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2.2 The Dataset and Model Menus

In all previous figures (see Fig. 2.14, for example) the toolbar shows
Dataset: | No active dataf Model: |No active mode

This portion of the toolbar shows the Remdr active dataset and active model. Both
initially show the value “not active”.

When we work with a dataset, the active dataset is the one to which the menu
commands are applied. In this section, we look at a dataset and model it with a
simple least-squares fit.

Data ~| Statistics ~ Graphs ~ Models ~ Distributions ~ Tools ~ Help ~

New data set...

Load data set...

Import data 4
Data in packages 4 List data sets in packages
Active data set 4 Read data set from an attached package...

Manage variables in active data set » f
| o T = v G H | J K

Fig. 2.15 R includes several datasets. We will make one of them active by clicking
in the Remdr Data » Data in packages » Read data set from an attached package...
menu. This opens the dialog box in Fig. 2.16.
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'63 9o i Microsoft Excel
- Home Insert Page Layout Formulas Data Review View Add-Ins
RExcel ~ | MG  Read Data From Package E| @ el
Dataset: Mo o

Package [Double-click to select]  Data et [Double-click to select]

Menu Commands

| Al +(®

Enter name of data set: l

| oK I Cancel I Help I

Fig. 2.16 R consists of a “base package” and many additional packages. The
Read Data From Package menu shows those currently attached packages that include
datasets.

R P S R

R File - Ed

Dataset: |No 2
Package [Double-click to select]  Data set [Double-click to select)
swiss o]
treering
uspop ] in pz

Enter name of data set: |hiees

| oK I Cancel | Help |

Fig. 2.17 Double-click a package name to put the list of datasets in the right-hand
menu, double-click the trees dataset, and click OK.

RExcel ~ R File ~ Edit - Data - Statistics ~ Graphs ~ Models -~ Dist

Dataset: trees * | Model: |No active mode

Fig. 2.18 The toolbar now shows trees as the active dataset.
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We query R on the dataset by typing ?trees in the Script Window and clicking
the | . button. R replies by displaying a help file. The screenshots of the query
and the help file are shown in Fig. 2.29 and 2.30. The help file says the data is the

Girth, Height and Volume for Black Cherry Trees
Description:

This data set provides measurements of the girth, height and volume of timber in 31 felled
black cherry trees. Note that girth is the diameter of the tree (in inches) measured at 4 ft 6
in above the ground. A data frame with 31 observations on 3 variables.

[,1]1 Girth numeric Tree diameter in inches

[,2] Height numeric Height in ft

[,3] Volume numeric Volume of timber in cubic ft

We need to look at the numbers in the dataset. The easiest way is to bring the
numbers into Excel, using the technique described in Section 3.6.
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B9 -o-E)F Bookl - Microsoft Excel

Home Insert Page Layout Formulas Data Review View Develo

RExcel ~ R File ~ Data - Statistics - Graphs ~ Models = Distributions ~ Tools ~ Help =

Dataset: trees ~ | Model: | N
I Menu Commanse Cuctam Toolbars
[:— Calibri ~|11 ~ A" A" § ~% » F F
B IE=ii-%- - 0 30

| 4 B — A ok F G H

1

5 R Run in Remdr

3 I R RunR

| Get R Value

5 | ButR Var

6 Get Active DataFrame

| Get R DataFrame

8 | Put R DataFrame

9 I Remdr Get > B
10/ Get R Qutput

11 N R

t ame Range

12

12 | Insert Current R Plot

14 | Prettyformat Numbers

15| &b cut

16 K3 | Copy

17 4 Paste

18 | Paste Special...

19 | Insert...

20 | Delete...

= t Clear Contents

22

23 Filter LS |
24| sort :
25 | d Insert Comment

26 | #F Format Cells...

27 ! Pick From Drop-down List...

28 | Name a Range...

2 . Hyperlink

i ! Hyperlink...
30 | - .

Fig. 2.19 Use the Context menu (right-click menu) to copy the active dataset named
in the Dataset toolbar item into the Excel worksheet. We do so by activating an
empty worksheet, clicking in cell A1 and then right-clicking Get Active DataFrame.
The dataset will appear beginning with the highlighted cell. If you choose to bring
data into an existing workbook, be careful about the choice of starting cell. There is
no undo for this transfer.
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o) |

Insert Page Layout Formulas Data R

R File ~ Edit -~ Data ~ Statistics = Graphs ~ Models ~

Dataset: |trees Model: | No active mode
Menu Commands Custom Toolbars
| trees v 5|
] Bookl
| A B c Bl e | F
1 Girth Height Volume
2 1 8.3 70 10.3
3 2 8.6 65 10.3
4 3 8.8 63 10.2
5 4 10.5 72 16.4
263 5 10.7 81 18.8
7 6 10.8 83 19.7
8 il 11 66 15.6
9 8 11 7S 18.2
10 9 111 80 22.6
11 10 11.2 75 19.9
12 11 11.3 79 24.2
13 12 11.4 76 21
14 13 11.4 76 21.4
15 14 11.7 69 21_3I
16 15 12 75 19.1
17 16 12.9 74 22.2
18 17 12.9 85 33.8
19 18 13.3 86 27.4
20 19 13.7 71 25.7
21 20 13.8 64 24.9
22 21 14 78 34.5
23 22 14.2 80 315
24 23 14.5 74 36.3
25 24 16 72 38.3
26 25 16.3 77 42.6
27 26 17.3 81 55.4
28 27 17.5 82 05
29 28 17.5 80 58.3
30 29 18 80 51.5
31 30 18 80 51
32 31 20.6 87 77
22

Fig. 2.20 The dataset is displayed in the worksheet. This dataset has four columns:
the row name (in this example, a numerical index) and three variables. The region
of the worksheet containing the dataset is colored and is given a name in the cell
identifier box on the Excel toolbar.
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( c::‘ HY9- -G+ Microsoft Excel
- Home Insert Page Layout Formulas Data Review View Developer
RExcel ~ R File ~ Edit ~ Data ~ Statistics ~ [Graphs 'I Models - Distributions = Tools = Help ~
Dataset: trees * | Model: N Color palette...
Index plot...
Menu Commands q Histogram...
-
| trees * Q fe | Stem-and-leaf display... |
= Boxplot... E
la] Bookl Quantile-comparison plot...
A B8 | c | D Scatterplot... L
L Girth nght Volume Scatterplot matrix...
2 1 8.3 70 10.3
Eras Line graph...
3 2 8.6 65 10.3 e —
3 3 8.8 63 10.2 g
5 4 10.5 72 16.4] i
6 5 10.7 81 18.8)
7 6 10.8 83 19.7]
8 7 11 66 15.6 Quantile-comparison plot with test...
9 8 Tl 75 18.2 Scatterplot matrix... (HH)
10 9 11.1 80 22.6
A1 10 1.2 75 19.91 XY conditioning plot... (HH]
12 1 11.3 73 24.2 Dotplot with stacked multiple hits... (HH)
13 12 114 76 21
ety Scatterplot.HH... (HH)
14 13 114 76 21.4 .
15 14 11.7 69 21.3 Squared Residuals... (HH)
16 15 12 75 194 B Eph ’
17 16 12.9 74 22.2 Savc piapiiiojide 4

Fig. 2.21 Now that there is an active dataset, we can use the Graphs » Scatterplot
matrix... (HH) menu item. Menu items with ... indicate that the dialog box in Fig. 2.22
will ask for further information. The boldfaced menu items are the ones that make
sense for the active dataset. The other items are grayed out.
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‘{-._3 H9- ™ - Microsoft Excel
~ Home Insert Page Layout Formulas Data Review View
CECER - NGTRS.  Scatterplot Matrix E] @
Dataset: |tree
Select variables {three or more)
Menu Commands
| trees - |
= Least-squares lines v
21 & Smaooth lines |
A B ©On Diagonal
1 Girth  H| Density piots @®
G 1 8.3 Histograms O
3 2 8.6 | Boxplots O
4 3 8.8 One-dimensional scatterplots ()
5 a 105 Normal QQ plats (@)
6 5 10.7 Nluthing (ernpt:{) O
7 6 10.8 Diagonal Direction
SW-NE'S' @
8 7 11 A
9 8 i e O
Subset expression
10 3 111 I{aﬁl valid cases> ‘
11 10 1.2 v bk 1
12 11 11.3 PRt by aroLps. |
13 12 114
14 13 na | Lo J [ concel ]
15 14 3957
16 15 12 75 15.1

Fig. 2.22 Many of the menus in the Remdr dialog boxes include variable-selection
dropdown boxes. When there is only one variable in the active dataset that meets
the criterion, that variable is shown highlighted when the dialog box opens. When
there are multiple variables, or when there is an optional variable selection, then no
variables are shown highlighted when the dialog box opens. In this example, select
all three variables, accept the defaults for the other items, and click OK.
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Fig. 2.23 The scatterplot matrix is a matrix of scatterplots of each variable plotted
against the others. The sequence of variables normally starts at the lower left. Look
at the plot of Volume ~ Girth in the upper left panel and observe the linearity of the
plot. This suggests a least-squares fit (see Chapter 8 for more information on least
squares) might be appropriate. The scatterplot matrix displays on the main diagonal
the estimated univariate densities for each of the variables. The notation y ~ x means
that the left variable is on the vertical axis and the right variable is on the horizontal
axis. This notation is used throughout R to specify statistical models.
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Microsoft Excel

Review View Add-Ins

[ R =
Home Insert Page Layout Formulas Data
RExcel ~ R File = Edit = Data = [Statistics ~| Graphs = Models = Distributions = Tools ~ Help ~
Dataset: |trees Summaries 4
Contingency tables »
Menu Commands Means 4
| trees ~ (@ I Proportions »
- Variances ’
1] Book2
- = = Monparametric tests » |
TR [, S R s o
~ - Dimensional analysis *
1 Girth Height - =
2 T %5 70 Fit models
3 2 8.6 65 10.3
4| 3 8.8 63 10.2|
S5 4 10.5 72 16.4
6 5 10.7 81 18.8
__7 6 10.8 83 19.7|
8 7 11 66 15.6l

G H I

Linear regression,..
Linear model..,

Generalized linear model..,

Fig. 2.24 Specify a least-squares fit on the active dataset by selecting the Statistics

» Fit models » Linear regression... menu item.
Oa)\\H 92 -+ Microsoft Excel
~ Home Insert Page Layout Formulas Data Review View Add-Ins
RExcel ~ R File - Ed Linear Regression
Dataset: |tree

Menu Commands

Enter name for model: | RegModel.1
Response varniable [pick one)

Explanatary varables [pick one or more]

Gitth :
Height Height
olume =

=

‘ trees + (o
| B Bookz Subset expression
A B 1<all valid cases>
1 | Girth H -
2 1 8.3 oK I Cancel Help
3 | 2 8.6
- L L - an A 1 fmanaralivad limaar madal

Fig. 2.25 The Linear Regression dialog box asks for a response variable, and we
select the y-variable Volume from the Volume ~ Girth plot in Fig. 2.23. We select as
Explanatory variable the x-variable Girth. Output from this dialog box is in Fig. 2.26.
The dialog box also changes the active model as shown in Fig. 2.27.
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R Commander.

Script Window

data(trees, package="datasets")

scatterplot.matrix (~Girth+Height+Volume, reg.line=lm, smooth=FAL3E,

span=0.5, diagonal = 'density', data=trees, rowlattop=FAL3IE)

RegModel.l <- lm{Volume~Girth, data=trees)

summary (RegModel.1)

Cutput Window M
A

> sumnary (RegModel. 1) B

Call:

lmiforrula = Volume ~ Girth, data = trees)

Residuals:

Min 12 Hedian 30 Hax
-5.0654 -3.1067 0O.1520 3.4945 9.5568
Coefficients:
Estimate 3td. Error t walue Pri>|t]

[Intercept) -36.9435 3.3651 -10.98 7.62e-12 *#*%

Girth 5.0659 0.2474 Z0.458 <« Ze-16 *#*%

Signif. codes: 0 '#*¥%%' Q0,001 '+*' Q.01 '+*' oO.,05 ‘.t o0.1 ' 1

Residual standard error: 4.252 on 29 degrees of freedom

Multiple R-sguared: 0.9353, Adjusted R-sguared: 0.9331

F-statistic: 419.4 on 1 and 29 DF, p-wvalue: < 2.2Ze-16 -
b

Messages
A
v

Fig. 2.26 The R Commander window shows the printed output from the dialog box
in Fig. 2.25. The generated R code is in the top Script Window. The analysis object
is given the name RegModel . 1. The summary of the regression analysis in model
RegModel. 1 is in the bottom Output Window. The coefficients of the least-squares
line are displayed in the coefficients section of the output. The least-squares
line is

¥ = —36.9435+5.0659x

The least-squares line is displayed as the dotted line in the Volume ~ Girth panel on
the plot in Fig. 2.23.



32 2 Using RExcel and R Commander

RExcel ~ R File ~ Edit ~ Data ~ Statistics ~ Graphs * Maodels ~ Dis

Fig. 2.27 The Model item in the Remdr menu now shows the name of the active re-
gression analysis object RegModel . 1. Compare to Fig. 2.18, where only the active
dataset is displayed. The summary of the model object is automatically displayed in
Fig. 2.26. Additional graphs and tables can be constructed from the active model.
All menu items in the Models menu use the active model object.

2.3 R Console

R was originally designed as a command language; commands were typed into a
text-based input area on the computer screen and the program responded with a
written response to each command. The written response is usually a table. In this
book, we normally do not use the command language directly. Occasionally, we
need it; therefore, we give a small introduction here.

Start R as in Figs. 1.13 and 1.14. The R Console in Fig. 1.14 is essentially a
typewriter window. The R Console opens with information and then a prompt mark,
usually > , indicating that it is ready for us to type. We type a line, ending with the
«— Enter key. Then R types one or more lines in return, ending with the prompt > .

In Fig. 2.28, we repeat in the R Console the regression example first shown in
the Remdr Output Window in the bottom section of Fig. 2.26.
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|- R Console

33

File Edit Misc Packages Help

>
> data(trees, package="datasets"”

> gcatterplot.matrix (~Girth+Height+Volume, reg.line=lm, smooth=FALSE,
+ span=0.5, diagonal = 'density', data=trees, rowlactop=FALLSE}

> Reglodel.l <- lm({Voluwe~Girth, data=trees)

> summary (FeglModel. 1)

Call:
Imiformula = Volume ~ Girth, data = trees)

Residuals:
Hin 10 HMedian 30 Hax
=53.0654 =3.1067 0.1520 3.4948 0O.5368

Coefficients:
Estimate Std. Error t walue Prix|t])
(Incercept) -36.9435 3.3651 -10.98 7.62e-12 *+FF
Girth E.0659 0.2474 20.48 < Ze-=16 *%F¥
Signif. codes: O '**%' Q0,001 '**' 0,01 '*" Q.05 *.' 0.1 ' " 1

Residual standard error: 4.252 on 29 degrees of freedom
Multiple R-scuared: 0.9353, hdjusted R-scuared: 0.9331
F-statistic: 419.4 on 1 and 29 DF, p-value: < 2.2e-16

>

<

Fig. 2.28 Repeat of the regression analysis in Fig. 2.26. This figure is primarily a
demonstration of the R Console window and only incidentally an illustration of the
regression analysis. The R Console displays a prompt mark > indicating that it is
ready for us to type. We type each line into the R Console window and end each
line with an < Enter keypress. After each complete line is typed, the R Console
responds with a prompt > saying it is ready for a new line. After incomplete lines—
in this example, the first line of the scatterplot.matrix () function call—
the R Console responds with a continuation prompt + . The data () command
produces no printed output. The scatterplot.matrix () command tells R to
construct and display the plot in Fig. 2.23. The summary () command produces an
output display, which is shown immediately after the command line and before the

next prompt.
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2.4 R Commander Window

The R Commander window is so named because it generates R commands from
clicks on the menu. Let’s look again at Fig. 2.26, this time focusing on the structure
of the window.

In Figs. 2.15 and 2.18, we clicked menus and dialog boxes. The R Commander
translated those clicks into the data () command in the Script Window in the top
half of the R Commander window in Fig. 2.26. It also put the command in the Output
Window in the bottom half of the R Commander window in Fig. 2.26 (it scrolled
offscreen in this illustration).

In Figs. 2.21 and 2.22 we clicked menus and dialog boxes. The R Commander
translated those clicks into the scatterplot .matrix () command in the Script
Window. It also put the command in the Output Window. This command also scrolled
offscreen in this illustration.

In Figs. 2.24-2.25 we clicked menus and dialog boxes. The R Commander trans-
lated those clicks into the 1m () and summary () commands in the Script Window.
It also put the command and its printed output in the Output Window.

The Script Window simulates a program file of commands that could be typed into
the R Console. The Output Window simulates the R Console window.

It is possible, and sometimes useful, to type commands into the R Commander
Script Window and submit them to the R Commander Output Window for execution.
Just enter a complete command in the Script Window and click the Submit button.
In Section 2.2, we showed the information in the help file for the trees dataset.
In Section 2.5, as an example of typing into the R Commander window, we show
screenshots of the query in Fig. 2.29 and the help file in Fig. 2.30.
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2.5 R Help Files

All functions and datasets in R have a help file. Help files can be accessed by typing
a query, for example, ? trees, in the R Commander Script Window and then clicking
the Submit button as shown in Fig. 2.29. In addition, all Remdr dialog boxes include
a Help button that will open the appropriate help file.

Fig. 2.30 shows the help file for the trees dataset in the standard MS help
format. R can present help files in other formats. See ?help for more information.
If the help files appear in some other format, you can force R to use the standard
MS help format by entering options (chmhelp=TRUE) in the R Commander
Script Window and then clicking the Submit button. You can also change the help file
format from the RExcel » Options dialog box.

R Commander

Scripk Windaw

‘tree ﬂ

Oukput Window Suhmi‘tl
> ?trees

Fig. 2.29 Type the help query ?trees in the R Commander Script Window and
leave the cursor on that line. Then click the | button. The R Commander
copies the line to the Output Window and executes the line by opening the help file
in Fig. 2.30 to a discussion of the trees dataset.

2.6 Messages from R, Remdr, or Excel

R and Excel are two different processes running on your computer. The RExcel
interface coordinates communication between them. It is possible for them to get
out of phase, particularly during startup. See Appendix B for remedies for some of
the more likely problems.
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R Help for package datasets
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2] Molor Trend Car Road Tests

[2] New York Air Quality Msasurer
2] Occupational Status of Fathers
2] Old Faithful Gepser Data

21 Passeanner Miles nn Cammereiz
|

Girth Height and Volume for Black Cherry
Trees

Description

This data set provides measurements of the girth, height and volume of timber in 31 felled
black cherry trees. Note that girth is the diameter of the tree (in inches) measured at 4 ft 6 in
above the ground.

Usage
trees
Format

A data frame with 31 observations on 3 variables.
[,1] Girth numeric Tree diameter in inches
[,2] Height mumeric Height in ft

[,3] Volume mumeric Volume of tmber in cubic ft
Source

Ryan, T. A., Joiner, B. L. and Ryan, B. F. (1976) The Minitab Student Handbook. Duxbury
Press.

References
Atlinson. A C. (1985) Plots, Transformations and Regression. Oxford University Press.
Examples

require(stats): require(graphics)

pairs(trees, panel = panel.smooth, main = "trees data")

plot (Volume ~ Girth, data = trees, log = "xy"

coplot (log(Volume) ~ log(Girth) | Height, data = trees,
panel = panel.smooth

summary(fml <- lm(log(Volume) ~ log(Girth), data = trees)

summary (fm2 <- update(fml, ~ . + log(Height), data = trees))

step (fm2)

#% i.e., Volume ~= ¢ * Height * Girth"2 seems reasonable

[Package datasets version 2.8.1 Index v

Fig. 2.30 This is an illustration of a help window in the standard MS help format.
The right panel describes the dataset. The left panel opens to the table of contents for
that help file. In this example, the help file contains descriptions of all the datasets
included as part of base R.



Chapter 3
Getting Data into R

Abstract Datasets are frequently given as Excel worksheets. We must transfer them
from Excel to R in order to place the variable names on the Rcmdr menu items. We
show how to do the transfer for several different data structures. Sometimes datasets
are given as ASCII text files. These too can be read into Excel and then transferred
to R. Sometimes datasets are already in R. We can work with them directly, and
we can display them in Excel by transferring the data the other direction from R to
Excel.

3.1 Example Datasets

Datasets are frequently given as Excel worksheets. Most statistics texts, for example,
include their example datasets in Excel workbooks. The usual method (if Excel is
not started already) of bringing files into Excel is by double-clicking their file name
in Windows Explorer.

For specificity in describing the transfer of the datasets to R, we include four
example Excel workbooks in the RExcel » RthroughExcel Worksheets menu item.
Because these datasets are part of the R through Excel distribution, they are acces-
sible from the RExcel menu instead of the usual Windows Explorer. We show how
to access our example datasets in Figs. 3.1 and 3.2. Once opened, they are ordinary
Excel worksheets.

R.M. Heiberger, E. Neuwirth, R Through Excel, Use R, 37
DOI 10.1007/978-1-4419-0052-4 3,
© Springer Science+Business Media, LLC 2009
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- =X

@’ Home  Inset  Pagelayout  Formulas  Data  Review  View WJ RERARS @

gaNotelsapistdbutions sioolss Helo

Oa\H9-¢-@ )+ Microsoft Excel
7| | IR File - Data - Statistics - Graphs
Close R taf - | Modet | No active mode - [
Run Code
M Get R Value » Custom Toolbars
Put R Var 3 “-E ]
o Get R gutput
2 Set R working dir
| o | E |
1 Load R file
1 Copy Code
q Debug R
4 Error Log
4 Options
g Set R server
1@  RExcel Help
8 @ RHelp
9 Stop RCommander
f Demo Worksheets »
1 RihraugnBxcel Workshests |
1R 2bout Rexcel '

| Ready | 3 |

Fig. 3.1 Click in the RExcel » RthroughExcel Worksheets menu item. This opens the

workbook BookFilesTOC in Fig. 3.2.
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) BookFilesTOC xlsm
A B C D E F G H L

Demo files for the book
R through Excel

Linear Regrassion Linear Regression Workbook Documentatianl

Wo(~mm&lw N

10 Norrel and normal and t Workbook Documentation |

14 Student Data Student Data Workbook Documentation |

19 Adverse Effects

Adverse Effects Dotplot Documentation ]
ET) Dotplot

22 TwoColumns

26 MoHeader Data Format Documentation
27 TwoColumns

28 MoHeader

29 Long

30 Long Wide

ET Wide

38 betaWeightedAverage bataWWsightedAverage Documentation |

M 4> | Menu  Workbooks €0 4 [

Fig. 3.2 The workbook titled Demo Files for the book R through Excel was opened in
Fig. 3.1. The four example files we discuss in this chapter are accessed by clicking
one of the buttons TwoColumns, NoHeader, Long, Wide. Click the TwoColumns button
to open the TwoColumns workbook displayed in Fig. 3.3.



40

3.2 Named Columns of Data

3 Getting Data into R

& TwoColumns.xlsm

A B
ik b
% 1 1.4
3 2 3.7
4 3 2.87
5 4 21
6 5 9.1
7 6 7.2
8 7 8.7
9 g 8.01
10 9 1115
11 10
12 11
13 12
14
M 4 b W] Sheetl

il

&) TwoColumns.xlsm

A B c [i

1 x y |
2 1 1.4
3 2 3.7
4 3 2.87
|5 | 4 4.1 4
5 | 5 9.1
7 6 7.2
3 7 8.7
9 8 8.01)
10 9 1115
|11 10
12 11
13 12

14

4 4 » M| Sheetl

Fig. 3.3 The TwoColumns workbook is one of the workbooks distributed with the
R through Excel book. Follow the steps in Figs. 3.1 and 3.2 to open this workbook.
The TwoColumns workbook has two columns, with column names x and y in row 1
and numeric data values in rows 2—13. Highlight the data by clicking cell A1 and
pressing the standard Excel keyboard shortcut Ctrl+shift+*. This shortcut highlights
the smallest contiguous rectangle of cells containing the selected cell that is bor-
dered (even at the corners) by empty cells or the worksheet borders only. The row
containing the variable names is included.
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Fig. 3.4 Send the highlighted data, including the row containing the variable
names, to R by (a) right-clicking Put R Dataframe and (b) accepting the suggested
name in the dialog box and clicking OK. The suggested name is normally the base
name of the Excel file, in this example TwoColumns.

RExcel ~ R File =~ Data ~ Statistics = Graphs = Models = Distributions = Tools = Help ~

Dataset: | TwoColumns ~ | Model: | Mo active mode
Menu Commands Custom Toolbars

Fig. 3.5 The active dataset is now listed in the Rcmdr Dataset window as
TwoColumns. Compare to the Dataset window in Fig. 3.4, where it says No active
dataframe. One important consequence of Put R Dataframe is to make the transferred
data into the active dataset and therefore make its variable names available in the
Remdr menu items.
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(O H9-c-GE )+ Microsoft Excel - = x
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Fig. 3.6 We can now examine the data in the active dataset with the functions on
the Rcmdr menus. We illustrate by plotting y ~ x . The formula notation says
that v, the variable named on the left of the tilde “~”, is to be plotted on the vertical
axis and x, the variable named on the right of the tilde “~”, is to be plotted on the
horizontal axis. On the Rcmdr menu, click Graphs » Scatterplot.HH. .. (HH) to get the
dialog box in Fig. 3.7.
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Fig. 3.7 This dialog box comes from Fig. 3.6. We click x in the x-variable selection
box and y in the y-variable selection box. We accept the default values for all the
other options in the dialog box. When we click OK, we get the graph in Fig. 3.8 and
the generated statements in Fig. 3.9.



44 3 Getting Data into R

I R Graphics: Device 2 {ACTIVE)

File History Resize

10

Fig. 3.8 This is the graph specified by the dialog box in Fig. 3.6. The points are
specified by the x- and y-values in the rows of the dataset in Fig. 3.3. The line is the
least-squares line, which we will discuss in Chapter 8.
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R Commander.

Script Window

scatterplot (y~x, redg.line=lm, smooth=FAL3SE, labels=FAL3E, bhoxplots=FALSE,
span=0.5, cex=1.3, cex.axis=1.3, cex.lab=1.3, pch=16, data=TwoColumns)

Cutput Window Suhmi‘tl

> soatterplot (y~x, reg.line=lm, swooth=FALSE, labels=FALSE, hoxplots=FAL3E,

+ span=0.5, cex=1.3, cex.axis=1.3, cex.lab=1.3, pch=16, data=TwoColumns)

Messages

>

=

Fig. 3.9 Rcmdr works by translating the clicked items in the Remdr menu into
statements in the R language. The generated statements are displayed in the Script
Window of the R Commander window. The executed statements are displayed, along

with any printed output, in the Output Window of the R Commander window.
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3.3 Unnamed Columns of Data

a. Two columns, as opened. b. Row 1 highlighted.
) NoHeader.xlsm - = X ||&H NoHeaderxlsm - 8 X
| A B c i | A | B | ¢ | B

1 | 14 1| 1 14

2 2 3.7 2 2 3.7

3 3 2.87 3 3 2.87

4 14 4.1 4 14 4.1

5 5 9.1 5 5 9.1

6 6 7.2 = 6 6 7.2 =
7 7 8.7 7 7 8.7

8 8 3.01 8 8 3.01

9 9 11.15 9 9 11.15

10 10 9.87 10 10 9.87

11 11 11 11

12 12 12 12

13 13

14 14

15 15
M 4 > M| Sheetl M 4 > M| Sheetl

Fig. 3.10 The NoHeader workbook is one of the workbooks distributed with the R
through Excel book. Follow the steps in Figs. 3.1 and 3.2 to open this workbook. The
initial appearance is shown in Panel a. The NoHeader workbook has two unnamed
columns. The numerical values are the same as in the TwoColumns workbook in Fig.
3.3. We need column names when we send the data to R. In Panel b, we highlight
row 1 by clicking the row number column. We continue in Fig. 3.11.
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a. Right-click » Insert.
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b. New, empty row 1. c. Enter column names.
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7 6 1.2 7 6 1.2
8 £ 8.7 8 £ 8.7
9 8 8.01 9 8 8.01
10 9 1115 10 9 1115
11 10 9.87 11 10 9.87
12 11 10.5
13 12 11.2
14
15
M4

Fig. 3.11 Continuing from Fig. 3.10. In Panel a, we right-click the highlighted row
number and click Insert. In Panel b, we now see a new blank row inserted in front of the
previous row 1. In Panel c, we enter the column names in the newly inserted row 1. The
worksheet now shows a labeled dataset that we can send to R, as in Fig. 3.12
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a. Menu.

3 Getting Data into R

b. Dialog box.

= Calibri +/11 ~ A" A" § ~ 9
) NoHeader.xlsm A A °
BI=iH-~O-A-
‘ T Hr
1 1
2 1 R Run code in Remdr
3 > | R Run code Put dataframe in R E|
4 3 Get R Value
c P PULR Var Dataframe name in R
6 5 Get Active DataFrame | NoHeader
7 6 Get R DataFrame Get from Cell
8 7 Put R DataFrame
3 8 [~ with rownames
Remdr Get
10 ] v make active in Rcommander
Get R Qutput
11 10
Insert Current R Plot
13 12 Name Range
14 Prettyformat Numbers
15 & Cut
H 4 » ¥| Sheetl SH43 Copy
c. Ribbon with Remdr active dataset.
{7 _) s Microsoft Excel S
e =
- Home Page Layout Formulas Review View Developer Add-Ins | @)
RExcel - R File = Data ~ Statistics = Graphs ~ Models = Distributions = Tools = Help ~

Menu Commands

Dataset: MoHeader

Custom Toolbars

- | Maodel: |No active mode

Fig. 3.12 Continuing from Fig. 3.11. a. Highlight the data, including the row con-
taining the variable names, by clicking cell A1 and pressing the standard Excel key-
board shortcut Ctrl+shift+*. Then right-click Put R DataFrame to get the dialog box in
Panel b. Accept the default dataframe name and click OK. In Panel ¢, we see that the
active dataset is now listed in the Recmdr Dataset window as NoHeader. The variable
names in the dataset NoHeader are now available in the Rcmdr menu items.
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3.4 Numeric Columns and Factor Columns
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Fig. 3.13 The Long workbook is one of the workbooks distributed with the R
through Excel book. Follow the steps in Figs. 3.1 and 3.2 to open this workbook.
The Long workbook has two columns. The y column contains numerical values of
a response variable. The group column contains the level names for a factor. The
workbook name Long is chosen to indicate that this data is stored in the long format,
where all responses for all groups are in the same y column and the group member-
ship is indicated by the levels in the group column. Compare the long format to the
wide format in Fig. 3.16. The Long format is used by most of the modeling functions
in R. In this figure, we have highlighted the data region, including the row contain-
ing the variable names, with the standard Excel keyboard shortcut Ctrl+shift+* and
sent it to R with right-click Put R DataFrame to get Fig. 3.14.
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a. Menu specification of one-way ANOVA.

(O H9-c-GE )+ Microsoft Excel - =X

~ - Home Insert Page Layout Formulas Data Review View Developer | Add-Ins i@

RExcel~ R File = Data ~ |Statistics ={ Graphs ~ Models = Distributions = Tools = Help =
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Contingency tables  » T
MeRU Commands Means » single-sample t-test.., —
Long v Proportions » 0
f@ T Variances 2 sired t-te |
i A ! 8 c Monparametric tests » || One-way ANOVA,.. I :

1 [y group Dimensional analysis * Multi-way ANOVA.., S

2 4.2 A Fit models 3

| 52A

4 -2 A

5| 31A =

6 23 A

7] 53 A

8 6.3 A

9 a4 hn

10| 51A

11 6.984 A

12| 824

13| 23 A

14 10.2B

15 4004 B

16| 3.7B

17 79 B

18| 9.3B

19 823 B ||

4 4 » ¥ Sheetl  Sheell '

Ready | E | Average: 5814944444 Count: 74 Sum: 209338 | B

b. Dialog box for one-way ANOVA.

One-Way Analysis of Yariance

Groups (pick one) Response Warisble (pick one)
|
Pairwise comparisons of means |

I 0K I [ Cancel ] [ Help ]

Fig. 3.14 The Long dataset was sent to R in Fig. 3.13. Here we specify a one-
way analysis of variance (ANOVA) with the Remdr » Statistics » Means » One-way
ANOVA command. There are only one factor and one numeric variable in this dataset,
so both selection boxes are highlighted when the dialog box opens. This dialog box
specifies the tables in Fig. 3.15.
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R Commander.

Script Window

hnovaﬂodel.l <— @aov(y ~ group, data=Long)
summary [ AnovalModel. 1)
numSummwary (Long$y , groups=Longigroup, statistics=c("mean™, "sd"))

Cutput Window Suhmi‘tl

> hnowvalModel.l <- aovi(y ~ group, data=Long)

> sumerary [ AnovalModel. 1)

Df Zum S3g Mean 3g F walue Pri=F)
group Z 86.54 43.27 4.2292 0.02317 *
Residuals 33 337.64 10.23

Signif. codes: O '#¥*%' 0.001 '**' 0.01 '*" Q.05 ', o001t 1

> numZwmeary (Longdy , groups=Longigroup, statistics=c("mean'™, "sd"))
mean ad n

A 4,248667 Z.663938 12

B 7.9z27000 3.29993z2 12

C 5.269167 3.564908 12

Messages

=

Fig. 3.15 Analysis of variance command lines generated by the R Commander.
The Remdr Script Window shows the lines, and the Output Window shows the tabular
output from running those lines.
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3.5 Multiple Numeric Columns, One per Factor Level

'kﬂ T T Calibi ~/11 ~|A° A" $ * % 9
= = c |BIESE-O-A-QdNE
1 3 1 . . i |
2 4.2 10.2 i R Run code in Remdr
3 52 4004 3.21 R Runcode
4 -2 3.7 Get R Value
3 il 7.9 8. Put R Var
6 2.3 9.3 9. Get Active DataFrame
7 =) 8.23 3.2 Get R DataFrame
B &) 9.5 2 Put R DataFrame
d . e & Remdr Get
10 5.1 4.6 2.3
1 6.984 13.09 Get R Qutput
12 8.2 3.6 0.3 Insert Current R Plot
13 23 12.4 9. Name Range
14 Prettyformat Numbers
15 #  Cut
16 <3 Copy
17 4 Paste
i 4 > | Sheetl ~Sheetz ~Shy ¢ EPecal

Fig. 3.16 The Wide workbook is one of the workbooks distributed with the R
through Excel book. Follow the steps in Figs. 3.1 and 3.2 to open this workbook. The
initial appearance is shown in Panel a. Data about multiple groups is often stored
in the wide format shown in the Wide workbook. The Wide workbook has three
columns, one for each level of the group factor. To use data formatted this way in
the one-way ANOVA and many other commands, it is necessary to reshape it to the
long format. We do so by highlighting the data region, including the row containing
the variable names, with the standard Excel keyboard shortcut Ctrl+shift+*. We then
copy the data by right-clicking Copy, and we move to Fig. 3.17.
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Fig. 3.17 We highlighted and right-click-Copyed the data in Fig. 3.16. Here, we
place the cursor in cell E1, right-click Paste as Stacked, and click OK in the dialog
box to produce the stacked formatting of the data in Fig. 3.18.
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Fig. 3.18 The region in cells E1:F37 is the stacked arrangement of the original data
in cells A1:C13. cells F2:F13 in the var column are the numbers originally in cells
A2:A13. The value A in cells E2:E13 indicate that these numbers are associated with
the A level of the newly created factor group. Similarly, cells E14:F25 are the B level
of the group factor and cells E26:F37 are the C level of the group factor. Column F
is very difficult to read because the decimal points are not aligned. We repair that in
Figs. 3.19 and 3.20.
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E_ 5.1 4.6 2.34 A 3. Get R DataFrame
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| Get R Qutput
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; B 2.00. Insert Current R Plot
16 B 7. Mame Range
_1; B 74 Prettyformat Numbers |
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Fig. 3.19 Press the Esc key to remove the dotted line surrounding the original re-
gion A1:C13in Fig. 3.18. Highlight cells E1:F37 and right-click Prettyformat Numbers
to produce column F in Fig. 3.20.
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Fig. 3.20 The var column (column F) in the data from Fig. 3.19 is now format-
ted with aligned decimal points. Cells E1:F37 are still highlighted from Fig. 3.19.
We can now right-click Put R DataFrame to send the data, with the new name
WideStacked chosen to reflect the structural change, to R. The data becomes the
active dataset as shown in Fig. 3.21.

H9-o-E) - Microsoft Excel - 8 X

Home Insert Page Layout Formulas Data Review View Developer Add-Ins '@

RExcel~ R File = Data - Statistics = Graphs ~ Models = Distributions = Tools = Help =
Dataset: WideStacked ~ Model: Mo active mode =

Menu Commands Custom Taolbars

I WideStacked - [€ f'| group ,

Fig. 3.21 Continuing from Fig. 3.20, the active dataset is now WideStacked. Since
WideStacked is structured the same way as Long, we can continue with analyses
similar to those shown in Figs. 3.14 and 3.15.
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3.6 Transferring Data from R to Excel

In the previous sections, we illustrated the transfer of data from Excel to R. In this
section, we illustrate the transfer of data from R to Excel. R and its many packages
come with example datasets that are used in the R documentation and help files.
They are easily accessed from the Remdr menu bar.

D) [ N e Microsoft Excel SR
Home Insert Page Layout Formulas Data Review View Developer Adddns | )

RExcel~ R File = |Data v| Statistics ~ Graphs = Maodels = Distributions ~ Tools = Help =

Dataset: MNew data set..,

Load data set...

Menu Commands Import data v |
| Al - | Data in packages 4 List data sets in packages
= Active data set r Read data set from an attached package...
i Bookt

Manage variables in active data set » F
A B T 45 T T T E T F | G | H | I i

L1

ERE-- RS- R R TE R SR

Fig. 3.22 Click on the Recmdr » Data » Data in packages » Read data set from an
attached package. .. menu to get the dialog box in Fig. 3.23.

Read Data From Package E“_: E|

Package {Double-click ko select)  Data set {Double-click to select)

-ar OrchardSprays
AantGrowth

attice
ultcomp
OR
Enter name of data set: |PlantGroveth
[ 0K l [ Cancel ] [ Help ]

Fig. 3.23 This dialog box comes from Fig. 3.22. Double-click a package name,
then double-click a dataset name, and then click OK. This selects a dataframe from
an attached package, in this example, the PlantGrowth dataset from the datasets pack-
age. This makes the selected package the active dataset in the Remdr menu bar as
shown in Fig. 3.24.
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(a [ B IR e ' Microsoft Excel - = x
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Fig. 3.24 In Fig. 3.22 we selected the PlantGrowth dataset as the active dataset, and
we now see its name in the active dataset listing on the Remdr menu bar. The Remdr
menu items now know about the variable names in this dataset. To see the dataset
itself in Excel, we must get it from R. We do so by opening a new empty workbook,
clicking in cell A1, and then right-clicking Get Active DataFrame. This brings the
dataset into Excel as shown in Fig. 3.25.
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Fig. 3.25 This is the PlantGrowth data that we brought into Excel in Figs. 3.22 and

3.24.
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3.7 Other Input Formats, Including ASCII Text Files

Datasets come in many formats. R and/or Excel can read most of them. We show
the menu locations of the data import functions in both systems.

!{/Eg [ B IR e ' Microsoft Excel e
- Home Insert Page Layout Formulas Data Review View Developer Add-Ins '@
RExcel~ R File = |Data = | Statistics = Graphs ~ Models = Distributions = Tools = Help =
Dataset: P Mew data set...
Load data set...
Menu Commands Import data L2 from text file, clipboard, or URL...
| PlantGrowth - | Data in packages L4 from SPSS data set...
= Active data set 2 from Minitab data set...
i Bookt ) N
Manage variables in active data set » from STATA data set..,
A B = 4 T E T
from Excel, Access or dBase data set..,

Fig. 3.26 To read data directly into R, we can use the Rcmdr » Data » Import data »
menu. We show one more step here, the from text file, clipboard, or URL... item. Once
the dataset is in R, we can access it using the techniques illustrated in Section 3.6.

!{/Eg [ B IR e ' Microsoft Excel o
— Home Insert Page Layout Formulas Data Review Developer Add-Ins '@
@ |Gs] connections Al Eﬂ | i Clear = &
| Z¥ |z[a | S
= %F Properties &, Reapply Fa
Refresh il Sort Filter Y; Textto Remove . Outline
All= =2 Edit Links 2 Advanced || Columns Duplicates =2~ 4
| Connections Sort & Filter Diata Tools
B EN [FEN | N Y
S NNSEIRNET | Ell § i
From From | From |From Other Existing e m X
Access Web | Text | Sources~ | Connections £
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Fig. 3.27 To read data directly into Excel, we can use the Excel Data » Get External
Data menu. We show one more step here, the From Text item. Once the dataset is in
Excel, we can access it using the techniques illustrated in Sections 3.2-3.5.



Chapter 4
Normal and r Distributions

Abstract The normal and 7 distributions are heavily used in statistical analysis. The
normal and ¢-tables on the Remdr menu can be used to look up probabilities p
given quantiles (z- or ¢-values), or quantiles (z or f) corresponding to known p-
values. Some of these probability functions are also available in Excel (as part of
the Analysis toolpack), but the R functions are more versatile and more precise.

The tables can also be used to explore the relationship between an observed
mean X of n observations and its standard deviation s by using the standardized
normal z = X/s;z where the sample standard error of the mean is given by sz = s/+/n.

Graphical displays can be used to explore the Type I and Il errors associated with
hypothesis tests and to explore the effect of sample size on the width of a confidence
interval. We can access the graphs from the menus and also from an Excel workbook
described in Chapter 5 that communicates with the R process.

4.1 Accessing R Functions with the Remdr Menus

The standard normal and z-tables can be accessed directly from the menus. Figs.
4.1,4.2, and 4.3 show how to use the menu to find critical values given the p-values.
Figs. 4.4, 4.5, and 4.6 show how to use the menu to find p-values given the observed
value of the statistic.

R.M. Heiberger, E. Neuwirth, R Through Excel, Use R, 61
DOI 10.1007/978-1-4419-0052-4 4,
© Springer Science+Business Media, LLC 2009
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Distributions 'ITooIs > Help~

Continuous distributions  * Normal distribution b Mormal quantiles...
Discrete distributions L t distribution 4 Mormal probabilities..,
Chi-squared distribution » Plot normal distributian...
F distribution ¥ Sample from normal distribution...
Exponential distribution  » Plot hypotheses or Confidence Intervals ... (HH)
Unifarm distribution ¥
Beta distribution S
Cauchy distribution 3
Logistic distribution 13

Lognormal distribution ¥

Gamma distribution S
Weibull distribution 4
Gumbel distribution 3

Fig. 4.1 The Normal quantiles... menu item requests the dialog box in Fig. 4.2 in
which to specify the probabilities. This is the inverse use of the normal table.

Normal Quantiles Normal Quantiles
Frobailties || Probabilities |.025 .05 .10 .50 .90 .95 .97
mu [mean) D— mu [mean) D—
zigma [standard deviation] |1 zigma [standard deviation] |1
Lawer tail &+ Lawer tail &+
Upper tail Upper tail

ak. I Cancel | Help | ak. I Cancel | Help |

Fig. 4.2 Given a probability value p = 0.95, the normal quantile is z = 1.96. A list
of several probabilities can be entered into the dialog box. The box defaults to Stan-
dard Normal (mean 0 and standard deviation 1). The user can specify other values
for the mean and standard deviation. The left dialog box is the initial appearance.
The right dialog box is the same box after we filled in some probabilities.
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R Commander.

Script Window
gnorm(c(.025,.05,.10,.50,.90,.95,.975), mean=0, sd=1, lower.tail=TRUE)

Dutput Windaw Submit] |

> gnormic|.025,.05,.10,.50,.90,.95,.975), mean=0, =d=1, lower.tail=TRUE)
[1] -1.959964 -1.644554 -1.251552 0.000000 1.251552 1.644554 1.959964

Fig. 4.3 The Rcmdr generates an R statement and displays the generated statement
in the Script Window. The quantiles are displayed in the Output Window.

IDistrihu‘tians ~|Tools * Help ~

Continuous distributions  # Mormal distribution

-

Mormal guantiles...
Discrete distributions L t distribution ] Normal probabilities..,

-

Chi-squared distribution Plot narmal distribution...
F distribution L Sample from normal distribution...

Exponential distribution

-

Plot hypotheses or Confidence Intervals ... (HH}

-

Uniform distribution
EBeta distribution 3

Cauchy distribution L3

-

Logistic distribution

Lognormal distribution
Gamma distribution »

‘Weibull distribution

-

Gumbel distribution

-

Fig. 4.4 The Normal probabilities... menu item requests the dialog box in Fig. 4.5 in
which to specify the quantiles. This is the forward use of the normal table.



64 4 Normal and ¢ Distributions

Normal Probabilities

Variable valuels) [-1.95 -1.645 01,645 1.9
mu [mean] [0
sigma [standard deviation] |1
Lower tail *

Upper taill

(1] I Cancel Help

Fig. 4.5 Given the normal quantile z = 1.96, the probability value is p = 0.95. A list
of several quantiles can be entered into the dialog box. We filled in some quantiles.

R Commander.

Script Window

gnorm(e(.025,.05,.10,.50,.90,.95,.975), mean=0, =d=1,

lower.tail=TRUE)
pnormic{-1.96,-1.645,0,1.645,1.946) , mean=0, sd=1,

lower . taill=TRUE)

Clutput “window

Submit] |

> gnormic(.025,.05,.10,.50,.90,.95,.975), mean=0, =d=1,

lower . tail=TRUE])
[1] -1.959964 -1.644554 -1.251552 0.000000

1.251552 1.644554 1.9559964

> pnormic(-1.96,-1.645,0,1.645,1.96), mean=0, =sd=1, lower.tail=TRUE)
[1] 0.02499790 0.04593491 0.50000000 0.95001509 0,.97500210

Fig. 4.6 Rcmdr generates an R statement and displays the generated statement in
the Script Window. The probabilities are displayed in the Output Window. Both the
Script and Output windows accumulate during the session. They can be saved at the
end for a complete record of the day’s activity.
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The identical procedures work for the ¢ distribution (and the other distributions
listed on the pull-out menu). We illustrate here for the ¢ distribution on 5 degrees of
freedom.

Distributions '|T00|5 ~ Help—

Continuous distributions » Mormal distribution LJ
Discrete distributions 4 t distribution 1 t quantiles...
Chi-squared distribution » t probabilities...
F distribution »: Plot t distribution...
Exponential distribution  * sample from t distribution...
Unifarm distribution L Plot hypotheses ar Confidence Intervals ... (HH]
Beta distribution »
Cauchy distribution 3
Logistic distribution ]
Lognormal distribution  »
Gamma distribution 3
Weibull distribution 3
Gumbel distribution »

Fig. 4.7 Click the distribution menu item.

t Quantiles

Probabilities | 025 .05 .10 50 .80 .95 974
Degrees of freedom |5
Lower tail ©+

Upper tail ¢

oK I Cancel Help

Fig. 4.8 Fill in the dialog box with some probability values and the degrees of
freedom.

> gt{c(.025,.05,.10,.50,.90,.95, .975), df=5, lower.t=ail=TRUE)
[1] -2.570582 —-2.015048 -1.475884 0.000000 1.4758584 2.015048 2.570582

Fig. 4.9 The quantiles are displayed in the Output Window.
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4.2 Accessing R Functions from Within Excel Cells

RExcel can access R functions from inside Excel workbook cells. This ability places
the entirety of R’s capabilities inside the spreadsheet automatic recalculation model.

We illustrate this feature by getting numerical values calculated in R into spread-
sheet cells. In Figs. 4.2—4.4, we used the Remdr menus and dialog boxes to access
the normal table in R. In Figs. 4.10-4.13, we repeat the calculations, this time plac-
ing the R function calls inside the spreadsheet recalculation model.

RExcel provides a set of Excel sheet functions, functions that can be written
in an Excel cell. The RApply function is an Excel function that takes two or more
arguments. The first argument is the name of an R function as a text string. The
remaining arguments are references to regions of Excel cells. RApply calls the R
function with the values of the referenced cells as its arguments.

In Fig. 4.10, we show the Excel worksheet formula

=RApply("gnorm”,A4)

in cell B4. The argument string is constructed by ordinary Excel text commands and
clicking commands. The value in cell A4 (currently 0.025) will be sent to R to be
evaluated as the argument of the gnorm function. This has the same effect as typing
"gnorm(0.025)” into the R Console or the Rcmdr Script Window. This is the notation
in R for the probability statement: Find z such that Prob(Z < z) = 0.025 from the
standard normal distribution. The RApply command receives the numerical answer
z=—1.960 back from R, and displays it in cell B4 in Fig. 4.11.

| INDEX (0 X ¢ ﬁ| =RApply("gnorm",Ad)

2] Book1
A B & D
enter calculate
p-values quantiles
inExcel inR
" 0.025|=RApply("gnorm",Aa)l
0.050
0.100
0.500
0.500
0.950
0.975

WO 00|~ D a|w N

[
=

Fig. 4.10 Open a new workbook. Place probability values in cells A4:A10. Enter
the formula =RApply ("gnorm",A4) into cell B4. The blue A4 in the formula
bar and the blue-outlined cell A4 in the worksheet indicate that the formula in cell
B4 depends on the value in cell A4. Press Enter and continue on to Fig. 4.11.
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3 |inExcel inR

0.025 -1.960
0.050} |
0.100

0.500

0.900

0.950

10| 0975

W 0~ B

Fig. 4.11 Press Enter in Fig. 4.10, and the formula in B4 is evaluated to show the
numerical value —1.960.

3 |inExcel inR
0.025 -1.960;

Fig. 4.12 We use standard Excel techniques to extend the formula in Figs. 4.10
and 4.11 to additional z-values. Grab the fill handle in the lower right corner of cell
B4 and drag it down to fill cells B5:B10. The cell references will be automatically
updated as shown in Fig. 4.13.

3 inExcel inR

a 0.025 -1.960|
5 0.050 -1.645
6 0.100 -1.282
7 0.500 0.000|
8 0.900 1.282
9 0.950 1.645
10 0975 1.960|

Fig. 4.13 After the formula in cell B4 in Fig. 4.12 has been copied to cells B5:B10,
all cells are immediately evaluated and the resulting z-values are displayed in cells
B4:B10, for each probability in cells A4:A10.
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Many more examples, including some elaborate ones, of getting calculated val-
ues from R into Excel are in the Worksheet functions demo [Neuwirth et al., 2008]
on the RExcel menu as shown in Fig. 4.14.

(Oa - ™-E )T Microsoft Excel
- Home Insert Page Layout Formulas Data

RExcel ~ R File - Data - Statistics ~ Graphs ~ Models ~ Disl

Close R itaf ~ Model: Mo active mode ~

Run Code
M Get R Value v | Custom Toolbars

Ef Put R Var v L&

Get R gutput

Set R working dir
Load R file s
Copy Code
DebugR
Error Log

Options

@ RExcel Help
@ RHelp
Stop RCommander

Demo Worksheets b Data transfer

RthroughExcel Waorksheets Writing macros

R About RExcel Waorksheet functions

T

23 Graphics with sliders

24 Interactive graphics

Fig. 4.14 The RExcel » Demo Worksheets » Worksheet functions menu item opens a
workbook that lists and illustrates the RExcel functions used in the communication
between R and Excel.

The workbooks distributed with this book, available on the RExcel » RthroughEx-
cel Worksheets menu item, are constructed with the functions described in the Work-
sheet functions demo. Two of the workbooks will be discussed in Chapter 5 and
Chapter 9. If the RthroughExcel Worksheets menu item is missing, see step 4 of Sec-
tion A.3.3.
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4.3 Graphical Displays of the Standard Normal Distribution

Graphical displays of the density function of the normal and ¢ distributions are im-
portant to understanding the distributions. There are two access points to the graph-
ical displays, the menu and the Excel workbook. In both, we highlight regions as-
sociated with a range of z-values, and report the probability (area) of the region.
We illustrate menu access here. We illustrate access from an Excel workbook in
Chapter 5.

[Distnbutions "Too\s = Help= |

Continuous distributions  * Normal distribution MNormal quantiles..,

Discrete distributions ¥ t distribution Normal probabilities...

Chi-squared distribution Plot normal distribution...

F distribution Sample from narmal distribution...
Exponential distribution Plot hypotheses or Confidence Intenvals ... (HH)
Uniform distribution

Beta distribution

* v v vy v v v w

Cauchy distribution

Fig. 4.15 Click the Distributions » Continuous distributions » Normal distribution »
Plot hypotheses or Confidence Intervals ... (HH) menu item. This brings up the dialog
box in Fig. 4.16.

Normal and t Distributions Q|§|®

g (rearn)
standard deviation (sigma or s)
df {(degrees of freedom)
n {sample size)
left alpha
right alpha .05
Observed Yalue
mu (Alternate Hypothesis)
ymax (right-hand side)
Hypothesis or Confidence
Hypathesis Test ®
Confidence Interval (O

[ OK ] [ Cancel ] [ Help ]

Fig. 4.16 Normal and t Distributions dialog box from the Plot hypotheses or Confi-
dence Intervals ... (HH) menu item. Missing mu and sigma values default to 0 and 1,
appropriate for the standard normal. We specify right alpha for a one-sided o = 0.05
test. Click OK to get Fig. 4.17.
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I, R Graphics: Device 2 {ACTIVE) |Z||E|r‘5__<|

File History Resize
Standard Normal Density N(0,1)

1L 0

04 4 =04

034 —03
o0z - 0.2

01 4 =01

0 — 00
1 1 1 1 1 1

z -3 -2 -1 0 1 2 3 shaded area
. 1645 o =0.050

Fig. 4.17 This is the familiar standard normal density function

1 i
f(z):\/ﬁe -

with two z-scales. The ticks on the abscissa are standard z-values. The long tick
leading to the lower set of labels shows the critical value z.j = z,05 = 1.645 that
corresponds to the o = 0.05 that was specified in the dialog box. The area to the
right of the critical value z i = 1.645 is shaded blue, and the numerical value of the
area, o = Prob(Z > 1.645) = 0.03, is displayed in the right margin. There are two
scales on the abscissa. For the standard normal, both show the same values.
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4.4 Significance Level, Rejection Region, and Type I Error

In this chapter, we discuss tests only for the location parameter of a model, specifi-
cally for the mean. There are other tests, to be addressed later, for standard deviation
and other parameters of a model.

A typical homework exercise is as follows:

We have an experiment from a normally distributed population with

Hy: p=uy= 150
H: p> 150

We know o = 20. We have observed X, = 160 as the mean of n = 25 ob-
servations. Test at o = 0.05. Determine the critical value. Under the alternate
assumption that the population mean p; = 165, what is the probability of the
Type II error and what is the power of the test? The answer is displayed in
Figs. 4.18-4.22.

The statement ov = 0.05 means that we are willing to take the risk, with prob-
ability o, of making a Type I Error. A Type I error is a decision to reject the
null hypothesis, even when it is a correct description of the world. In Fig. 4.17,
we calculated the o = 0.05 critical value of the standard normal (with mean O
and standard deviation 1) as z.j = z.05 = 1.645. This is the value of z for which
Prob(Z > zer = 1.645) = 0.05.

We translate the problem statement from the data scale into the standard normal
scale by writing

Xobs - [.L

Zobs = G/\/ﬁ (41)

Then we can determine a critical value x. in the X scale by

o = Prob (reject Hy | Hy is true) 4.2)
= Prob (zops > 7,05 = 1.645)

fobs_,u
=P 1.64 =Uy=1
rob(c/\/ﬁ >1.645 | 1= Uo 50)

= Prob (Tops > 1504 1.645 x 20/v/25 = 156.579 = %oy

The arithmetic of Equation (4.2) is illustrated by the dialog box in Fig. 4.18 and the
graph in Fig. 4.19.
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Normal and t Distributions

mu (mean) 150
standard deviation (sigma or 5) 20
df {dearees of freedom)
n {sample size) 25
left alpha
right alpha .05
Observed Yalue | 160
mu {Alternate Hypothesis) |
ymax (right-hand side)
Hypothesis or Confidence
Hypothesis Test  (3)
Confidence Interval O

[ OK ] [ Cancel ] [ Help l

Fig. 4.18 Normal and t Distributions dialog box from the Plot hypotheses or Con-
fidence Intervals ...(HH) menu item. The values illustrated are all taken from the
homework specification. Click OK to get Fig. 4.19. The figure shows the specifica-
tion for the test of the null hypothesis against the general location alternative.
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I R Graphics: Device 2 {ACTIVE)

File History Resize
normal density: oy =4
X 150 1#&0
04 i - 0.10
I =008 .
03 | 8
| &
[ —
I 0.06 =
o 02 | 1%
| oo i
&
—
01 | o
| — 002
0 — 0.00
T T T ‘ E[\
7 140 145 150 155 160 shaded area
z 156.579
z 3 2 1 u] 1 2 3
z 1645 = 0050
z 25 p=0.006

Fig. 4.19 This figure shows the graphics window created by the dialog box in Fig.
4.18. The blue-shaded area is the rejection region. The & scale is in data units. The
z scale is in standard error units. The critical value shown in blue in the x scale,
corresponding to Zerjy = 1.645, is X = 156.579. The green vertical line shows the
observed sample mean Xops = 160 in data units, and the corresponding zops = 2.5 =
(Fobs — Mo)/ 0z = (160 — 150) /4 in the z scale. The green-outlined area indicates
the area associated with the p-value for the test p = Prob(Z > z,ps), and the p-value
itself is shown in the margin as p = 0.006. The left axis is marked in standard normal
density units and is paired with the z-axis labels. The right axis is marked in data-
scaled density units and is paired with the x-axis labels. The area under the curve
corresponds to probability and is the same using either set of axis pairs.
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4.5 Type II Error and Power

Once we have determined a critical value (¥ = 156.579 in Fig. 4.19) based on the
null hypothesis and the significance level, we can ask questions about the effective-
ness of the test in rejecting the null hypothesis for specified values of the alternative.
Specifically, we define

B = B(u)=Prob(X < e | 1 =p) 4.3)
power(t;) = 1 —B(u1) = Prob(x > Xeie | 4 = 1) (4.4)

Equation (4.3) is read: “Beta () equals the probability that the observed f is less
than the critical value of X conditional on the true mean having value ut;”. Therefore,
B is the probability of not rejecting Hy, conditional on the value ;. In this example,
when the population mean is 1y = 165, then not rejecting Hy (that the population
mean is lo = 155) is an error. The Type II Error 3 is a function of the specified
alternative mean U;. Not all texts make the dependence of 8 on ; explicit.

Power is the complement of the Type II Error. Equation (4.4) is read: “The power
of the test against the alternative hypothesis that the true mean has value p; is the
probability that the observed & is greater than or equal the critical value of X con-
ditional on the true mean having value pt;”. Therefore, power is the probability of
rejecting Hy, conditional on the value u;. A high power implies a high “detection
rate” for situations where Hy is not true. In this example, when the population mean
is 41 = 165, then rejecting Hy is the correct decision.

The notation for “conditional” is a vertical bar “|”. It is neither a forward slash
“/” nor a backslash “\”, both of which are meaningful symbols and mean something
else.

In Figs. 4.20-4.22, for this example, that becomes

B = B (1 =165) =Prob(x < 156.579 | u = 165) = 0.0176 4.5)
and

power(u; = 165) = Prob(¥ > 156.579 | u = 165) (4.6)
= 1-B(w = 165) = (1 —0.0176) = 0.9824

Both terms, Type II Error and power, are used. They carry the same information.



4.5 Type Il Error and Power 75

Normal and t Distributions

mu (mean) 150
standard deviation (sigma or 5) 20
df {dearees of freedom)
n {sample size) 25
left alpha
right alpha .05
Observed Yalue | 160
mu {Alternate Hypothesis) 165
ymax (right-hand side)
Hypothesis or Confidence
Hypothesis Test  (3)
Confidence Interval O

[ OK ] [ Cancel ] [ Help l

Fig. 4.20 Normal and t Distributions dialog box from the Plot hypotheses or Con-
fidence Intervals ...(HH) menu item. The values illustrated are all taken from the
homework example in Section 4.4. The alternate hypothesis value of u = 165 is
used to calculate the power against this specific alternative value. Click OK to get
Fig. 4.21 and then Fig. 4.22.
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R Graphics: Device 2 (ACTIVE)

Copy to the clipboard
Print... CTRL+P
Prg...
close Device Brp. .. al denSity: Ox = 4
¥ TIFF... 160 185
Jpeq 3
04 i =010
I - 008
03 | ::6:
| G
L ~—
| 006 5
H 02 X
=
I =004
&
=
01 4 I )
I 002 "
0 0.00
I ‘ g I
% 140 150 160 170 shaded area
k1 156.579
z -3 -2 -1 o 1 2 3 4 5 =1
z 1645 o = 0.050
z 25 p=0.006
I, -7 -6 -5 -4 -3 -2 -1 o 1 2
7 -2.105 p=00176
7 -1.25

Fig. 4.21 This figure shows the graphics window created by the dialog box in Fig.
4.20. We discuss the content of the graph in Fig. 4.22 and in the accompanying text.
The graph itself, not the window containing the graph, is displayed and discussed in
a report on the study.

Here, we discuss saving the graph into a file. The graphics window, is a compu-
tational intermediate and is never displayed in a report. Compare the quality of the
reproduction of the window in Fig. 4.21 and of the graph in Fig. 4.22. We have been
using png graphs for the screenshots. png is a bit-mapped format, which means the
individual dots on the screen are saved. Magnifying a screenshot gives bigger dots,
not better resolution.

Reproduction of a graph for a report should use a vector-graphics format, a for-
mat in which information about which line or character is to be plotted has been
saved. We saved this graph in the PostScript vector-graphics format using the File »
Save as » PostScript... menu item, as illustrated. MS Word users will normally use
the File » Save as » Metafile... menu item or, equivalently the Ctrl-w key.
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normal density: ox =4

X 150 1$0 165
0.4 J - 0.10
l - 0.08
0.3 | g
=
| 3
| 0.06 ?
g o024 3
- 0.04 1L
I &
=
0.1 - | =
| - 0.02
0 0.00
I ‘ 1 I
% 140 150 160 170 shaded area
. 156.579
z -3 -2 -1 0 1 2 3 4 5 6
, 1.645 o = 0.050
2 2.5 p = 0.006
24 -7 -6 -5 -4 -3 -2 -1 0 1 2
5 -2.105 B=0.0176
z4 -1.25

Fig. 4.22 This figure shows the graph that was created in the graphics device win-
dow of Fig. 4.21. The window titlebar and menus are not part of the graph and are
not displayed here. The graph, not a picture of a window containing a graph, is what
belongs in your report. Vector formats, such as Windows Metafile or PostScript,
have superior resolution. When a vector-graphics image is magnified, the graph will
be redrawn to take advantage of the higher resolution. See Section 4.6 for a discus-
sion of graphical file formats.

After discussing these technical details let’s look at the graph itself. The graph
displayed here is a variant of the normal plot in Fig. 4.17. The standard error for this
example is

o= L =20y
NIV

The left curve is centered at the null hypothesis o = 150. The right curve is cen-
tered at the alternate hypothesis t; = 165. The green vertical line is the location of
the observed sample mean. See the text for further details on this graph.
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Fig. 4.22 was created by the dialog box in Fig. 4.20. The critical feature of this
graph is the sizes of the blue- and red-shaded areas. The blue-shaded area shows o,
the probability of the Type I Error, the probability of incorrectly rejecting a true null
hypothesis. The red-shaded area shows (; ), the probability of the Type II Error,
the probability of not rejecting the null hypothesis when the null is false and the true
mean is .

The left curve is centered at the null hypothesis iy = 150 and is identical to the
curve shown in Fig. 4.19. The blue-shaded area is the area to the right of Xy =
156.579 and under the left curve. Equivalently, it is the area to the right of z.4 =
1.645 and under the left curve. Its numerical value o = Prob(Z > 1.645) = 0.05 is
displayed in the right margin of the axis. The blue-shaded area is the probability of
the Type I Error, the probability of rejecting the null hypothesis when it is actually
true.

The right curve is centered at the alternative hypothesis t; = 165. The red-shaded
area is the area to the left of X = 156.579 and under the right curve. We show
an additional horizontal axis, the zj-axis, in Fig. 4.22. The zj-axis is measured
in standard error units oy = % centered on the alternative hypothesis. When the

alternative is true, the z;-axis is in standard normal units. The red-shaded area is
the area to the left of z;. = —2.105 and under the right curve. Its numerical value
B = Prob(Z; < —2.105) = 0.0176 = B(u; = 165) is displayed in the right mar-
gin of the axis. The red-shaded area is the probability of the Type II Error, the
probability that a true mean of u; = 165 will not be detected by the test. The
complement of the red-shaded area under the right curve is the power of the test
power(u; =165) =1—B(u; = 165) = (1 —-0.0176) = 0.9824. Power measures the
probability that a true mean of (; = 165 will be detected by the test.

The green vertical line is the location of the observed sample mean. The observed
mean in data units Xops = 160 is shown in the ¥-axis label at the top of the graph.
The observed mean in null hypothesis units zops = 2.5 is in the bottom z-axis label.
The observed mean in alternate hypothesis units zj by = —1.25 is in the bottom
z1-axis label. In this example, the vertical line for the observed sample mean is in
the rejection region of the test. The green-outlined area is the area to the right of
Zobs = 2.5 and its numerical value p = Prob(Z > 2.5) = 0.006.
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There are nine sets of abscissa axis labels, one above the graph and eight below
the graph.

The x-axis labels are in the scale of the observed data. The z-axis labels are scaled
in standard error units centered at the null hypothesis

X—Ho
Z:
Ox

The z;-axis labels are scaled in standard error units centered at the alternative hy-
pothesis

_ X

=

21

The top axis of each type shows evenly spaced values defining the scale.
The middle z-axis label shows the critical value z.i = z,05 = 1.645 specified in
the dialog box. The bottom X-axis shows the same critical value in X units:

Xerit = Mo +1.645 x 05 = 1504 1.645 x 4 = 156.58

The middle z;-axis label shows the same critical value in standard error units cen-
tered at the alternative hypothesis:
_ Xeit— M1 156.58 — 165

“le Ox 4

There are two ordinate scales. The left scale is in standard normal f(z) units. The
right scale is in data units

o) = 1)/

X

4.6 Displaying Graphs

Screenshots, such as Fig. 4.21 and many of the illustrations in this book, use
bitmapped graphics. The individual dots on the screen are saved. Magnifying a
screenshot gives bigger dots, not better resolution. We use screenshots to illustrate
what the image on the computer screen looks like.

Reproduction of a graph for a report, for example, Fig. 4.22, uses a vector-
graphics format, a format in which information about which line or character is
to be plotted has been saved. When a vector-graphics image is magnified, the graph
will be redrawn to take advantage of the higher resolution. We use vector graphics
to show the graph of our data in the best resolution for the presentation medium we
will use. Printed graphs on paper have much higher resolution than dots on a screen
can provide.

Compare, for example, the smoothness of the curves in Figs. 4.21 (bitmapped)
and 4.22 (vector graphics) to see the difference. Similarly, the tick labels in the
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screenshot of Fig. 4.21 are granular, and the tick marks in the graph in Fig. 4.22 are
smooth.

MS Word users normally use the wmf (Windows metafile) format, a vector-
graphics format. Graphs can be copied from the R Grapics Device window as a
wmf either with the menu as shown in Fig. 4.21 or with Ctrl-w, and can then be
pasted into MS Word with Ctrl-v. MS Word users should not copy an R graph with
Ctrl-c, as that uses the lower-resolution bmp (Bitmap) format.

We used the ps (PostScript) [Adobe Systems Incorporated, 1999] format, an-
other vector-graphics format, for Fig. 4.22 and other figures. PostScript works
smoothly with the I&TEX Document Preparation System [Lamport, 1986] in which
this book was written.



Chapter 5
Normal and r Workbook

Abstract The normal and ¢ distributions discussed in Chapter 4 can be explored
dynamically with the normal.and.t workbook. This workbook uses Excel’s automatic
recalculation mode to change the R graph as numerical values or control tools are
changed in the workbook. A short discussion of how it works appears in Section
5.5. The workbook directly accesses the same R functions that the dialog box in
Fig. 4.16 uses.

5.1 Standard Normal and ¢ Distributions

The normal.and.t.dist workbook [Heiberger and Neuwirth, 2008] allows us to ex-
plore the Normal and ¢ distributions dynamically. Fig. 5.1 shows the screenshots
of the menus that open the workbook in Fig. 5.2.

R.M. Heiberger, E. Neuwirth, R Through Excel, Use R, 81
DOI 10.1007/978-1-4419-0052-45,
© Springer Science+Business Media, LLC 2009
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RExcel~| | R File - Data-~
Close R
Run Code
Get R Value
Put R Var
Get R output

Set R working dir
Load R file

Copy Code
Debug R

Error Log

Options

@ RExcel Help
@ RHelp
Stop RCommander
Demo Worksheets
RthroughExcel Worksheets
R zbout RExcel

5 Normal and t Workbook

TOCxism
B C D E F G H

Demo files for the book
R through Excel

Linear Regression Linear Regression Workbook Documentationl

Normal and t normal and t Workbook Documentation |

Fig. 5.1 Open the normal.and.t.dist workbook by clicking on RExcel » RthroughEx-
cel Worksheets. This opens an Excel workbook BookFilesTOC with the names of the
workbooks for this book. Click on normal.and.t. The full BookFilesTOC is shown in
Fig. 3.2. (If the RthroughExcel Worksheets menu item is missing, see step 4 in Section

A33)
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=
A B C D E E G H | J K

1 Show critical values  probability

2 |Optional user input Slider on Graph left right right-sided observation
3 [ ol O Display o 1.000]
4 4 O

5|z O z scale 1.645

6 |o 1 o 0.0500 0.0500

7 In

8 |v

9

10 Oaleft aright o @ prob or hypoth

1 0.050| 0.050| 3 confidence interval

12 < >

13

15 [Optional user-specified

16 |display parameters
17 |z-range

18 [horizontal min

19 |harizontal ma: }Copycurremhonzontal range

20 Jo(s) min [Co ot g0 e |
Copy current range

21 |g(®) max } Gony o(x) rang A

Standard Normal Density N(0,1)
0

n
0.4 - — 0.4
0.3 - 0.3
N 02 4 - 02
0.1 - - 0.1
0 — 0.0
T T T T
z -4 -2 0 2 4  shaded area
z 1.645 o, =0.0500

Fig. 5.2 Workbook normal.and.t.dist.x1lsm opens to Standard Normal
with one-sided o = 0.05. The user controls the graph by entering numbers in the
shaded cells, checking checkboxes, and moving the sliders. Numerical output val-
ues are displayed in cells G1:K13 and on the graph in the R graphics window. The
workbook uses the normal table when the v (degrees of freedom) field is empty. It
uses the appropriate ¢ distribution when the v field contains a positive integer.
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B normal.and.t.xlsm —

A B C D E E G H | J K
1 Show critical values  probability
2 |Optional user input Slider on Graph left right right-sided observation
3 (g ol O Display o 1.000]
4 4 O
5|z O z scale 1.440
6 |o 1 o 0.0750  0.0750
7 In
8 |v
9
10 Oaleft [¥la right o @ prob or hypoth
1 0.075| 0.075| 3 confidence interval
12 < >
13
14
15 [Optional user-specified
16 |display parameters
17 |z-range
18 |horizontal min
19 [horizontal ma } Copy current horizontal range
g? SE;{;T; } Copy current g(¥) range

Standard Normal Density N(0,1)
0

n
0.4 — 0.4
0.3 ~ 0.3
g 0.2 - 0.2
0.1 — 0.1
0 — 0.0
T T T T
z -4 -2 0 2 4  shaded area
z 1.44 o = 0.0750

Fig. 5.3 Adjust the significance level o (with scroll bar « right) to show one-sided
o =0.075.
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=
A B C D E E G H | J K
1 Show critical values  probability
2 |Optional user input Slider on Graph left right right-sided observation
3 [ ol O Display s 1.000]
4 [}
50 O tscale 1.699
6 |s 1 o 0.0750 0.0750
7 |n
8 v 5
9
10 Oaleft [¥la right o @ prob or hypoth
1 0.075| 0.075| 3 confidence interval
12 £ >
13
14
15 [Optional user-specified
16 |display parameters
17 |z-range
18 |horizontal min
19 [horizontal ma } Copy current horizontal range
g? SE;{;T; } Copy current g(¥) range

0.4

0.3

0.2

0.1

Standard t

Density, v=5
0

— 0.4

— 0.3

— 0.2

~ 0.1

— 0.0

-4 -2

T T
0 2 4  shaded area

1.699 o =0.0750

Fig. 5.4 When the degrees of freedom are not missing, the graph displays a ¢ dis-
tribution, in this case with 5 degrees of freedom and showing one-sided o = 0.075.
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A comparison of Figs. 5.3 and 5.4 shows important differences between the nor-
mal distribution and the ¢ distribution. The ¢5 distribution is differently shaped than
the normal. The maximum value of the density curve at t = 0 is smaller than the
normal curve at z = 0, and the body of the curve is wider. The value of the density at
t = 4.32, where the graph is truncated, is larger than for the normal at z = 4.32. The
o = 0.075 critical value for the 75 distribution is larger than the oo = 0.075 critical
value for the normal. Some of the highlighted area for the #5 distribution is offscreen
to the right. It would be necessary to change the xmin and xmax values to see more
of the highlighted area.

5.2 Relation Between o and 7

Fig. 5.5 Derivatives in Action. Using the Fig. 5.2 setup, press and hold the left
arrow on the ¢-right slider and watch the progress of the blue rejection region as
o increases. It’s right-left motion noticeably slows down near the middle of the
null-hypothesis distribution (near z = 0). The terminator is moving proportionally
to probability units, not z units, and the probability units are much closer together
in z-coordinates near the mean of the normal density function.
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5.3 Normal Tests, Type II Error, and Power

1. Construct a one-sided test with o¢ = 0.05 of
Hy: n=pup=0
Hi: u>pup=0

in a situation where n = 1 and we know o = 1.
a is called the probability of the Type I Error. A Type I Error means that the null
hypothesis is rejected when the null hypothesis is true.

a. Answer (algebra)
Find the critical value X, such that P(X > X5 | £ = 0) = 0.05.

05=P(x > Xerit | u=0)
= P((x—)/0x > (Xeic = 0)/1 | p=0)
=P( z > Xerit )
=P( z > 2,05 )
=pP( z > 1.645 )

We have determined that X = 1.645. In this example, with gy =0and 6 = 1,
we found X, = z.05. Equality is not the case for other values of i and ©.

b. Answer (workbook)
We can calculate the numerical value X, with the normal.and.t workbook in
Fig. 5.6, which in turn generates the graph in Fig. 5.7. Four numbers and one
side are mentioned in the problem statement for part 1. All are entered into
the workbook:

Parameter a Yo n o Side
Value 005 0 1 1 right
Workbook cell Bll B3 B7 B6 check B10 and uncheck A10
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2. From part 1 we have a test:

Reject the null hypothesis if the observed X > X, = 1.645.

What is the probability 1 — 8 = 1 — () of rejecting the null hypothesis when
the true value of population mean u = py; = 2.5? Equivalently, what is the prob-
ability B = B(u1) of NOT rejecting the null hypothesis when the true value of
population mean g = p; = 2.5? The number 3 is called the probability of the
Type II Error. The Type Il Error means that the null hypothesis is not rejected
when the null hypothesis is false. The probability B = B(u;) is a function of
the alternative hypothesis value ;. The dependence on p; is not always stated
explicitly.

a. Answer (algebra)
Evaluate 1 — 8 = P(¥ > Xerie|t = 2.5).

=P(x > Xeri | =)
—P(% > 1.645 | u=2.5)
= P((i—p)/os > (1.645—2.5)/1 | 1 = 2.5)
—pP( > —0.855 )
= 0.8038

We have determined that 1 — 8 = 0.8038; therefore, B =1—(1—3) =0.1962.
b. Answer (workbook)

We can calculate the numerical values 3 and 1 — B with one additional entry
on the normal.and.t workbook in Fig. 5.6. We enter u; = 2.5 into cell B4.
B =0.1962 is displayed in cell J12. Power = 1 — 3 = 0.8038 is displayed in
cell J13.

The red-shaded region in Fig. 5.7, with area B = 0.1962, is to the left
of the critical value X = 1.645 and under the normal curve centered at
X = u; = 2.5. Power against the alternative t = y; = 2.5 is illustrated as
the complement of the red-shaded area under the normal curve centered at
X=u =2.5.
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B normal.and.t.xlsm - =

A B C D E E G H | J K
1 Show critical values  probability
2 |Optional user input Slider on Graph left right right-sided observation
3 [ ol O Display ox 1.000]
4y 25 < | ¥ | Display % scale 1.6449
5 K O z scale 1.645
6 |o 1 o 0.0500 0.0500
7 |n 1
8 |v
9
10 Oaleft [¥la right o @ prob or hypoth
14 0.050| 0.050| 3 confidence interval z; for Hy -0.855
12 £ > g 0.1962
13 power 0.5035
14
15 [Optional user-specified
16 |display parameters
17 |z-range
18 [horizontal min
19 [horizontal ma } Copy current horizontal range
g? SE;;{;?;HX } Copy current g(¥) range

Fig. 5.6 For part 1, the specified ov = 0.05 level is placed in cell B11 and is
displayed again in cell 16. The calculated numerical value from the normal table
Z05 = 1.645 is in cell 15. The calculated numerical value of X is in cell I14.

For part 2, u; is entered into cell B4 and the checkbox in cell C4 is checked.
B = 0.1962 is displayed in cell J12. Power = 1 — 3 = 0.8038 is displayed in cell
J13.
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Standard Normal Density N(0,1)

u 0 25
0.4 — — 0.4
0.3 - 03 ©
-
o)
=
— =
o 0.2 — 0.2 |>'<
i
=<
0.1 7 - 01 g
0 — 0.0
T T T T
z -4 -2 0 2 4 6 shaded area
5 1.645 o = 0.0500
Z4 -6 -5 -4 -3 -2 -1 0 1 2 3 4
z; -0.855 B =0.1962

Fig. 5.7 The answer to part 1 is illustrated by the blue-shaded region. The blue-
shaded region, with area ov = 0.05, is to the right of the critical value X3 = 1.645
and under the normal curve centered at X = gy = 0.

The answer to part 2 is illustrated by the red-shaded region. The red-shaded
region, with area § = 0.1962, is to the left of the critical value X = 1.645 and
under the normal curve centered at ¥ = t; = 2.5. On the zj-axis we see that the
critical value in z; units is z; = —0.855. Power against the alternative 4 = u; =
2.5 is illustrated as the complement of the red-shaded area under the normal curve
centered at X = p; = 2.5.
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5.4 Significance, Rejection Region, and Power—Continued

In Sections 4.4 and 4.5, we illustrated significance, rejection region, and power with
graphs specified using the Normal and t Distribution dialog box. Here, we continue
with the same example, this time specifying the graphs with the worksheet. We
illustrate the specification in Fig. 5.8. The graph itself is displayed in Fig. 5.9.

& normal.and.t.xlsm -

A B c D = E G H | J K
1 ! Show critical values  probability
2 |Optional user input Slider on Graph left right right-sided obsemvation
3 Yo 0l O Display oy 4.000
4 Juy 185 O % scale 156.58 160
5 X 160 £ 3| Display z scale 1645 2.500
6 |o 20 o 0.0500  0.0500
7 In 25
8 |v 1z for p value Hq 2500
9 p value Hy 0.0062
10 | alert aright a @ prob or hypoth
1 0.050| 0.050| 3 confidence interval
12 < >
13

15 |Optional user-specified
16 |display parameters

17 |z-range

18 |horizontal min 134

19 [horizontal ma 181 }Copy current horizontal range

o
21 |o(®) max } Copy current g(%) range T

Fig. 5.8 Specification by worksheet of the typical homework exercise introduced
in Section 4.4. We set the null - and alternative t;-values and the observed mean
X by typing into cells B3:B5. The observed mean line is displayed by checking the
checkbox in cell C5. The worksheet displayed here specifies the graph we display in
Fig. 5.9. We set the horizontal limits, the sample size n, and the known population
standard deviation o = std.dev by typing them into the workbook cells. In this ex-
ample, with known standard deviation, we leave the degrees of freedom field empty.

We need to set the horizontal limits because their default values are based on
the initially entered values L, i1, and X. We will be changing (t; as part of the dis-
cussion of Type II Error. Changes in values made by typing numbers in the Lo, U1,
and ¥ cells change the horizontal limits. Changes in values made by adjusting the
scrollbars do not change the horizontal limits.

We do not need to set the g()-limits, because we will not be changing ¢ or n
in this discussion. See Section 5.7 for an example where it is imperative to set the
g(%)-limits.



92 5 Normal and t Workbook

normal density: ox =4

u X 150
0.4 — — 0.10
— 0.08
0.3 — S
~
/l.lo;
— 0.06 =<
. =
g o021 X
— 0.04 ‘wﬁ
<
0.1 — S
— 0.02
0 e — 0.00
T T T
% 140 150 160 170 180 shaded area
% 156.579
z -4 -3 -2 -1 0 1 2 3 4 5 6 7 8
z 1.645 o = 0.0500
z

Fig. 5.9 Plot of null hypothesis and observed mean. This figure is specified by the
worksheet in Fig. 5.8. This figure is almost identical to Fig. 4.19 specified by the the
Normal and t Distribution dialog box in Fig. 4.18. Here, we allowed additional space
on the right because we know we will need it for the alternative hypothesis that we
saw in Figs. 4.21 and 4.22 and will see again in Fig. 5.10.
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B normal.and.t.xlsm - =

A B C D E E G H | J K
1 ! Show critical values  probability
2 |Optional user input Slider on Graph left right right-sided observation
3 [ 150 O Display ox 4.000
4y 165 < | (% Display % scale 156.58 160
5 K 160 < ¥ | Display z scale 1.645 2.500
6 |o 20 o 0.0500 0.0500
7 |n 25
8 |v z for p value Hq 2.500
9 p value Hy 00062
10 Oaleft [¥la right o @ prob or hypoth
1 0.050| 0.050| ¢ canfidence interval z; for Hy -2.105 -1.250
12 < > g 0.0176
13 power 0.9524
14
15 [Optional user-specified
16 |display parameters
17 |z-range
18 |horizontal min 134
19 |horizontal ma 181 } Copy current horizontal range
20 [o(%) rin
21 [gfx) max ) | _Rmt

normal density: ox =4

ux 150 165
0.4 ~ 0.10
- 0.08
0.3 o
3
T
- 0.06 =<
S T
N 02+ -
- 0.04 =
<
0.1 =
- 0.02
0 — - 0.00
T T T 1
< 140 150 160 170 180 shaded area
< 156.579
z -4 -3 -2 -1 0 1 2 3 4 5 6 7 8
z 1.645 o = 0.0500
z
74 -8 -7 -6 -5 -4 -3 -2 -1 0 1 2 3 4
5 -2.105 B=0.0176

Fig. 5.10 We continue with the example in Figs. 5.8 and 5.9. Evaluate the power at
the alternative hypothesis mean p; = 165. Check the checkbox in cell C4 to display
the alternative distribution on the graph. When the checkbox is checked, the scroll
bar can be used to dynamically adjust the value of ;. In this figure, we set the
alternative mean to y; = 165 and see that §(u; = 165) = 0.0176 and power(u; =
165) = (1 —0.0176) = 0.9824. This figure is identical to Fig. 4.22.
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2} normal.and t.xlsm -

A B C D E E G H | J K
1 Show critical values  probability
2 |Optional user input Slider on Graph left right right-sided observation
3 [ 150 O Display ox 4.000
4y 155 < » | Display % scale 156.58 160
5 K 160 < ¥ | Display z scale 1.645 2.500
6 |o 20 o 0.0500 0.0500
7 |n 25
8 |v z for p value Hq 2.500
9 p value Hy 00062
10 Oaleft [¥la right o @ prob or hypoth
1 0.050| 0.050| ¢ canfidence interval z; forHy 0.395 1.250
12 < > g 0.6535
13 power 0.3465
14
15 [Optional user-specified
16 |display parameters
17 |z-range
12 Eg::ﬁg:z:: :::K 13: } Copy current horizontal range
2 o m } Comcuntgyang | 012

normal density: ox =4

u X 150 155
| ]
0.4 — 0.10
- 008
0.3 1 ©
=<
’g
- 0.06 =<
= T
N 0.2 1 %
~ 0.04 *ﬁ’
<
0.1 4 5
- 0.02
0 — 0.00
T I T T T
< 140 150 160 170 180 shaded area
% 156.579
z -4 -3 -2 -1 0 1 2 3 4 5 6 7 8
z 1.645 o =0.0500
z
74 -5 -4 -3 -2 -1 0 1 2 3 4 5 6
7 0.395 B =0.6535

Fig. 5.11 In this figure, we set the alternative mean to p; = 155 and see that B (p; =
155) = 0.6535 and power(u; = 155) = (1 —0.6535) = 0.3465.
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5.5 How Does the Normal and t Workbook Work?

The normal.and.t workbook gives a user in Excel control over a complex graph con-
structed in R. It does so by placing the R functions inside the standard Excel auto-
matic recalculation model. When a user changes a cell in the Excel workbook, a call
to a graph in R is automatically generated using the revised data values in the cell.

Cells A1:K21 are designed for user input and output. This workbook contains
several shaded data entry fields and several standard Excel checkboxes and sliders
for user control. It contains a region in cells G1:K13 for numerical output. It produces
a graph in the R Graphics window.

The communication between R and Excel is done in the offscreen sections of
the workbook, using the REval function (introduced in Section 4.2) and several re-
lated functions, particularly RCallA. The workbook collects all inputs to R in cells
AF1:AG28. In cell AF30, RCallA constructs a call to an R function using the name of
the function and an argument constructed from the values of the input Excel cells.
The workbook uses REval to collect all the outputs from R in cells AM1:AN20. The
automatic updating process then copies those values to the display region in cells
G1:K13.

When the workbook detects that the user has changed a cell, either by typing into
one of the shaded fields or by using a checkbox or slider, it automatically updates all
cells that depend on the value of the changed cell. Automatic updating is the defining
feature of spreadsheets. Cell AF30 contains a call to an R function normal.and.t.dist
with all the values that are currently in the workbook. When cell AF30 detects that
one of the data entry cells has been changed, it automatically issues a new call to the
normal.and.t.dist function in R with the revised argument values. The normal.and.t.dist
function calls the same normal.curve and related functions that are accessed by the
menu items described in Section 4.3.

5.5.1 Input Fields

These numbers completely specify the statistical problem.

Means: Uy, U1,z,t,%.  Values typed into the entry fields B3:B5 are used to set the
horizontal limits on the graph and to set the range of the sliders in cells D3:D5.
Moving the sliders to change the values displayed in cells B3:B5 does not change
the range of the sliders, nor does it change the horizontal limits on the graph. The
checkboxes in cells C3:C5 hide or show the sliders and determine whether the
associated values will be displayed on the graph. The label in cell A5 is either z
or t, as appropriate for the degrees of freedom, when the sample size in cell B7 is
empty. The label in cell A5 is X when a sample size is entered in cell B7.

Standard error: o or s, n. The standard error o3 or s; is calculated from these val-
ues and is displayed in cell K3. When both fields are empty (use the Delete key),
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the standard normal or standard ¢ distribution is displayed. The label in cell A5
changes to either z or ¢, as appropriate for the degrees of freedom.

Degrees of freedom: v. Blank (use the Delete key) means the standard deviation
o is known, the label in cell A6 is ¢, and the normal distribution is used. A
positive integer means the standard deviation s was determined from the data,
the label in cell A6 is s, and the ¢ distribution with v degrees of freedom is used.
Various labels in cells G3:G13 are adjusted accordingly.

Hypothesis test or confidence interval.  Check one of the option buttons. The graph
for hypothesis tests is centered on the uy-value. The graph for confidence in-
tervals is centered on the X-value. Various labels in cells G3:G13 are adjusted
accordingly.

Significance or confidence level: . The significance level is . The confidence
level is 1 — a. Sidedness is determined by checking the « left and/or o right
checkboxes. The ¢ displayed in cell C11 is the sum of the values in cells A11:B11.
When o left is checked, the “a left from right scrollbar?” checkbox appears
in cell A13. Check it (the default) for symmetric two-sided tests or intervals.
Uncheck it for independent control on each of the sides.

5.5.2 Display Parameters

These values give the user control over the use of the plotting region in the graph.
They override the default calculations of the horizontal and vertical limits. They do
not affect the numerical values on the graph or in the Output region of the workbook.

z-range. The horizontal limits of the graph default to z standard errors below
min (o, U1,%) and z standard errors above max (Lo, iy, X).

horizontal limits.  Optionally override default values. Used when comparing, for
example, the effect of different alternatives 1, or to see the effect of different
potentially observed values x. Visual comparability requires the same x limits.

g(%) limits.  Optionally override default values. Used when comparing the effect
of changing standard error ox (usually by changing either o or n). Visual com-
parability requires the same g(%) limits. See Section 5.7 for an example.

5.5.3 Numerical Output

All numerical values used in the construction of the graph are displayed.

Label. The displayed results and their labels change as a function of the values in
the input fields.

Critical values. The critical values are displayed in as many scales as are appro-
priate, chosen from z,z;,¢,;,X. Left and right significance levels are shown.
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Probability.  As appropriate, chosen from o, p, 3, power = 1 — 3.
Observed value. The observed value is displayed in as many scales as are appro-
priate, chosen from z,z1,7,¢;,X. The standard error is also shown in this column.

5.6 Confidence Intervals

This is a typical confidence interval homework exercise:

For a sample of size n = 50 from a population whose standard deviation is known to be
o =25, and for which the observed sample mean is ¥ = 100, estimate the population mean
with 90% confidence.

The terminology “two-sided 90% confidence interval” means that the normal
curve has been partitioned into three sections, with probability 0.90 in the center
and probability 0.05 on each side.

a=1-090=0.10
/2 =0.05
Zg/2 = 205 = 1.645

5.6.1 Algebra

The interval estimate is centered on the observed sample mean and has a width that
is based on the standard error of the mean and on the tabled values of the normal
distribution.

Then

90%CI(1) = T£245 (0/\/n)
= 100+ 1.645 (25/1/50)
= 100+5.815
= (94.185,105.815)

Sometimes the interval is denoted by its endpoints:
LCL =94.18 and UCL = 105.82

where LCL means “lower confidence level” and UCL means “upper confidence
level.”
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5.6.2 Workbook

&l normal.and txism - =
A B C D E E G H | J K

1 Show 90% conf limits__ probability

2 |Qptional user input Slider on Graph left right two-sided observation|
3 Mg ol O Gx 3.536
4y, ol O % scale 94 185 105.82 100
5 [ 100 < 3 Display z scale -1.645 1645 0.000
6 |o 25 1-Confidence 0.0500 0.0500  0.1000

7 In 50| confidence level 0.9000

g |v

9

10 | @#aleft [¥]a right a rprob or hypoth

11 0.050 0.050| 0.100| @ confidence interval

12 < >

13 o left from right scrollbar?

14

15 |Optional user-specified

16 |display parameters

17 [z-range

12 :E;:ig:}:: z:: 1?3 } Copy current horizontal range

g? Ec% :al } Copy current g(%) range

90% Normal Confidence Limits: og = 3.536, n =50

T 100
0.4
— 0.10
0.3 &
- 0.08 ?;
L
< - 0.06 *
T 02 o
- 0.04 I
1
0.1 5
~ 0.02
0 0.00
T ] ] T
- 90 '95 100 105! 110 shaded area
- 94.185 105.815
z -3 -2 -1 0 1 2 3
z -1.645 1.645 Conf Level=0.9000

Fig. 5.12 On the normal.and.t workbook, click confidence interval, set x.min=90,
x.max=110, n=50, 6=25, click both o checkboxes, click « left from right scrollbar?,
accept the default for o right = 0.050, click the x checkbox in cell C5, and set ¥ = 100.
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5.7 Scaling to Keep Constant Area

The default vertical scaling for the normal and ¢ density plots uses the entire vertical
space of the panel. The vertical scale has the maximum value of normalized density
f(2), £(0) = 0.3989423, near the top of the panel. The right-hand scale, in g(x) =
f((x—u)/oz)/0x units, varies as a function of oz, which in turn depends on the
sample size n. When the sample size changes, as in the left column of Fig. 5.14, the
graphs have a constant numerical area (in probability units), but varying visual area
(in square inches or cm?). We maintain a constant visual area, as well as a constant
numerical area, by specifying the range on the right-hand axis. In the right column
of Fig. 5.14, the graphs have a constant visual area because all three panels have the
same specified min and max values on the right-hand g(¥)-axis. We illustrate the
specification in the workbook excerpts in Fig. 5.13.
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a.g(X)min= , g(X¥) max= ,n= d. g(*) min =0, g(X) max = 1.6, n =
EA normal.and.txlsm & normal.and.txlsm
A B A B
7l — 7 —
18 [%.min -4 18 [%.min -4
19 . max 4 19 |x.max 4
20 [ftx) min 20 [f(x) min 0
21 [fix) max 21 [fitx) max 1.6
b. g(¥) min= ,g(¥) max= ,n=4 e. g(*) min=0, g(x) max =1.6,n =4
EA normal.andtxlsm EA normal and.txlsm
A B A B
7k L4 7 ]n L4
18 . min -4 18 |«.min -4
19 [x.max 4 19 . max 4
20 [ftx) min 20 [f(x) min 0
21 [fix) max 21 [fx) max 1.6
c.g(¥) min= ,g(¥) max= ,n=16 f. g(¥) min =0, g(x) max = 1.6, n =16
i normal.and.txlsm & normal.and.txlsm
A E A =]
7 |n 16 7 |n 18]
18 % min " 18 [¢.min -4
19 |x.max 4 19 Jx.max 4
20 (f(x) min 20 [f(x) min 0
21 [fix) rmax 21 () max 1.6

Fig. 5.13 Display parameters in normal.and.t workbook that specify the scaling in
Fig. 5.14. We specify the vertical range in g(X) = f(z)/0z units in cells B20:B21.
For constant o, we control oz = ¢ /1/n by specifying n in cell B7. In all six panels,
we control xp;, = 4 and x.x = 4 in cells B18:B19.
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a.g(X) min= ,g(¥) max= ,n
Standard Normal Density N(0,1)
0

0.4 o Foa
03 - o3
8 024 - 02
0.1+ o1
0 00
T T T T
B -4 -2 0 2 4 shaded area
z 1.645 o= 0.050

b. g(¥) min= , g(X) max= ,n=4

normal density: oz = 0.5

" 0
0.4 o 08
03 - Fo6 &
£
=
_ ;
8 o2 F 04
I
&
0.1 Fo2 &
0 00
T T T T
N - -2 0 4 shaded area
: 0.822
2 w7654 9210123 45 6 78
. 1.645 0=0.050

c.g(X)min= , g(X¥) max= ,n=16

normal density: ox =0.25
0

0.4
15
0.3 o £
F1o £
g o2+ 5
e
Fos =
0.1 o )
0 L 0.0
T T ‘ T T
N -4 -2 0 2 4 shaded area
i 0.411
2 47 4 1 8 6 4 20 2 4 6 8 101214 16
2 1.645 o =0.050

d. g(¥) min =0, g(¥) max = 1.6, n =

Standard Normal Density N(0,1)
0

101

1.5 - k15
14 - 1.0
N
05 | Fos
o \ 00
T T ‘ T T
z -4 -2 ] 2 4 shaded area

z 1.645

e. g(X) min=0, g(¥) max = 1.6,n =4

normal density: cx=0.5
mn 0

o =0.050

08
F 15
06 )
Lo £
g o4+ 5
W
&
Fos =
02 - =
o 00
T T T T
R i -2 0 4 shaded area
: 0.822
: 6754210 123 45 6 78
. 1.645 = 0.050

f. g(xX) min=0, g(X) max = 1.6, n =16

normal density: ox=0.25

u 0
0.4 |
k15
03 | &
1o 2
=
T o024 %
b
Fos =
0.1 | =
0 L 0.0
T T ‘ T T
R -4 -2 0 2 4 shaded area
: 0.411
2 o4 s e 4 20 2 4 6 8 1012
z 1.645 o =0.050

Fig. 5.14 The areas under the curve are numerically the same for all graphs in both
columns because all six panels have the same vertical scaling on the f(z)-axis on
the left [the maximum value is always f(0) = 0.3989423]. The areas are visually
different in the left column, because each of Panels a, b, and ¢ has a different vertical
range on the g(¥) = f(z)/oz-axis on the right. The areas are visually the same in the
right column because all three Panels d, e, and f have an identical vertical range on
the g(X) = f(z)/oz-axis on the right. The specification of vertical range is shown in
Fig. 5.13. In all six panels, we control xpi, = 4 and xp,x = 4.
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5.8 Normal Approximation to the Binomial

This is an example of an extended use of the normal.and.t workbook.

The normal approximation to the binomial sets z = p/+/(p(1 — p)/n). We can
use the confidence interval setting to display how the width of a specified size con-
fidence interval gets narrower as we move away from p = 0.5.

(O @ = Microsoft Excel = 3
y Home Insert Page Layout Formulas Data Review View Developer Add-Ins '@J
RExcel ~ Worksheet Info Repair formulas Repair Reference
Menu Commands Custom Toolbars
\ B6 - | f | =SQRT(BS*(1-85))
i3] normal.and txlsm - =
A B [ D E E G H | J K
2 |Qptional user input Slider on Graph left right two-sided observation|
3 |ug 05 O G5 0.100
4y, ol O % scale 04326 05674 04
5 [x 05 3 3| Display z scale 0.674 0674 0.000
6 |o 0.5l 1-Confidence 02500 02500  0.5000
7 In 25 confidence level 0.5000
g v
9
10 | aleft [¥la right a: (> prob or hypoth
1 0.250 0.250| 0.500 @ confidence intervall
12 < >
13 o left from right scrollbar?
14
15 |Optional user-specified
16 [display parameters
17 |z-range
18 |horizontal min 0
19 |horizontal max 1 }Cnpy current horizontal range
g? EEZ::::;HX 30} Copy current g(%) range
22
Ready | 2 BT e (Sl

Fig. 5.15 Turn on the x slider and enter yo = 0.5, u; = 0, ¥ = 0.5. These three
numbers set the scale and initialize the sliders. Set the horizontal range of the plot
with the values horizontal min to 0 and horizontal max to 1. Set the g(x) max to 30. Set
the standard deviation to y/p(1 — p) using the Excel formula =SQRT(B5*(1-B5)) as
shown in the Excel formula box. Enter the sample size n = 25. Set the display to
confidence interval. Click the checkboxes to show the x slider and turn off the other
two sliders. Set both ¢-levels to 0.250. This sets the central portion of the displayed
confidence interval to 50%. These settings specify the graph in Fig. 5.16.
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Fig. 5.17 Now, as we scroll the x slider in Fig. 5.15, we see that the width of the

Normal Approximation to the Binomial

50% Normal Confidence Limits: oz = 0.1, n =25

50% conflimits  probability
left right two-sided observation
0.100
0433 0567 0.5
0674 0674 0.000
0.250 0250 0.500
0.500
50% conflimits __ probability

left right two-sided observation
0.087]
0.692 0.808 0.75
-0.674 0674 0.000)
0.250  0.250 0.500
0.500
50% conflimits _ probability
left right two-sided observation
0.044
0921 0979 095
-0.674 0674 0.000
0.250 0.250 0.500
0.500
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3 - 30
5 | - 25
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2 - 20 ’\g
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1 - ~ 10 —
[
=
5 -5
O el . 0
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0.0 0.2 0.4 0.6 0.8 1.0 shaded area
0.433
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-0.674 Conf Level=0.5000

Graph of normal approximation to the binomial as specified in Fig. 5.15.
When p = 0.50 and n = 25, the 50% confidence limits are p +z05+/(p X p/n) =
.51+0.6744898 x 0.5/5 = (0.432551,0.567449).
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50% range is widest at the center and narrowest at the extremes of the range.



Chapter 6
t-Tests

Abstract The ¢-test is used for the mean of a normal distribution with estimated
standard deviation s, or for comparing the means of two normal distributions.

We will look at several datasets, graphically and numerically, and focus on two
types of questions.

Testing:  We have null (Hy) and alternative (H) hypotheses about the true value
u of the mean of the population from which the data was drawn. We wish to
test whether there is enough evidence to reject the null hypothesis. The possible
answers to the test are “reject the null hypothesis” or “do not reject the null hy-
pothesis.” The possible answers do not contain any numbers.

The null hypothesis is a statement about the world. It might be a true state-
ment. It might be a false statement. The phrase “reject the null hypothesis” means
the evidence from the data suggests that the null hypothesis is a false statement.

Estimation: =~ We have some data, and we wish to estimate the location of the pop-
ulation mean u. We estimate the location with a confidence interval with a spec-
ified confidence level. Frequently, the level is 95%. The answer is an interval, a
set of two numbers. The interval is written in the form

95%CI(1) = (L,U) (6.1)

where the numbers L and U stand for “lower bound” and “upper bound,” respec-
tively. The interval is written as a set of parentheses with the smaller number on
the left, the larger number on the right, and a comma separating them.

R.M. Heiberger, E. Neuwirth, R Through Excel, Use R, 105
DOI 10.1007/978-1-4419-0052-4 6,
© Springer Science+Business Media, LLC 2009



106 6 t-Tests

6.1 Data—Canned Vegetables

The initial dataset we look at is similar to examples in an introductory text. We have
a claim that the average weight of canned vegetables in cans marked 16 ounces is
actually 15.75 ounces or less. If the claim is sustained, the company is subject to
regulatory action for false advertising. The contents of n = 12 cans are weighed.
The resulting values are

15.13 15.31 15.72 16.51 16.02 16.19 15.73 15.90 15.78 16.05 15.75 15.77
We begin by entering the data into a new workbook in Fig. 6.1.

-'E!:: s RN Microsoft Excel S T 3
L =
Home Insert Pagelayout Formulas Data Review View Developer | Add-Ins| (@)
RExcel -~ R File -~ Data - Stafistics ~ Graphs ~ Models = Distributions ~ Tools =~ Help -
Dataset: Davis *  Model: No active mode ~ )
Menu Com.., Custom Toolbars
A13 - @ fe| 15.77 ]
&) Books
| A B C D E F G H
1 |weight
2 15.13
3 15.31
4 15.72
5 16.51
6 16.02
7 16.19
8 15.73
9 15.9
10 | 15.78
11| 16.05
12 15:.75
13 15.77|
L]
14
Ready | P13

Fig. 6.1 Row 1 contains the variable name weight, and rows 2—13 contain the ob-
served values. Notice that the decimal points are not aligned. Specifically, the num-
ber 15.9 in cell A9 has only one digit after the decimal point while all the other
numbers have two digits after the decimal. Unaligned decimal points make it diffi-
cult to read a column of numbers. We will repair this in Figs. 6.2 and 6.3.



6.1 Data—Canned Vegetables

- @ Microsoft Excel e - il &
Home Insert Pagelayout Formulas Data Review View Developer |Md-]ns| ©
RExcel ~ R File ~ Data - Statistics = Graphs ~ Models - Distributions ~ Tools ~ Help ~ |
Dataset: Davis *  Model: No active mode ~ )
Menu Com.., | Custom Toolbars |}
Al ~@ fe | weight
Calibi ~[11 ~|A* A" 8§ ~ % » F .
at] Bookd =
e B 7 - O - A%
[ : : : F G H
1 |weight R runcode in Remdr
2 15.1
e R Run code
- Get R Val
a 15.7 SRR
5 16.5 Put R Var
6 16.0 Get Active DataFrame
7 16.1 Get R DataFrame
8 15.7. Put R DataFrame
9 15. Remdr Get L |
10 15.7 Get R Qutput
i 16.02 Insert Current R Plot
G
12 15.73 MName Range
13 15.7%
8 | ! £ Numb
14 k
= & cut
Average: 153# 53 copy = ! +

107

Fig. 6.2 Highlight the region A1:A13 containing the data—including the variable
name. Right-click Prettyformat Numbers to align the decimal points, as seen in Fig.

6.3.
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Mm99 s Microsoft Excel e
Home Insert Pagelayout Formulas Data Review View Developer |Add.-Ins @
RExcel -~ R File -~ Data - Stafistics ~ Graphs ~ Models = Distributions ~ Tools =~ Help -
Dataset: Davis * Model: No active mode ~ )
Menu Com.., Custom Toolbars
‘ Al +(a fe | weight
p— ibri = - el v 0 3
& Bookd Calibri 11 ALK S % v F
LA B ZEE-3 A-WNE = = 5
1 [weight 1
2 15.11 R Run code in Remdr
3| 1531 R Buncode
4 15.72 Get R Value
3 16.51 Put R Var
6 16.02 Get Active DataFrame
7 16.15 Get R DataFrame
3
e LTS Put R DataFrame
9 15.90
Remdr Get 4
10 15.7¢
] Get R Qutput
11| 1609 S
12 i 15.73 Insert Current R Plot
13 15.77 MName Range
14 Prettyformat Numbers
- Cut
Average: 1582 | 2 - ! A+t
] (X2 | o

Fig. 6.3 Now that the decimal points are aligned, we can continue. We send the
data from Excel to R, using the the technique detailed in Section 3.2. The data is
already highlighted from Fig. 6.2. We right-click Put R Dataframe to get the dialog
box in Fig. 6.4.

a. Default name. b. Name chosen to reflect data.
Put dataframe in R E\ Put dataframe in R E\
Dataframe name in R Dataframe name in R
| Bookd] | Cannedveq|
et from Cell I Get from Cell
[ with rownames [ with rownames
V¥ make active in Recommander V¥ make active in Recommander
Cancel | Cancel |

Fig. 6.4 Dialog box for Put dataframe in R. The default name Book4 in Panel a is not
descriptive of this dataset. We change the name in Panel b to CannedVeg and click
OK. All menu items on the Remdr menu refer to variables that are columns in the
active dataframe.
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6.1.1 Plot the Data

109

We show several different types of graphs for looking at measured data: the his-

togram, the dotplot, and the boxplot.

6.1.1.1 Histogram

a. Menu.

— =

(B tﬂ ‘) ey ~
Ta

Home Insert Page Layout Formulas

Microsoft Excel -

RExcel ~ n File ~ Data - Statistics = |Graphs ~| Models - Distributions - Tools ~ Help ~

B X

Data Review View Developer Add-Ins '@

Color palette..,
Index plot...

Histogram... l_-_
Stem-and-leaf display...
Boxplot...

Quantile-comparison plot...

Strio chart...

b. Dialog box.

Dataset: CannedVeg * M
Menu Com...
\ CannedVeg v Se
L
20 Booka
B G
Histogram
‘ariable (pick one)
Number of bins:
Axis Scaling

Frequency counts @
Percentages O
Densities O

W=

Lo I

Cancel

)

Help l

Fig. 6.5 The active dataset is now listed as CannedVeg. The Rcmdr menu items will
now know the variable names in this dataset. We graph the data, with a histogram in

this case, by clicking in Panel a on the Rcmdr menu Graphs » Histogram. ..

and in

Panel b accepting the defaults in the Histogram dialog box. The histogram is shown

in Fig. 6.6.
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- R Graphics: Device 2 (ACTIVE)

File History Resize

m—
q‘—
N
=y
S o
&
=
& N
=
——
D—

| | | |
150 155 160 165

CannedVeg$weight

Fig. 6.6 The histogram constructed by the menu and dialog box of Fig. 6.5. The
graph of the weight variable shows the numbers to be centered at a value smaller
than the labeled value of 16. We can’t tell if they are smaller enough to need to take
regulatory action.
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6.1.1.2 Dotplot

a. Menu.

[ B R R T R Microsoft Excel = X

Home Insert Pagelayout Formulas Data Review View Developer Add-Ins @

RExcel ~ R File - Data ~ Statistics JGraphs ~| Models - Distributions ~ Toaols = Help ~

Dataset! CannedVeg v |M Color palette..,
Index plot...
Menu Comman... Histogram... |
| CannedVeg v @ Jx ‘ 1 Stem-and-leaf display... a
(g] Bookd EBoxplot...
[ 4 i A : B _ c . D Quantile-comparison plot.., !
1 lweight
13 | 15.771 g
14 Dotplot with stacked multiple hits... (HH)
18 catterplot. HH HH
| Average: 15.82 Count: 13 Sum: 1894 . .

b. Dialog box.

dotplot with tiebreakers

Factors (pick zero or one) ~ Response Variable (pick one) | Groups (pick zero ar more)
r
Change defaults if needed:

Factor. jitter: |5

cex: |l

pch: |16

layse: |

layy: |

betx: o

bety: 1

altx: 1

alby: 1

I OK I [ Cancel l [ Help ]

Fig. 6.7 Specification of the dotplot with the Graphs » Dotplot with stacked multiple
hits. .. menu item. The plot is shown in Fig. 6.8.
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= R Graphics: Device 2 (ACTIVE) Q@E]

File History Resize

* @» "o * = » *

T T T
155 16.0 16.5

weight

Fig. 6.8 Dotplot specified in Fig. 6.7. The dotplot shows each individual point. The
points close together in the center of the plot give a direct impression of density. The
center of the plot is at a value smaller than the labeled value of 16.
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6.1.1.3 Boxplot

a. Menu.

9@ Microsoft Excel = X

Home Insert Pagelayout Formulas Data Review View Developer _Add.Insi@

RExcel ~ R File - Data ~ Statistics lGraphs '] Models ~ Distributions ~ Tools = Help ~

Dataset! CannedVeg M Color palette...
Index plot...
Menu Comman... Histogram... |
I CannedVeg hlL - Jx I 1 Stem-and-leaf display... ﬂ
@ Bookd Boxplot...
[ 4 A . B - c . D Quantile-comparison plot... |
1 lweight St

b. Dialog box.

Boxplot E| I'E

Wariable (pick one)

Identify outliers with mouse [

Plat by groups... I

I OK I [ Cancel ] [ Help ]

Fig. 6.9 Specification of the boxplot with the Graphs » Boxplot... menu item. The
plot is shown in Fig. 6.10.
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i R Graphics: Device 2 (ACTIVE)

File History Resize

<t )
o
2t
= —_—
]
E —
[o
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= 5 !
i
N_ R —
b
o o

Fig. 6.10 Boxplot specified in Fig. 6.10. The boxplot shows the median as a hori-
zontal line, the quartiles at the top and bottom of the box, and two outliers at more
than 1.5 interquartile distances from the quartiles.
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6.1.2 Calculate the t-Test

a. Menu.
‘-"E-_, b 9--E )+ Microsaft Excel ————
= =
Home Insert Pagelayout Formulas Data Review View Developer  Add-Ins @

RExcel ~ R File =~ Data - |Statistics 'éGraphs ~ Models ~ Distributions ~ Tools = Help ~

Dataset: Canned\ Summaries »

Contingency tables »

MEDICOM: Means » Single-sample t-test...
CannedvVeg -~ Q Proportions »
I Varianees »
& Books
T r Nonparametric tests »
| A | B 3 !
- Dimensional analysis »
1 |weight Fit e .
— it models
32 15.13 - t
3 15.31
4 15.72
_5_ 16.51]
6 16.02,
7 16.19
8 15.73
9 15.90]
10 15.78
Skl 16.05
12 15.75
13 15.77
14 |
Average: 15.82 Count:13  Sum: 189.86 Jﬁ‘=
b. Dialog box.
Single-Sample {-Test Eh_ E|
Variable {pick one)
Alkernative Hypothesis

Population mean = mud ) Null hypothesis: mu =
Population mean < mud &) corfidence Level: |.95

Population mean > mud )

I oK I [ Cancel ] [ Help ]

Fig. 6.11 For this example, the null hypothesis is 4 = 15.75 and the alternative
hypothesis is p < 15.75. We specify the 7-test with the Statistics » Means » Single
sample t-test... menu and dialog. In Panel b, the variable name is automatically
highlighted because it is the only variable name in the dataset. We must type the null
hypothesis value mu=15.75. We must click on the alternative hypothesis Population
mean < mu0. Then click OK. This produces the tabular output in Fig. 6.12.
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R Commander.

Script Window

Hist (CannedVeg§weight, scale="freguency”, breaks="Sturges", col="darkgray™)
t.test (CannedVegiweight, alternative='less', mu=15.75, conf.level=.95)

Cutput Window Suhmi‘tl

b Hist (CannedVegiweight, scale="freguency”, breaks="Sturges", col="darkgray™)

> t.test (CannedVegiweight, alternatiwve='less', wu=15.75, conf.level=.35)
One Sample t-test

data: CannedVegiweight
t = 0.6778, df = 11, p-value = 0.744
alternative hypothesis: true mean is less than 15.75
95 percent confidence interwval:
—Inf 16.01154

sample estimates:
mean of x

15.582167

Messages

54l

Fig. 6.12 t-test output from the menu and dialog box in Fig. 6.11. The R commands
generated from the dialog box are displayed in the Script Window, the top half of
the Commander window, and the executed command and output are in the Output
Window, the bottom half of the Commander window. The observed ¥ = 15.822 is
larger than the hypothesized value g = 15.75 (we rounded the observed mean to
one more digit than in the data; see the discussion on rounding in the Notes to
Readers section). We are not in the rejection region and hence do not reject the
null hypothesis. We will act as if the null hypothesis is true, and we will not take
regulatory action. We draw the graph of the result of this test in Figs. 6.13-6.16.
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6.1.3 Plot the t-Test

a. Menu.

bl ™) Microsoft Excel i

Home Insert Page layout Formulas Data Review View Developer Add-Ins @J

RExcel - R File = Data ~ |Statistics '!Graphs ~ Models - Distributions = Tools ~ Help ~

Active data set Summaries = !
Numerical summaries... | Contingency tables  »
Means 3 | ]
Count missing observations Proportions r E
Variances 3

Monparametric tests  »

arrelation te Dimensional analysis * E 8 i
Shapire-Wilk test of normality... Fit models »

) |

4 15.72

5 16.51

6| 1502

7| 1619

8| 1573

9| 1590

10| 1578

1 1605

12| 1575

13 15.77

14 |

Ready | 3

b. Dialog box.
Numerical Summaries E| E'

Yariables (pick one or mare)

Mean v

Standard Deviation [V
Quartiles V¥ quantiles: 0, .25, 5, .75, 1

Summarize by groups... I

I OK I [ Cancel ] [ Help ]

Fig. 6.13 Drawing the graph requires the sample standard deviation. We calculate
the summary statistics, including the sample standard deviation, with the Remdr
Statistics » Summaries » Numerical Summaries. .. menu item and its dialog box. For
this example, accept the defaults in the dialog box.
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R Commander.

Script Window

Hist (CannedVeg§weight, scale="freguency”, breaks="Sturges", col="darkgray™)

t.test (CannedVegiweight, alternative='less', mu=15.75, conf.level=.95)

numdwnar v (CannedVeg[, "weight™] , statistics=c("wean®, "sd", "guantiles™),
gquantiles=c(0,.25,.5,.75,1)

Cutput Window Sub

> Hist (CannedVegiweight, scale="frequency”, breaks="3turges", col="darkgray™)
> t.test (CannedVegiweight, alternatiwve='less', wu=15.75, conf.level=.35)
One Sample t-test

data: CannedVegiweight
t = 0.6778, df = 11, p-value = 0.744
alternative hypothesis: true mean is less than 15.75
95 percent confidence interwval:
—Inf 16.01154

sample estimates:
mean of x

15.582167

> numdwanary (CannedWVeg[, "weight™] . statistics=c("mean™, "=d", "guantiles"),
+ gquantiles=c(0,.25,.5,.75,1)
mean =d 0% Z5% 50% 75%  100% n
15.82167 0.3662546 15.13 15.7275 15.775 16.0275 16.51 12

Messages

54l

Fig. 6.14 The printed output in the Commander window shows the standard devia-
tion to be sd = 0.3662546. We pick up the standard deviation value with the mouse
and paste it into the dialog box in Fig. 6.15b. Alternatively, we could have used an
Excel sheet function =RApply(’sd”, A2:A13), which returns the value 0.366254589

into its cell, and copied that value into the dialog box.
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a. Menu.
@ o P e T Microsoft Excel i =i

Home Insert Pagelayout Formulas Data Review View Developer Add-Ins '@

Rexcel - R File ~ Data - Statistics = Graphs = Models ~ |Distributions "jToan * Help ~

Dataset: Cann1 Normal distribution 3 Continuous distributions » |
t quantiles.., ! t distribution [3 Discrete distributions »
t probabilities... Chi-squared distribution » /8
Plot t distribution... F distribution > E
Sample from t distribution... Exponential distribution »
Plot hypotheses or Confidence Intervals ... (HH) Uniform distribution L3 | T & H
1 Iweight Beta distribution [ 1
2 | 15.13 Cauchy distribution 2
3 15.31 Logistic distribution L3
_4 1_5_72- Lognormal distribution »
D 16.51 Gamma distribution 4
6 16.02 Weibull distribution »
7 1619 Gumbel distribution »
8 15.73 ! '
k| 15.90
10 15.78
11| 16.05
12| 15.75
13 | a5:7F
14
es]
| Ready |

b. Dialog box.

Normal and t Distributions E|

mu (mean) 15,75
standard deviation (sigma or 5) . 36625¢
df {degrees of freedom) |11 )
n{sample size) |12
left alpha .05
right alpha
Observed value |is.821¢
mu (Alternate Hypothesis)
ymax (right-hand side)
Hypothesis or Confidence
Hypothesis Test (&)
Confidence Interval ()

I OK I [ Cancel ] [ Help ]

Fig. 6.15 We can now specify the plot of the ¢-test as introduced in Section 4.4.
The dialog box is the same for the normal and ¢ distributions. In this example, we fill
in the degrees of freedom box to inform the dialog box that this is a ¢ distribution.
The plot is in Fig. 6.16.
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I R Graphics: Device 2 {ACTIVE)

File History Resize

t density: s3=0.106, v=11

WX 15.74 5.\16;22
04 i
\ ]
03 e
—
LII%<
—
=
g 024 2k
i
LII%<
—
0.1 L
0 0
I I I I I I
% 155 1156 157 158 159 160 shaded area
T 15.56
t -3 -2 -1 o 1 2 3
t 1796 = 0.0500
t 0678 p = 07441

Fig. 6.16 Plot of the ¢-test in Fig. 6.12. The observed value ¥ = 15.822 is to the
right of the null hypothesis iy = 15.75; hence, the green-outlined area representing
the p-value is large, in this case p = 0.7441. The standard error of the mean, shown
on the plot as sz = 0.106, was calculated as s/+/n = 0.3662546/+/12 = 0.1057286

and rounded to three digits.
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6.2 Data—Heights

The second dataset we look at is the Davis dataset containing the heights and weights
of a group of men and women engaged in regular exercise. We will bring it into
R and Excel using the technique introduced in Section 3.6, look at the numbers
themselves, at several plots of the numbers, and ask several questions of the data
about the heights of the subjects.

|t|_':l s L ' R Microsoft Excel - = x
- & Home Insert Page Layout Formulas Data Review View Developer Add-Ins L@
RExcel ~ R File = Edit - |Data = | Statistics ~ Graphs = Models ~ Distributions = Tools ~ Help =
Dataset: trees New data set...

Load data set...

Menu Commands Import data 3
‘ D8 + & Data in packages L§ List data sets in packages
= Active data set L Read data set from an attached package...
] Books

Manage variables in active data set ¥ )_
A B o T .= T F T G | H | I | 1

Fig. 6.17 Click the Data » Data in packages » Read data set from an attached pack-
age... menu item.

Read Data From Package E“: E|

Package [Double-click to select])  Data set (Double-click to select)

datasets
lattice
multcomp

OR

Enter name of data set:
0K I Cancel | Help I

Fig. 6.18 Highlight the package and the dataset names. Click OK.
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HY- -+ Microsoft Excel -2Xx

Home Insert Page Layout Formulas Data Review View Developer | Add-Ins | @

‘ RExcel ~ R File = Edit = Data - Statistics ~ Graphs ~ Models ~ Distributions = Tools ~ Help =

Dataset: Davis = Model: No active mode ~

‘ Menu Commands Custom Toolbars

\ AL 2 C—

=]

'm&hbri M AN S -% P .= x
lalB - Al E
1

R Run in Remdr

R RunR

Get R Value
Put R Var

Get Active DataFrame |
Get R DataFrame

0|~ @ | M

Put R DataFrame

Fig. 6.19 The dataset name now appears as the active dataset in the Dataset box in
the Remdr menu bar. To bring it into Excel, we highlight a cell (here A1) and use
the right-click Get Active DataFrame menu item.
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_‘:@ lﬂ__l ‘.l‘:l z Microsoft Excel = <
= n Irmt Pag?@yuut Furﬁms R v prer @
R File = Edit = Data - Statistics ~ Graphs = Models ~ Distributions = Tools ~ Help =
Dataset: Davis ~ | Model: Mo active mode ~
Menu Commands Custom Toolbars
‘ Davis ~( I |
] Books = X
Ploa e e o B e | & | W kK
[T sex weight  height repwt repht
(2 | iM 77 182 o 0 %
3 | 2F 58 161 1] 0
4 | 3F 53 161 o 0
5 | amM 68 177 1] 0
6 | ik 53 157 o 0
| 7 | 6 M 76 170 1] 0
8 | M 76 167 o 0
(9 | 8 M 69 186 1] 0
10 9 M 71 178 o 0
(11 | om 65 171 1] 0
12 1im 70 TEH o 0
13 12 F 166 57 1] 0
Lk 13 F 51 161 o 0
15| 14 F 64 168 1] 0

Fig. 6.20 The dataset is displayed in Excel. Its region is highlighted and its name
now appears in the Excel Name Box, immediately above cell A1. We look at the
numbers and immediately see that case 12 is an anomaly. It looks like the height
and weight fields may have been interchanged. We will need to go back to the data

source to confirm this.
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6.2.1 Plots

We need to plot the data, conditioned on the classification factor sex, before doing
any arithmetic. We will look at a pair of scatterplots, a pair of dotplots, and a pair of

boxplots.

6.2.1.1 Scatterplots

o9 -~-GE) - Microsoft Excel
Home Insert Page Layout Formulas Data Review View Developer |
RExcel ~ R File ~ Edit ~ Data - Statistics ~ |Graphs ~| Models ~ Distributions ~ Tools = Help =
‘ Dataset: Davis ~ Model: R Caolor palette...
Index plot...
| Menu Commands Histogram... -
‘ Al hd '\‘ S | Stem-and-leaf display...
= Boxplot... —
@ Book3 Quantile-comparison plot...
;_L‘[ 8 c D Scatterplot... !
L._'sex weight height Scatterplot matrix...
2 1M 77 182 :
Line graph...
3 2F 58 161 e i
1 3E 53 161 conditioning plot...
5 aAM 68 177 Plot of means...
6 5F 59 157 Ear graph...
7 6 M 76 170 Pie chart...
8 M 76 167 Quantile-comparison plot with test...
9 &M 69 136 Scatterplot matrix.., (HH)
10 IMm 7L 178 P f two-way interact I
= Sl o A XY conditioning plot... (HH) |
12 um 70 175 Dotplot with stacked multiple hits... (HH)}
13 12 F 166 57
Scatterplot.HH... (HH)
14 13 F 51 161 :
15 18F 64 168 Squared Residuals... (HH)
16 | 15F 52 163 3D:gaph r
17 16 F 65 166 Save graph to file 4

Fig. 6.21 We need to plot the data before doing any arithmetic. Use the
Graphs » XY conditioning plot ... (HH)

menu item.
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XY Conditioning Plot (9[=3

Explanatory variables (pick one or more) Response variables (pick one or more)

Conditions T (pick zero or more) Groups 'groups='pick zero or more)
Options
Automatically draw key v

Different panels for different y~x combinations |
Xebuiz Scales in Different Panels v-Axis Scales in Different Panels

Identical - Identical g
Free f" Free g
Same range . Same range C
Layout

number of columns: :

number of rows:

oK I Cancel | Help |

Fig. 6.22 Click the explanatory variable height, the response variable weight, and
the conditions variable sex. Then click OK.

I R Graphics: Device 2 (ACTIVE)

File Hitory Resize

100 150 200
1 1 1 Il Il
F M
B
150 F
B
=
o
g 1 w
S
..,§.
't 5 .
%
N
'’
a0 9 °_‘ F
.
T

T T
100 180 200

height

Fig. 6.23 Conditioning on the sex variable gave us a pair of coordinated plots. We
see the anomalous observation by itself in the upper left-hand corner of the F panel.
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6.2.1.2 Dotplots

dotplot with tiebreakers Eh O E|
Factors (pick zero or one) ~ Response Variable (pick one) | Groups (pick zero or more)
height
repht e

repwit

weight
Change defaults if needed:

factor.jitter: 5
CEH: 1
pch: 16
lays:

layy:

betx: i}
bety: 1
alt: 1
alty: 1

0K I Cancel | Help |

Fig. 6.24 Click the Graphs » Dotplot with stacked multiple hits ...(HH) to get this
dialog box. Click height as the response variable and sex as the factor to get Fig.
6.25.

- R Graphica: Device 2 [ACTIVE)

B Hstory Besie
L L .
L
L
-
-
L4
LI
e
bk
< pahima
T A
M A EEmEmESmEEmEG o4
i
i
vk
-
-
B S
B RRRRRRAR
W RRARRARR
ek
r * e
T T T
100 150 200
heght

Fig. 6.25 This plot was specified in Fig. 6.24. That anomalous point in the Female
heights is very visible as a lone point on the left side of the graph. We will put it
aside in Section 6.2.5 and study the remaining points.
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6.2.1.3 Boxplots

- 5 [x)

Groups variable {pick one)

Identify outliers with mause |

Plot by groups... |

l CK I { Cancel ] [ Help ] l. CK | [ Cancel ]

Fig. 6.26 Click the Graphs » Boxplot... to get the first dialog box. Click Plot by
groups. .. to get the second dialog box. Clicking OK gives Fig. 6.27.

= R Graphics: Device 2 (ACTIVE) Q@JE]

File History Resize
— —
= I_:_l
w = T
— L
] 1
— -] %
s I
D -
=
o
D —
—
o
©w o
| I
F M
sex

Fig. 6.27 This plot was specified in Fig. 6.26. That anomalous point in the Female
heights is very visible as an outlier far below the box and whiskers. We will put it
aside in Section 6.2.5 and study the remaining points.
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6.2.1.4 Bar Graph for Frequencies

Factors require a different type of graph than measured variables. Here we show a
bar graph for the sex factor. We plot the number of F observations and the number
of M observations.

= ] - fEJ T i -
(D = ( 5T} Microsoft Excel S I
Home Insert Page Layout Formulas Data Review View Developer Add-Ins '@
RExcel ~ R File - Data ~ Statistics = |Graphs .| Models ~ Distributions ~ Toals ~ Help =
Dataset: Davis M Caolor palette...
Index plot...
Menu Commands Histogram...
| Davis - I | Stem-and-leaf display...
. Boxplot...
] Book3
Quantile-comparison plot...
A | B | G | D 1 J
— - - Scatterplot... 1 1
1 sex weight  heigh
Scatterplot matrix...
[z 1M 77 o,
3 IE 58 Line graph...
a 9 53 XY conditioning plot...
5 am 68 Plot of means...
6 5F 59 Strip chart...
T B M 76 Bar graph...
I 8 | M 76 Pie chart...

Bar Graph

Variable (pick one)

l Ok I[ Cancel I [ Help ]

Fig. 6.28 Click the Graphs » Bar graphs. .. to get the dialog box. This specification
gives the bar graph in Fig. 6.29.

I R Graphics: Device 2 (ACTIVE)

File History Resize

Frequency
40 80

]

Sex

Fig. 6.29 This plot was specified in Fig. 6.28. The plot shows the number of F and
M observations in the dataset.
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6.2.2 Summary Statistics

R File - Edit -~ Data ~ |Statistics =| Graphs ~ Models - Distributions ~ Tools = Help ~

Dataset: | Davis Summaries L Active data set
Contingency tables  » | Numerical summaries...
Means > Frequency distributions...
v 2 I Proportions 4 Count missing observations

. Numerical Summaries

Vaiiables [pick one or more)

repht
repwt

Mean v
Standard Deviation v

Quantiles ¥ quantiles: |0,25,5,75,1

Summarize by groups... |
[ ok | coca | Heb |

Groups vatiable [pick one)

|
o |

Cancel I

Fig. 6.30 We will look at the summary statistics with the Statistics » Summaries
» Numerical summaries... menu item. We click the height and weight variables in
the dialog box, click the Summarize by groups. .. button, and select the sex variable.
Click OK twice.

Eutput Wwitdow Ml

~

> pumSummary (Davis[, o ("height™, "weight™)], groups=Davisjisex, statistics=c|™mean

Varisble: height

mean sd 0% Z5% 50% 75% 100% n
F 163.7411 11.643925 57 161 165 169 178 112
M 178.0114 &.440701 163 173 178 183 197 &8

Varisble: weight

mean ad 0% 25% 50% 75% 100% n
F 57.86607 12.38314 39 52.75 56 62 166 112
M 75.89773 11.59034 54 67.75 75 83 119 83

Fig. 6.31 The tabular summary is in the Output Window of the R Commander win-
dow.
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6.2.3 Subsetting the Data for Males
H®-o @ s Microsoft Excel - = x
Home Insert Page Layout Formulas | Dag-i Review View Developer Add-Ins @
‘ & ;‘..@ @Cnnec‘tfc-ms 4 k? ;r‘ Clear : =~ % Group ~ E |
3" Properties = i Reapply [EI ~A Ungroup = ==
(Get External| Refresh = 0 %L Sort ilter 5 Text ta Rcrr.mve B z
‘ Data~ All~ == Edit Links ‘ W Advanced || Columns Duplicates i g @Subtuta}
(| | Connections Sart & Filter Data Tools Outline ] |
‘ B1 M 5 | sex
5] Books = =
|4 Y PSS YT Y S ) ] ] X
Lot | weight height repwt repht
2 | im 77 182 o o
3 | 2|F 58 161 o o
(4] 3|F 53 161 0 0
3 | 4 68 177 o o
6 | S|F 5% 157 o o
LE 61M 76 170 o o
8 | 7m 76 167 o o
(3 8|m 69 186 o o
10 slm 7 178 0 0
11 100M 65 17 o o
12 1M 70 175 o o
13 12)F 166 57 o o
i 13)F 51 161 o o
15| 14F 64 168 o o
16 15|F 52 163 0 0
17| 16|F 65 166 o o
18 17IM 52 187 o o
(19]] 18)F 62 168 o o
20 19IM 76 197 o o
(21 200F 61 175 o o
(22 21IM 119 180 o o
23 221F 61 170 1] o
M 4 » »| Sheetl ~Sheet? - Sheet3 %2 & T il
Ready | =

Fig. 6.32 Initially, we look at the two groups individually. We illustrate how to
look at the males. Click column B containing the sex variable. On the Excel Data
tab, click the Filter icon. This places a selection arrow in cell B1.
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' Hw9-© ks Microsoft Excel i &
plamg = 2 =
Home  Insert  Pagelayout  Formulas | Data | Review  View  Developer  Adddns @
‘ E| @ 3| Cannections 2l [z R Clear qu % Group = =
o [ Properties ! E \I_a Reapply EE ! [ A Ungroup =~ =
Get External| Refresh El Sort iltes . extto  Remove
Data» | All» =2 EditLinks X7 ndvanced | columns Duplicates £~
Connections Sort & Filter  DataTools Outline. fa

E
- Jweight height repwt  repht
4] sortAtez
2l sertztoa
Sort by Color

=[-N

=]

£y

]

WK | Clear Filter From “sex

(=]

Filter by Calar

1]

Text Filters

- ] (Select Al
- |

@M

oo

15

5

I3

g6z 8]

6 i 5

=

]

8

1]
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1]
1]
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1]
1]
1]
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32 1]
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0
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Fig. 6.33 Click the arrow, and then uncheck F and click OK.
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(R, Rl s Microsoft Excel S
Home Insert Page Layout Formulas | Ei Review View Developer Add-Ins @
EE | ”:@ Cannections 4l W Clear <E =)~ | % Group -
S Properties A ‘I:_; Reapply L = {Fi “# Ungroup -
et - Rﬂmv!h =2 Edit Links L%ll Soft Al v"¢'.I\cl\ranced i aeelo Rerr_mur Lﬁ‘?’ %Suhtutaf |
Data All Columns Duplicates 5 | |
| Comnedtions | Sort & Filter ! Data Taols | outine &
‘ B1 - (‘ P | sex

& Books i
.~ B c | o | e | F | & |

Lot | sex -fJweight height repwt repht
02 1M 77 182 a a
e alm 68 177 1] 1]

o7 & 4 76 170 a 1]

| 8 | 7|M 76 167 1] 1]

LEL a|m 69 186 a a

1o E L Al 178 1] 1]

(2 10|m 65 T a 1]
|32 11m 70 175 1] 1]
18 17|m 92 187 a a
20 15|mM 76 197 1] 1]
|22 21m 18k, 180 a 1]

24 23ImM 65 175 1] 1]
25 241m 66 173 a a
31 aopm 101 183 1] 1]

33 azm 75 178 a 1]
34 a3m 79 173 1] 1]
37 a6|m 64 176 a a

39| 3g|m 69 174 1] 1]

40 | a9m 88 178 a 1]
AL 40IM 65 187 1] 1]
43 42IM 80 178 a a

45 44IM 78 123 [1] [1]

M4 v ¥ Sheetl /Sheet? “Sheet3 3 AN T N
Ready &8 of 200 records found | | Count: 39 |

Fig. 6.34 Only the male data values are displayed.
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R R T Microsoft Excel e
Home Insert Page Layout Formulas Data Review | V\ew_l Developer Add-Ins @
; Dj 0 o q ] © B || 2 newwindow | 1 % % |
) 5 Ia ~ E Arrange All m |
Mormal| Page __ | Show/Hide Zoom 100% Zoomto | = Save Switch Macras
Layout = - Selection |||E] Freeze Panes.=| [ | 14 | ‘Workspace Windows * >
Waorkbook Views || Zoom E Freeze Panes s |
e Keep rows and columns visible while the rest of e
‘ B1 T &_ £ | SEX the worksheet scrolls {based on current selection).
| === Freeze Top Row |
5 Books | Keep the top row visible while scrolling through | - =
| A B. c D T c | the rest of the worksheet, | K
- f N N . Freeze First Column .
2 5 sex  [Wweight height repwt Keep the first column visible while scrolling
&) i [ 77 182 through the rest of the worksheet,
5 4 68 177 70 175
7 5 L 76 170 76 165
8| L 76 167 7 165
9 | &M 69 186 73 180
10| oM 71 178 71 175
11 10pm 65 171 64 170
12 11m 70 175 75 174
18 17 92 187 101 185
20 19m 76 197 75 200
22 21M 119 180 124 178
24 23pM 65 175 66 173
25 248 66 173 70 170
31 30qM 101 183 100 180
33 32IM 75 178 73 175
34 33M 79 173 76 173
37 36\ 64 176 65 175
39 38IM 69 174 69 171
40| 39qM 88 178 86 175
41 40fm 65 187 67 188
43 420 a0 178 a0 178
35| adllm 1 73 183 80 180
M 47 ¥ Sheetl <Sheeta Sheet3 . (2] _u—u-“ =
Ready 88 of 200 records found | | Count: 89 ‘

Fig. 6.35 We will need to scroll down the data, but first we will freeze the top
pane so the column names stay visible. On the Excel View tab, click Freeze Panes »

Freeze Top Row.
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B R T R Microsoft Excel = X
Home Insert Page Layout Formulas | Dag-I Review View Developer Add-Ins @
‘ l;] ”@ @Cnneéﬁem | » W Clear E*E =~ % Group ~ |
S Properties | . %Reapp[}r {Fi “# Ungroup -
Get External| Refresh % ﬁl Sort Filter 7. Textto  Remove i ?
‘ Data~ Alf> =2 Edit Links .4 Advanced || Columns Duplicates = @Subtutﬂ}
(| | Connections Sort & Fifter Data Tools Outline ] |
| D1 - fe | height
& Books =
A | 8 | c [eue Ee |k S H ! ] X
1 sex @ weight Jheight |repwt repht
166/ 165 M 56 163 a a
170 165 M 96| 191 1] 1]
172 171 M 76 169 a 1]
174 173 M 61 170 1] 1]
175| 174 M 23] 176
176/ 175 M 62] 168 1] 1]
177 176 M 71 178 a 1]
179 178 M 66| 170 1] 1]
130 179 M 81 178 a a
181 180 M 68 174 1] 1]
182 181 M 80 176 a a
184 183 M 82 181
186 185 M 70] 173 a a
150 189 M 76| 123 1] 1]
192 191 M 28] 185 a 1]
193 192 M 83 173 1] 1]
197 196 M 74 175 a a
198 197 M 83 180 1] 1]
199 198 M 21 175
200 199 M 90| 181 1] 1]
201 200 M 79 177 a a
202
M 4 » b | Sheetl ~Sheet? - Sheet3 ¥ & T I
Ready 3B of 200 records found | E | Average: 1780113636 Counkt: 39 Sum: 15665 |ﬁ 0] |0t

Fig. 6.36 The top row is now always visible. Put the cursor on cell D1 (the variable
name for height), and press Shift-Control-| to highlight the height column (of only

male heights).
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D R R T Microsoft Excel = X
Home Insert Page Layout Formulas | Data Review View Developer (7]
B ‘@ IE Cannections 4l EE | r ‘& Clear ﬁ =4 - 4=
e 51 Properties |[® | \I_v Reapply = [Fi =z
Get External| Refresh %l Sort Fitter | - Textto Remove .
Data~ All~ =2 Edit Links | |47 Advanced || columns Duplicates EP~
Connections Sort & Filter Data Tools £} |
| D1 - fe | height
& Books Calibri ~H11 ~| A" 37 § ~ % » F =%
T B = . 0 .00 3
| A B | G D B I & A T00 .0 K
1 sex @ weight Jheight
166 165 M 56 16: R Run in Remdr
170 169 M 9% 19]R Runr
172 171 M 76 16 Get R Value
174 173 M 61 17 Put R Var
175 i7a m 82] 17 Get Active DataFrame
176 75 M 62| 164 Get R DataFrame
17 176 M 71 178 Put R DataFrame
179 178 M 66 17 I b
130 179 M 81 17
PR Get R Dutput
131 130 M 68 17.
182 181 M 80 G Fiome fanae
1—8—5 183 M 22 18 Expand Array Formula
186 185 M 70l 171 & | Cut

Put dataframe in R

Dataframe name in R

et from Cell I

[ with rownames
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[V make active in Rcommander

Cancel |

Fig. 6.37 Right-click Put R DataFrame. Enter the dataframe name DavisMheight.
This dialog box constructs a dataframe in R consisting of the male heights and
makes it the active dataset in the Rcmdr window. All menu items on the Remdr

menu refer to variables that are columns in the active dataframe.
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6.2.4 One-Sample t-Test for Males

las Data Review View Develc
_Glaphs' Models ~ Distributions = Tools = He
Colaor palette...
Index plot...
Histogram...

Stem-and-leaf display...
Boxplot...

Quantile-comparison plot...

dotplot with tiebr

Scatterplot...
2 Factors ipick zero or one) ~ Response Yariable {pick one) | Groups {pick 2ero or mare)
Scatterplot matrix...
Line graph..
¥Y conditioning plot...
Change defaults if needed;
Factor.jitker: .5
cext 1
pch: 16
laya:
Quantile-comparison plot with test... lepie
Secatterplot matrix... (HH) bets: 0
bety: 1
albx: 1
Dotplot with stacked multiple hits... s n
3D graph r
grap [o]:4 ] [ Cancel ] [ Help
Save graph to file 13
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Fig. 6.38 Dotplot of the male heights.



6.2 Data—Heights 137
I/Tn HY-o-[E - Microsoft Excel = x
~ Home Insert Page Layout Formulas Data Review View Developer Add-Ins @)

RExcel ~

Single-Sample t-Test
Wariable [pick one)

height

Alternative Hypothesis
Population mean = mud &
Population mean < mud

Population mean > mud

[ 1|

Cancel

R File = Edit - Data - |Statistics =| Graphs =~ Maodels ~ Distributions = Tools = Help ~

{7

»

k| single-sample t-test..,

»

Dataset: DavisMheight Summaries
Contingency tables
Menu Commands | Means
‘ D1 * I Propartions
= Variances
'Ej Book3 Monparametric tests
i A B | € | Dimensianal analysis
1 sex_ [ weight [ Fit madels
165 M 56
169 M 96| 191 1]
171 M 76| 169 1]
173 M 61 170 o

o o o o

Null hypothesis: mu = @
Confidence Level: |.55

I Heo |

Fig. 6.39 We are ready to do the arithmetic of the #-test of the null hypothesis
Hy: u = 180. Use the Statistics » Means » Single-sample t-test... menu item. Fill in
the Null hypothesis: mu=180 and accept the other defaults.
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Dutput Windaw Submit] |
A
> dotplotirep('', nrow(DbavisMheight)) ~ height, data=DavisMheight, panel=panel.d

> t.test (DavisMheightiheight, alternative='two.sided', mu=180, conf.level=.35)
One Sample t-test

data: DavisMheightfheight
t = -2.8964, df = 87, p-value = 0.004773
alternative hypothesis: true mean is not egqual to 180
95 percent confidence interwval:
176.6467 179.3760
sample estimates:
mean of x
178.0114

Fig. 6.40 The output answers two distinct questions. Usually, only one of them is
meaningful in a problem setting.

The t-value —2.8964 with p-value 0.004773 answers the question about the null
hypothesis. Since the observed p = 0.004773 is much less than the « level of the
test (not stated here, so we usually use @ = 0.05), we reject the null hypothesis.

The confidence interval is

95%CI(1) = (176.6467,179.3760)

This answers the question about estimating the value of the true mean of the popu-
lation from which the data was drawn.
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6.2.5 Two-Sample t-Test Comparing Males and Females
D He-c-Em )+ Microsoft Excel i
L — =
- Home Insert Page Layout Formulas Data Review View Developer | Add-Ins @
RExcel ~ R File = Edit - Data - Statistics = Graphs = Maodels = Distributions = Tools = Help ~ ‘
Dataset: DavisMheight ~ Model Mo active mode =
Menu Commands Custom Toolbars |
‘ D1 - @ e ] height
& Books
B~ | s | c Rl e | F G H l
it sex  |-flweight |height |repwt repht
166 165 M 4] sorAtez 0
170 169 M Zl sortZtoa 0
172 171 M Sort by Color v &
174, 173 M & Clear Filter From “sex” 0
75 174 M s .
176 175 M T"H'F_'It i , 0
177 azeim ([ IEAREEE 0
179 M V] o Eselectan 0
1 1M v 0
181 180 M 0

Fig. 6.41 Clear the filter by clicking on the filter arrow.

9o s
Home Insert Page Layout Formulas
RExcel ~ R File ~ Edit ~ Data ~ Statistics ~ Graphs
Dataset: DavisMheight |~ | Model: No activ
Baumann
‘ Menu Commands| | |Davis Custom
DavisMheight =z
| D1 | Ericksen height
Friendly —
@ Book3 recovery
| | A B trees D E
sex [0 epedight  Jrepwt
165 M 56 163
166 F 59 159
167 F 63) 170
168 F 66 166
169 M 96 1931

Fig. 6.42 Click the dropdown Dataset box, and restore Davis as the active dataset.
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14 13:F 51 161 Q.
15 uF 64 168 gyiaAy conv
16 15F 52 163 o @ Peste
17 16 F 65 166 o Paste Spedial...
18| 17 M 92 187 o Insert
19 18 F 62 168 o Delete
20 13 M 76 157 0 Clear Contents
=L 20 = s 0 5 Format Cells...
22 21 M 119 130 o
e Row Height...
| 23 22 F A i N 7 0
M 4 » »| Sheetl ~ Sheet? .- Sheet3 ~¥1 A Hide
Unhid
Ready | = Average: 47 s = +

Fig. 6.43 Click the row (in the row number area) containing the anomalous obser-
vation and right-click Hide.
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Put dataframe in R E|

Dataframe name in R

et from Cell |

I with rewnames

| Davisx12]

v make active in Rcommander

Cancel |

Fig. 6.44 Highlight the dataset with the hidden row in Excel using Shift-Control-*
and right-click Put R DataFrame. Name it Davisx12. All menu items on the Rcmdr
menu refer to variables that are columns in the active dataframe.

‘E [ B R e T I Microsoft Excel - B X
Haome Insert Page Layout Formulas Data Review Wiew Developer Add-Ins 'QJ
RExcel = R File = Edit = Data - |Statistics '| GGraphs = Madels = Distributions ~ Tools ~ Help =
Dataset: Davisd2 Summaries L4
Contingency tables ¥
Menu Commands Means L4 single-sample t-test..,
! Davis hill - 5 Froportions L4 Independent samples t-test..
= Variances L Paired t-test...
@ Book3 Nonparametric tests  » One-way ANOVA,.. = =
A B c Dimensional analysis * Multi-way ANOVA... |- . k
1 sex weight h B ¥ I
2 im 7T ——r— ()]
3 2F 58 161 0 0
4 3F 53 161 0 0|
3 4 M 68 177 0 0
6 5F 59 157 0 0
7 6 M 76 170 0 0
2 7™ 76 167 0 0
9 &M 69 186 0 0
10 9 M 71 178 0 0|
1 wom 65 171 0 0
12 1mim 70 175 0 0
14 13F 51 161 0 0
15 14 F 64 168 0 0
16 15F 52 163 0 0

Fig. 6.45 The anomalous row is now hidden in the Davisx12 dataset. Note that the
row numbers go from 12 directly to 14. The height variable contains heights for both
males and females. The groups are distinguished by the value of the sex variable.
We specify the independent samples ¢-test with the Statistics » Means » Independent
samples t-test... menu item.
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Independent Samples t-Test EHE E|

Groups [pick one) Response Yariable (pick one]

Difference:  <Mo groups selected>
Alemative Hypothesis  Confidence Level  Assume equal variances?

Two-sided S I 95 Yes +

Difference <0 Mo .
Difference >0

| QK I Cancel | Help |

Fig. 6.46 Specify the Response variable as height and the Groups variable as sex.
We take the default alternative hypothesis as Two-sided, the default 95% confidence
level, and check Yes to use the equal-variances formulas. Click OK.

Dutput Windaw Submit] |

-

> dotplot (sex ~ height, data=Davis, panel=panel.dotplot.th, factor=0.5, cex=1, p

> dotplot (sex ~ height, data=DavisxlZ, panel=panel.dotplot.th, factor=0.5, cex=1
> L.testheight~sex, alternative='two.sided', conf.lewel=.95, wvar.equal=TRUE, da
Two Sample t-test

data: height by sex

t = -15.464, df = 197, p-wvalue < Z.Ze-186

alternative hypothesis: true difference in means is not egqual to 0
95 percent confidence interwval:

-15.005585 -11.61144

sample estimates:
mean in group F mean in group M

164.7027 178.0114

< >

Meszages

54l

Fig. 6.47 The t-test output is in the Output Window of the Remdr window. Two dif-
ferent questions are answered in the output listing.

The test of the null hypotheses Hy: U = Uy vs the alternative hypothesis
Ho: U # Uy has t = —15.464 with p < 2.2 x 10719, We can reject the null hy-
pothesis.

The 95% confidence interval for the difference of the population means is given
by the interval (—15.00588,—11.61144).
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Fig. 6.48 Draw the same plot as in Figs. 6.24 and 6.25 to get this figure. Now we
see clearly that the male population has a distribution with a higher mean than the
female population.
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6.3 Matched Pairs 7-Test

Read Data From Package E“: E|

Package [Double-click to select]  Data set [Double-click to select]

stack. loss [stackloss)
stack.x [stackloss)
stackloss

Enter name of data set:
oK I Cancel | Help I

Fig. 6.49 We will look at the sleep dataset to study matched pairs. The dataset
shows the effect of two soporific drugs (measured as increase in hours of sleep
compared to control) on 10 patients. Each subject was measured twice, once on
each of the drugs. We are interested in the difference between the two drugs.

On the Remdr menu, click the

Data » Data in packages » Read data set from an attached package. ..

menu item to open this dialog box. Double-click the package datasets and the dataset
sleep. Click OK.

New Waorkbook
Microsoft Exce

G 9 -G
| Templates ‘ |_
R Recent Documents Blank and recent ]
Mew Bl
| : ank and re«
1 RExcel2007Startup.xlsm {= Installed Templates
= 2 Roster 2007 xls f= My templates..,
e 7 Gpen
3 Bookl.xls = New from existing... i T
I I Save 4 Bookl.xlsx = Microsoft Office Online
N 5 normal.and.t.xlsx {= Eastired Blank Warkbook

Fig. 6.50 Open a new Excel workbook in which to display the data.
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|.:!,'l, B R T R Microsoft Excel = X
- Home Insert Page Layout Formulas Data Review View Developer | Add-Ins | @
RExcel ~ R File = Edit - Data - Statistics ~ Graphs = Models ~ Distributions ~ Tools ~ Help ~
Dataset: sleep ~ | Model: Mo active mode ~
||Menu Commands Custom Toalbars |
‘ B1 M 5 | extra
] Books ST l
[ 4 Bl c D E F G H i i k
L extra zroup [
2 | 1 0.7] 1
[ 3 | 2] -1.6 1
4| 3 -0.2 1
5| 4 -1.2 ik
6 5 -0.1 1
| 7 | 6 3.4 1
8 | 7| 3.7 1
(9 | 8] 0.8] ik
10| El 0.0} 1 =
11 10] 2.0] 1
12 11 1.9 2
13 12 0.8] 2
14 13 1.1 2
(15| 14 0.1] 2
16 | 15] -0.1 2
(17| 16 4.4 2
18 | 17] 5.5] 2
19 18] 1.6 2
20| 19 4.6 2
21 20] 3.4 2
2|
4 4 » »i| Sheetl ~Sheet2 - Sheet3 ~¥J AL m B
Ready | 53 | Average: 1.5 Count: 21 Sum:30.8 Hﬁ-w 100%

Fig. 6.51 In the new workbook, place the cursor in cell A1 and right-click Get Active
DataFrame to bring the data into Excel. The default format for the extra column
was unaligned. Therefore, we aligned it to one decimal position with the right-click
Prettyformat Numbers menu item.
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.ﬁ [ R R N 5 R Microsoft Excel - = X
Home Insert Pagelayout Formulas Data Review View  Developer | Add-Ins @J
RExcel - R File - Data - Statistics = Graphs ~ Mdcalibri ~ 11 -~ A A" % ~ %
Dataset: Modek |No actiy = B
' EN B rEH-H- AU NG
Menu Commands Custom Ta R R code i Remde
| E2 il - F | R Bun code
@BDOM Get R Value
| A B c . D . E Put R Var
. ) . axtra group 1 Get Active DataFrame
% 15 ----- a}i 1 I Get R DataFrame
3 2 —l.ﬁi 1 Put R DataFrame
'
4 3 -0.2) 1 Remdr Get
]
5 45 L2y 1 Get R Qutput
B 5 '0'15 1 Insert Current R Plot
'
7 E': 3.4 1 MName Range
(] "
. TI“': 3'?: . Prettyformat Numbers
2) =N 0.8: 1 %
v u
10 9 o) 1k 7 7
1 0 @ 1 s Com
12 1 19 2 B Paste
13 12 0.8 2 Paste Special...
14 13 Aol 2 Insert Copied Cells...
15 14 0.1 2 Delete...
16 15 -0.1 2 Clear Contents
17 16 4.4 2 Filter
13 17 5.5 2
sort
19 18 16 2
20 19 46 2 d Insert Comment
21 20 3.4 2 |5 Format Cells...
22 | Pick From Drop-down List...
‘M 4> ¥ | Sheetl ~Sheetd ~Sheet3d %] ¢ Name a Range...
Select destination and press ENTER or choose Paste | BB 5 Hyperlink...

Fig. 6.52 1t is usually easier to work with paired data when it is stored in a wide
format, as in Section 3.5. The individual subjects in the study take the role of the
factor used in the illustration in Section 3.5. We reshape it manually. In cell E1, type
the new column name g1. Then highlight the first group of data in cells B2:B11, copy
it with right-click Copy, and paste it into a block beginning in cell E2. Similarly, copy
cells B12:B21 into cells F2:F11 to get Fig. 6.53.
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a. Enter formula.

147

E Book

W o |~ ol |f|w M=

R R R R S R
O W N n s W N o

22

4
A

1
2
3
a
5
6
7
8
9

10
11
12
13
14
15
16
17
18
it
20

B
extra

0.7
-1.6
-0.2
2 b
-0.1

3.4

3.7

0.8

0.0

2.0

1.9

0.8

1.1

0.1
-0.1

4.4

S

1.6

4.6

3.4

C
group

M RN NNRNNRNNNNBERRBER]BHB 2 2 4 4

M 4 » M| Sheetl , Sheet2 - Sheet3 ~¥J

E £ G
gl g2 gimg2
[ 0.7! 1.9i=e2-F2 |
-1.6 0.8
-0.2 11
) 0.1
-0.1 -0.1
34 4.4
3.7 5.5
0.8 1.6
0.0 4.6
2.0 3.4
[

b. Pull down fill handle.

c. Add id variable.

gl
0.7
-1.6
-0.2
-1.2
-0.1
34
3.7
0.8
0.0
2.0

g2

G
Eim 32
1.9] -1.2]
0.8] -2.4
1.1 -1.3|
0.1 -1.3
-0.1] 0.0
4.4 -1.0]
S.5) -1.8]
1.6 -0.8]
4.6 -4.6|
3.4| -1.4

g1

0.7
-1.6
-0.2
-1.2
-0.1

34

3.7

0.8

0.0

2.0

g2

H
glmg2 id
1.9 -1.2 1
0.8 -2.4 2
11 -1.3 3I
0.1 -1.3 4
-0.1 0.0 5
44 -1.0 6
5.5 -1.8 7
1.6 -0.8 8
4.6 -4.6 9|
3.4 -1.4 10

Fig. 6.53 With paired data, we are usually interested in computing a difference
value for each pair. We use Excel’s arithmetic for the differences. In Panel a, enter
the command =E2-F2 in cell G2. In the Panel b, we grab the fill handle of cell G2
and drag it down to G11. Together, these steps produce column G in Panel c. The
difference column g1mg2 has mostly negative values with one zero value. In Panel
¢, we add an id variable in column H to use as an explanatory variable in the plot
to be defined in Figs. 6.54 and 6.55 We right-click Put R DataFrame the highlighted
region E1:H11 with the name sleep2col.
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XY Conditioning Plot EEX

Explanatory variables (pick one or more) Response variables (pick one or more)

1
1mg2 1mg2
2

d

Conditions ‘| {pick zero or more} Groups ‘groups=" (pick zero or more}
I

Options

Autornatically draw key v

Different panels for different y~x combinations |

Plot Type (one or both)

Points v

Lines v

#-Axis Scales in Different Panels Y¥-Axis Scales in Different Panels
Identical ® Identical ®

Free O Free O

Same range O Same range O

Layout

number of columns: |
number of rows:

C > [ oo |

Fig. 6.54 We plot both obervations on the vertical axis against the id on the hor-
izontal axis. Use the Graphs » XY Conditioning Plot...(HH) menu item to get the
dialog box. Specify id as the explanatory variable and both g1 and g1 as response
variables (use control-click for the second variable). Check both Points and Lines.
This produces Fig. 6.55.
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gl +92
N
1

Fig. 6.55 This plot is specified by the dialog box in Fig. 6.54. This dataset is
grouped by id, with each id measured at both group = 1 and group = 2. For almost
every id, group 2 (the red circles) has a higher value on the vertical axis (variable
extra in the original dataset) than does group 1 (the blue circles).
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(ﬁq [ N T B Microsoft Excel - = x
- o Home Insert Page Layout Formulas Data Review View Developer Add-Ins @
RExcel = R File = Edit ~ Data - [Statistics =| Graphs ~ Models = Distributions ~ Tools ~ Help ~
Dataset: sleep2col Summaries »

Contingency tables  »

Menu Commands Means 14 Single-sample t-test... : i
| Eil - '\ ra Propaortions 4 Independent samples t-test
5o Variances 4 Paired t-test.., _——
[ @] Focka MNonparametric tests  » One-way AN —— l
= — — Dimensional analysis * Multi-way ANOVA I =
Paired t-Test [Z],_ @
First variable {pick one) Second variable (pick one)
1
img2 1mg2
2
d d
Alternative Hypaothesis Confidence Level
Twa-sided ®
Difference <0 (O
Difference >0 )
[ OK ] [ Cancel ] [ Help ]
Fig. 6.56 Specify the paired 7-test of the variables g1 and g2.
Output Window Submit
[ ~

> t.test(sleepZeooligl, sleepicol$g?, alternative='two.sided', conf.level=.95,
+ paired=TRUE)

Paired t-test

data: sleepZeolfgl and sleepZeolfg?
£t = —4.0621, df = 9, p-value = 0.002633
alternative hypothesis: true difference in means is not equal to 0
95 percent confidence interval:
-2.4598858 -0.7001142
sample estimates:
mean of the differences
-1.58

Fig. 6.57 The null hypothesis that the differences of the pairs have mean 0 is re-
jected with a p-value of 0.002833.
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( mg - -G Microsoft Excel i =
~ Home Insert Page Layout Formulas Data Review View Developer Add-Ins @
RExcel = R File = Edit ~ Data - [Statistics =| Graphs ~ Models = Distributions ~ Tools =~ Help ~
Dataset: sleep2col Summaries »
Contingency tables  »
_ME!IUCO""NEHUS i Means 4 Single-sample t-test... = -
| F1 - (- S Proportions v idependint it
= e Variances > Paired t-test... ='Z|
[@] T Monparametric tests  » E——
Dimensional analysis » =

Single-Sample t-Test

Variable {pick one)
1

2
d

Alternative Hypothesis
Population mean = mul &) Null hypothesis: mu =

Population mean <mud O confidence Level:
Population mean > mud )

[ OK ] [ Cancel ] [ Help ]

Fig. 6.58 Specify the single-sample 7-test of the difference gimg2 = g1 — g2. The
t-values and p-values in Fig. 6.59 are identical to those in Fig. 6.57.

Output Window Submit

> t.test(sleepZeoliglmgz, alternative='two.sided', mu=0.0, conf.level=,95)
One Sample t-test

data: =sleepZcoliglmg2
t = -4.0621, df = 9, p-value = 0.00Z833
alternative hypothesis: true mean is not egqual to O
95 percent confidence interval:
-2.45985858 -0.7001142
sample estimates:
mean of x
-1.56

Fig. 6.59 The null hypothesis that the set of differences of the pairs have mean 0 is
rejected with a p-value of 0.002833.
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6.4 Confidence Interval Plot

Problem statement:

We have an observed ¥ = 10 and sample standard deviation s = 4 from a sample of
size n = 18. Display a 95% two-sided confidence interval for estimating the popu-
lation mean.

6.4.1 Confidence Intervals with the normal and t Worksheet

The normal.and.t.dist worksheet introduced in Chapter 5 allows us to explore the
Normal and ¢ distributions dynamically. Open the worksheet by clicking on RExcel
» RthroughExcel.Worksheets (as shown in Fig. 5.1) and then click on normal.and.t.

&) normal.and.txdsm - A x
A B c D E F G H I J K g’
1 Show 95% conf limits _ probability
2 |Optional user input Slider on Graph left right two-sided observation|
3 (Mo ol O Display 5z 0.943
4 oy ol O % scale 8.011 11.98% 10
5 X 10 < | #]| Display It scale -2.110 2,110 0.000
6 |3 4 1-Confidence 0.025 0.025 0.050
7 |n 18 confidence level 0.950 3
8 |v 17
9
10 aleft aright a: ) prob or hypoth
1 0.025 0.025| 0.050 @ confidence intervall
12 < >
13 aleft from right scrollbar?]

14
15 |Optional user-specified

16 |display parameters

17 |z.range
1§ | min 715
18 bmax {7 ge|}_Copycurentirance |
P’ -
2 o me } HlaeononTes
21 (fix) max Reset

H 4 ¥ ¥ prob and hypoth %J

Fig. 6.60 On the normal.and.t worksheet, set the values for ¥ = 10,s = 4,n =
18,v = 17, check a left, « right, and « left from right scrollbar?, slide the o right
scrollbar to 0.25, and check confidence interval. This specification is sufficient to
illustrate the problem statement. To scale the graph in Fig. 6.61 to exactly match the
specification in the dialog box in Fig. 6.62, we also set horizontal min to 7.15 and
horizontal max to 12.85.
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I R Graphics: Device 2 {ACTIVE)

File History Resize
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Fig. 6.61 The
green to show

graph is centered at ¥ = 10, with the central 95% of the area colored
the confidence level (Conf Level = 0.950). The confidence interval

(8.011, 11.989) is indicated with a double-headed arrow as the range of the X-axis
between the lower (LCL = 8.011) and upper (UCL = 11.989) confidence limits. This
graph can be specified with either the worksheet in Fig. 6.60 or the dialog box in

Fig. 6.62.
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6.4.2 Confidence Intervals with the
Plot [normal|t] hypotheses or Confidence Intervals. .. Menus

The Plot hypotheses or Confidence Intervals. .. (HH) menu is accessible from either the
normal or ¢ distribution menus.

Distributions '|Tnols = Help ~

Continuous distributions » Normal distribution 4

Discrete distributions L4 t distribution L3 t gquantiles...
Chi-squared distribution » t probabilities...
F distribution 4 Plot t distribution..,

Exponential distribution sample from t distribution...

»

F G Uniform distribution L: Plot hypotheses or Confidence Intervals ... (HH)
Beta distribution 4
3

Cauchy distribution
Logistic distribution

>
Lognormal distribution  »
Gamma distribution 3

>

Weibull distribution
Gumbel distribution 4

Normal and t Distributions

mu {mean)
standard deviation (sigma or s |4
df {degrees of freedom) |17
n (sample size) |18
left alpha |.025
right alpha |.025
Observed Value |10
mu {Alternate Hypathesis)
winax (right-hand side)
Hypathesis or Confidence
Hypothesis Test ()
Confidence Interval (5) §

OF, 1 [ Cancel ] [ Help

Fig. 6.62 On the Remdr menu, click

Distributions » Continuous distributions » t distribution » Plot hypotheses or Confidence
Intervals. .. (HH)

to get the dialog box for the Normal and t distribution plot. Fill in the numerical values
from the problem specification or, in other examples, from the summary informa-
tion. Check Confidence Interval. This specification is another way to produce the
graph in Fig. 6.61.



6.5 Hypothesis Plot and Confidence Interval Plot from Summary Information 155
6.5 Hypothesis Plot and Confidence Interval Plot from Summary
Information

We continue with the example in Fig. 6.31. The tabular summary is repeated in Fig.
6.63.

Dutput Windaw Submit] |

-

> numS3ummary (Davis[,c("height™, "weight™)], groups=Davis§sex, statistics=c("mean

Variasble: height

mean =sd 0% 25% 50% 75% 100% n
F 163.7411 11.643925 57 161 165 169 175 112
M 175.0114 £.440701 163 173 175 183 197 &8

Variasble: weight

mean =d 0% Z5% 50% 75% 100% n
F 57.86607 12.35314 39 52.75 56 62 166 112
M 75.89773 11.59034 54 g7.75 75 83 119 88

Fig. 6.63 The tabular summary of the Davis height and weight data is repeated
from Fig. 6.31. The mean, standard deviation, and sample size for both variables,
grouped by sex, are shown. A two-sided, one-sample 7-test for this data is shown
in Fig. 6.40. We will construct a ¢ hypothesis plot of the male heights using the
summary information.

6.5.1 Hypothesis Plots with the Plot hypotheses and Confidence
Intervals Menu and Workbook

The Plot hypotheses or Confidence Intervals. .. (HH) menu and dialog box are acces-
sible from either the normal or ¢ distribution menus. The dialog box, for a normal
distribution with ¢ on the right, is illustrated in Figs. 4.18 and 4.19.

The Excel Workbook normal.and.t was introduced in Chapter 5.

The illustrations in this section show how to use both the dialog boxes and the
normal.and.t workbook to illustrate a two-sided ¢-test and the two-sided ¢-confidence
interval using summary information that was previously calculated.
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6.5.2 Hypothesis Plot

Distributions '|Too|s - Help ~

Continuous distributions »

Normal distribution

Discrete distributions

¥ t distribution

Chi-squared distribution

F distribution

Exponential distribution
Uniform distribution
Beta distribution
Cauchy distribution
Logistic distribution
Lognormal distribution
Gamma distribution
Weibull distribution

Gumbel distribution

»

3

»

»

t quantiles...

t probabilities...

Plot t distribution...

Sample from t distribution...

Plot hypotheses or Confidence Intervals ... (HH)

Normal and t Distributions

mu {mean) 180
standard deviation (sigma or s} 440701
df {degrees of freedom) &7
n {sample size) 88
left alpha |.025
right alpha 025
Observed Yalue 3.0114
mu {Alternate Hypothesis)
wmax {right-hand side)
Hypothesis or Confidence
Hypothesis Test (O]
Confidence Tnterval )

J |

[ Ok Cancel ] [

Help

J

Fig. 6.64 Menu and dialog box specification of Fig. 6.66 using the summary infor-

mation in Fig. 6.63.

&) normal.and.txdsm o e
A B c D E E G H | J K

1 Show critical values  probability

2 |Optional user input Slider on Graph left right two-sided observation|

3 (Mo 180 O Display 5z 0.687

4 oy ol O % scale 178.635 181.365 178.0114]

5 X 178.0114 £ #]| Display It scale -1.988 1.938 -2.896

6 |3 6.440701 o 0.025 0.025 0.050

7 |n 88 I

8 |v 87 it for pvalue Hy | -2896 2896

9 p value Hy 0.005

10 | #aleft [¥laright |G- @) prob or hypath

" 0.025 0.025| 0.050| £ confidence interval

12 < |.&

13 aleft from right scrollbar?)

14

15 [Optional user-specified

16 |display parameters

17 |z.range

g i;;:x 171782} Copy current x range

g ) min } Copy current f(x) range

21 [fix) max Reset

H 4 ¥ ¥ prob and hypoth /%J

Fig. 6.65 Workbook specification of Fig. 6.66 using the summary information in
Fig. 6.63. The horizontal min and horizontal max values are there solely to make the
scaling identical to the scaling from the dialog box.
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IF2 R Graphics: Device 2 {ACTIVE) =3
File History Resize
t density: sy =0.687, v=87
X 178,011 180
¥ 06
04 i -
I — 05
034 | 0
I - 04
o
—
| =
= 02 - I —03 |~>I<
| B
- 02 =
0.1 7 I =
I ~ 0.1
0 - — 00
D ‘ T T T
7 178 179 180 181 182 shaded area
% 178.635 181.365
t -3 -2 -1 u] 1 2 3
t -1.988 1.988 o =0.050
t -2.896 2.896 p=0.005

Fig. 6.66 This figure is produced by either Fig. 6.64 or 6.65. The observed value
X =178.011 is in the left rejection region. The p-value (p = 0.005) is calculated
from both the left green-outlined area and the right green-outlined area. The critical
values for the test are displayed in large blue X units and in smaller black #g7 units.
The observed t = —2.896 agrees with the value we saw in Fig. 6.40.
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6.5.3 Confidence Interval Plot

Distributions '|Too|s - Help ~

‘ Continuous distributions » Normal distribution

Discrete distributions ¥ t distribution
Chi-squared distribution »
F distribution
Exponential distribution »
F G Uniform distribution

Beta distribution
Cauchy distribution
Logistic distribution

Gamma distribution
Weibull distribution

Gumbel distribution

Lognormal distribution  »

t quantiles...

t probabilities...

Plot t distribution...

Sample from t distribution...

Plot hypotheses or Confidence Intervals ... (HH)

Normal and t Distributions

mu {mean)
standard deviation (sigma or s} 440701
df {degrees of freedom) &7
n {sample size) 88
left alpha |.025
right alpha 025
Observed Yalue 3.0114
mu {Alternate Hypothesis)
wmax {right-hand side)
Hypothesis or Confidence
Hypothesis Test O
Confidence Interval (3 §

6 t-Tests

[ Ok I [ Cancel ] [

Help ]

Fig. 6.67 Menu and dialog box specification of Fig. 6.69 using the summary infor-

mation in Fig. 6.63.

&) normal.and.txdsm

A B c D E E G H | J K
1 Show 95% conf limits _ probability
2 |Optional user input Slider on Graph left right two-sided observation|
3 (Mo 180 O Display 5z 0.687
4 oy ol O % scale 176.647 179.376 178.0114]
5 X 178.0114 < | #]| Display It scale -1.988  1.938 0.000
6 |3 6.440701 1-Confidence 0.025 0.025 0.050
7 |n 88 confidence level 0.950
8 |v 87|
9
10 | #aleft [¥laright |G- {7 prab or hypath
" 0.025 0.025| 0.050| @ confidence interval
12 < |.&
13 aleft from right scrollbar?)
14
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Fig. 6.68 Workbook specification of Fig. 6.69 using the summary information in
Fig. 6.63. The horizontal min and horizontal max values are there solely to make the
scaling identical to the scaling from the dialog box.
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Fig. 6.69 This figure is produced by either Fig. 6.67 or 6.68. The confidence inter-
val, indicated by the horizontal two-headed arrow, is centered on the observed value
X =178.011. The green shading has area equal to the confidence level 0.95 = 95%.
The lower and upper bounds of the confidence interval (176.647, 179.376) are dis-
played in large green X units and in smaller black #g7 units. The confidence bounds
agree with the values we found in Fig. 6.40.
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6.6 Alternate Styles for the Calculation of Confidence Intervals

The 7-test dialog box and the normal and t worksheets can be used in many apparently
different situations, as illustrated in earlier sections. In this section, we show the
reason that these situations all lead to the same graph is that they are fundamentally
variations on the same formula. For specificity, we do so with an example of a two-
sample normal test of the differences of two means.

Assume X and Y are normally distributed random variables with means

Standard ) Sample
Mean deviation Variance size

X px=18 ox=3 02=3=9 nx=10
Y /Jy:15 O'y:3 6%232:9 I’lyZlO

Calculate the probability that X > ¥, P(X > 7).

We use the basic formula for the mean and variance of the sum of two indepen-
dent normals. If X and Y are independent normally distributed random variables
with means gty and fly and with variances 62 and 67, then

ey = E(X+Y)= EX)+ E(Y)=pux+uy (62)
03,y = var(X +Y) = var(X) + var(Y) = 63 + 0} (6.3)
Note that this formula for variances is true only in the special case that X and Y

are independent. The more general formula for variances has a covariance term
2cov(X,Y).

6.6.1 Recommended Style

We recommend defining and using a new symbol, W. This style simplifies the ap-
pearance of the calculation and makes it clearer how to generalize to other examples.

1. Identify the information in the problem statement.

ux =18
py =15
O'X:?)
Gy=3
nxy = 10

ny:IO
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2. Define the new variable, W = Xy — Xy. Find the mean and standard deviation of
w.
Then, from Equation (6.2), we see

= — 4+ —
=18
ow = 1.341641

The mean Uy and standard deviation oy are used in the formula in the next step
and in the dialog box in Fig. 6.70.
3. The assignment is to calculate

P(Xx > Xy)
— P(Xx — Xy > 0)
=P(W >0)
We now use the ordinary formula and dialog box, along with ty and oy,
to complete the calculation.
(0
Ow V1.8
= P(Z > —2.236068)

= 0.9873263
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Distributions | Tools ~ Help ~

Continuous distributions *

Discrete distributions L3

Mormal distribution

t distribution
Chi-squared distribution
F distribution
Exponential distribution
Unifarm distribution
EBeta distribution
Cauchy distribution
Logistic distribution
Lognormal distribution
Gamma distribution
Weibull distribution

Gumbel distribution

6 t-Tests
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4 Plot normal distribution...

L4 Sample from normal distribution...
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- R Graphics: Device 2 (ACTIVE)
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Fig. 6.70 Menu: Distributions » Continuous distributions » Normal distribution » Plot
hypotheses or Confidence Intervals ... (HH)
The numerical answer to the exercise is identified as p = 0.987 and is illustrated as
the green-outlined area to the right of X = 0 and the right of z = —2.236. The X-scale
is called W in the algebraic expansion. uy and oy are entered into the dialog box.
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6.6.2 Not Recommended Style

The niive formula treats the problem as a special case with its own unique formula.

PRy %y >0y = p| Fx=Xr) (o —py)  0-(18-5)

i% + i% ﬁ + 3—2
x|y 1010
= P(Z> —2.24)
= 05+P(0<Z<224)
= 0.5+0.4875

= 0.9875

This formula gets the same answer as the recommended style. It is, after all,
doing the same arithmetic. The difficulty with this style, and the reason we don’t
recommend it, is that the simplicity of the standard phrase

W —
Ow

is not instantly visible. Several clear steps, as in Section 6.6.1, are always to be
preferred to one complex step, as in Section 6.6.2.



Chapter 7
One-Way ANOVA

Abstract One-way ANOVA (analysis of variance) is a technique that generalizes
the two-sample 7-test to three or more samples. We test the hypotheses (specified
here for k = 6 samples) about population means L ;:

Ho: =t = H3 = fla = Us = Us
Hy: Not all u; are equal (j = 1:6)

The test is based on the observed sample means X;.

7.1 Data

We will explore ANOVA with an example from the chickwts dataset that is dis-
tributed with R. From the help file ?chickwts:

An experiment was conducted to measure and compare the effectiveness of various feed
supplements on the growth rate of chickens. Newly hatched chicks were randomly allocated
into six groups, and each group was given a different feed supplement. Their weights in
grams after six weeks are given along with feed types.

R.M. Heiberger, E. Neuwirth, R Through Excel, Use R, 165
DOI 10.1007/978-1-4419-0052-4 7,
© Springer Science+Business Media, LLC 2009
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7 One-Way ANOVA

(e - [&@l |+ Microsoft Excel g i
Insert Page Layout Formulas Data Review View Developer Add-Ins | '@
RExcel ~ R File ~ |Data - | Statistics = Graphs -~ Models - Distributions =~ Tools = Help ~
Dataset: |} New data set..
Load data set...
Menu Commands Import data » B
I Al h Data in packages 4 List data sets in packages
B Bookz Active data set F Read data set from an attached package..
I A . Manage variables in active data set » I' G H 1 1 li

Read Data From Package

Fig. 7.1 Use the

Package {Double-click to select)  Data set (Double-click ko select)
car ars A
lattice 02

multcomp rimtab v
CR

Enter name of data set:

I OK I [ Cancel ] [ Help ]

Data » Data in packages » Read data set from an attached package. . .

menu item. Double-click to select the datasets package, double-click again to select
the chickwts dataset, and then click OK.

H9-c-@E Microsoft Excel - =X
Home Insert Page Layout Formulas Data Review View Developer Adddns | (@)
RExcel ~ R File =~ Data = Statistics = Graphs = Models = Distributions = Tools = Help =
Dataset: | chickwts Madek |No active mode
Menu Commands Custom Toolbars
| A1 ~(a 5|
& Bookz Calibri ~ |11 | A° A" § - % » F| —
| a |[BZSH-3-A-u%E | F G H 1 1
B 2 R Run code in Remdr
3| R Runcode
2 Get R Valuz
.5 PBut R Var
| Get Active DataFrame
24| Get R DataFrame

Fig. 7.2 chickwts is now listed as the active dataset on the Rcmdr menu. All menu
items on the Recmdr menu refer to variables that are columns in the active dataframe.
Put the cursor in cell A1 of a new workbook and use the right-click Get Active

DataFrame menu item to get the chickwts data into the Excel worksheet, where we
can look at it.
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Workbook Views

Page Layout Formulas Data Review | View Developer Add-Ins '@

Q £ New Window [ | 1 =] %

S ) - o-f@l ) F
(O S
T
> Home Insert

5

I
Normal| Page Show/Hide|| Zoom
Layout = # -

Microsoft Excel N T

= arrange Al | TH

| chickwts v

] Bookz

| [ I [N - T -

=3 weight feed
2 1: 179 horsebeayg

3 & 160 horsebeayg
4 3 136 horsebeayg
2y 4 227 horsebeai

Ly

— . Save switch Macros

Bﬂ Freeze Panes.w| ] | old Workspace Windows ~ =
Freeze Panes lios -
Keep rows and columns visible while the rest of
the worksheet scrolls (based on current selection). s
Freeze Top Row =
Keep the top row visible while scrolling through .

the rest of the warksheet, 1 1
Freeze First Column

Keep the first column visible while serolling
through the rest of the worksheet.

Fig. 7.3 Freeze the top row of the worksheet. This makes the variable names always
visible, even if we are scrolled down to high-numbered rows. Click the Excel View
tab, and then click the Freeze Panes » Freeze Top Row menu item. Then click the
Excel Add-Ins tab to get back to the Remdr menu.

I Eook2 e
Pll.a 8 c ¢ b | E | FE | 6 | H | v | I

1 weight ifeed

o 1 179:horsebeag

3 2 160:horsebeag

4 3 136:horsebeag

5 4 227:horsebeag

6 5 217 horsebeag

i 6 168:horsebeag

8 2 108:horsebeag

3 8 124:horsebeag

10 9 143 horsebeag

1 10 140:horsebeag

12 11 309:linseed

13 12 229:linseed

14 13 181:linseed

15 14 141:linseed
4 4 > ¥| Sheetl Sheet? , Sheet3 ~¥J + [T m

Fig. 7.4 Notice that the top row is underlined, indicating that the top row is now
frozen. Also, note that column C is not quite as wide as the word horsebean. We
widen the column by placing the cursor on the boundary between the column names
C and D and then double-clicking. We see the wider column in Fig. 7.9.
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7.2 Plots

Before doing any arithmetic or statistical analysis on the data, it is important to look
at it with several graphs. We show two types of graphs, the dotplot and the boxplot.

7.2.1 Dotplot

The dotplot shows one dot for each observation, plotted on a vertical scale for the
data value and on a horizontal scale for the groups.

Strip Chart

Factors (pick zero or more)  Response Variable (pick ane)

Duplicate Values

Stack ®

Jtter O

[ OK l [ Cancel ] [ Help ]

Fig. 7.5 Click the Graphs » Strip chart... to get this dialog box. There is only
one factor and one continuous variable in the chickwts dataset so we can accept the
defaults. Click OK to get Fig. 7.6.
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Fig. 7.6 Each of the six feeds is displayed in its own column. The vertical axis
shows the response variable weight. Each point is one observation. Visually, two
feeds (sunflower and casein) have higher means than the other four. Three feeds
(soybean, meatmeal, and linseed) have very similar ranges.
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7.2.2 Boxplot

The boxplot shows a summary of a variable’s values, consisting of the basic order
statistics: median, quartiles, minimum, maximum. Calculate these order statistics
by ordering the data values from smallest to largest and counting. The median is the
middle observation. The quartiles are half way from the end points to the median.
See the help file ?boxplot . stats for details. Each box shows its group’s median
in the center. The bottom and top lines of the central box are at the first and third
quartiles. If there are no outliers (defined in a moment), the whiskers go out to the
minimum and maximum of the data. If there are outliers, the program defines the
fences as 1.5 interquartile ranges out from the quartiles. The whiskers go out to the
last point inside the fence. Points beyond the fences are individually plotted. Outliers
are points that are noticebly smaller or larger than the remaining points, as measured
on a scale defined by the distance between the first and third quartiles. There is no
implication that they are necessarily incorrect. Existence of outliers often indicates
that the data do not come from a normal distribution. Sometimes it is a consequence
of a large number of observations.

Boxplot E| QTX |

Wariable {pick one)

Groups vatiable (pick one)

Identify outliers with mouse [

Plak by &oups...
I OK I[ Cancel ] [ Help J | OK QJ[ Cancel }

Fig. 7.7 Use the Graphs » Boxplot... menu item. Click Plot by groups. .. to specify
parallel boxplots of the six groups.
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Fig. 7.8 In this plot, the response variable weight is on the vertical axis. There is
one box for each feed. As in Fig. 7.6, we see that two feeds (sunflower and ca-
sein) have higher medians (boxplots use order statistics, hence medians not means)
than the other four. Three feeds (soybean, meatmeal, and linseed) have very similar
ranges. We need to look (in Section 7.3) at the arithmetic of the analysis of vari-
ance (ANOVA) to determine if the visible differences in the observed x;-values and
medians are an indicator of real differences in the population means ;.
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7.3 ANOVA Specification

-_.,; [ I R 7 Microsoft Excel - = X
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Home Insert Page Layout Formulas Data Review View Developer Add-Ins | &)
RExcel~ R File = Data ~ |Statistics ={ Graphs ~ Models = Distributions = Tools = Help =
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1 |weight feed Dimensional analysis * Multi-way ANOVA..,
il 1 179 horseb Fikmadels ’
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RExcel = R File = Data = Statistics = Graphs = Models ~ Distributions = Tools = Help =
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Fig. 7.9 Use the Statistics » Means » One-way ANOVA... menu item to get the
ANOVA dialog box. Specify feed as the group variable and weight as the response
variable. In this example, with only one numeric variable and one factor, the vari-
ables are initially highlighted. Check the Pairwise comparison of means checkbox.
This dialog box sets the active model to AnovaModel.1 and produces the output in
Table 7.1 and Fig. 7.13.
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Table 7.1 This is the complete tabular output from the dialog box in Fig. 7.9.
We illustrate it here to show that the simple command in Fig. 7.9 produces many
subtables and graphs, all of which must be read and interpreted. We will print in a
full-size font and discuss each subtable and graph individually.

> AnovaModel.l <- aov(weight ~ feed, data=chickwts)

> summary (AnovaModel.1l)

Df Sum Sg Mean Sg F value Pr (>F)
feed 5 231129 46226 15.365 5.936e-10 **x*
Residuals 65 195556 3009

Signif. codes: 0 ’“x*%’ 0.001 ‘*%=’ 0.01 "=’ 0.05 .’ 0.1 * " 1

> numSummary (chickwts$weight , groups=chickwts$feed, statistics=c("mean",
+ "sd"))
mean sd n
casein 323.5833 64.43384 12
horsebean 160.2000 38.62584 10
linseed 218.7500 52.23570 12
meatmeal 276.9091 64.90062 11
soybean 246.4286 54.12907 14
sunflower 328.9167 48.83638 12

> .Pairs <- glht(AnovaModel.l, linfct = mcp(feed = "Tukey"))
> confint (.Pairs)

Simultaneous Confidence Intervals
Multiple Comparisons of Means: Tukey Contrasts
Fit: aov(formula = weight ~ feed, data = chickwts)
Estimated Quantile = 2.9361

95% family-wise confidence level

Linear Hypotheses:

Estimate lwr upr
horsebean - casein == 0 -163.3833 -232.3381 -94.4286
linseed - casein == 0 -104.8333 -170.5791 -39.0876
meatmeal - casein == 0 -46.6742 -113.8976 20.5491
soybean - casein == 0 -77.1548 -140.5090 -13.8006
sunflower - casein == 0 5.3333 -60.4124 71.0791
linseed - horsebean == 58.5500 -10.4047 127.5047
meatmeal - horsebean == 0 116.7091 46.3441 187.0741
soybean - horsebean == 0 86.2286 19.5502 152.9069
sunflower - horsebean == 0 168.7167 99.7619 237.6714
meatmeal - linseed == 58.1591 -9.0643 125.3825
soybean - linseed == 0 27.6786 -35.6756 91.0328
sunflower - linseed == 110.1667 44.4209 175.9124
soybean - meatmeal == 0 -30.4805 -95.3668 34.4058
sunflower - meatmeal == 0 52.0076 -15.2158 119.2310
sunflower - soybean == 82.4881 19.1339 145.8423

> old.oma <- par (oma=c(0,5,0,0)
> plot(confint (.Pairs))
> par (old.oma)

> remove (.Pairs)
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7.4 ANOVA Table and F-Test

The ANOVA (analysis of variance) table is the first section of the output from the
One-Way Analysis of Variance dialog box in Table 7.1. We repeat it in Table 7.2 as it
appears in the Remdr Output Window and in Table 7.3 as it is normally reformatted
in a table in a report.

Table 7.2 ANOVA table as displayed in the Remdr listing in Fig. 7.1. The p-value
of 5.936 x 10~!° is significant at any reasonable level of significance.

> AnovaModel.l <- aov(weight ~ feed, data=chickwts)

> summary (AnovaModel.1l)

Df Sum Sg Mean Sg F value Pr (>F)
feed 5 231129 46226 15.365 5.936e-10 *x**
Residuals 65 195556 3009

Signif. codes: 0 ‘xxx’ 0.001 %%’ 0.01 "=’ 0.05 ".” 0.1 " " 1

Table 7.3 ANOVA table from the Remdr listing in Fig. 7.1 and Table 7.2 reformat-
ted as it is normally displayed in a printed report.

Analysis of variance table for response: count

Degrees of Sum of Mean

Source freedom squares square F-value p-value
Feed 5 231129 46226 15.365 5.936x10710 #kx
Residuals 65 195556 3009

Total 70 426685




7.4 ANOVA Table and F-Test

Distributions ~ | Tools ~ Help ~

Continuous distributions »

Discrete distributions r

F Distribution

MNormal distribution

t distribution
Chi-squared distribution
F distribution
Exponential distribution
Uniform distribution
Beta distribution
Cauchy distribution
Logistic distribution
Lognormal distribution
Gamma distribution
Weibull distribution

Gumbel distribution

]

»

]

»

]

»

]

F quantiles...

F probabilities...

Plot F distribution...

Sample from F distribution...

Plot F hypotheses ... (HH)

dft (rumerator degrees of freedom) S
df2 {denominator degrees of freedom) 5

F max {right-hand side)

left alpha |
tight alpha .05
Observed Yalue 15,365

F(F) max (top side)

[ o

Cancel J

[ Help }

175

Fig. 7.10 The ANOVA table showed a significant F-value, with F = 15.365 with 5
and 65 degrees of freedom and p5.936 x 1071, We can look up that observed value
of F in the F table and locate it on the plot of the F’ distribution. Use the Distributions

» Continuous distributions » F distribution » Plot F hypotheses. ..

menu item and its

dialog box. Enter the degrees of freedom and observed F-value from the ANOVA

table.
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Fig. 7.11 The observed value of 15.365 is so far from the default setting of the
scale that we do not see it on the graph. We will need to redraw it with control of
the right side.
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Fig. 7.12 Respecify the plot, this time using the F max (right-hand side) field. The
observed value is very far in the tail and clearly in the rejection region for any
reasonably sized significance level. The graph shows the density of the F5 g5 distri-
bution with the o¢ = 0.05 critical value of 2.356 printed in blue to go with the blue
coloring of the rejection region. The observed F'-value of 15.365 is printed in green,
and the area associated with the p-value of 5.94 x 107!0 is outlined in green. The
observed F-value is in the blue rejection region.
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7.5 Table of Means

7 One-Way ANOVA

The table of means is the second section of the output from the One-Way Analysis of
Variance dialog box in Fig. 7.9. We repeat it in Table 7.4 as it appears in the Remdr
Output Window and in Table 7.5 as it is normally reformatted in a table in a report.

Table 7.4 Table of means as displayed in the Remdr listing in Fig. 7.1.

> numSummary (chickwtsS$weight,
+ groups=chickwtsS$Sfeed,

+ statistics=c("mean", "sd"))

mean sd n
casein 323.5833 64.43384 12
horsebean 160.2000 38.62584 10
linseed 218.7500 52.23570 12
meatmeal 276.9091 64.90062 11
soybean 246.4286 54.12907 14
sunflower 328.9167 48.83638 12

Table 7.5 Table of means from the Remdr listing in Fig. 7.1 reformatted as it is
normally displayed in a printed report.

Standard Sample

Feed Mean deviation size
casein 323.6 64.4 12
horsebean  160.2 38.6 10
linseed 218.8 522 12
meatmeal  276.9 64.9 11
soybean 246.4 54.1 14
sunflower  328.9 48.8 12
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7.6 Multiple Comparisons

Assuming inferences are independent, the probability of simultaneously making
three correct inferences, when each of the three individually has

P(correct inference) = 1 — o = 0.95

is only (1 —a)? = 0.95% = 0.857. Alternatively, the probability of making at least
one incorrect inference is 1 —0.857 = 0.143 ~ 3¢. In general, the more simultane-
ous inferences we make at one time, the smaller the probability that all are correct;
equivalently, the higher the probability that at least one is incorrect. The goal of
multiple comparisons is to control the probability of making at least one incorrect
inference.

We consider all inferences in a related family of inferences. The family we con-
sider here is the set of all (1;) pairwise comparisons X; —X; for 1 <i, j <k.

The way we control the probability of making at least one incorrect inference is
to use a larger critical value for each test than we would use for the tests in isolation.
Here we will use the Tukey Studentized Range Test for determining the critical
value. For k = 6 means and v = 66 degrees of freedom, we will use the critical
value grukey (0.95,6,66)/ /2 =2.935 instead of the 1025.66 = 1.997 value that would
have been used without the adjustment for multiple comparisons. The critical values
for the Studentized Range Test are calculated with the gtukey function in R. The
tables for ¢ are based on the distribution of (% — ;). The number g/+/(2) that we
use is scaled for confidence intervals on individual %;. All the hard work is done
by the ghlt function that is specified either by checking the Pairwise comparison of
means box on the One-way ANOVA. .. or by using the MMC Plot. .. (HH) menu.
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Table 7.6 Table of confidence intervals for pairwise differences of means of the
treatments. This table was produced by the dialog box in Fig. 7.9 and is included in
the output displayed in Fig. 7.1. The critical value for the table, 2.935 in this exam-
ple, is from the Studentized Range distribution and is calculated with

> gtukey (.95, 6, 66)

[1] 4.150851

> gtukey (.95, 6, 66)/sqgrt(2)
[1] 2.935095

The critical value adjusts for simultaneous tests and is therefore larger than the
t 025,66 = 1.997 value that would have been used without the adjustment. The hy-
potheses are ordered alphabetically by the level names. This is usually not a useful
ordering. We replace the alphabetical ordering by a data-dependent ordering in Sec-
tion 7.7.

Simultaneous Confidence Intervals

Multiple Comparisons of Means: Tukey Contrasts

Fit: aov(formula = count ~ spray, data = InsectSprays)

Estimated Quantile = 2.9347
95% family-wise confidence level

Linear Hypotheses:
Estimate lwr upr
0.8333 -3.8654 5.5321
-12.4167 -17.1154 -7.7179
-9.5833 -14.2821 -4.8846
-11.0000 -15.6988 -6.3012
2.1667 -2.5321 6.8654
-13.2500 -17.9488 -8.5512
-10.4167 -15.1154 -5.7179
-11.8333 -16.5321 -7.1346
1.3333 -3.3654 6.0321
2.8333 -1.8654 7.5321
1.4167 -3.2821 6.1154
14.5833 9.8846 19.2821
-1.4167 -6.1154 3.2821
11.7500 7.0512 16.4488
13.1667 8.4679 17.8654
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95% family-wise confidence level

horsebean - casein | (——————) i
I

linseed — casein )

I

I

meatmeal — casein — (—'—‘)
soybean — casein — ——e—) :
sunflower — casein | (—:r'—)
linseed — horsebean — F:—O—)
1eatmeal — horsebean —| : )
soybean — horsebean — : e
unflower — horsebean — 3 —e—
meatmeal - linseed — (*:—0%
soybean — linseed | H—'—)
sunflower — linseed —| : )
soybean — meatmeal —| (—o%
sunflower — meatmeal —| (:—'—)
sunflower — soybean — : ———
T T | T T
-200 -100 0 100 200

Linear Function

Fig. 7.13 Plot of confidence intervals for pairwise differences of means of the
treatments. This figure was produced by the dialog box in Fig. 7.9. It shows the same
intervals as in Table 7.6. We will replace the alphabetical order of the contrasts in
this figure with a data-dependent ordering in Figs. 7.16 and 7.17.
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7.7 Mean-Mean Multiple Comparisons Plot

The Mean—Mean Multiple Comparisons Plot (MMC plot) [Heiberger and Holland,
2006] is a single plot that displays all of

the sample means themselves, with correct relative distances.

the point and interval estimates of the (]2‘) pairwise differences.

the point and interval estimates for arbitrary contrasts of the level means.
declarations of significance.

confidence interval widths that are correct for unequal sample sizes.

NS

The MMC plot in Fig. 7.16 and the corresponding table in Table 7.7 are specified
with the dialog box in Fig. 7.15. In this example, the averages of many of the con-
trasting means are similar. We therefore also print the tiebreaker plot in Fig. 7.17.
Since we frequently need both plots at the same time, it is important to turn on
graphics history as indicated in Fig. 7.14.

22 R Graphics: Device 2 (ACTIVE)

File [

add s 95% family-wise confidence level
Replace
Previous Palp 1

B Mext PgDown  ———e—————3 |
Save to variable,,, ( ! |
Get From variable. .. i
Clear history (—'—%_)

i mmenin : :
Fig. 7.14

Verify at this time that the Graphics Device history is on. From the Graphics Device
menu, click History » Recording to put the checkmark in place.
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Models ~| Distributions = Tools ~ Help ~

i e
L J K
Hypothesis tests »
Mumerical diagnostics L

Graphs >

MMC Plot... (HH)

MMC Plot A=)

AOY model {pick one)

Anovatodel. 1

Tiebreaker Plot [v

I. OK ][ Cancel ] [ Help }

Fig.7.15 Specify the MMC plot with the Models » Graphs » MMC Plot. .. (HH) menu
and its dialog box. Check the Tiebreaker Plot checkbox. This dialog box specifies
Figs. 7.16 and 7.17 and Table 7.7.
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multiple comparisons of means of weight
simultaneous 95% confidence limits, Tukey method

328.88 - sypflpwer .- oo - sunflower-casein
—— F eHBEmuLebyBdIEan
276.91 — meatmeal e F sHBERWGHSisped
...... A - meatmeal-soybean
246.43 - soybean == N : IRAkRARHeBRakan
...... NS - soybean-linseed
218.75 — linseed ~— I meatmeal-horsebean
— I soybean-horsebean

------- J=- == I linseed-horsebean

160.20 —+ horsebean

1 111 |
mean T T I T T T

weight -200 -100 0 100 200 300
feed level contrast

contrast value

Fig. 7.16 MMC plot of confidence intervals for pairwise differences of means of
the treatments. This plot and its tiebreaker plot in Fig. 7.17 were specified in the
dialog box in Fig. 7.15. The tiebreaker, specified by checking the Tiebreaker Plot
checkbox, is needed to separate the contrast labels in the right margin. Each con-
fidence interval is plotted at a height equal to the average of the means of the two
treatments compared in that contrast. The labels in this MMC plot are overprinted
because the averages of many pairs of treatment means are similar.

The left axis of the MMC plot is labeled with the means for the treatments. The
bottom axis is labeled in contrast units, differences between the treatment means.
Each horizontal line representing a confidence interval is at a height that is the aver-
age of the two treatment means it compares. Solid red lines do not cross the vertical
x = 0 line and therefore represent a significant contrast at the specified confidence
level, in this example 95% after the Tukey adjustment for simultaneous tests. Dashed
black lines represent nonsignificant contrasts.

We discuss the content of the MMC plot in Fig. 7.17.
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(—3'—) - sunflower—casein
(3—'—) - sunflower-meatmeal
(i—'—) - casein-meatmeal
3 ——e— - sunflower—soybean
3 ) I casein—soybean
3 ) - sunflower—linseed
3 ) - casein-linseed
(—:—'—) - meatmeal-soybean
F:—'—) - meatmeal-linseed
3 ) - sunflower—horsebean
3 ) - casein—horsebean
(—%—'H - soybean-linseed
3 e - meatmeal-horsebean
3 ) - soybean—horsebean
(3—'—) - linseed-horsebean
T T | T T T
-200 -100 0 100 200 300

Fig. 7.17 The tiebreaker plot shows the same set of contrasts on the same left-to-
right scale and in the same bottom-to-top order as the MMC plot in Fig. 7.16. The
tiebreaker plot spaces the contrasts equidistantly in the bottom-to-top direction.

In this example, the significant contrasts on the upper right edge of the isomeans
grid in Fig. 7.16 indicate that the sunflower and casein means are different from
most of the other treatment means. The significant contrasts on the lower right edge
of the isomeans grid indicates that the horsebean mean is different from most of
the others. The sunflower—casein contrast crosses the vertical O-line, indicating that
the means of sunflower and casein are indistinguishable from each other. The three
contrasts in the center of the MMC plot (meatmeal—soybean, meatmeal—linseed, and
soybean—linseed) show that the three treatments meatmeal, soybean, and linseed are
similar to each other.

Taken together, these contrasts suggest that there are three clusters of treatments
(sunflower, casein), (meatmeal, soybean, and linseed), and (horsebean). We will in-
vestigate this suggestion in Section 7.8.
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Table 7.7 Tabular output from the MMC dialog box. The $mca contrasts are the
values from which Fig. 7.16 was constructed. The numerical values are identical
to those in Table 7.6. The items in the Smca section are ordered by the height
(the average of the two treatment means each compares) column. The items in the
none section (meaning no contrasts, but rather the estimates of the means for each
treatment level) are ordered by the observed means (in the est imate column). The
ry and x. of £set arguments to the plot command and the omd argument to the
par command together control the placement of the plot in the plotting window.
See ?MMC for details.

> old.omd <- par (omd=c(0, 0.8, 0,1))
> AnovaModel.l.mmc <- glht.mmc (AnovaModel.l)

> AnovaModel.l.mmc

Tukey contrasts

Fit: aov(formula = weight ~ feed, data = chickwts)
Estimated Quantile = 2.935338

95% family-wise confidence level

Smca

estimate stderr lower upper height
sunflower-casein 5.33333 22.3925 -60.39472 71.0614 326.250
sunflower-meatmeal 52.00758 22.8958 -15.19770 119.2129 302.913
casein-meatmeal 46.67424 22.8958 -20.53103 113.8795 300.246
sunflower-soybean 82.48810 21.5780 19.15095 145.8252 287.673
casein-soybean 77.15476 21.5780 13.81762 140.4919 285.006
sunflower-linseed 110.16667 22.3925 44.43861 175.8947 273.833
casein-linseed 104.83333 22.3925 39.10528 170.5614 271.167
meatmeal-soybean 30.48052 22.0998 -34.38831 95.3493 261.669
meatmeal-linseed 58.15909 22.8958 -9.04619 125.3644 247.830

sunflower-horsebean 168.71667 23.4855 99.78050 237.6528 244.558
casein-horsebean 163.38333 23.4855 94.44717 232.3195 241.892

soybean-linseed 27.67857 21.5780 -35.65857 91.0157 232.589
meatmeal-horsebean 116.70909 23.9658 46.36304 187.0551 218.555
soybean-horsebean 86.22857 22.7102 19.56816 152.8890 203.314
linseed-horsebean 58.55000 23.4855 -10.38617 127.4862 189.475
Snone

estimate stderr lower upper height

sunflower 328.9167 15.83391 282.4388 375.3946 328.9167
casein 323.5833 15.83391 277.1054 370.0612 323.5833
meatmeal 276.9091 16.53798 228.3645 325.4537 276.9091
soybean 246.4286 14.65936 203.3984 289.4587 246.4286
linseed 218.7500 15.83391 172.2721 265.2279 218.7500
horsebean 160.2000 17.34518 109.2860 211.1140 160.2000

> plot (AnovaModel.l.mmc, x.offset=34.468926055317,
ry=c(114.392542547306, 374.724124119361))

+

> plot.matchMMC (AnovaModel.l.mmcSmca, xlabel.print=FALSE)

> par (old.omd)
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7.8 Linear Contrasts

This section illustrates a more advanced concept, user-specified linear contrasts
among the levels of the factor. It uses techniques that are not available on the menu
system and must therefore be written directly in the R language.

There are 5 degrees of freedom in the ANOVA in Table 7.2, yet 15 contrasts in
Figs. 7.16 and 7.17. We can summarize Figs. 7.16 and 7.17 to show just 5 contrasts.
We noted in Fig. 7.17 that the feeds seem to cluster into three groups, (sunflower
and casein), (meatmeal, soybean, and linseed), and (horsebean). We formalize that
impression by defining a set of orthogonal contrasts in Table 7.8 and using them in
the ANOVA table in Table 7.10 and in the MMC plot in Table 7.11 and Figure 7.18.
The first two contrasts distinguish between the three groups. The last three contrasts
will be used to verify that there is no significant difference within the groups.

Table 7.8 Specification of a contrast matrix. We specify a set of contrasts in the
treatment levels. The first contrast compares the average of the casein and sunflower
treatments to the average of the other four treatements. The second contrast com-
pares the average of the cluster of (meatmeal, soybean, and linseed) treatments to the
average of the horsebean treatment. The remaining contrasts are an orthogonal com-
pletion of the contrast matrix. The constructed matrix chickwts. focus.lmat
is an orthogonal matrix. The data for this example does not have an equal number of
observations in each group. When the contrast matrix is used to specify the dummy
variables in an example with unequal sample sizes, the orthogonality is lost. We
discuss how we handle the unequal sample size situation in Table 7.9.

> chickwts.focus.lmat <-

+ ## ca ho 1li me so su
+ cbind("su.ca-rest"=c( 2, -1, -1, -1, -1, 2),
+ "msl-h"=c( 0, -3, 1, 1, 1, 0),
+ "su-ca"=c( -1, 0, 0, 0, 0, 1),
+ "me-sl"=c( O, O, -1, 2, -1, 0),
+ "so-li"=c( O, 0, -1, 0, 1, 0))
> dimnames (chickwts.focus.lmat) [[1]] <-

+ levels (chickwtsS$Sfeed)

> chickwts.focus.lmat
su.ca-rest msl-h su-ca me-sl so-1i

casein 2 0 -1 0 0
horsebean -1 -3 0 0 0
linseed -1 1 0 -1 -1
meatmeal -1 1 0 2 0
soybean -1 1 0 -1 1
sunflower 2 0 1 0 0
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Table 7.9 In this example, the number of observations for each feed level
are not the same. The numbers are close. Therefore, the orthogonality in the
contrast matrix (crossprod (chickwts.focus.lmat)) is diagonal) im-
plies only near-orthogonality in the matrix of dummy variables (the matrix

crossprod (chickwts.aov$x) is close to diagonal).

> with(chickwts, tapply(weight, feed, length))
casein horsebean linseed meatmeal soybean sunflower
12 10 12 11 14 12
> crossprod (chickwts. focus.lmat)
su.ca-rest msl-h su-ca me-sl so-1i

su.ca-rest 12 0 0 0 0
msl-h 0 12 0 0 0
su-ca 0 0 2 0 0
me-sl 0 0 0 6 0
so-11i 0 0 0 0 2
> chickwts.aov <- update(chickwts.aov, x=TRUE)

> crossprod (chickwts.aov$x)

(Intercept) feedsu.ca-rest feedmsl-h feedsu-ca feedme-sl feedso-1i

(Intercept) 71 1 7 0 -4
feedsu.ca-rest 1 143 -7 0 4
feedmsl-h 7 -7 127 0 -4
feedsu-ca 0 0 0 24 0
feedme-sl -4 4 -4 0 70
feedso-1i 2 -2 2 0 -2

2
-2
2
0
-2
26




7.8 Linear Contrasts 189

Table 7.10 We recalculated the ANOVA table, this time using the contrasts defined
in Table 7.8. We then partitioned the ANOVA table to show that the two degrees of
freedom distinguishing the clusters are highly significant and the remaining three
degrees of freedom are not significant. See ?summary.aov for details. The details
of the arithmetic for sequential sums of squares assure us that the partitioning of
the sums of squares is correct even though the matrix of dummy variables is not
orthogonal.

> contrasts (chickwtsS$Sfeed) <- chickwts.focus.lmat
> chickwts.aov <- aov(weight ~ feed, data=chickwts)
> summary (chickwts.aov)

Df Sum Sg Mean Sqg F value Pr (>F)
feed 5 231129 46226 15.365 5.936e-10 =xxx%
Residuals 65 195556 3009

Signif. codes: 0 'xxx’ 0.001 %%’ 0.01 '+’ 0.05 ".” 0.1 " " 1
> summary (chickwts.aov,
+ split=1list(feed=1ist(
+ ‘su.ca-msl-h’'=1:2,
+ ‘rest’=3:5)))
Df Sum Sg Mean Sg F value Pr (>F)
feed 5 231129 46226 15.3648 5.936e-10 =xxx*
feed: su.ca-msl-h 2 211546 105773 35.1574 4.477e-11 xxx*
feed: rest 3 19583 6528 2.1697 0.1000
Residuals 65 195556 3009

Signif. codes: 0 “#%x’ 0.001 "**’ 0.01 "%’ 0.05 . 0.1 " " 1
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Table 7.11 We recalculate the multiple comparisons, this time using the contrasts
defined in Table 7.8 in addition to the pairwise contrasts. The printed output of
the recalculated chickwts.mmc contains all of Table 7.7 plus the $Imat section listed
here. The plot showing the contrasts specified here is displayed in Figure 7.18. The
contrasts here are not totally independent as a consequence of the unbalance in the
sample sizes for the feeds. The magnitudes of the sums of squares are such that the

conclusions are still valid.

7 One-Way ANOVA

\

chickwts.mmc

+

<-—

> chickwts.mmc$lmat

estimate
su-ca 5.33333
su.ca-rest 100.67808
me-sl 44.31981
so-11i 27.67857
msl-h 87.16255

VV VYV + VYV

par (old.omd)

glht .mmc (AnovaModel .1,
focus.lmat=chickwts. focus.lmat)

stderr
3925 -60.3947

22.
13.
19.
21.
19.

x.0ffset=34.4705974297444,

7969

lower

60.1805

7461 -13.6402
5780 -35.6586

5699

old.omd <- par (omd=c (0, 0.8,
plot (chickwts.mmc,

ry=c(114.391957566256,
par (mfrow=c (2,1))
plot.matchMMC (chickwts.mmc$lmat,
par (mfrow=c (1,1))

29.7198

0,1))

71.
141.

102

91.
144.

upper
0614
1757
.2798
0157
6053

height

326

275.
. 749
232.
.781

254

203

374.724709100411))

.250

911

589

col.signif="blue’)
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multiple comparisons of means of weight
simultaneous 95% confidence limits, Tukey method

328.88 - fuplipwer  --2 b su—ca
276.91 |+ meatmeal —t— su.ca-rest
----- oo me-sl
246.43 — soybean
------ Koo so-li 1
218.75 — linseed
— msl-h 1
160.20 —+ horsebean
Il L1 ! | Il
mean T T T T T T
weight -200 -100 0 100 200 300
feed level contrast

contrast value

HO—) su-ca
3 — su.ca-rest
6—.—) me-sl
———) so-li
3 e msl-h
T T f T T T
-200 -100 0 100 200 300

Fig. 7.18 This figure is specified by the R statements in Table 7.11. There are five
contrasts, corresponding to the five degrees of freedom in the ANOVA table for
the six feeds. The two contrasts distinguishing the three clusters are all significant
and do not cross the vertical 0-line. The three contrasts within the clusters are not
significant and do cross the 0-line. We show the tiebreaker plot even though it is not
absolutely needed here.



Chapter 8
Simple Linear Regression

Abstract Linear regression by the least-squares method is a way of fitting a straight-
line model to observed data.

Linear regression is one of the fundamental techniques in the statistical analysis
of data. We assume a straight-line model for a response variable y as a function
of one or more predictor (or explanatory) variables x. In this chapter, we look at
exactly one predictor variable. Beginning with Chapter 10, we will look at two or
more predictor variables.

The key model assumption is that the mean value of ys for a given x depends
linearly on the value of x. In addition, the model assumes that the observed y values
are distributed according to a normal distribution whose mean is linear in x and
whose standard deviation is independent of the value of x. That is, the variability of
the y data around the mean is independent of x. For one x-variable, the model is

yi=Po+Pixi+&
& ~ N(0,07)

for data consisting of a response variable y and a single predictor variable x. We fit
the model with the least-squares estimates

A 2 —X)(yi—Y)

b= S(x—x)?

o=y Pix

$i = o+ Pixi

2= 2()’1’*)7)2
n—2

The estimates are usually calculated by a computer program. We will usually first
graph the data and then use the Rcmdr Statistics » Fit Models » Linear regression ...
menu item to access the R 1m function.

R.M. Heiberger, E. Neuwirth, R Through Excel, Use R, 193
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8 Simple Linear Regression

8.1 Least-Squares Regression with RExcel/Remdr

Our initial illustration of regression uses the artificial data in Table 8.1. We will enter

the data into a new Excel workbook in Fig. 8.1.

Table 8.1 Artificial data for initial regression example.

1 -0.16

2 —

O 0 9 & n B~

10

0.80
0.00
0.60
1.36
1.28
1.40
0.72
1.04
1.36
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() 9 - - - Microsoft Excel - =2 X
o .
Home Insert Page Layout Formulas Data Review View Developer Add-Ins ' (7]
RExcel ~ R File -~ Data - Statistics ~ Graphs = Models ~ Distributions ~ Toals -~ Help
Dataset: InsectSprays ~ Model! No active mode =
Menu Commands Custom Toolbars
s o &
@Eookl.xlsx i =i
| A | B c D e | G H I J K
1 |x Y
2 | 1 -0.16
3| 2 -0.8
4 | 3 0
5| 4 0.6
6 | E 1.36
@ 6 1.23
g | 7 14
2L 8 0.72
10| 9 104 1|
11 10 1.36 1
Ready | 7o | "EEEET

Fig. 8.1 When the numbers are first entered, Excel by default formats them with-
out aligning decimal points. Unaligned decimal points are very difficult to read;
therefore, in Fig. 8.2, we will align them as we did in Fig. 6.2.

(O e @~ - fE0 Microsoft Excel - = X
Home Insert Page Layout Formulas Data Review View Developer Add-Ins L7}
RExcel = R File = Data - Statistics = Graphs =~ Models = Distributions = Tools ~ Help ~
Dataset: InsectSprays ~ Model: Mo active mode ~
Menu Commands Custom Toolbars
| AL e £ x
& Bookl xlsx Calibri - |11 - AT AT § - % 0 F - = x
[ A | 8 |BI - A-wBE e H I ] (.
1 [x v | [
1 -0.1 R Run code in Remdr
3 A -0. R Run code
_t_l_ 3 Get R Value
5 4k 0. Put R Var
_6_ E L3 Get Active DataFrame
i 6 1.2 Get R DataFrame
8 7 14
= Put R. DataFrame
a 8 0.7
_10 3 1.04 Remdr Get 1
11 10 13 Get R Qutput |
Ready | E I Insert Current R Plot Suim: 618 | =l
Mame Range
| Prettyformat Numbers
& | cut

Fig. 8.2 Highlight the region (including the column labels in row 1) containing the
poorly formatted numbers, and then right-click Prettyformat Numbers to get Fig. 8.3.
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:.'E” R o Microsoft Excel - = x
= Home Insert Page Layout Formulas Data Review i e Developer Add-Ins 'Q)
RExcel = R File = Data = Statistics = Graphs = Maodels = Distributions = Toaols = Help =
Datasek: Mo active dataf ~ Model: Mo ackive mode -
Menu Commands Custom Toolbars
| a1 - (a S| %
3] Boold xlsx L ;11 i LR O%W’_ s i
& g |22 O -A - u A G H J k|
i b 1 i 016 R Runin Remdr
3 L
4 3 0.0 Get RYalue
5 4 0.6 Put R War
E 5 1.3¢ 3 d
; 7"“ (3 1.2 Get R DataFrame
8 7 1.4 Put R DataFrame
3 8 0.73 Remdr Get v
U 2 LO4 Getmoutput
2L i Li3k Fame Range
Ready S Expand Array Formula B2 Sum:6ld | 5 g
Insert Current R Plot
Prettyformat Mumbers
& | Cut
3 copy
[ | Paste .
paste special.. Put dataframe in R g‘
Ihsert.,
Shiate.. Dataframe name in R
Clear Contents I EUUka'“
Fitek J Get from Cell
sort L3
| Insert Comment I with rownames
% Format Cells... [V make active in Rcommander
Pick From Drop-down List.,
Mame a Range... QLCEI,
g,, Hypetink...

Fig. 8.3 The numbers are now aligned. Since they are still highlighted from Fig.
8.2, we can send them to R by right-clicking Put R DataFrame. RExcel gives a dialog
box with a suggested name for the R dataframe that has been constructed from
the name of the Excel workbook. Excel and R have different restrictions on the
formation of valid names. The suggested name satisfies both restrictions.
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— ) - 04 - [E ) S i
ID&\ = (1] Microsoft Excel - = X
- Home Ihsert Page Layout Formulas Data Review Wiews Developer Add-Ins (7]
RExcel = R File = Data ~ Statistics = Graphs = Models = Distributions = Tools = Help =

Dataset: Book_1_xlsx = Maodel: Mo active made =

Menu Commands Cusktom Toolbars

Fig. 8.4 Once the dataframe has been put into R, the Dataset field in the Remdr
menu shows the name of the now active dataframe. All menu items on the Rcmdr
menu refer to variables that are columns in the active dataframe.

8.2 Scatterplot

I/:;\ H9-~-E)- Microsoft Excel - = X
3/ Home Insert Page Layout Farmulas Data Rewiew Wi Deweloper Add-Ins '@1
RExcel ~ R File ~ Data =~ Statistics = |Graphs =| Models = Distributions = Tools = Help =
Dataset: Book_ 1 xlsx - M Color palette...
Index plot..,
Menu Commands Histogram...
| Book_1_xlsx - S | X Stem-and-leaf display...
30 Bookl xlsx Baxplot.. - = x
7y 5 = = Quantile-camparison plot.. | K =
1 [« v Scatterplot..
2 1 -0.16
g 2 0,80 Line graph...
4 3 0,00 i conditioning plot...
5 4 0.60
3 ] 1.36
7 3 1.28
3 7 1.4a Quantile-camparison plotwith test.,
3 8 0.72
10 9 1.04
11 10 1.36

H¥ canditioning plat., [HH)
Ready | Aoiery H| 100% (=
b Dotplot with stacked multiple hits... [HH) o O

ScatterplotHH... [HH]

[1]

Squared Residuals... [HH)
3D graph 3
Sawe graph to file 3

Fig. 8.5 Now that the data is in R, we are ready to begin the analysis. Almost
always an analysis begins with a plot of the data. Here we show the Graphs » Scat-
terplot.HH. .. (HH) menu item, which opens the dialog box in Fig. 8.6.
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Scatterplot.HH [;“: E|

#-varable (pick one) y-variable [pick one)

[r— —

Identify points r
Jitter wevariable |
Jitter yvarisble [
Marginal boxplots |
Least-squares ine v
Smooth Line I~
50

Span for smooth
L1

Subset expression

<all valid cases»
Flot by groups... I
w-anis label y-avis label
| <autor ‘ <autox
Flotting Parameters
Flatting characters |(aulo>
S 13
Point size Iil
13
Axis text size lil
Axis-labels teut si L3
xis-labels test size
|

(u] I Cancel I Help I

Fig. 8.6 Scatterplot.HH dialog box specifying the scatterplot in Fig. 8.7. We high-
lighted the x-variable on the left and the y-variable on the right. This figure shows
our default settings for the various options in the dialog box. They are different
from the defaults for the Scatterplot... menu item. We have checked only the Least-
squares line box and unchecked all others. Our default Plotting characters is 16 (to
specify solid dots), and we increased the size of Point size, Axis text size, and Axis-
labels text size.
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Fig. 8.7 Scatterplot specified in Fig. 8.6. The straight line is the least-squares line.
We calculate its coefficients in the next few figures.
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8.3 Linear Regression Analysis

H9-M-@ )~ Microsoft Excel - = X
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Fig. 8.8 Statistics » Fit Models » Linear regression... requests the linear regression
dialog box in Fig. 8.9.

Linear Regression ELT g|

Enter name for model: | Reghodel 1
Response vanable (pick one) Explanatary vaniables (pick one or more)

— [ —
Subset expression

<all walid cases>
0K I Cancel | Help I

Fig. 8.9 Regression dialog box. We specify the response variable y and the ex-
planatory (predictor) variable x.
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R Commander E| E| Pz|

Script Window

scatterplot (y~x, reg.line=lm, smooth=FAL3E, labels=FAL3E, bhoxplots=FAL3E, span=0
FegModel.l <- lm{y~x, data=Book 1 xlsx)

summary (RegModel.1)

< >
Cubput Window Suhmi‘tl
AoREgQruae L. 1 = LI YR, UHLH—DUU)&_J._KJ.ﬁx.I .

> sumnary (RegModel. 1)

Call:
Imiformala = ¥ ~ x, data = Book 1 xlsx)

Residuals:
Min 1Q Hedian 30 Hax
-0.79103 -0.29518 -0.07103 0.37236 0.77342

Coefficients:
Estimate 3td. Error t walue Pri>|t]
(Intercept) -0.40267 0.35020 -1.150 0.25343
* 0.19685 0.05644 3.4585 0.00823 *+*
Signif. codes: 0 '#*¥%%' Q0,001 '+*' Q.01 '+*' oO.,05 ‘.t o0.1 ' 1

Residual standard error: 0.5126 on 8 degrees of freedom —
Multiple R-sguared: 0.6033, Adjusted R-sguared: 0.5537

F-statistic: 12.16 on 1 and § DF, p-wvalue: 0.00822Z5 ¥

Messages

MNOTE: The dataset Book 1 xlsx has 10 rows and 2 columns. L
v

Fig. 8.10 The regression model has been calculated and stored in the model object
RegModel . 1. The model RegModel. 1 is now the active model in Rcmdr. The
regression coefficients, the intercept and slope of the straight-line fit, are displayed.
Also included in the standard display are the test statistics for the coefficients. In this
example, the slope B; = 0.19685 is significant at p = 0.00823. The double “**” is
a reminder that the p-value is between 0.001 and 0.01.
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./_-1\\ H9-o-F)- Microsoft Excel R
(et :
—/ Home Insert Page Layout Formulas Data Review Wiew Developer Add-Ins 7]

RExcel ~ R File = Data = Stakistics = Graphs = Models = Distributions = Tools = Help =
Dataset: Book_1_xlsx = Model: RegModell -

henu Commands Cuskom Toolbars

Fig. 8.11 The name of the active model now appears in the Model field on the
Remdr menu.

.\ H9 -o-&)s Microsoft Excel - = X

Home Insert Page Layout Formulas Diata Review Wiewn Developer Add-Ins 'Q)

RExcel R File = Data = Statistics = Graphs ~ [Models = Distributions =~ Tools = Help ~

Dataset; Book_1 xlsx = Model: Reg Select active model...
Summarize model
Menu Commands Custo Add obseration statistics to data..,
| Baok_1_xlsx - f | x Canfidence interals...
F‘i] Booklxlsx Best subsets regression.., [HH) .= x
Confidence interval Plot..,
A B C o | J K
Prediction Intervals... [HH]
1 |« ¥
2 1 _0.16] Hypothesis tests > ANOWA table
3 9 -0,80 Mumetical diagnastics * Compare two models..,
4 3 0.00] Graphs L4 Linear kypothesis...
5 4 0.60 ANMOWE table [Type I Sums of Squares)
& 3 1.36 ANOVA table Type I Sums of Squares)
T 3 1.28
& 7 1.40
9 g 0.72
10 3 1.04
11 10 1.36
ready | 2] Anerage! 3,00 Count: 22 Sum: 613 | EO g (=)0

Fig. 8.12 The Models menu is used to specify additional calculations or displays of
the active model. Models » Hypothesis Tests » ANOVA Table (Type | Sums of Squares)
requests the sequential ANOVA table displayed in Fig. 8.13.
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Script Window
scatterplot (y~x, reg.line=lm, smooth=FAL3E, labels=FAL3E, bhoxplots=FAL3E, span=0

FegModel.l <- lm{y~x, data=Book 1 xlsx)
summary (RegModel.1)
anova (RegModel. 1)
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Signif. codes: 0 '#*¥%%' Q0,001 '+*' Q.01 '+*' oO.,05 ‘.t o0.1 ' 1

Residual standard error: 0.5126 on 8 degrees of freedom
Multiple R-sguared: 0.6033, Adjusted R-sguared: 0.5537
F-statistic: 12.16 on 1 and § DF, p-wvalue: 0.00822Z5

> anova (RegModel. 1)
Analysis of Variance Table

Response: ¥y

Df Zwm Sg Mean S3g F wvalue Pri=F)
* 1 3.1965 3.1965 12.165 0.0032Z25 *+*
Residuals & 2Z.1024 0.2628

Signif. codes: O '#¥*%' 0.001 '**' 0.01 '*" Q.05 ', o001t 1 |
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Fig. 8.13 ANOVA table for regression analysis in Fig. 8.10. The p-value for x in
the ANOVA table is identical to the p-value for x in the table of coefficients in Fig.
8.10. The mean square (Mean Sq) on the Residuals line of the ANOVA table is the
square of the Residual standard error.
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8.4 Residuals Analysis

8 Simple Linear Regression

Iffg‘\ = CTRE Microsoft Excel .= x
—/ Home Insert Page Layout Formulas Data Review Wie Developer Add-Ins @)
RExcel = R File = Data = Stakistics = Graphs = |Models = Distributions = Toaols = Help =
Dataset: Book_1 xlsx  + Model: Reg Select active model,.
Summarize model
Menu Commancds Custan Add observation statistics to data,.
| 16 vl Je | Confidence intervals..
.T‘i] ookl xsx Best subsets regression... (HH) o= x
Confidence interval Plat.., =
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Fig. 8.14 We normally look at the residuals after fitting a model. Recall that the
residual standard error is given by s> = (3(y; — $)?)/(n — 2). The terms inside the
summation e; = y; — ¥ are the residuals. They are the unexplained part of y, the
leftover or residual part, after the model has been fit to the x-variable. We calcu-
late the residuals and predicted values for the active model with the Models » Add
observation statistics to data. .. menu item, which opens the dialog box in Fig. 8.15.

Add Observation Statistics to Data EHE E|

Fitted values
Residuals
Studentized residuals
Hat-values

Cook's distances

Observation indices

[ 1|

v
v
-
-
r
-

Help

Cancel |

Fig. 8.15 At this time we check just the fitted values and residuals. These will be
added as variables to the active dataset in R.
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3 Paste
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Insert...
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Fig. 8.16 We can see the dataframe as revised with the additional columns by
placing the cursor on an empty cell to the right of the existing cells and then right-
clicking Get Active DataFrame.
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a. Default formatting with unaligned decimal points.

E ookl xsx - B X
o, B T D E F < H I J ki

1 | y X b fitted.Regresidual s [Reghodel 1

2 1 -0.16 1 1 -0.16 -0.20582 0.045818

3 2 -0.80 2 2 -0.8 -0.00897 -0.79103

4 3 0.00 3 3 0 0.187879 -0.18788

El a4 0,60 a4 4 0.6 0.384727 0,215373

& 5 1.26 5 5 1.26 0.581576 0,778424]

7 [ 1.28 [ B 1.28 0.778424 0,501576

8 7 1.40 7 7 1.4 0.975273 0424727

&l 8 0.72 a 8 0.72 1.172121 -0.453212

10 9 1.04 8 g 1.04 1.26897 -0.32897|

11 10 1.26 10 10 1.26 1.56581% -0,20582 1

b. Aligned decimal points after right-clicking Prettyformat Numbers.
2] Bookl xsx - B X
& B C o 3 F G H | 1 kK i

1 % y b i fitted.Regresidual s, Rpghodel 1

@ 1 -0.16 1 1 -0.16 -0.20382 0.045818%

3 2 -0.80 2 2 -0.80 -0.008397 -0.7910303

4 g 0,00 3 3 0,00 0.,18788 -0,1878788

] 4 0,60 4 4 0.0 0.28473 0,2152727

(= 5 1.326 5 5 1.26  0.58158 0,7784242

T [ 1.28 [ B 1.28 0.77842 0.5015758

g T 1.40 T 7l 1.40 0.97527 0.4247273

9 g 0.72 g 8 0.72  1.17212 -0.4521212

10 9 1.04 9 9 1.04 1.36897 -0,3289697

11 10 1.26 10 10 1,26  1.56582 -0,2058182 -

Fig. 8.17 The dataset with the additional columns is displayed. Initially, it has
unaligned decimal points; therefore, we align them by right-clicking Prettyformat
Numbers. See Fig. 8.2 for a display of the right-click menu showing Prettyformat
Numbers.
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Fig. 8.18 We specify a scatterplot of the residuals variable residuals.RegModel.1

against the predictor x-variable.
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Fig. 8.19 This plot of the residuals against the x-variable shows no structure. If any
structure were visible, we would attempt to fit it with a more complex model. We
show such examples in the next few chapters.
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8.5 Confidence Bands and Prediction Bands

Once we have estimated a linear model, we need to use it.

We need to make statements about the location of the fitted line. These statements
take the form of confidence bands around the fitted line. The confidence bands pro-
vide an estimate of the expected mean value of ys for a given value of x and a given
confidence level.

We need to make predictions, based on the fitted straight line, of the y-values of
new observations for which we know the x-values. The prediction bands gives an
estimate of an interval which will contain observed values (not means) for a given
value of x and a given confidence level.

[afy = Microsoft Excel B

ol =
—/ Home Insert Page Layout Formulas Data Rewigini higani Dreweloper Add-Ins 7]

RExcel = R File = Data = Statistics = Graphs = [Madels '|Distr\butinns = Toals = Help =

Dataset: Book_1xlsx - Model: Reg Select active madel...

Summarize model

Menu Cammands Custom Add observation statistics to data,.
| F1 ~Q £y Canfidence intenvals... 2
‘ @ SOkl Hlew Best subsets regression.., (HH) ——
Confidence interval Plot..
1 .K A v = & B i Prediction Intervals... (HH] gIVIDIdEI.l 4 1 &
2 1 -0.16 1 Hypothesis tests L4
3 ] -0.80 ] Mumerical diagnostics L
4 2 0.00 3 Graphs L
] 4 0,60 4 4 0,60 0,38473 0.2152727
& 5 1.36 5 5] 138 0.58158 0.7784242
i 3 1.28 3 3 128 0.77842 0.5015738
a i 1.40 7 7 140 097527 0.4247273
9 8 0.72 8 g 0.72 117212 -0.4331212
10 3 1.04 3 2l 1.04 136897 -0.3283697
11 10 1.36 10 10 138 1,56582 -0.2058182 .
Ready | 1] [[EEE e 9 i)

Fig. 8.20 Use the Models » Confidence interval Plot... menu item to request the
dialog box in Fig. 8.21 and the display in Fig. 8.22 of the data and least-squares
regression line from the model of Figs. 8.10 and 8.13. Fig. 8.22 also shows the
confidence bands for estimating the regression line’s y-value for a specified x:

Kyl = E(y|x) = Po+Pix
and the prediction bands for predicting the y-values of new observations at specified
X:

Y= +e=Po+Pix+e.

The prediction bands are wider than the confidence bands because they include the
uncertainty € of the new observation.
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Confidence Intervals in Simple Linea... E“_ E|

Enter name for model: RegModel.2
Response variable (pick one) Explanatory variables (pick one)

itked RegMadel.1 itked.RegMadel. 1
siduals Regtodel. 1 esiduals.Regtodel, 1

Subset expression

<all valid cases>

I [s4 ] [ Cancel ] [ Help ]

Fig. 8.21 Dialog box for confidence intervals. In addition to drawing Fig. 8.22,
this dialog box recalculates the regression analysis and places it in model object
RegModel. 2.
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I R Graphics: Device 2 {ACTIVE) |Z”E|r$—_<|

File History Resize

95% confidence and prediction intervals for RegModel.2

observed *
fit E—
confint _—
pred int f—

Fig. 8.22 Data points (in blue) and least-squares regression line (in magenta) along
with the confidence bands (in green) for estimating the regression line’s y-value for
a specified x (this corresponds to predicting the mean of many observations with
this value of the independent variable):

Myl = E(y|x) = Bo+Pix
and the prediction bands (in red) for predicting the y-values of new observations at
x:

y |)C = Hy|x +e€
The prediction bands are wider than the confidence bands because they include the
uncertainty € of the new observation.
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The prediction and confidence intervals displayed in Fig. 8.22 are calculated with
formulas similar to the formulas for the hat diagonals to be introduced in Section
9.3.

Define

_ 8.1
fo1(xj—X)? @1

where xy is not necessarily one of the original x-values.
The confidence bands (in green) in Fig. 8.22 for estimating the regression line’s
y-value for a specified xg

Myl = E(Yx0) = Bo + Bixo
are given by
.ay|x0 :l:t%7n—2 sy ho = E(y|X()) it%7n—2 DAY, ho
= Bo+Bixo+ t2 n—2 8/ ho (8.2)

The prediction bands (in red) in Fig. 8.22 for predicting the y-values of new
observations at xy:

y|x0 = Uy|xy +e&
are given by

ﬁ\xo :tl%ﬂ_z s/ 1+hy = Bo—‘r[;le:tt%’n_g s/ 1+ hg (8.3)

Note in Fig. 8.22 that both sets of bands are farther from the regression line for
Xo points farther away from x than for points closer to .



Chapter 9
What Is Least Squares?

Abstract The linreg workbook distributed with this book allows us to explore linear
regression dynamically. We discuss the meaning of least squares, hat diagonals,
leverage, and residuals.

9.1 Minimizing the Sum of Squares

The linreg workbook [Heiberger and Neuwirth, 2008] (either 1inreg.xlsx in
Excel 2007 or 1inreg.x1s in Excel 2003) allows us to explore linear regression
dynamically.

This workbook uses the automatic recalculation mode of Excel to update the
R graph as numerical values or control tools are changed in the workbook. The
workbook directly accesses the same R function that the dialog box in Fig. 11.14
uses.

Fig. 9.2 shows artificial data (the same data we used in Fig. 8.2), the table of
coefficients, and the ANOVA table from a linear regression of that data. Fig. 9.3
shows the graph of the data along with the least-squares line, the predicted values,
and the residuals.

The arithmetic for calculation of the regression coefficients is displayed in region
E1:112. The residuals e; in column H are squared to ei2 and displayed in column L.
Their sum Ze[z is displayed in cell I12. This is the same number as is displayed in
the ANOVA table as the “Sum of Squares for Residuals” in cell N9.

R.M. Heiberger, E. Neuwirth, R Through Excel, Use R, 213
DOI 10.1007/978-1-4419-0052-4 .9,
© Springer Science+Business Media, LLC 2009
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RExcel~| | R File - Data-~
Close R
Run Code
Get R Value
Put R Var
Get R output
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Set R working dir
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Load R file

Copy Code E;

o Demo files for the book

ErrorLag R through Excel
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@  RExcel Help Linear Regression Linear Regression Workbook Documentationl
& RHzlp

Stop RCommander

Demo Worksheets

RthroughExcel Worksheets
R zbout RExcel

Normal and t normal and t Workbook Documentation |

Fig. 9.1 Open the normal.and.t.dist workbook by clicking on RExcel » RthroughEx-
cel Worksheets. This opens an Excel workbook BookFilesTOC with the names of the
workbooks for this book. Click on linreg to open the linreg workbook displaying cells
A1:Q25 as in Fig. 9.2 and an R graph reproducing Fig. 9.3. The full BookFilesTOC
is shown in Fig. 3.2. (If the RthroughExcel Worksheets menu item is missing, see
step 4 of Section A.3.3.) (If the values in the workbook don’t match the ones in the
figures, then click cell on A17 and choose the scenario R through Excel. Double-click
it to reset the workbook to the default values. See the illustration and discussion in
Section 9.4.)
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Fig. 9.2 Artificial data with x; and y; in columns E and F and a color name in col-
umn A. The y;-values in column F are controlled by the sliders in column C. The
table of regression coefficients is in region L1:P4 and the ANOVA table for the re-
gression is in region L6:Q10. The data is plotted in Fig. 9.3. The predicted values J;
are in column G and the residuals ¢; = (y; — J;) are in column H.

The term “least squares” means that the regression coefficients [30 in cell M3 and
Bl in cell M4 are the values that minimize the sum of squared differences between
the observed and predicted y-values. That is,

i1 ei2 =30 (i —)A’i)z =2 (i~ (Bo+ lei))2

is at its minimum value when By = ﬁo and f3; = Bl- The differences, labeled resid-
uals, are in column H, and the squared differences are in column I. The sum of
squared differences is in cell I12 and in the ANOVA table in cell N9.
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Fig. 9.3 Plot of artificial data in the spreadsheet of Fig. 9.2. Each observed point
(xi,y;) from columns E and F is plotted in the color specified in column A. The
least-squares line for this data is in black. Each predicted value ¥; is marked with a
small black dot on the least-squares line. Residuals are indicated with the vertical
lines e; = (y; —§;) at each value of x;.

Additional features on the graph are

1. Subtitle adjust the y values with the sliders. Reminder that this graph is directly
connected to the workbook in Fig. 9.2.

2. Bottom rug. The lengths at the tick marks are proportional to the squared residu-
als and their sum (cells 12:I11, 112).

3. The numerical value of the sum of squared residuals (cell 112) is displayed.

4. Gray box. The area is proportional (with a different factor) to the sum of squared
residuals (cell 112).

5. Top rug: leverage. The lengths are proportional (yet another proportionality fac-
tor) to the hat(x) values in cells J2:J11.
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Fig. 9.4 We can see that the least-squares line minimizes the sum of squared resid-
uals by looking at the individual squares in the sum. Click cell L19 to display the
squares of each residual. This click yields Fig. 9.5.
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Fig. 9.5 We click cell 19 to produce this figure, which is a repeat of Fig. 9.3 with
the residuals indicated by squares, each of whose side is the length of the residual
e; = (yi —¥i). The squares are visual squares; the number of inches used on the page
or screen for the horizontal side is the same as the number of inches used by the
vertical side ¢; = (y; — $).

You may construct a similar plot for your own data using the menu shown in
Figs. 11.14 and 11.15.
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Fig. 9.6 We click use alternate in cell C16 to produce Fig. 9.7. The least-squares
line in Fig. 9.5, based on the least-squares coefficients in cells M3:M4, is still visible
as a dashed gray line. The residuals and squared residuals shown here are distances
from the arbitrary line specified by the coefficients in cells C18:C19. The alternate
line goes through the alternate points y.alt in cells G15:G24. The alternate residuals
in cells H15:H24 are squared in 115:124. The sum of squares of the alternate residu-
als are shown in cell 125. The alternate sum of squares in cell 125 is always greater
than or equal to the residual sum of squares in cell I12.
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Fig. 9.7 The observed points, identical to those in Fig. 9.5, are plotted along with
the alternate line specified by the coefficients in cells C18:C19. The squares of the
alternate residuals are visibly bigger than the squares of the least-squares residuals
in Fig. 9.4. In this example, the alternate line has much larger squared residuals at
the larger values of x, and slightly smaller squared residuals at the smaller values of
x. This pair of plots works very well on a live screen, where it is possible to toggle
between them.
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Fig. 9.8 We can make a direct graphical comparison of the squares associated with
the two lines. Double-click the resid® value of the point at x = 7 in both the least-
squares and the alternate displays (cells I8 and 121). The cell values are now colored
the associated color in cell A8. The squared residuals from both lines are also now
colored the associated color in Fig. 9.9.
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Fig. 9.9 The squared residuals from both lines are now colored the associated color
in cell A8 in Fig. 9.8. In this example, we immediately see that the alternate squared
residual is larger than the least-squares squared residual for this point at x = 7. The
bottom red rugs are proportional to the squared alternate residuals in cells H15:24.
The alternate sum of squared residuals in cell I25 is shown on the graph both numer-
ically and as a red square that is always larger than the gray square for the residual
sum of squares calculated by least squares.
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9.2 Hat Diagonals and Leverage

We can adjust the sliders and see the least-squares line shift a lot for values of x; on
the extremes of the range of the x-values and shift not very much for intermediate
values of x;. In this example, in Fig. 9.2, both points 5 at (5, 1.36) and 10 at (10,
1.36) have the same y-value of 1.36. In Fig. 9.10, we first clicked reset Alt to LS in
cell C17 to set the alternate coefficients to match the least-squares coefficients.

Then, in Figs. 9.10 and 9.11, we change the y-value for point 5 to 0.36 and note
that the regression line has not moved very much. In Figs. 9.12 and 9.13, we change
the y-value for point 10 to 0.36 and note that the regression line has moved a lot to
follow the changed point.

We collect Figs. 9.5, 9.11, and 9.13 into Fig. 9.14 to make it easier to compare
them.

The amount of shift in J; for a unit shift in y; is called leverage and is given by
the hat value h; in cells J2:J11. For simple linear regression (one x-variable as in this
example), the leverage values are given by

1 ()Ci — )E)z
hi = . + = %7 ©.1)
The term “leverage” is used by analogy with physical levers. The farther away we
are from the center of the x-values, the more we can move the regression line with
the same change to the y-values.

We can approximate the calculation of the leverage from the observed changes.
The difference by which we make a small shift in y; is called Ay;. The amount by
which y; changes in response is called A¥;.

In this example, Fig. 9.11 shows

Aj;  0.54—0.58

=T 0
Ay 036136 10

and Fig. 9.13 shows

Ay 143-1.57

Ay 036-136 032

Compare these observed ratios to the hat values in column J (0.1030 and 0.3455).
The hat values are precise for infinitesimal shifts, as the amount of change Ay;
goes to 0. It is possible to show

AS: 99
lim 2= 2
Ayi—0 Ay;  dy;

i



224 9 What Is Least Squares?

=1
A B © Tor 2 G H 1 (Laiaals T M n o P a
1 rcolor sliders for y Xy v.hat resid resic®  hatfx) Regression Coefficients
2 red < | k3 1| -0.16 -0.33 0.17 0.0200) 0.3455 Estimate Std. Errar tvalue  Pri=|t])
3 purple a 0 > 2| -0.80 -0.13 -0.67 0.4487 0.2485  (Intercept) | -0.5360 0.2301 -1.8478 0.1018
4 green < | 3 3| 0.00 007 -0.07 0.0053 01758 x 0.2029  0.0458  4.3403 00025 =
5 gold < | B 4l 0.0 028 0.32 0.1052( 0.1273
6 orange < | ® 5| 036 048 -0.12 01030 ANOWAtable
7 deep pink < | > £ 1.28 0.68 0.60 0.3583( 0.1030 Df Sum S Mean Sq Fvalue Pri=F)
8 forest green < | > 7| 140 088 052 0.2658 01273 x 1 33967 3.3367 13.3378 0‘0025‘
3 brown < | > 8 0.72 109 -0.37 01343 0.1758  Residuals § 14435 01803
10 |salmon < | B 3| 1.04 129 -0.25 0.0625 0.2485  Total 9 48392
11 [blue < | & 10| 136 149 -0.13 0.0077 0.3455
12 1.4425
13
14 W v.alt  resaltres.alt”
15 1| -0.16 -0.21 0.05 0.0021 Residual
16 use alternate 2| -0.80 -0.0L -0.79 0.6257 display
17 recet Alt ko LS 3| 0.00 019 -0.19 0.0353 O rone
18 < [12-0.4027 4| D0.60 0.38 0.22 0.0463 @ line
19 < |i*)_ 01968 5| 0.36 0.58 -0.22 O square
20 6| 128 078 0.50 02516 ColorRestore
71 7| 140 098 0.42 01804
22 | [FGraph on Top| 8| 0.72 117 -0.45 0.2044
23 3| .04 1.37 -0.33 0.1082
24 10| 136 157 -0.21 0.0424
5 1.5455

M 4 » M| Sheetl

o

Fig. 9.10 Use the slider to change the y-value of point 5. The regression coefficients
in cells M3:M4 have shifted not very much from the values in Fig. 9.5 (and retained
here as the alternate values in cells C18:C19).
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Fig. 9.11 Moving the y-value of a point with an intermediate x, in this case x =5,
does not change the regression line very much. The residual for the new location of
the point at x = 5, y = 0.36 to the original line (red) is larger than that from the new
location to the new line (dashed gray). Neither residual is the same as in Fig. 9.5.
This figure is repeated in Fig. 9.14 for ease of comparison.
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Fig. 9.12 Use the sliders to return ys to its original value and to change the y-value
of point 10. The regression coefficients in cells M3:M4 have shifted a lot from the
values in Fig. 9.5 (and retained here as the alternate values in cells C18:C19).
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Fig. 9.13 Moving the y-value of a point with an extreme x, in this case x = 10,
changes the regression line a lot. The residual for the new location of the point at
x =10, y =0.36 to the original line (red) is larger than that from the new location
to the new line (dashed gray). Neither residual is the same as in Fig. 9.5. This figure
is repeated in Fig. 9.14 for ease of comparison.
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9 What Is Least Squares?

Fig. 9.13
ys = 1.36, y10 = 0.36

Abernase Line

y=—0.4027 +0.1968x

y=—0.5360+0.2029x

y=—0.2027+0.1423x

Fig. 9.14 Figs. 9.5,9.11, and 9.13 repeated, so we can easily compare their regres-
sion lines and the sizes of the squared residuals. The regression lines for the first
two panels, original data and with point 5 changed, are similar. The line for the third
panel, with point 10 changed, is different. In the right two panels, the original line is
shown as a solid red line and the the new lines are dashed gray lines. In the second
panel, the residuals of the new point from both lines are similar. Point x =5 is in
the center of the range of x-values. Therefore, changing its y-value does not have
a large effect on the line. In the third panel, the residual of the new point from the
original line is larger than from the new line. This is to be expected because the new
line follows the change in the y-value of point x = 10, which is on the extreme of

the x-values.
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9.3 Residuals and Leverage

R provides Basic diagnostic plots, a set of plots that help us interpret the results of the
regression analysis.

Close the linreg workbook and reopen a fresh copy of the linreg workbook. This
will restore the values in the cells to the values used in the figures here.

The workbook operates by automatically sending a dataframe xy.aov.total to R
every time the user changes a value with a slider, or changes a checkbox or button.
R then calculates, and stores in model xy.Im, the regression analysis on that revised
dataframe. In Fig. 9.15, the dataset xy.aov.total and the model xy.Im are shown as
the active dataset and active model. If they are not shown as the active dataset and
model, then use the dropdown boxes to set those values.

""Qg\'. [ - [al )+ Microsoft Excel
Home Insert Page Layout Formulas Data Review Wiew Developer Add-Ins
RExcel = R File ~ Data = Statistics ~ Graphs - Models = Distributions = Tools =~ Help ~
Dataset: |xy.aov.total hModel: [xy.lm
Menu Commands Custom Toolbars

Fig. 9.15 The active dataset is xy.aov.total and the active model is xy.Im.
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Fig. 9.16 Request the Basic diagnostic plots, a set of plots that help us interpret the
results of the regression analysis. The plots are displayed in Fig. 9.17. The plots are
more heavily used in multiple regression (more than one x-variable) than they are in
simple regression (one x-variable).
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Fig. 9.17 Basic diagnostic plots for the regression analysis in Figs. 8.10
and 8.13. These plots give visual feedback on the effectiveness of the model
vy 7 xin capturing the information in the data. The upper left plot Residuals vs Fit-
ted plots cells H2:H11 (resid = e) against cells G2:G11 (y.hat = y). A well-fitting
model will give a Residuals vs Fitted plot with no apparent pattern. The remaining
three plots in this figure are discussed in the body of this section. Three of the plots
show a smoothed curve for the points. See ?panel . smooth and ?1lowess for

details.
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Three of the four plots in Fig. 9.17 need further discussion. The Scale—Location
plot, the Normal Q—-Q (quantile—quantile) plot, and the Residuals vs Leverage plot use
the standardized residuals, which have identical variance under the null hypothesis.
The standardized residuals are given as

* €i
e = ———— 9.2
! sv 11— /’l,’ ( )
where the leverages h; are the hat values displayed in cells J2:J11 and calculated for
simple linear regression models by

1 ()Ci —)E)z
hi=—+or———=3 9.3
n j=1 (xj — %) O

For multiple regression (more than one x-variable), the hat values are calculated
as the diagonal entries of the hat matrix influence () Shat; see ?hat and
?influence.

The Scale—Location plot, also called the Spread—Location or S-L plot, in the lower
left panel of Fig. 9.17 takes the square root of the absolute residuals in order to
diminish skewness; (m is much less skewed than |e*| for Gaussian zero-mean
e).

The Q-Q plot shows the sorted standardized residuals e* against the theoreti-
cal quantiles g;, calculated as a set of values equidistant in probability under the
assumption of a standard normal distribution. See ?ggnorm and ?ppoints for
further details.

The Residuals vs Leverage plot, in the lower right panel of Fig. 9.17, shows the
standardized residuals ¢* against the leverage A; along with contours of Cook’s dis-
tance. Cook’s distance, a combined measure of the “unusualness” of a case’s pre-
dictors and response, is defined as

2

e; h;
D=1 ——
ps* (1 —hi)

9.4)

The contours of constant Cook’s distance c are calculated as /¢ p (1 — h;) /h;, where
p is the number of estimated regression coefficients (p = 2 for simple linear regres-
sion). By default, contours are plotted for the two c-values 0.5 and 1. Note on the
graph that the contour lines are closer to the O-residual horizontal line for higher
leverage values (corresponding to points farther away from ) than for lower lever-
age values.
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9.4 Reset the Workbook to the Values in the Text

We added two new features to the 1 inreg workbook after the screenshots for this
chapter were completed. We now have a Reset: cell that restores the workbook val-
ues to one of

1. the values illustrated in this chapter.
2. an example with uneven x-spacing.
3. an example with negative slope.

As a consequence, we changed the format of the x-values in column E to show one
digit after the decimal point. Fig. 9.4 shows the details.

2] linregErichRmhg xlsm - =5 X
A B G D| E E G H 1 1|k L M N o] P Q 'i
1 color sliders fory Xy y.hat resid resid®  hat(x) Regression Coefficients
2 red £ | 2 10 -0.16 -0.21 0.05 0.0021f 0.3455 Estimate Std. Error tvalue  Pr{>|t])
3 purple & 0 5 2.0/ -0.80 -0.01 -0.79 0.6257| 0.2485 (Intercept) | -0.4027  0.3502 -1.1498 0.2334‘
4 green 4 | & 3.0 0.00 0.19 -0.19 0.0353|0.1758 x 0.1968  0.0564 3.4878 0.0082
5 gold 4 | 3 40| 0.60 038 0.22 0.0463| 0.1273
6 orange 4 | & 50| 136 0.58 0.78 0.6059|0.1030 ANOVA table
7 deep pink < | 3 6.0, 1.28 0.78 0.50 0.2516(0.1030 Df SumSg  MeanSg Fvalue Pr(>F)
s forestgreen 4 | & 7.0 140 0.98 042 0.1804} 0.1273 x 1 3.1968 3.1968 12.1646 0.0032‘
9 brown 4 | & 8.0/ 072 117 -0.45 0.2044]0.1758  Residuals s 21024 0.2628
10 |salmon < | B 9.0/ 1.04 1.37 -0.33 0.1082(0.2485 Total 9 5.2992
11 blue < | 3| 100| 135 157 -0.21 0.0424] 0.3455
12 2.1024
13
14 X y y.alt res.alires.alt®
15 1.0 -0.16 -0.25 0.09 0.0090 Residual
_6_‘Reset: [Juse sltePrat= 2.0| -0.80 -0.11 -0.69 0.4807| display
(17 e 3.0/ 0.00 004 -0.04 0.0017 Onone
18 even . 40| 0.60 019 041 0.1686 @ line
19 | negative slope e dick b 50| 136 034 1.02 1.0458 Crsquare
% 6.0 128 049 0.79 0.6315 ColorRestore|
7.0 140 0.63 0.77 0.5878
8.0/ 072 0.78 -0.06 0.0038
23 9.0 104 093 011 0.0122
24 10.0| 136 1.08 0.28 0.0799
WoAs b Sheetl 7 AN : T T |

Fig. 9.18 The Reset: cell A17 has a dropdown list that restores the workbook values
to one of three scenarios. The default scenario even spacing is the one used in the
examples in this chapter. We also show an example with uneven x-spacing and an
example with negative slope.



Chapter 10
Multiple Regression—Two X -Variables

Abstract Multiple regression by least squares is the natural generalization of simple
linear regression to data with more than one explanatory variable.

10.1 The Multiple Regression Model

Multiple regression is similar to simple linear regression, but with more than one
explanatory variable. In this chapter, we look at exactly two x-variables. In Chapter
12 we will look at more than two x-variables.

The model assumptions are the natural generalization of the assumptions for sim-
ple linear regression. We assume that the mean value of ys for a given set of vari-
ables, x1,...,x¢ (k=2 in this chapter) depends linearly on the values of xi,...,x;.
When k = 1 (Chapter 8), that was interpreted as a straight line in a graph of y vs
x. In this chapter, with k = 2, that is interpreted as a plane in a three-dimensional
graph of y in the vertical direction vs x; and x; defining a base plane. We show a
picture of this situation in Fig. 10.7. In Chapter 12, with £ > 3, we interpret it as
a hyperplane in k+ 1 dimensions and can’t draw a simple graph. Instead, we use a
scatterplot matrix (introduced in Fig. 2.23) to show the relation of all possible pairs
of variables and many diagnostic plots.

The multiple regression model also assumes, as does the simple linear regression
model, that the standard deviation of the y-values at each xi,...,x; is independent
of the value of the x; variables. That is, the variability of the y data around the mean
hyperplane is independent of the x;.

In simple linear regression in Chapter 8, we assumed a straight-line model

yi = Bo+Pixi+&
& ~ N(0,07%)

for data consisting of a response variable y and a single predictor variable x. We fit
the model with the least-squares estimates

R.M. Heiberger, E. Neuwirth, R Through Excel, Use R, 235
DOI 10.1007/978-1-4419-0052-4_10,
© Springer Science+Business Media, LLC 2009
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B = X(xi = X)(i—Y)

(x;—X)?
Bo=7-PBix
$i = Bo+Buxi
2= 2()’1'_)7)2
n—2

In this chapter, with two x-variables, we fit a plane model

yi = Po+Bixi + Poxio + &
& ~ N(0,0?%)

to observed data with one response variable y and two explanatory variables x; and
x». We fit the model with the least squares-estimates

Bo
Bl = solve linear equations with your computer program
B2

$i = Bo+ Brxin + Paxic

2= Z(yi *)7)2

Cn—(2+1)
We will usually first graph the data and then use the Remdr

Statistics » Fit Models » Linear regression ...

menu item to access the R 1m function.

10.2 Example

[Davies and Goldsmith, 1972], reprinted in [Hand et al., 1994], investigated the re-
lationship between the abrasion loss of samples of rubber (in grams per hour)
as a function of hardness and tensile strength (kg/cm?). Higher values of
hardness indicate harder rubber. The dataset appears in the file

hh("datasets/abrasion.dat").

1. Produce a scatterplot matrix of this dataset. Based on this plot, does it appear that
strength would be helpful in explaining abrasion?

2. Produce a three-dimensional plot of the data.

Calculate the fitted regression equation.

4. Find a 95% prediction interval for the abrasion for a new rubber sample having
hardness 60 and strength 200.

b
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R Commander

Seript Window

le (hh("datasets/abrasion.dat™), header=TRUE)

Fig. 10.1 Read the abrasion data by entering the line

abrasion <- read.table(hh("datasets/abrasion.dat"),
header=TRUE)

into the Rcmdr Script Window and clicking | ,

IE_! He-o~-E Bookl - Microsoft Excel - =
L | =
=~ Home Tnsert Page Layout Formulas Data Review View Developer | Adddns | @ - & X
RExcel = |R‘ File = Data = Statistics = Graphs * Models = Distributions * Tools = Help =

Dataset: | Mo active datal - | Model

Menu Commands| | Custom Toolbars

H =9 (- &l )T Bookl - Microsoft Excel - B

Home Insert Page Layout Formulas Data Review View Developer | Add-Ins @ - 2 X

RExcel ~ R File -~ Data - Statistics - Graphs ~ Models = Distributions ~ Tools = Help -
Dataset: ctive da‘ta‘hameF Modet

abrasion |

Menu Commands Custom Toolbars

Fig. 10.2 Make abrasion the Remdr active dataset with two steps. Click the blue R
on the RExcel Remdr menu to let the menu know that we have added a dataframe to
R by means other than using the menu. Then click on the Dataset dropdown menu
and make abrasion the active dataset. Making abrasion the active dataset places its
variable names into all the Rcmdr dialog boxes.
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- /)7 Bookl - Microsoft Excel - B X

Insert Page Layout Formulas Data Review View Developer | Add-Ins @ - 7 X

‘ RExcel ~ R File -~ Data - Statistics - Graphs ~ Models = Distributions ~ Tools = Help -

Get Adtive DataFrame |

Dataset: |abrasion Maodek |MNo active mode
|MenuC Custam Toolbars 3 |
I:— Calibi ~11 ~|A" A" § - % » F
¥

L B 7 My - A - =0 .00 ] |
A LG £ F G H i s

1

5 R RuninRemadr
E 3 | R BunR
i Get R Value
== Put R Var
1 B ]

?,

Get R DataFrame

Fig. 10.3 Bring abrasion into a new Excel worksheet from the context menu.
Place the cursor on cell A1 and then right-click Get Active DataFrame.
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|- -GS

Microsoft Excel

Formulas Data Review View Developer

R File = Data - Statistics ~ | Graphs =| Models ~ Distributions = Tools = Help =

Home Insert Page Layout
RExcel =
Dataset: abrasion | M
Menu Commands
| abrasion -2 = ‘
] Book1
s | 8 | ¢ | o
i abrasion hardness streng
| 2 | 1 372 45
3 2 206 55
4 | 3 175 61
o 4 154 66
6 | 5 136 71
7 6 112 71
8 T 55 81
3 3 45 a6
10 L n 53
b 10 166 60
12 11 164 64
13 12 113 68
13 82 79
5| w o» o=
4 4 » M| Sheetl , Sheet2 - Sheet3
. Ready | ﬂ Averag|

Color palette...
Index plot...

Histogram...

Add-Ins

Stem-and-leaf display...

Boxplot...
Quantile-comparison plot...
Seatterplot...

Scatterplot matrix...

Line graph...

XY conditioning plot...

Strip chart...

Quantile-comparison plot with test...

Scatterplot matrix... (HH)

XY conditioning plot... (HH)

Dotplot with stacked multiple hits... (HH]
Scatterplot.HH... (HH)

Squared Residuals... (HH)

3D graph 3

Save graph to file 3

Boxplots

SWME [
HW-SE 'Y '

Least-squares lines v

Smocth lines r
On Diagonal

Density plots
Histograms

One-dimensional scatterplots
Mormal QG plots

Mothing {empty)

Diagonal Direction

Subset expression

<all valid cases =
Flot by groups. .. |

O0O000®

®
@]

[ o

] [ Cancel ] [ Help ]

Fig. 10.4 Plot the data with the Graphs » Scatterplot... (HH) menu item. The menu

brings up the dialog box. Highlight all three variable names and click OK.
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Fig. 10.5 This figure shows all the two-variable plots of these three variables in the
off-diagonal panels of the scatterplot matrix plus a marginal density plot for each
single variable along the main diagonal. The response variable abrasion is in the
bottom row. We can see a tight downhill trend in the abrasion ~ hardness
panel, and a weaker downhill trend in the abrasion ~ strength panel. We
also need to look at the three-variable plot in Fig. 10.7.
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- -G Microsoft Excel - = X
Home Insert Page Layout Formulas Data Review View Developer Add-Ins '@
RExcel R File = Data ~ Statistics ~ [Graphs | Models ~ Distributions ~ Tools = Help =
Dataset: abrasion | M| Color palette...
Index plot...
Menu Commands Histogram...
| abrasion - (@& S \ Stem-and-leaf display...
of Boxplot...
& Bookl onpio i~ it
i Quantile-comparison plot...
| A | B | c | D L ! J K
L= - Seatterpiot.. 1 1 1
1 abrasion hardness streng LAETRR
2 1 277 as Scatterplot matrix...
scatterplot matrix... (HH)
11 10 166 60
12 11 164 64
13 12 113 58 ¥¥ conditioning plot... (HH)
14 13 82 79 Dotplot with stacked multiple hits... (HH}
15 14 32 81 Scatterplot.HH... (HH}
4 4 » ¥ Sheetl Sheet? “Sheet3 7§ squared Residuals... (HH} il
Ready | 5 Averag 3D graph ] 3D scatterplot..,
Save graph to file »
3D scatterplot... (HH}

JD Scatterplot
Rezponse varisble [pick one]  Explanatary varisbles [pick hwa)

hardness
strength

|dentify observations
with mouse

Show surface gid lines v
Open neve 30 graphics window |

Surfaces to Fit

Linear least-squares ¥ coef multiple = ’1EI—
Quadratic least-squares -

Smoath regression r df = ’m
Additive regression [ difeach tem)] = ’m

Background Color

Black
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Residuals Dizplay
Line -
Square  (*

Plat by groups
(1] I Cancel | Help |

Fig. 10.6 The Graphs » 3D Graph » 3D scatterplot. .. (HH) menu item brings up the
dialog box.
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10 Multiple Regression—Two X -Variables

Fig. 10.7 Dynamic 3D plot specified in Fig. 10.6. The top panel is the opening po-
sition. The bottom panel is after rotation by the mouse. The user can rotate the figure
in any direction. The estimated plane through the points is the natural extension of a
straight line in two dimensions to the analogous geometry in three dimensions. The
vertical lines connecting the points to the plane are the residuals. The squares of
each residual are shown. The least-squares fit produces the plane that has the small-

est sum of squares of the residuals of any plane. See Section 9.1 for the illustration
of this concept in two dimensions.
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10.3 Specify and Fit Several Linear Models

When there is more than one potential predictor variable for the response variable,
we don’t know which, if any, will give the best fit to the data. In this section, we fit
several different models and compare them. The abrasion dataset has two potential
predictor variables: hardness and strength. We will look at three models, with each
of the variables alone and with both variables.

In Section 10.4, we show graphical comparisons of the three models. In Section
10.5, we show tabular comparisons of the three models.

Framl s IRl O Bookl - Microsoft Excel TR
—’) Home  Insert Page layout  Formulas Data  Review  View Developer | AddIns | @) - = X

RExcel ~ R File =~ Data - [Statistics ={ Graphs ~ Models =~ Distributions ~ Tools = Help =

Dataset: | at Summaries L |
Contingency tables  »
Menu Commands Means (3 |
abrasion - Propartions >
A B (e Variances Ll 13 G H 1 J K Ii
1 abrasion hardne MNaonparametric tests  »
2 1 372 Dimensional analysis ¥
3 2 206 Fit models 4 Linear regression..
4 2 175 ox Z32] :
Linear model...
5 4 154 66 231
Generalized linear model...
6 3 136 71 231
7 6 112 71 237
8 7 5l 81 224

Fig. 10.8 Specification of linear regression. All three models we will look at— the
two one-x models in Figs. 10.12 and 10.10 and the two-x model in Fig. 10.14—begin
with the Statistics » Fit models » Linear regression. .. menu.
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Linear Regression E“: g|

Enter name for model: | Reatlodel. 1
Response vanable (pick one) Explanatary vaniables (pick one or more)

abrasion
hardness
strength shrength
Subset expression

<all walid cases>
0K I Cancel | Help |

Fig. 10.9 Dialog box for the model abrasion ~ hardness. In this figure, we
have highlighted the response variable abrasion and the single explanatory variable

hardness. Clicking OK generates Fig. 10.10.

R Commander.

Script Windaw

abrasion <- read.table (hhi"datasets/sbrasion.dat”), header=TRUE)
SCatTerplot.matrix (~sbrasiont+hardness+strength, reg.line=lm, swooth=FALSE, span=
RegModel.l <- Ilm(abrasion~hardness, dats=abrasion)

summary (RegModel. 1)

<

D_utput window Suhmrtl ‘

> summary [(Fegliodel. 1)

Call:
lm(formala = abrasion ~ hardness, data = abrasion

Fesiduals:
Hin 12 Median 30 Hax
-G6.15 —-46.77 -19.49 54.2Z7 111.4%9

Coefficients:
Estimate Std. Error t© wvalue Frix|tl|)

(Intercept) 550.4151 65,7867 §.367 4.2Ze-09 *F%
hardness -5.3368 0.92z% -5.782 3.i9e-06 **%
Signif. codes: 0O '#FF' 0,001 ‘% 0,01 ‘% 0,05 ', 0.1 01

Residual standard error: 60,52 on 2§ degrees of freedom
Nultiple RE-3quared: 0.544Z, Adjusted R-sgquared: 0.5279
F-gtatistic: 33.43 on 1 and 25 DF, p-value: 3.Z5%4e-06

Messages

1=

Fig. 10.10 Summary for model abrasion ~ hardness specified in Fig. 10.9.

The residual standard error is 60 and the R2 is 0.544.
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Linear Regression E“: g|

Enter name for model: | Reatlodel 2
Response vanable (pick one) Explanatary vaniables (pick one or more)

abrasion
hardness hardress
strength
Subset expression

<all walid cases>
0K I Cancel | Help |

Fig. 10.11 A second use of the menu in Fig. 10.8 gives us the dialog box. This time
we fill it out for the model abrasion ~ strength.

R Commander,

Script window

shrasion <- read.table (hh{"datasets/abrasion.dat"), header=TRUE
goatterplot.matrix (~abrasionthardness+strength, reg.line=lm, swooth=FAL3SE, span=
BeglModel.l <- lm(sbrasion~hardness, data=sbrasion

surnary (RegModel. 1)

BeglModel.2 <- lm(sbrasion~strength, data=sbrasion

surnary (RegModel . 2)

£

Dutput Window Submit] ‘

> swmmary (Reglodel.2) A
Call:

lm (forwula = abrasion ~ strength, data = asbrasion

Fesiduals:
Min hie] Nedian 30 Hax
-155.640 -59.919 2.795 61.221 183.285

Coefficients:
Estimate Std. Error t wvalue Pris|t|

(Intercept) 305.2248 78,9962 3.815 0.000685 **%
strength -0.7192 0.4347 -1.654 0.109232
Signif. codes: 0O '#¥%! 0,001 '*%*' 0,01 '*"° 0,05 '.' 0.1 1

Bezidual standard error: 85.56 on 28 degrees of freedom
Multiple B-Sguared: 0.089204, Adjusted R-sguared: 0.0565
F-ztatistic: 2.737 on 1 and 28 DF, p-values: 0,1092 =

%

Meszages

4]

Fig. 10.12 Summary for model abrasion ~ strength. The residual standard
error is 85 and the R” is 0.089. The single variable hardness in Fig. 10.10 is a
much better predictor of abrasion than the single variable strength.
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Linear Regression E“: g|

Enter name for model: | Reatlodel. 3
Response vanable (pick one) Explanatary vaniables (pick one or more)

abrasion
hardness
strength
Subset expression

<all walid cases>
ok | conea | Hep |

Fig. 10.13 A third use of the menu in Fig. 10.8 gives us the dialog box. This time
we fill it out for the model abrasion ~ hardness + strength.

R Commander,

Script window

sbrasion <- read.table (hh{"datasets/abrasion.dat"), header=TRUE)]

goatterplot.matrix (~abrasionthardness+strength, reg.line=lm, swooth=FAL3SE, span=

BeglModel.1l <- lm(sbrasion~hardness, data=sbrasion)

surnary (RegModel. 1)

RBegModel.2 <- lm(sbrasion~strength, data=sbrasion)

surnary (RegModel . 2)

BeglModel.3 <- lm(sbrasion~hardness+strength, data=sbrasion)

surnary (RegModel . 3)

< >

Output Windaw ‘M ‘

> swmmary (Reglodel.3) A

Call:

lm(forwula = abrasion ~ hardness 4+ strength, data = abrasion)

Fesiduals:

Min 10 Median 30 Hax
-79.385 -14,608 3.816 19,755 £5.981
Coefficients:
Estimate Std. Error t wvalue Pris=|t|)

[{Intercept) 885.1611 61.7516 14.334 3.54e-14 ***

hardness -6.5703 0.5832 -11.267 1.03e-11 ***

strength -1.3743 0.1943 -7.073 1.3Ze-07 **%

Signif. codes: 0O '*¥*! Q0,001 '**' 0,01 '*" 0,058 '.' 0.1 1

Bezidual standard error: 36.49 on 27 degrees of freedom

Multiple B-Sguared: 0.85402, Adjusted R-sguared: 0.5254 =

F-ztatistic: 71 on 2 and 27 DF, p-valus: 1.767e-11 v

Meszages
A
v

Fig. 10.14 Summary for model abrasion ~ hardness + strength. The
residual standard error is lowered to 36 and the R? is increased to 0.840. The
variables hardness and strength together are a much better predictor of
abrasion than either variable alone.
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10.4 Graphical Comparison of Models

In this section, we study the residuals and fitted values for the three regression mod-
els we have looked at for the abrasion data. We calculate and plot the residuals and
fitted values for each model here. In Section 10.5, we compare the models numeri-
cally with the analysis of variance table.

a. Specify model.

RExcel = R File = Data = Statistics = Graphs = Models ~ Distributions = Tools ~ Help ~

Dataset: |a Model: RegModel3 H
RegModell
Menu Commands cuf RegModel.2 )
= = RegModel3 i
abrasion > Q I | RS
b. Models » Add observation statistics to data. ..
[ B R s Bookl - Microsoft Excel - =X

Home Insert Page Layout Formulas Data Review  View Developer Addins | @) - = X

RExcel = R File = Data = Statistics = Graphs = [Models =| Distributions ~ Tools * Help =

Dataset: |al Model: Reg Select active model...
summarize model
Menu Commands : : Custom Add observation statistics to data... )
abrasion - I | Confidence intervals..,
A B iz D H Best subsets regression... (HH) 1 J K
A abrasion hardness strength . Confidence interval Plot.. | . .
i il 372 45 162 Prediction Intervals... HH)
3 2 206 55 233 Hypothesis tests L3
.4. 3 175 61 232 MNumerical diagnostics L3
b 4 154 66 231 Graphs '
6 5 136 1 231

c. Specify fitted values and residuals.

Add Observation Statistics to Data E”f E|

Fitted values v
FResiduals v
Studertized residuals [
Hat-values r
Cook's distances r

Observation indices |

0K I Cancel | Help |

Fig. 10.15 We need to plot the fitted values and residuals from each of the models
we have looked at. We do these steps three times, once for each model.

a. Specify the active model for Remdr. The dropdown box for Model in the Rcmdr
menu bar shows all models defined in this session.

b. As in Fig. 8.14, we calculate the fitted values and residuals for the active model
with the Models » Add observation statistics to data... menu item.

c. Check the Fitted Values and Residuals boxes, and leave the other boxes unchecked.
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o =9 [&l | = Bookl - Microsoft Excel
- Home Insert Page Layout Formulas Data Review View Developer Add-Ins
RExcel ~ R File -~ Data - Statistics = Graphs ~ Models = Distributions ~ Tools = Help =

Dataset: |abrasion Model RegModell *
Menu Commands Custom Toolbars
= v f-| Calibri =11 ~ A A" 8 ~% » F
, 5 L €0 .00 B

| A B c D E B . @ é. b
L abrasion hardness strength I i
2 1 372 45 162 Run in Remdr
3 2 206 55 233 R Runr
4 3 175 61 232 Get R Value
5 4 154 66 231 Put R Var
6 5 136 71 231 Get Active DataFrame
7 e 112 71 237 Get R DataFrame

Fig. 10.16 In Fig. 10.15, we added the fitted values and residuals for the three
models to the dataframe in R. Now we bring the revised dataframe back to Excel.
Place the cursor on row 1, one column beyond the end of the existing data (in this
example, the data is in columns A:D, so we place the cursor in column F). Get the
revised active dataset, now containing the sets of predicted values and residuals, one
set for each of the three models we have looked at, into the Excel worksheet with
the right-click Get Active DataFrame menu. This produces Fig. 10.17.
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G H 1 1 K L M N |Calibri - |11 - AT AT § - % 2 F
1 |abrasion hardness strength fitted.Regresiduals. fitted.Regresiduals. fitted.l g 7 - Iy - A -8 B E
2 372 a5 162 366.8353 5.164742 188.7145 183.2855 310.2702 BL72976] T
3 206 55 233 203.5508 2.449176 137.6514 68.34858 zss.gjn e
4 175 61 232 165.5002 949584 138.3706 36.62938 248 b | pnp
5 154 66 231 134.0203 19.97968 139.0898 14.91018 198.2 et R Value
6 136 71 231 101.1662 34.83383 139.0898 -3.08982 17L5
7 112 71 237 92,9203 19.0797 134.7746 -22.7746 17L5 IR
8 55 81 224 45.07805 9.921946 144.1242 -89.1242 118.1 Get Adtive DataFrame
9 45 %6 219 19.09546 25.90454 147.7202 -102.72 91.47 SRPHETELR
10 221 53 203 257.9218 -36.9218 159.2274 6177262 267.5 Put R DataFrame
11 166 60 189 231.1664 -65.1664 169.2962 -3.29617 230.2 Remdr Get 4
12 164 64 210 176.0225 -12.0225 154.193 9.807008 208.8 Get R Qutput
13 113 68 210 149.7392 -36.7392 154.193 -41.193 187.5 Name Range
14 82 79 196 96.70044 -14.7004 164.2618 -82.2618 128.8 P T Er TR REED
15 32 81 180 105.5478 -73.5478 175.769 -143.769 118.1% Pretiyformat Numbers
16 228 56 200 242.3323 -14.2323 161.385 66.61502 251.5¢ , | .

Fig. 10.17 The revised abrasion dataset, now containing fitted values and residuals
for all three models, is shown here. The columns of residuals and fitted values are
not well formatted—the decimal points are not aligned. We highlight all the new
columns and format them with the right-click Prettyformat Numbers... menu to get
Fig. 10.18.

G H | ] K L [\l N (0] P Q
1 |abrasion hardness strength residuals. fitted.Reg residuals. fitted.Reg residuals.RegModel.1
2 372 45 162 366.835 5.1647 188.715 183.285 310.270 61.730
3 2008 55 233 203.551 2.4452  137.651 68.349 250.905 -50.905
4 175 61 232 165.500 9.4958 138.371 36.629 224.885 -49.885
5 154 66 231  134.020 19.9797 135.090 14.910 198.203  -44.203
] 136 71 231 101.166 34.8338 1359.090 -3.090 171.520 -35.520
7 112 71 237 92.920 15.0797 134.775 -22.775 171.520 -59.520

Fig. 10.18 Now the columns are aligned, hence legible. The default names for the
columns of fitted values and residuals are truncated in the cells in the display of row
1 of the worksheet. The full names are visible in the formula bar.
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10.4.1 Plot Residuals ~ Fitted

We will plot the residuals against the fitted values for each of the three models we
have viewed in Figs. 10.10, 10.12, and 10.14.

Scatterplot.HH E”: @

x-wariable (pick one) y-variable (pick one)
brasion  hardness A

ithed RegMadel.2 — fresiduals.RegMade!, 2
itted RegModel. 3 + [residuals. RegModel. 3

Identify points I
Jitter x-variable [
Jitker y-variable |
Marginal boxplots [
Least-squares line [V
Smooth Line r

50
Span For smooth I

Subset expression

<all valid cases>
Plot by groups... I

w-axis label w-axis label
<auto> <auto>

Plotting Parameters
Plotting characters |<auto>
2.0

Point size I

1.3
Axis btext size
Axis-labels text size 1.3
l OK ] [ Cancel ] [ Help ]

Fig. 10.19 The scatterplot dialog box is specified on the Graphs » Scatter-
plot.HH...(HH) menu. We will plot the residuals against the fitted values for each
of the three models we have viewed in Figs. 10.10, 10.12, and 10.14. In this il-
lustration, we have highlighted the x-variable fitted.RegModel.1 and the y-variable
residuals.RegModel.1. All three individual graphs are displayed in Fig. 10.20. The
graphs are shown very small; therefore, we made the dots much larger than normal
by adjusting the slider to increase the Point size to 2.0.
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abrasion ~ hardness, s = 60,R> = 0.544

abrasion ~ strength,s= 85,R2 =0.089

ey

" " .

ey

Fig. 10.20 Plots of the residuals against the fitted values for each of the three mod-
els in Figs. 10.10, 10.12, and 10.14. The graphs of the models are hard to compare,

as each has a different set of x- and y-limits. We therefore repeat these plots with a
common scaling in Figs. 10.21 and 10.31.



252

10.4.2 Rescale Plots for Ease of Comparison

abrasion ~ hardness, s = 60,R> = 0.544

abrasion ~ strength,s= 85,R2 =0.089

abrasion "~ hardness + strength,s= 367R2 =0.840

= .
.
o . . -
. . . , .
P A .
. .
. .

Fig. 10.21 Repeats, with common scaling, of the plots of the residuals against the
fitted values for each of the three models in Figs. 10.12, 10.10, and 10.14. As s
decreases, we see that the residuals have a smaller and smaller vertical range. As R?
increases, we see that the fitted values have a wider and wider horizontal range as

they do a better job of approximating the observed response values. The commands
we used to control the scaling are illustrated in Fig. 10.22.

10 Multiple Regression—Two X-Variables
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scatterplot (residuals.RegModel.3 " fitted.RegModel.3, reg.line=1m,
smooth=FALSE, labels=FALSE, boxplots=FALSE, span=0.5, cex=1.3,
cex.axis=1.3,
cex.lab=1.3, pch=16, data=abrasion)

scatterplot (residuals.RegModel.3 " fitted.RegModel.3, reg.line=1lm,
smooth=FALSE, labels=FALSE, boxplots=FALSE, span=0.5, cex=1.3,
cex.axis=1.3,
cex.lab=1.3, pch=16, data=abrasion,
xlim=c(0,350), ylim=c(-200,200))

R Commander
Script Window

seatterplot (residuals.RegModel . 3~fitted. RegModel.3, reg.line=lm,
swooth=FALZE, labels=FALSE, boxplots=FALSE, span=0.5, cex=2, cex.axis=1.3,
cex.lab=1.3, pch=16, data=abrasion]

line=1lm,

, ce

Oukput Windaw Suhmitl

Fig. 10.22 The three plots in Fig. 10.20 were plotted with commands similar to the
first command shown here for model RegModel.3. These commands were generated
directly by Remdr from repeated use of the dialog box in Fig. 10.19. The three plots
in Fig. 10.21 were plotted by editing those commands and submitting them. We
show the editing for RegModel.3. We copied the command generated by Rcmdr and
edited it by adding the last line specifying wider x- and y-limits for the plot. The val-
ues here were chosen by looking at the three graphs in Fig. 10.20 and selecting new
limits that covered the range of all three graphs. We manually specified the x1im
and y1lim arguments to force all three on the same scale. The common scaling is
specified by adding the two arguments

x1lim=c(0,350), ylim=c(-200,200)

to the generated commands. The top panel shows the original and edited commands.
In the bottom panel, we highlighted the entire four-line edited command and sub-
mitted it to Remdr by clicking the lswmiq button.
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10.4.3 Lattice Plots with Coordinated Scales

There is another way to get all three plots scaled alike by using the Graphs » XY
conditioning Plot... (HH) menu item and dialog box. This menu and dialog box use
R’s Lattice package to coordinate the scaling of all panels with a single call. This
dialog box requires stacking the fitted and residuals columns from all models and
distinguishing the three models with a new factor named model. The stacked data is
shown in Fig. 10.23.

In Section 10.4.4, we construct the stacked columns in Fig. 10.23 with the RExcel
right-click Paste as Stacked menu item. Column T contains the group labels. The
column labels in Fig. 10.18, generated by the Models » Add observation statistics to
data... menu item in Fig. 10.15, include the model name RegModel.n. Here, we have
stacked all three fitted.RegModel.n columns into a single column fitted and all three
residuals.RegModel.n columns into a single column residuals. The numerical names
n (selected from 1, 2, 3 here) are arbitrary. It is much more informative to use the
model formula as the label, and we have done so in column T.

& Bookl xlsx - = X
| s T U v w B
1 |m0de| |fitted .residuals .
2 abrasion ™ hardness 310.27 61.73
3 abrasion ™ hardness 256.905 -50.905
4| abrasion ™ hardness 224.885 -49.885
30 abrasion ™ hardness 118.154  96.846
31 abrasion ™ hardness 91.472  56.528
32 | abrasion ™ strength 188.715 183.285 4
33 abrasion ™ strength 137.651  68.349 1
60 | abrasion ™ strength 208.852 6.148
61 | abrasion ™ strength 213.887 -65.887
62 abrasion ™ hardness +strength  366.835  5.1647
63 . abrasion ™ hardness + strength  203.551 2.4492
90 abrasion ™ hardness + strength  168.766 46.2339
91 abrasion ™ hardness +strength  145.532  2.4679
92
4 4 > M| Sheetl  Sheet2  ‘Sheet3 . ¥J {I

Fig. 10.23 Here we show the entire stacked dataset containing the fitted values and
residuals from the three models shown in Fig. 10.18. In this figure, we show the first
few and last few observations for each model. The remaining rows were hidden by
highlighting the Excel row numbers and using the right-click hide menu item.
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10.4.4 Stacking with the Right-Click Menu

Here we show how to use the RExcel right-click Paste as Stacked menu item to
create the columns illustrated in Fig. 10.23 from the three sets of residuals and fitted
values in Fig. 10.18.

2] Book1 xlsx Calibri =11 - A" 47 % - % o+ F - = X
1 K L B 7 S Al % Q R
1 |fitted.Regresiduals. fitted.Reg residuals. fitted.Reg residualsRegModel.3 models
2 | 310270  61.730 188.715 R Run code in Remdr abrasion ™ hardness
3 256.905 -50.905 137.651 R Run code abrasion ™~ strength |
4 | 224.885 -49.885 138.371 Get R Value abrasion ™ hardness + strength|
5| 198.203 44203 139.090  pugpy,
6 171.520 -35.520 139.090 Get Adtive DataFrame
7 171.520 -59.520 134.775
3 118.154 -63.1534 144.124 e
9 | 91472 -46472 147.720 TR Dats
10| 267.578 -46.578 159.227 EonaiCEt >
11| 230.222 -64.222  169.296 CelROGpUY
12| 208.876 -44.876 154.193 Insert Current R Plot
13 187.530 -74.530 154.193 Mame Range
14| 128.827 -46.827 164.262 Prettyformat Numbers
15| 118.154 -86.154 175.769 % ocut
W 4+ W] Sheetl ~ Sheet? . She| E———
Ready E ~y -

Fig. 10.24 We show two steps here. In cells R1:R4, we write the three model for-
mulas for later use in Fig. 10.26. We begin with Fig. 10.18 and highlight the six
columns in cells J1:031 and right-click Copy.
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N el Microsoft Excel - = X
Tl =
» Home Insert Page Layout Formulas Data Review | View Developer Add-Ins L]
I_j 0 = L_é _ {_F’_, 35 New Window [ | 11 | = % iq|
| 13 } —%‘] = Arrange Al = 1 H =a
Mormal| Page Show/Hide | Zoom 100% Zoom to - Save Switch Macros
Layout = - Selection Freeze Panes = (] | 14 | warkspace Windows = -
Waorkbook Views Zoom Window Macros
| T - £ &
= Galibri ~{11 ~ A" A" § v % v F
2] Bookl xisx |
A B I S i S}
o
1 _;rreslduals}iegl\.ﬂodelj models R Fun code in Remar
2! 51647 abrasion ™ hardness
! y R Bun code
3 2.4492: abrasion ™~ strength b
' & alue
4 ! 9.4998; abrasion ™ hardness + strength o
51 19.9797) S
6 i 34 8338: Get Active DataFrame
i ] . 1)
7 | 19.0797 Get R DataFrame
' \
8! 99n9 Put R DataFrame
9 1 2590451 Remalr Get »
10} -36.9218, Get R Qutput
' '
11 ! -65.1664 Insert Current R Plat
& Y
- ! 12'0225: Mame Range
i ! _36'?392: Prettyformat Numbers
14! -14.7004;
' " Paste as Stacked
15, -73.5478:
W 4+ W[ Sheetl /Sheet?  Sheet3 /%J [ =
Select destination and press ENTER or choose Paste H 5| Copy y

Mumber of Yariables

-

o |

Fig. 10.25 We move the cursor to cell T1 and right-click Paste as Stacked to get
the dialog box shown here. The dialog box opens with Number of Variables at 1 and
Group names from worksheet grayed out. In this example, there are two columns in
each of the groups, so we move to Fig. 10.26 to make that change in the dialog box.
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|@_Q'?'P-@ 3 N
=

Home Insert Page Layout Formulas Data Review \ View | Developer Add-Ins @
EIE S QLI D 22 S

) Iaj - E Arrange All | (i

Normal| Page __ |Show/Hide | Zoom 100% Zoomto - Save Switch Macros
Layout 3 - Selection Freeze Panes = (] | 414 | workspace Windows = -

Workbook Views || Zoom Window Macros |
| R2 * Quus fol
féﬂEookl‘xlsx =
| 4 a | R Lo JOSES v | v | w | X

1] egModel.3 models I I

2 ‘abrasion ™ hardness N

il ! —— 1
| 3 | :abrasmn strength H Paste as Stacked r§|
el \sbrasion ” hardness # strength | o
5] Number of Yarishles 2 =
-

i

L= ¥ Group names From workshest

10 I Sheet11$REZ R4 =

2z 5 e

13 Ancel

L

15

M 4 » M| Sheetl  Shest? . Sheetd ¥J £

\ Point | S | ‘

Fig. 10.26 We click the up arrow in the spinner to change the number of variables
to 2 and to ungray the Group names from worksheet checkbox. Check the checkbox,
and the entry box for the group names appears. With the mouse, select the model
names that we previously placed in cells R2:R4 and click OK to get Fig. 10.27.
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a. Default column names from Paste as Stacked.

i Bookd xlsx e
-~ R - | s e v | v | ow [ x

al _hegModelB models roup fitted.Regresiduals.RegModel.1

3| abrasion ~ hardness abrasion™  310.27 61.73

3| abrasion ™ strength abrasion™ 256.905 -50.905

a abrasion ™ hardness + strength abrasion™ 224.885 -49.885

5 abrasion™ 198.203 -44.203

| abrasion™  171.52 -35.52

| abrasion™  171.52 -59.52

8| abrasion” 118.154 -63.154

2] abrasion™ 91472 -46.472

10 abrasion™ 267.578 -46.578
11 abrasion™ 230.222 -54.222

12| abrasion™ 208.876 -44.876
13| abrasion™  187.53  -74.53

14 abrasion™ 128.827 -46.827

15 abrasion™ 118.154 -86.154

W 4+ M| Sheetl - Sheet? - Sheet3 .~ ¥J

Ready | 5 |

b. More appropriate column names and column widths.

& Book xlsx g =i
¥ R s T u | w ’_\ w X

1 !models model fitted IresiduaIE

56 | abrasion ™ strength 189.434 151.566

57| abrasion ~ strength 200.222 139.778

58 | abrasion ™ strength 198.783 84.217

59 | abrasion ™ strength 201.66 65.34

60 abrasion ™ strength 208.852 6.148

61 | abrasion ~ strength 213.887 -65.887

62 | abrasion ™~ hardness + strength 366.835  5.1647

63 | abrasion ™~ hardness + strength 203.551 2.4432

64 | abrasion ™~ hardness + strength 165.5 9.4998

65 abrasion ™ hardness + strength 134.02 19.9797

66 abrasion ™~ hardness + strength ~ 101.166  34.8333

67 | abrasion ™ hardness + strength 92.92 19.0797

68 | abrasion ™~ hardness + strength 45.078 9.9219

69 | abrasion ~ hardness + strength 19.095 25.9045

4 4 + M| Sheetl Sheet? - Sheet3 %1 & "

et | & |

Fig. 10.27 The three columns created in Panel a have default names and default
widths. To get to Panel b, we type more appropriate names in cells T1:V1 and change
the width of column T by placing the cursor in the row names between T and U and
double-clicking.
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Put dataframe in R g|
Dataframe name in R
| abrasionFitResidLong
et from Cell |
kl_ with rownames
v make active in Rcommander
cance |
2 Bookl xlsx = x
A s I, u v ow
1 models model fitted residuals
80 | abrasion ™ hardness + strength 143.385 -79.385
81 abrasion ™ hardness + strength ~ 276.218  -27.218|
82 | abrasion ~ hardness + strength ~ 211.111  7.8889
83 | abrasion ™~ hardness + strength 132.733  53.2667
84 | abrasion ~ hardness + strength 138.832 16.168|
85 | abrasion ™ hardness + strength 124.445 -10.4453
86 | abrasion ™ hardness + strength 328.785 12.2154
87 abrasion ™ hardness + strength ~ 296.833  43.1674
88 | abrasion ~ hardness + strength ~ 254.659  28.341
89 | abrasion ~ hardness + strength ~ 201.019  65.9812]
90 | abrasion ~ hardness + strength 168.766 46.2339
9| abrasion ™ hardness + strength 145.532 2.4679
92|
8|
44+ b | Sheetl /“Sheetd .~ Sheet3 /¥J
Ready S | Average: 67.71665556 Count: 273 Sum: 15788.995 “ B

Fig. 10.28 We are now ready to put the stacked data into R. Highlight cells T1:v891
and right-click Put R DataFrame (not shown here) to get the dialog box. Choose the
name abrasionFitResidLong and click OK. The appearance of the worksheet is the
same (except for hiding the rows) as in Fig. 10.23. One more step is needed to make
the graph in Fig. 10.31 correct. Factor levels are, by default, ordered alphabetically,
which is usually not the right order. In this case, the alphabetical order of the models

1S

abrasion
abrasion
abrasion

hardness
hardness + strength
strength

‘We need to match the ordering:
abrasion "~ hardness

abrasion

strength

abrasion ~ hardness + strength
(top to bottom) of Fig. 10.31.
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RExcel =
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a. Reorder factor levels menu item.

R rile 'EData ~|Statistics ~ Graphs ~ Models ~ Distributions ~ Tools ~ Help ~

Dataset: |5

Menu Commands

MNew data set...

Load data set...

Impaort data 3
Data in packages »
Active data set L3N |

Manage variables in active data set »

b. Variable selection dialog box.

Reorder Factor Levels E| j.FZI

Factor (pick one)

Name for Factor
<same as original >

Make ordered factor [v

M N

Recode variables...

Compute new variable...

Add observation numbers to data set

Standardize variables...

Convert numeric variables to factors...

Bin numeric variable...

Reorder factor levels...

Define contrasts for a factor...

Rename variables...

Delete variables from data set ..,

c. Order specification dialog box.

Old Levels
abrasion ~ hardness

abrasion ~ hardness + strength n

abrasion ~ strength

Reorder Levels E| i.g|

Mew order

2

|

l OK Cancel

]

J |

[ o

Cancel

J

Fig. 10.29 We use the Rcmdr menu item for reordering factor levels. In Panel a,
click Data » Manage variables in active data set » Reorder factor levels. ... This gives
the Reorder Factor Levels dialog box in Panel b. When we take the default <same as
original>, we get the warning message that we are about to overwrite the variable.
In this example, overwriting is OK. Click Yes to accept overwriting. In Panel c, we
specify the new order. Lattice panels are ordered from bottom to top, so we specify
the bottom level abrasion ~ hardness + strength as number 1. We are
now ready for the graph specification in Fig. 10.30.
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10.4.5 Menu and Dialog Box for Lattice Plot

XY Conditioning Plot 9[=3

Explanatory variables (pick one or mare) Response variables (pick one or more)

itted
esiduals

Conditions '|' {pick zero or mare) Groups ‘groups="{pick zero or more)
odel ______| ode!

Options

Automatically draw key 2

Different panels for different v~ combinations |
Plot Type {one or both)

Points [

Lines [

¥-fixis Scales in Different Panels ¥-Axis Scales in Different Panels
Identical ® Identical ®

Free QO Free O

Same range O Same range O

Layout

number of columns: |1
number of rows: d

I OK I [ Cancel ] [ Help ]

Fig. 10.30 We continue from Fig. 10.29. Specify model as the conditioning factor.
Specify one column and three rows for the layout of the figures. The default value,
Identical, for the axis scales forces the common scaling.
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I~ R Graphics: Device 2 (ACTIVE)
File Histary Resize

|
abrasion ~ hardness
- * . -
IDD » .. * - *
. * *
i . * L
D . * * - *
* .0 '.'00. Lo
-100 * =
abrasion ~ strength
*
'.
- =100
% :0 c"
ﬁ — :.0.0" -0
w *
@ ‘e
*
. $t e, - 100
* .
abrasion ~ hardness + strength
100 4 B
*
* o .. ¢ .« * .
0 * + ”. .9 ” * *r
. **
. o *
-100 -

Fig. 10.31 We narrowed the Graphics window by grabbing its left side and pulling
it toward the right to improve the aspect ratio. The strip label identifies the model
in each panel. The strip labels are automatically generated from the levels of the
conditioning factor.

Compare the three panels in this figure, specified with a single dialog box in Fig.
10.29, to the similar content and scaling in the three panels in Fig. 10.21 that were
individually specified as described in Fig. 10.22.
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The display of a regression analysis usually includes an ANOVA (analysis of vari-
ance) table. The sequential ANOVA table (each line includes the additional sum of
squares from its term, after accounting for all preceding terms) is specified by the
ANOVA table (Type | Sums of Squares) menu.

' 0\ T Bookl - Microsoft Excel eSO
—) Haome Insert Page Layout Formulas Data Review View Developer AddIns | @ - = X
RExcel R File -~ Data ~ Statistics = Graphs ~ |[Models '|D\strlbutlons ~ Tools = Help ~
Dat or Model Reg Select active model..,
Summarize model
Menu Commands Custam Add observation statistics to data...
Ald - £ ‘ 13 Confidence intervals..,
A B & D B Best subsets regression.., (HH) | J KB
1 abrasion hardness strength Confidence interval Plot... ength fitted.Reg residu:
2 ald JT2 45 162 Prediction Intervals... (HH] 162 366.835 5.1¢
3 2 206 35 233 Hypothesis tests ANOVA table
4 3 175 61 232 Numerical diagnostics Compare two models...
5 4 154 66 231
= z e = a1 Graphs Linear hypothesis..,
7 5 112 71 237 5 112 71 ANOVA table (Type II Sums of Squares)
3 7 55 81 224 7 55 81 ANOVA table (Type 1 Sums of Squares)

Fig. 10.32 Specify the sequential ANOVA table from the menu.

Output ‘wWindow

Submit] |

> anova (RegModel.3)
Analysis of Variance Table

F wvalue

Response: abrasion

Df Zwum Sg Mean Sg
hardness 1 122455 122455
strength 1 66607 sG607
Residuals 27 35950 1331
Signif. codes: 0 '#*#**%! 0,001 '**!

Pr (>F)

91.970 3.458e-10 #**%
S0.025 1.325e-07 #%%

o.o01 '

o.os 'Lt

o.1 v 1

Fig. 10.33 The total sum of squares is partitioned into three components. The
hardness term accounts for 122,455, the strength term explains an additional
66,607, and the Residuals the remainder (residual) 35,950. The total sum of
squares is not displayed in this figure. We calculate the total sum of squares in Fig.

10.34.
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R [T A Bookl - Microsoft Excel - = X
Insert Page Layout Formulas Data Review View Developer | Add-Ins l@ - m X
RExcel ~ R File -~ Data - [Statistics =| Graphs ~ Models = Distributions ~ Tools = Help =
Dataset: |ab Summaries b Active data set
Contingency tables  » Numerical summaries...
Menu Commands Means »
Ald hl - Proportions 4 Count missing observations
| A | B c Variances 13 3 7 ctatist ] K
A abrasion hardne Monparametric tests  » Cotrelatin matiie. fitted.Reg residug
2 1 372 Dimensional analysis » Correlationtests 12 366.835 5.1
< 2 2o Fit models Lg Shapiro-Wilk test of normality... Bt 2
4 3 175 T 232 ¥ T UL z32 165.500 9.4¢
Numerical Summaries | ||ﬁ g|

Wariables [pick one or more)

abiasion

fitted. Reghodel 1

fitted. Reghodel 2

fitted Reghadel 3

Mean v

Standard Deviation

Quantiles ¥ quantiles: |0,.25,5,.75,1

Summarize by groups.... |

| 0K I Cancel | Help |

> numdwmanary (sbrasion[, "abrasion™] . statistics=c("mean®”™, "=d", "guantiles"™))

mean =d 0% Z5% 50% 75% 100% n
175.4333 58.08526 32 113.25 165 Z20.5 372 30

> ZO0%EE.08526%2
[1] 225011.4

> 122455 + 66607 + 35950 W
[1] 225012

|<

Fig. 10.34 The total sum of squares is identical to the sum of the squared mean-

centered differences ¥;(y; —)*> = (n—1) sg. We use the numerical summaries menu
and dialog box to get the summary. The last line shows the summation of the sums
of squares in Table 10.33. The last two lines were manually entered into the Remdr

script window.

> 29%88.085262

[1] 225011.4

> 122455 + 66607 + 3590
[1] 192652



10.6 Confidence Intervals and Prediction Intervals 265

10.6 Confidence Intervals and Prediction Intervals

Fig. 10.7 shows the least-squares regression plane constructed from the observed
values of y = abrasion fit to the observed predictor variables x; = hardness and
X, = strength. We are usually interested in estimating the y location on the regres-
sion plane for any specified values of the xi- and x;-variables. There is a population
mean [, of y

:uy\x = E(y|x) = BO + B1x1 + ﬁ2x2

that we cannot know. We find a point estimate of this value as
Sl = Bo+ Brxi + Paxa

The blue plane in Fig. 10.7 shows the set of point estimates for all values of x; and
X2.

In simple linear regression, we calculated confidence intervals for estimating the
population fy, at each value of the x-variables with Equation (8.2). We also calcu-
lated prediction intervals for predicting the y-value corresponding to new observa-
tions of the x-values with Equation (8.3). We can do the same for multiple regres-
sion.

We calculate a confidence interval for the mean abrasion of a very large sample
of rubber having a common value of hardness and strength with the formula for
estimating the confidence interval of a population mean f,,

Sxtte, 35 vVh (10.1)

where 4 is defined in Equation (10.3). Equation (10.1) is the analog of Equation
(8.2). The calculation is specified by the first interval in Fig. 10.36 using the Models
» Prediction Intervals. .. (HH) menu with the confidence interval for mean box checked.

We calculate a prediction interval for the abrasion for one sample of rubber with
a specific value of both hardness and strength

ylx= Myx +€
using the formula for the prediction interval for a new observation
§|xit%.n_3svl+h (10.2)

Equation (10.2) is the analog of Equation (8.3). The calculation is specified by the
second interval in Fig. 10.36 using the Models » Prediction Intervals. .. (HH) menu
with the prediction interval for individual box checked. The prediction intervals are
wider than the confidence intervals because they include the uncertainty € of the
new observation.

For simple linear regression, we gave the formula for / in Equation (8.1). For
multiple regression, the h-value is usually calculated by software using an analogous
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matrix equation
h=x(X'X)"'¥ (10.3)

where the vector x for the new point is defined by x = (1 x; x2) and the matrix
X = (1 X; X3) consists of three columns: 1 is the column of all ones, X is the
column of x;; for the n original observations, and X; is the column of x;; for the n
original observations.

Enter X data for new observations E| i‘g|

MNumber of Rows: i 1

Models ~| Distributions = Tools = Help ~ | - o
nter X values:

Select active model... hiardriess: shength
Summarize model |1 50 200
Add observation statistics to data... Prediction Interval

point estimate only o

Confidence intervals...

Best subsets regression... (HH) confidence interval for mean

prediction interval for individual

Confidence Level .95

Standard Eror |
Hypothesis tests »

Numerical diagnostics 3 0K I Cancel | Help |
Graphs »
Enter X data for new observations E| i‘g|

Number of Rows: i 1

Enter ¥ values:

Confidence interval Plot...

Prediction Intervals... (HH)

hardness strength
1 60 20d
Prediction Interval

point estimate only o
confidence interval for mean

prediction interval for individual

Confidence Level .95

Standard Emor [

0K I Cancel | Help I

Fig. 10.35 The confidence interval and prediction interval for new observations
are calculated by the Models » Prediction Intervals. .. (HH) menu and its dialog box.
Two specifications of the dialog box are shown here. The first shows the confidence
interval specification and the second shows the prediction interval specification. The
printed output for the two dialog boxes is in Fig. 10.36.
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> .NewData <- data.frame (hardness=60, strength=200, row.names="1")

> .NewData # Newdata
hardness strength
1 60 200

> predict (RegModel.l, newdata=.NewData, interval="confidence",
+ level=.95, se.fit=FALSE)

fit lwr upr
1 216.0490 197.5783 234.5196

> .NewData <- data.frame (hardness=60, strength=200, row.names="1")

> .NewData # Newdata
hardness strength
1 60 200

> predict (RegModel.l, newdata=.NewData, interval="prediction",
+ level=.95, se.fit=FALSE)

fit lwr upr
1 216.0490 138.9343 293.1636

Fig. 10.36 The confidence interval and prediction interval for a new observation as
specified by the two dialog boxes in Fig. 10.35. The table here was taken from the
Rcmdr Output Window.



Chapter 11
Polynomial Regression

Abstract If the relationship between a response variable Y and an explanatory vari-
able X is believed to be nonlinear, it is sometimes possible to model the relationship
by adding an X?-term to the model in addition to an X-term. For example, if Y is
product demand and X is advertising expenditure on the product, an analyst might
feel that beyond some value of X, there is “diminishing marginal returns” on this
expenditure. Then the analyst would model ¥ as a function of X and X2, and possi-
bly other predictor variables, and anticipate a significant negative coefficient for X2.
Occasionally a need is encountered for higher-order polynomial terms.

11.1 Regression on a Quadratic Function of X

Our example illustrates use of the quadratic model
y=Po+Bix+pox’ +¢ (11.1)

which can be fit with the same procedures as multiple regression.

We use as our example the hardness data (from [Heiberger and Holland, 2004]
and from [Hand et al., 1994], original reference [Williams, 1959]). In this sec-
tion, we investigate the modeling of ¥ = hardness as a quadratic function of
X =density.

Hardness of wood is more difficult to measure than density. Modeling hardness
in terms of density is therefore desirable. This dataset comes from a sample of Aus-
tralian Janka timbers. In Fig. 11.1, we show the result of fitting both linear and
quadratic model to this data.

R.M. Heiberger, E. Neuwirth, R Through Excel, Use R, 269
DOI 10.1007/978-1-4419-0052-4_11,
© Springer Science+Business Media, LLC 2009
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Fig. 11.1 The linear model y :ﬁo + élx is fit to the hardness data in the top panel.
The quadratic model y = f3y + Bix + Brx? is fit to the hardness data in the bottom
panel. We can see that the quadratic model fits the points more closely than the
linear model. We see it both in terms of closeness of the fitted line to the observed
points and in terms of the sizes of the squared residuals. Refer back to Section 9.1
for a discussion of the display of squared residuals. We show the dialog boxes that
generate these graphs in Fig. 11.14.
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Let us now build up to the display in Fig. 11.1. Read the data by entering

hardness <- read.table(hh("datasets/hardness.dat"),
header=TRUE)

in the Remdr Script Window and then click the Submit button. Bring the data into
Excel by clicking the blue R icon to make Remdr aware of the dataframe, and then
right-click Get Active DataFrame to get Fig. 11.2. See Fig. 10.2 for a screenshot of
the blue R icon. Note the density column on the left side of Fig. 11.2 does not
have aligned decimal points, making it very difficult for a reader to make visual
comparisons of numbers in the same column. We need to format the density
column uniformly with the right-click Prettyformat Numbers menu item, in this case
to always show one digit after the decimal point. The properly formatted data is
shown on the right side of Fig. 11.2.

(Do) 9 - ™ -l )3 (o) d e O Book2
. y Home Insert Page Layout For - _-_3 Home Insert Page Layout Formulas
RExcel ~ R File = Data = Statistics ~ Gri RExcel ~ R File ~ Data = S5tatistics = Graphs = My
Dataset: hardness ~ Mode Dataset: hardness * Model: |No acti
Menu Commands ( ||| Menu Commands Custom To
hardness ~ @ 5| | hardness - £ |
J A B C D A B C D | E
Al density hardness il density hardness
2 1 24.7 484 2 1 24.7 434
3 2 248 427 3 2 24.8 427
4 = 27.3 413 4 3 27.3 413
5 4 28.4 517 5 4 28.4 517
6 5 28.4 549 6 o 28.4 549
7 6 29 648 7 6 29.0 643
8 7 30.3 587 8 7 30.3 587
9 8 32.7 704 9 8 32.7 704
10 9 35.6 979 10 9 35.6 979
11 10 38.5 914 11 10 38.5 914
12 11 38.8 1070 12 11 38.8 1070
13 12 39.3 1020 13 12 393 1020
8] 13 w4 120l 18] 13 394 aze]
4 4 » M| Sheetl ~Sheet? ~Sheet3 . ¥J (| M 4 » M| Sheetl ~Sheet2 ~Sheet3 ~¥J &
Ready ﬂ Average: 511.2351 | Ready ﬂ Average: 511 ¢

Fig. 11.2 The hardness data is brought into Excel with right-click Get Active
DataFrame. Note the density column on the left side of the figure does not have
aligned decimal points. We formatted the density column to one digit after the
decimal point by right-clicking Prettyformat Numbers. We show the properly format-
ted data on the right side of the figure.
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Fig. 11.3 We plot the data starting with Recmdr Graphs » Scatterplot.HH. .. (HH) to
get the dialog box shown here, where we specify the x- (predictor) and y- (response)
variables. [The Scatterplot.HH. .. (HH) menu is based on Scatterplot menu, but uses
different defaults. It uses plotting character 16 for solid dots and increase the labels
to size 1.3. The only option checked by default is the Least-squares line.]
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Fig. 11.4 The scatterplot shows most of the points on both ends of the density
range to be above the least-squares line and a greater proportion of points in the
center of the density range to be below the least-squares line. This is the first
indicator that a straight-line fit will not be sufficient and that a quadratic fit may be
needed.
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11.2 Linear Fit

Linear Regression
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Fig. 11.5 We specified the linear regression with the Rcmdr Statistics » Fit models
» Linear regression... menu item to get the dialog box shown here. We specify the
single-x regression and get the summary table displayed in Fig. 11.6.
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Script Window

hardness <- read.tablehh("datasets/hardness.dat™), header=TRUE)

RegModel.4 <- lmihardness~density, data=hardness)
summary (RegModel. 4)

<
Output ‘wWindow

scatterplot (hardness~density, reg.line=lm, smooth=FAL3E, lakhels=FAL3E, boxplots=

> sumnary (RegModel. 4)

Call:
lmiformula = hardness ~ density, data = hardness)

Residuals:
Min 12 Hedian 30 Hax
-338.40 -96.95 -15.71 92.71 6Z5.06

Coefficients:
Estimate 3td. Error t walue Pri>|t]
(Intercept) -1160.500 105.580 -10.69 2.07e-12 #*#*+*
density 57.507 Z.279 25.24 <« Ze-1g *#*¥
Signif. codes: 0 '#*¥%%' Q0,001 '+*' Q.01 '+*' oO.,05 ‘.t o0.1 ' 1

Residual standard error: 183.1 on 34 degrees of freedom

Multiple R-Squared: 0.9493, Adjusted R-sguared: 0.9475
F-statistic: 5637 on 1 and 34 DF, p-wvalue: < 2.Ze-16
Meszages

54|

Fig. 11.6 The straight-line model has a p-value of p =2 x 107'% and a residual

standard error s = 183.1.
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Fig. 11.7 We add the residuals and fitted values of the regression model
RegModel . 4 to the dataset hardness with the Rcmmdr Models » Add observation

statistics to data...

menu. We then use the Remdr Graphs » Scatterplot.HH. .. (HH)

menu to get the dialog box shown here. This dialog box specifies the plot of

residuals

density that we show in Fig. 11.8.
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Fig. 11.8 Compare this residual plot to the data plot in Fig. 11.3. We see much more
clearly now that there the residuals show quadratic behavior when plotted against
the x = density variable. Most of the points on the left and right of the plot are
above the x-axis. Most of the points in the center of the plot are below the x-axis.
We must model the quadratic behavior and test whether it is large enough to keep in

the model.
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11.3 Quadratic Fit

/ - ER R Book2 - Microsoft Excel - =
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Fig. 11.9 In order to specify the quadratic term, we must use a new menu item. We
specify the Linear model... menu item to give the dialog box in Fig. 11.10.
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Linear Model
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Fig. 11.10 The linear model dialog box allows the right-hand side of the linear
model specification to be a complicated function of one or more predictor vari-
ables. We are using the quadratic model specification hardness ~ density
+ I(density”2). (There are several other formulations that would also work.)
We find it easier to enter the model by typing rather than by clicking the variables’
names and function buttons.
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R Commander.

Script Window

hardness <- read.tablehh("datasets/hardness.dat™), header=TRUE)

scatterplot (hardness~density, reg.line=lm, smooth=FAL3E, lakhels=FAL3E, boxplots=

RegModel.4 <- lmihardness~density, data=hardness)

summary (RegModel. 4)

hardness§fitted.RegModel.4 <- fitted|(RegModel.4)

hardnessiresiduals.RegModel. 4 <- residuals (RegModel. 4)

scatterplot (residuals.RegModel. 4~density, reg.line=lm, smooth=FAL3E, labels=FAL3

LinearModel.5 <— lm{hardness ~ density + I{density"2), data=hardness)

summary (LinearModel. 5)

£ >

Output YWindaw M |

> summary (LinearModel.5) L

Call:

lmiformula = hardness ~ density + I(density*Z), data = hardness)

Residuals:

Min 12 Hedian 30 Hax
-326.63 -51.35 -15.27 59.87 537.82
Coefficients:
Estimate 3td. Error t walue Pri>|t]

[Intercept) -115.0074 334.9669 -0.352 0.72686

density 9.4340 14.9356 0.6832 0.53197

I{density"Z) 0.5091 0.1567 3.245 0.002Z67 **

Signif. codes: 0 '#*¥%%' Q0,001 '+*' Q.01 '+*' oO.,05 ‘.t o0.1 ' 1

Residual standard error: 161.7 on 33 degrees of freedom

Multiple R-Squared: 0.9616, Adjusted R-squared: 0.9593

F-statistic: 413.2 on 2 and 33 DF, p-wvalue: < 2.2Ze-16 ¥

Meszages
A
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Fig. 11.11 The quadratic model has a smaller standard error s = 161.7, compared
to the value s = 183.1 for the linear model in Fig. 11.6. The p-value for the addi-
tional term x> = I(density"2) is significant at p = 0.00267. We also note that the
marginal test for the coefficient for x = density is not significant. The marginal test
means the additional effect of the linear coefficient after the quadratic coefficient is
included. A better test is the sequential test shown in the sequential ANOVA table
in Figs. 11.12 and 11.13. In the sequential test of the quadratic term, we assume
the linear term and test whether the inclusion of an additional quadratic term im-
proves the fit. We will almost always retain the linear term in the model whenever
the quadratic term is significant, even when the marginal test of the linear effect is
not significant. The geometry of quadratic functions also argues for keeping the lin-
ear term. A quadratic function without a linear term y = a + cx? is symmetric around
the origin. Such symmetry is unlikely in most data situations.



11.3 Quadratic Fit 281

- - fEh )+ Book2 - Microsoft Excel il 3
Home Insert Page Layout Formulas Data Review View Developer Add-lg-l @ - X
RExcel ~ R File ~ Data = Statistics > Graphs ~ [Models = | Distributions = Tools = Help ~
Dataset: hardness - | Madel: Ling Select active model...
Summarize model
|(MEnt Commands £ Htos) Add observation statistics to data..
hardness - (_‘ Je | Confidence intervals...
A ‘ B | . | D ‘ B Best subsets regression... (HH)

2] density  hardness fitted.Regresid Confidence interval Plot...
4 1 24.7 484  259.92 224 Prediction Intervals... (HH)
= 2 248 427  265.67 16 Hypothesis tests > ANOVA table
i 3 7.3 413 403.43 Mumerical diagnostics ¥ Compare twao models...

5 4 284 517 47269 44
e Graphs L Linear hypothesis...

6 5 284 549  472.69 @ Tt
'?_ 6 29.0 648 507.19 140.806 ANOVA table (Type I Sums of Squares)
8 7 30.3 587 581.95 5.047 I AMNOVA table (Type I Sums of Squares) |l
E 8 32.7 704  719.97 -15.969
10 9 35.6 979  886.74  92.262|
| 10 385 914 1053.51 -139.507|
42 11 388 1070 1070.76 -0.759|
13| 12 2003 1020 1099.51 -79.513

14 15 394 1210 1105.26 104.737|

W 4 b b | Sheetl ~Sheet? ~'Sheetd ~#1 £ !

Ready | 73 | Average: 601  Count: 184  Sum: 108114 | =2

Fig. 11.12 We specify the sequential analysis of variance (ANOVA) table with the
Models » Hypothesis tests » ANOVA table (Type | Sums of Squares) menu item.
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Seript window

scatterplot (hardness~density, reg.line=lm, smooth=FALSE, labels=FALSE, hoxplots=
RegModel.4 <- lmihardness~density, data=hardness)

surmmary (RegModel. 4)

hardness$fitted.RegModel. 4 <- fitted(RegModel.4)

hardnessiresiduals.Reglodel. 4 <- residuals(RegModel.4)

scatterplot (residuals.Reglodel. 4~density, reg.line=lm, swooth=FAL3E, labels=FiL3
LinearModel.5 <- lmi{hardness ~ density + I{density*2), data=hardness)

summary (LinearModel. 5)

anova (LinearModel. 3)

e
< >
Output Yindow M |
Iidensity*2) 0.5091 0.1567 3.245 0.00267 *%* 5
Signif. codes: 0O '#*#**' Q0,001 '#**' Q0,01 '*" Q.05 ', o001 1
Residual standard error: 161.7 on 33 degrees of freedom
Multiple R-Sguared: 0.9616, Adjusted B-zscuared: 0.9593
F-statistic: 413.2 on 2 and 33 DF, p-wvalue: < 2.Ze-16
> anova(LinearModel.5)

Analysis of Variance Table
Response: hardness

Df  Sum Sg Mean Sog F ovalue Pr (»F)
density 1 21345674 21345674 515.923 < Z.Ze-16 *#*%
Iidensity*2) 1 276041 276041 10.552 0.002689 *%*
Residuals 33 S63325 Z6161
Signif. codes: 0O '#*#**!' Q0,001 '#**' Q0,01 '*" Q.05 ', o001 1

v
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Fig. 11.13 In the sequential ANOVA table, we see that x = density is significant.
In addition, the increment to the sum of squares explained by the model from the
quadratic term x> = I(density"2) is also significant. We must therefore keep both
terms.
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11.4 Plot of Squared Residuals
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Fig. 11.14 We specify the display of squared residuals with the Graphs » Squared
Residuals. .. (HH) menu item and its dialog box. Two dialog boxes are shown here.
On the top, we accept the default simple linear regression seen on the top in Fig.
11.15. On the bottom, we specify the active model, in this case LinearModel . 5,
which holds the quadratic fit, seen on the bottom in Fig. 11.15.
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Fig. 11.15 This is a repeat, in context, of the display in Fig. 11.1. On the top, we
show the squared residuals from the linear model in Fig. 11.6. On the bottom, we
show the squared residuals from the quadratic model in Fig. 11.11. The quadratic
model fits the points more closely than the linear model. We see it both in terms of
closeness of the fitted line to the observed points and in terms of the sizes of the
squared residuals. An additional virtue of the quadratic model is that its intercept
term differs insignificantly from zero (p = 0.726 from Fig. 11.11); this is not true of
the straight-line model for these data (p = 2 x 10~ !? for the intercept in Fig. 11.6).
(If wood has zero hardness, it certainly has zero density.)



Chapter 12

Multiple Regression—Three or More
X-Variables

Abstract Multiple regression is often the method of choice for analysis of datasets

that have many potential predictor variables. In this chapter, we illustrate the ba-

sic techniques of fitting a model with three or more x-variables and some of the

techniques for testing the quality of the fit and for viewing the data and the fit.
Multiple regression with more than one x-variable fits the model

yi = Bo+Bixi + Poxio+ ...+ Bpxip + &
g ~ N(O,Gz)

to observed data consisting of one response variable y and p explanatory variables
X1,X1,X2,...,Xp. We fit the model with the least-squares estimates

Bo
B
BZ = solve linear equations with your computer program
By
$i = Bo+ Bixit + Poxio + ...+ Bpxip
2= >(yi _)7)2
n—(p+1)

As in Chapter 10, we will usually first graph the data and then use the Remdr
Statistics » Fit Models » Linear regression ... menu item to access the R 1m function.

R.M. Heiberger, E. Neuwirth, R Through Excel, Use R, 285
DOI 10.1007/978-1-4419-0052-4_12,
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12.1 Shoe Sizes of Austrian Students

The dataset StudentData [Neuwirth, 2008] consists of measurements on 1,126
Austrian undergraduates over the past 10 years. We will look at several variables that
will help us investigate shoe sizes: Sizes are heights in cm. Size is the student’s
height, while SizeFather and SizeMother are the heights of the student’s
father and mother. Weight is in kg. Shoesize is European sizes. Gender has
the values male and female.
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Fig. 12.1 The data is included as one of the Excel workbooks on the RExcel »
RthroughExcel Worksheets menu. Click the Student Data button to get Fig. 12.2. Click
the Student Data Workbook Documentation button to see the description of the vari-
ables in this dataset.
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/ ™ R e O StudentData.xlsm - Microsoft Excel - = x
Home Insert Page Layout Formulas Data Review View Developer | Adddns | @ - o x
| RExcel ~ R File = Data - Statistics = Graphs ~ Models = Distributions = Toals = Help ~
Dataset | No active data Modek |No active mode
| Menu Commands Custom Toalbars
| A2 @ K | male
oA ] 8 | € [ D E £ G H ‘ o K L
1 Gender Weight Size Eyes Hair Shoesize Mathgrad GermangiEnglishgri Smok EduMothe Sizel
2 |male ! 68 183 gray darkblonde 44 4 3 #NA yes Upper Sec
3 |male 80 184 blue blonde 44 3 2 1 no Secondary
4 [female 62 173 blue blonde 39 4 2 2 yes Upper Sec
5 female 55 165 green blande 38 3 3 3 yes Degree
6 |female 60 165 blue brown 38 4 g 3no Secondary
7 |male 70 185 blue black 44 #NIA #NIA #N/A yes Secondary  #N
8 male 81 179 bluegray brown 42 #NIA 1 2 yes Secondary
9 |male 23 185 brown brown 44 4 4 3 yes Secondary
10 |female 70 178 blue blonde 42 3 4 2 yes Upper Sec
11 female 75 168 brown brown 38 3 2 4 yes Upper Sec
12 [female 65 165 green brown 39 #NA 3 3 no Secaondary
13 /male 80 182 brown brawn 45 3 4 3 no Secondary
14 imale 83 193 brown blackbrowr 45 3 3 2no Secondary
15 |male 65 172 brown brown 42 2 2 2no #NIA #N
16 |male 73 173 green brown 42 4 3 3 no Degree
17 lfemale A& 162 hlue __ darkhl KA 1 Secandan:
4 4 » H | Studentdata_raw - Studentdata %1
Ready | 5 |

Fig. 12.2 Note that we froze the first line containing the variable names. This way
the variable names are always visible as we scroll through the file.
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( Ea H9-¢-G) - StudentData.xlsm - Microsoft Excel
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Ready 7 | [ Paste Count:19159 |{EE T B=i=—
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Dataframe name in R

Get from Cell I

[ with rownames
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[V make active in Reommander

Cancel

Fig. 12.3 Put the StudentData into R by highlighting the entire worksheet with
Ctrl-Shift * and then right-clicking the Put R DataFrame menu item and dialog box.
RExcel proposes the dataframe name StudentData, which we kept. All menu items
on the Remdr menu refer to variables that are columns in the active dataframe.
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Fig. 12.4 The student data for the Austrian students has additional variables. We
look at three here. EduMother and EduFather are the educational levels of the stu-
dent’s mother and father. The correct order of the levels is Secondary, Upper
Secondary, Degree. ZodiacSign should be ordered by the positions of the con-
stellations in the sky. We need to verify the ordering of these three ordered factors.
We do so with the Statistics » Summaries » Frequency distributions. .. menu item and
its dialog box. We select the three variables with Ctrl-left-click (only two are visible

in the scroll window) and click OK.

We see in Table 12.1 that the education variables are ordered alphabetically:
Degree, Secondary, Upper Secondary. Similarly, we see that the signs of
the zodiac are initially ordered alphabetically. We correct both orderings in Fig.

12.5.
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Table 12.1 Levels of the three factors are ordered alphabetically by default. This
table is a subset of the output printed in the Rcmdr Output Window that was specified
by the Frequency Distributions dialog box in Fig. 12.4.

> .Table # counts for EduFather

Degree Secondary Upper Secondary
377 465 255

> .Table # counts for EduMother

Degree Secondary Upper Secondary
225 505 377

> .Table # counts for ZodiacSign

Aguarius Aries Cancer Capricorn

82 97 84 67

Gemini Leo Libra Pisces

94 118 80 96
Sagittarius Scorpio Taurus Virgo
87 70 99 86

Table 12.2 Levels of the three factors sorted as specified in the Reorder Factor Lev-
els dialog boxes in Figs. 12.5 and 12.6. This table is a subset of the output printed in
the Remdr Output Window that was specified by a repeat of the Frequency Distributions
dialog in Fig. 12.4.

> .Table # counts for EduFather

Secondary Upper Secondary Degree
465 255 377

> .Table # counts for EduMother

Secondary Upper Secondary Degree
505 377 225

> .Table # counts for ZodiacSign

Aries Taurus Gemini Cancer

97 99 94 84

Leo Virgo Libra Scorpio

118 86 80 70
Sagittarius Capricorn Aquarius Pisces

87 67 82 96
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Fig. 12.5 Rcmdr has a menu item for reordering factor levels. We will use this
menu item and its dialog box three times, once for each variable to be reordered.
Click Data » Manage variables in active data set » Reorder factor levels. ... This gives
the Reorder Factor Levels dialog box. We show the EduFather variable highlighted.
Repeat for the other two variables. When we take the default <same as original>, we
get the warning message that we are about to overwrite the variable. In this example,
overwriting is OK. Click Yes to get the dialog boxes in Fig. 12.6. The Make ordered
factor checkbox is used to determine the type of contrasts used for the factor. The de-
fault is treatment contrasts. When checked, the contrasts are orthogonal polynomial
contrasts. See ?contrasts for more information. We do not use the contrasts in
this book.
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Fig. 12.6 The top two dialog boxes show the Before and After settings for the
EduMother and EduFather variables. The bottom dialog box shows the After setting
for the ZodiacSign variable.
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Fig. 12.7 As always, we begin with a plot. We first show the scatterplot matrix
from the menu. Only the eight continuous variables show up in the list, and we
select all eight. The five variables at the top right are the size and weight variables.
They look reasonably normal, although there is some bimodality that might need
investigating in Shoesize. We will be using Shoesize as the response variable in the
regression analysis; therefore, we are most interested in the four outlined panels in
the Shoesize row and the Size and Weight columns of the scatterplot matrix. We will
expand these four panels in Figs. 12.8 and 12.9. The three variables in the lower left
are grades on a discrete scale of (1, 2, 3, 4). The scatterplots are a lattice, and the
univariate densities on the diagonal reflect the discreteness of the variables.
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12 Multiple Regression—Three or More X -Variables
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Fig. 12.8 The XY Conditioning Plot. .. (HH) menu gives access to the R lattice plot,
a coordinated set of plots. In this example, we expand the outlined panels from Fig.
12.7. We construct four panels, each showing the same response variable Shoesize
in the right-side Response variable dropdown menu and the four highlighted vari-
ables in the left-side Explanatory variables menu. We highlight Gender in the second
row right-side Groups menu to differentially color the points for males and females.
Automatically draw key is checked, so the legend telling which is which will be placed
on the graph. Each of the four graphs is to appear in its own panel, so we check Dif-
ferent panels for different y~x combinations. Free scaling for the X-Axes means each
will be allowed to maximally fill its plot area. Identical scaling would mean that both
heights in cm and weights in kg would be scaled from 40 to 200. Most of the area in
all four panels would be empty. We specified a 2x2 arrangement of the panels. The
graph specified by this dialog box is in Fig. 12.9.
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Fig. 12.9 This is the figure specified by the dialog box in Fig. 12.8. We will
improve the specification in Fig. 12.11 and redraw the plot in Fig. 12.12. There
are three height variables in this set of four panels: Size, SizeFather, and
SizeMother. Each has a different set of x-limits, chosen to maximally fill the
left-to-right space in its panel. Therefore, our attention is not drawn to one of the
most important features of this plot: female students and all mothers have the same
height range, and male students and all fathers have the same height range. We must
take control of the scaling to make this important finding immediately obvious to
the reader of the graph. We do so in Figs. 12.11 and 12.12.
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xyplot (Shoesize
Size + SizeFather + SizeMother + Weight
| Gender,

outer=TRUE, layout=c(2, 4), type="p", pch=16,
auto.key=1list (border=TRUE) ,
par.settings=simpleTheme (pch=16),
scales=1list(

x=1list (relation='free’),

y=list (relation='same’)),
data=StudentData)

Fig. 12.10 The Rcmdr dialog box in Fig. 12.8 generated this statement for Fig.
12.9 in the Script Window. The statement shows free scaling for the x-axis of each of
the eight panels from the dialog box in Fig. 12.8. We will modify this statement in
Fig. 12.11 by changing the scales argument.

xyplot (Shoesize ~
Size + SizeFather + SizeMother + Weight
| Gender,
outer=TRUE, layout=c(2, 4), type="p", pch=16,
auto.key=1list (border=TRUE) ,
par.settings=simpleTheme (pch=16),
scales=1list(
x=1list (relation='free’,
limits=1ist(

c(132,205),c(132,205),
c(132,205),c(132,205),
c(132,205),c(132,205),
c(0,150), <¢(0,150))),

y=list (relation='same’)),
data=StudentData)

Fig. 12.11 We constructed this modified statement, based on the generated state-
ment in Fig. 12.10, to take control of the x-axes. The important feature for program-
ming is to let the dialog box do as much of the thinking as possible. Only at the end
do we intervene and make some small changes to the generated code. This modi-
fied statement specifies Fig. 12.12. We replaced the scales argument by the more
elaborate statement here. The x-axes for the six size panels are the same as each
other and wide enough to include all observations in all panels. The x-axis for the
two weight panels are the same as each other and extended on the left to make the
left-right positioning of the weight point cloud approximately the same as the size
point cloud.
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Fig. 12.12 This is the enhanced version of the plot in Fig. 12.9 that was constructed
with the command-line statement in Fig. 12.11. Now our attention is drawn to the

important feature that female students and all mothers have the same height range.
78
56
34|
12
panel (Panel 1) have the same x-range as all dots in the SizeMother row (Panels 5
and 6). Similarly, male students (Panel 2) and all fathers (Panels 3 and 4) have the
same height range. Because we took control of scaling, this important finding is
immediately obvious from the graph. We can do even better, and we do so in Figs.

12.13 and 12.14.

Label the panels We see that the dots for female students in the lowerleft
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xyplot (Shoesize Size + Weight + SizeFather + SizeMother,
outer=TRUE, layout=c(2, 3),
skip=c (FALSE, FALSE, FALSE, TRUE, FALSE) ,
groups=Gender,
auto.key=1list (border=TRUE, pch=c(17,16)),
par.settings = simpleTheme (pch=c(17,16)),
scales=1list(relation="'free’,
x=1ist (limits=1ist(c(132,205), c(39,150),
c(132,205)
c(132,205))),
y=list (limits=c(34,50))),
data=StudentData)

Fig. 12.13 In this specification statement, we place all three height variables in
the left column. We place the two variables on the students themselves in the bot-
tom row. The groups=Gender statement forces separate colors for female and
male students. The two pch=c (17,16) statements specify solid triangles and
solid circles as the plotting characters for the groups. The pch statement in the
auto.key specifies the plotting characters in the legend and the statement in
the par.settings specifies the characters in the plot itself. Several changes
are needed to control the placement of the panels. We changed the layout to two

columns and three rows. The panels on the plotting surface are numbered (j j) The
12

default sequence for sending packets to be drawn in the panels is bottom to top, and
within each row from left to right. Therefore, we changed the order of the variables
in the right side of the specification to match the drawing sequence. We use the
skip argument to skip the fourth panel. The fourth packet (Shoesize ~ Size) is sent
to the fifth panel on the plotting surface. The resulting plot is in Fig. 12.14.
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Fig. 12.14 We have two columns and three rows of panels. The left column shows
all three height variables. It is now even easier to see that female students (blue
triangles in the bottom row) and all mothers (the top panel) have the same height
range and that male students (red circles in the bottom row) and all fathers (the
panel in the second row) have the same height range. The bottom row shows both
height and weight for the students themselves. We now see two potential outliers,
observations that need careful investigation in the source data. The accuracy of the
data for the male student with Size = 132 cm and Weight = 150 kg needs further
investigation. (The second sheet in the StudentData worksheet removes the data for
this student.) Similarly, we might wish to check the accuracy of the data for the male
with Shoesize = 37.
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12.3 Regression Analysis
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Fig. 12.15 We specify the initial linear model with the Statistics » Fit models »
Linear regression. .. menu item and dialog box. This dialog box shows only the con-
tinuous variables and places them in alphabetical order. That is an acceptable first
step. The dialog box calculates the regression model and displays the summary in
Table 12.3. The Models » Hypothesis tests » ANOVA table (Type | Sums of Squares)
menu item displays the sequential ANOVA table, also shown in Table 12.3.
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Table 12.3 All four continuous explanatory variables are shown as significant, al-
though the heights of the parents have p-values of only 10~3. Gender, which we see
from the graphs is very important, is not in this model. In Fig. 12.16 and Table 12.4,
we will construct an improved model based on our insight from this model.

> RegModel.6 <- 1lm(Shoesize~Size+SizeFather+SizeMother+Weight,
+ data=StudentData)

> summary (RegModel.6)

Call:
Im(formula = Shoesize ~ Size + SizeFather + SizeMother + Weight,
data = StudentData)

Residuals:
Min 1Q Median 30 Max
-5.50358 -0.90325 0.04158 0.80143 5.48781

Coefficients:
Estimate Std. Error t value Pr(>|t])
(Intercept) 9.051955 1.593298 5.681 1.80e-08 *x*x

Size 0.215778 0.006700 32.204 < 2e-16 #*x*x
SizeFather -0.024033 0.006877 -3.495 0.000498 =xxx*
SizeMother -0.029116 0.007964 -3.656 0.000271 *xxx
Weight 0.055190 0.004218 13.083 < 2e-16 *x*x
Signif. codes: 0 ’*%x’ 0.001 '**’ 0.01 "%’ 0.05 ’.” 0.1 " " 1

Residual standard error: 1.328 on 905 degrees of freedom
(216 observations deleted due to missingness)

Multiple R-squared: 0.759,Adjusted R-squared: 0.7579

F-statistic: 712.5 on 4 and 905 DF, p-value: < 2.2e-16

> anova (RegModel.6)
Analysis of Variance Table

Response: Shoesize

Df Sum Sg Mean Sg F value Pr (>F)
Size 1 4644.0 4644.0 2634.053 < 2.2e-16 *xxx
SizeFather 1 44.7 44.7 25.381 5.680e-07 *xx*
SizeMother 1 34.0 34.0 19.297 1.251e-05 =xxx
Weight 1 301.8 301.8 171.170 < 2.2e-16 **x
Residuals 905 1595.6 1.8

Signif. codes: 0 'xxx’ 0.001 %%’ 0.01 '+’ 0.05 *.” 0.1 " " 1
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Fig. 12.16 We specify the revised linear model with the Statistics » Fit models »
Linear model... menu item and dialog box. This dialog box shows factors as well
as continuous explanatory variables, allows user control of the order of terms in the
model, and gives facilities for specifying interaction and other relationships among
the explanatory variables. The dialog box opens (left side of the figure) with the
Model Formula Shoesize ~ Size + SizeFather + SizeMother + Weight, the formula for
the previous linear regression, in the box. We need to edit it to a better model (right
side of the figure). We placed Gender sequentially first and moved SizeFather and
SizeMother sequentially last. The new model formula is Shoesize ~ Gender + Size
+ Weight + SizeFather + SizeMother. Clicking OK calculates the regression model
and displays the summary in Table 12.4. The Models » Hypothesis tests » ANOVA
table (Type | Sums of Squares) menu item (not shown here) displays the sequential
ANOVA table, also shown in Table 12.4.
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Table 12.4 Linear model with predictor variables ordered by size of the p-value.
We see that the gender, height, and weight of the student are sufficient to explain
shoe size. The information on parents does not provide significant additional ex-
planatory power. We see the p-value psizemMother = 0.9435 in both the summary and
the ANOVA. Why are they the same numerical value? Had SizeMother been
sequentially earlier, as in RegModel . 6, it would have been significant. Why is
SizeMother not significant here in RegModel. 7?

> LinearModel.7 <- 1lm(Shoesize Gender + Size + Weight +
+ SizeFather + SizeMother, data=StudentData)

> summary (LinearModel.7)
Call:

Im(formula = Shoesize Gender + Size + Weight + SizeFather +
SizeMother, data = StudentData)

Residuals:
Min 1Q Median 30 Max
-6.20646 -0.73868 -0.03658 0.68864 4.59488

Coefficients:
Estimate Std. Error t value Pr(>|t])
(Intercept) 11.8442645 1.3789228 8.590 <2e-16 **x*

Gender [T.male] 2.2106553 0.1232408 17.938 <2e-16 x*%

Size 0.1393854 0.0071593 19.469 <2e-16 x*xx*
Weight 0.0391494 0.0037406 10.466 <2e-16 xxx*
SizeFather 0.0071875 0.0061936 1.160 0.246
SizeMother -0.0004983 0.0070291 -0.071 0.944

Signif. codes: 0 "xxx’ 0.001 %%’ 0.01 ’'«x’ 0.05 ".” 0.1 * " 1

Residual standard error: 1.141 on 901 degrees of freedom
(219 observations deleted due to missingness)

Multiple R-squared: 0.8218,Adjusted R-squared: 0.8208

F-statistic: 831.2 on 5 and 901 DF, p-value: < 2.2e-16

> anova (LinearModel.7)
Analysis of Variance Table

Response: Shoesize
Df Sum Sgq Mean Sg F value Pr (>F)

Gender 1 4190.7 4190.7 3219.4945 <2e-16 *+*%
Size 1 1074.6 1074.6 825.5175 <2e-16 x#*x
Weight 1 142.8 142.8 109.7384 <2e-16 =xx%*
SizeFather 1 1.7 1.7 1.3417 0.2470
SizeMother 1 0.006542 0.006542 0.0050 0.9435
Residuals 901 1172.8 1.3

Signif. codes: 0 '*xx’ 0.001 %%’ 0.01 '+’ 0.05 ".” 0.1 " " 1
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12.4 Basic Diagnostic Plots
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Fig. 12.17 The basic diagnostic plots are displayed with the Models » Graphs »
Basic diagnostic plots menu item and dialog box. See Section 9.3 for a general dis-
cussion of these plots. In this example, much of the granular structure of the plots
can be attributed to the use of a two-level factor Gender. Observation 849, the point
with the extremely high leverage on the right in the Residuals vs Leverage plot, is the
individual we spotted in Fig. 12.14 with Size = 132 cm and Weight = 150 kg.
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12.5 Confidence Intervals
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Add observation statistics to data...
Confidence intervals...

Best subsets regression... (HH)
Confidence interval Plot...
Prediction Intervals... (HH)

Hypothesis tests >
Numerical diagnostics L3
Graphs 3
Enter X data for new observations @|i,®
Number of Rows: | _| | 2
Enter ¥ values:
Gender Size .Weight SizeFather SizeMother

1 male 170 75 170 170

2 Female 170 75 170 170

Prediction Inkerval

point estimate only 9

confidence interval for mean (&)

prediction interval for individual O

Confidence Level 95
Standard Error v

[ OK ] [ Cancel ] [ Help ]

Fig. 12.18 Let’s construct confidence intervals for the estimate of the mean Shoe-
size for a group of males and a group of females, each of whom has a height and
parent’s height of 170 cm and a weight of 75 kg. We use the Models » Prediction
Intervals. .. (HH) menu item and dialog box. We wish to construct confidence inter-
vals on the means for two different groups. We use the slider at the top of the dialog
box to set the box to accept two rows of data. Then we enter the data. We select the
confidence interval for mean option and select Standard Error. Clicking OK generates
the statements in the Script Window of Fig. 12.19 and the confidence intervals in the
Output Window of Fig. 12.19.
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R Commander.

Script Window

Newhata <- data.frame (Gender=structure (2L, 1L), .Lakhel = c("female™,
"male™), class = "factor™), Size=c (170, 170), Weight=c (75, 75).,
SizeFather=c (170, 170), SizeMother=c (170, 170), row.nsmes=c ("1™, "2"))

HewData # Newdata

predict (LinearModel.?, newdata=.NewData, interval="confidence®, lewvel=,95,
se.fit=TRUE)

54|

Cutput Window Suhmi‘tl

> JNEWUATE F NEWOata
Gender Size Weight 2izeFather S3izeMother B

1 male 170 75 170 170

Z female 170 75 170 170

> predict (LinearModel.?, newdata=.Newlbata, interval="confidence®, lewvel=.,95,
+ se.fit=TRUE]
$fit
fit lur upr
1 41.523581 41.62710 42.02051
Z 39.61315 39.39923 39.52707

fze.fit
1 Z
0.1002252 0.1055997

$df
[1] 901

Fresidual.scale
[1] 1.120908

1|

Messages

54|

Fig. 12.19 The statements in the Script Window were generated by the dialog box in
Fig. 12.18. The Output Window shows the observations that were specified (read them
carefully to be sure there were no interpretation errors) and the confidence intervals.
Reading from the bottom up, the df and residual.scale are the degrees of
freedom v and residual standard error s (square root of the Residuals Mean
Sq) from Table 12.4. The se. £it is the standard error of the fit from the formula
sv'h in Equation (10.1) where 4 is defined in Equation (10.3). For new observation
1, vh = 0.0878495 and for new observation 2, v/h = 0.0955377. For illustration,
we duplicate the calculations for the £it and the confidence intervals in Table 12.5.
Normally, this arithmetic is done only by the dialog box.
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Table 12.5 Selections from the Output Window, where we manually entered com-
mands to duplicate the calculation of the confidence intervals on the means. Nor-
mally, this arithmetic is done only by the dialog box.

Case Fit: §|x
> 11.8442645 +
+ 2.2106553 x 1 +
+ 0.1393854 * 170 +

New case 1 (male) + 0.0391494 x 75 +
+ 0.0071875 %= 170 +
+ -0.0004983 % 170
[1] 41.82381
> 11.8442645 +
+ 2.2106553 % 0 +
+ 0.1393854 % 170 +

New case 2 (female) + 0.0391494 » 75 +
+ 0.0071875 % 170 +
+ -0.0004983 * 170
[1] 39.61315

Case Lower confidence limit: $|x —7 025,y (s Vh)

> 41.82381 - 1.962600 = 0.1002282
NeWCﬁSCl(male) [1] 41.6271

> 39.61315 - 1.962600 % 0.1089997
New case 2 (female) [1] 39.39923

Case Upper confidence limit: $[x+7 025,y (s Vh)

> 41.82381 + 1.962600 = 0.1002282
Newcasel(male) [1] 42.02052

> 39.61315 + 1.962600 = 0.1089997
New case 2 (female) [1] 39.82707




Chapter 13
Contingency Tables and the Chi-Square Test

Abstract Contingency tables are designed to study relationships between two cate-
gorical variables or factors. A contingency table has rows and columns labeled with
the levels of two factors. The (row i—column j) cell in the table gives the number of
observations in the dataset whose value on the first factor is level i and whose value
on the second factor is level j. For example, if we have a group of people of both
genders, with some smokers and some nonsmokers, we can ask the question, is the
percentage of smokers essentially the same for both genders or, equivalently, does
the data indicate that there is a significant difference in percentage of smokers?

We will investigate relationships between gender and smoking behavior using the
StudentData dataset accompanying this book. We will also investigate relationships
between student grades in different subjects and gender.

The variables in the StudentData dataset are described in Chapter 12.

Load the StudentData workbook as illustrated in Fig. 12.1, and click on the sec-
ond, Studentdata, worksheet. In Chapter 12, we used the first, Studentdata_raw, work-
sheet. Select a cell in the data range, press Ctrl-Shift *, and then right-click Put R
Dataframe to transfer the data to R as a dataframe.

/ ET o = StudentData.xlsm - Microsoft Excel - =X
] .
—/ Home Insert Page Layout Formulas Data Review View Developer Add-Ins W - 7 X
RExcel ~ R File - Data ~ Statistics = Graphs -~ Models = Distributions ~ Tools = Help ~
Dataset: |StudentData - | Madek |No active mode
Menu Commands Custom Toolbars
E10 - I | blonde
A B c D E E G H I J K
1 Gender Weight Size Eyes Hair Shoesize Mathgrad GermangiEnglishgri Smok Edulothe Size’
2 male 68 183 gray darkblonde 44 4 3 #IA yes Upper Sec
3 |male a0 154 blue blonde 44 3 2 1no Secondary
4 female 62 173 blue blonde 39 4 2 2 yes Upper Sec

Fig. 13.1 Excel window after transferring the data. The active dataset is indicated
as StudentData. The transferred region was colored during the transfer.
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13.1 Gender and Smoking

13.1.1 Two-Way Table Chi-Square Test

,-‘El:; = B Bl ¥ StudentData.xlsm - Microsoft Excel e m
EL) 1 =
- Home Insert Page Layout Formulas Data Review View Developer Add-Ins @ - =7

RExcel ~ R File = Data ~ |Statistics =| Graphs ~ Models = Distributions ~ Toaols = Help =

Dataset: Studentl summaries » k
Contingency tables  # Two-way table...
Menu Commands Means LS Multi-way table...
ElL * & Propartions 4 Enter and analyze two-way table...
A B & Variances 3 Two-way table... (HH) L K -
1 Gender Weight Size Nonparametrictests o R AN R el e, (EiE pker EdulMothe Size;
2 male 68 1 Upper Sec
3 male a0 1 Dimensional analysis * Analyze two-way table... (HH] Secundary
4 female 62 1 Fit models L4 | 39 4 2 2 yes Upper Sec
5 female 55 165 green blonde 38 3 3 3 yes Degree
6 female 60 165 blue brown 38 4 3 3 no Secondary
7 male 70 185 blue black 44 #NIA #NIA #NIA yes Secondary  #M
—
Two-Way Table | - || @
Row variable (pick one) Column variable (pick one)

mokeFather ~

Compute Percentages
Row percentages |

Column percentages [
Total percentages |

Hypothesis Tests
Chi-square test of independence W
Print chi-square components r
Print chi components (residuals) [
Print expected frequendies I
Fisher's exact test r
Subset expression
| <all valid cases>> l
l OK l [ Cancel ] [ Help

Fig. 13.2 Click the Statistics » Contingency tables » Two-way table...(HH) menu
item to get the Two-Way Table dialog box. From the StudentData, we select Gender as
the row variable and Smoker as the column variable. From the options, we choose
only Chi-square test of independence. This produces test results in the Recmdr Output
Window as shown in Table 13.1.
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Table 13.1 The table shown here is from the Rcmdr Output Window. This table
shows the analysis specified in Fig. 13.2. There are 229 female and 514 male non-
smokers and 107 female and 261 male smokers in our student sample. The propor-
tion of nonsmoker females within all females is 229/(229 + 107) = 0.682 and the
proportion of nonsmoker males within all males is 514/(514 +261) = 0.663. The
p-value for the test for independence of the variables is p = 0.5512, so the interpre-
tation of the test result is that there is no significant difference in the nonsmoking
percentage between men and women in our sample.

> .Table <- xtabs(“Gender+Smoker, data=StudentData)
> .Table
Smoker

Gender no yes

female 229 107

male 514 261
> .Test <- chisqg.test(.Table, correct=FALSE)
> .Test

Pearson’s Chi-squared test

data: .Table
X-squared = 0.3552, df = 1, p-value = 0.5512
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13.1.2 Two-Sample Proportions Test

i 2 b StudentData.xlsm - Microsoft Excel NS e
Home Insert Page Layout Formulas Data Review View Developer Add-Ins 'QJ - 7 X
RExcel ~ R File = Data - |Statistics =| Graphs ~ Models = Distributions ~ Toaols = Help =
Dataset: |Studentl Summaries ¥
Contingency tables  #
Menu Commands Means »
| A2 ¥ Froportions » Single-sample proportion test...
f!_\ B c Variances 12 Tw{~sample proportions test... J K
1 Gender  Weight Size Nonparametrictests » PESIZE AU rEU GETITENYITNy i Smok EduMothe Size
2 [male ! 68 1 44 4 3 #NIA yes Upper Sec
- 3
3 male 80 1 bmensional anasis 44 3 2 1no Secondary
4 female 62 1 Fit models L4 39 4 2 2 yes Upper Sec
A female 55 1R Arern anda 38 3 3 3 wes Denares

Two-Sample Proportions Test

Groups (pick one)

Difference: Female - male
Alkernative Hypothesis
Two-sided ®
Difference <0 ()
Difference =0 ()

Tvpe of Test

Mormal approximation ®

Marmal approximation with O
continuity correction

Confidence Level: [-95

| (

[ oK Cancel ] [ Help

l

Fig. 13.3 An equivalent test can be performed by choosing Statistics » Proportions
» Two-sample proportions test. ... In the dialog box, we set Gender as the group vari-
able and Smoker as the response variable. As we will see in Table 13.2, the group
and response variables are interpreted differently, so specifying them correctly is

important.

Computing the test with the Proportions menu is possible only when we have
exactly two groups and the percentage is taken for a dichotomous response variable,
i.e. a variable with only two possible values. The Rcmdr Two-sample proportions test
dialog box displays variables of only this type in the selection boxes. This menu and
dialog box give the results shown in Table 13.2.
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Table 13.2 This table was specified by the menu and dialog box in Fig. 13.3. By
default, the percentages within the groups are displayed. The p-value for the test for
independence of the variables is p = 0.5512, because statistically this is the same
test as the one in Table 13.1.

> .Table <- xtabs(“Gender+Smoker, data=StudentData)

> rowPercents (.Table)
Smoker
Gender no yes Total Count
female 68.2 31.8 100 336
male 66.3 33.7 100 775

> prop.test(.Table, alternative='two.sided’, conf.level=.95,
+ correct=FALSE)

2-sample test for equality of proportions without continuity
correction

data: .Table
X-squared = 0.3552, df = 1, p-value = 0.5512
alternative hypothesis: two.sided
95 percent confidence interval:
-0.04158248 0.07822611
sample estimates:
prop 1 prop 2
0.6815476 0.6632258
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Sometimes, the two-sample proportions test is performed not by using the chi-
square statistic as done by these menus, but with the z-statistic. The hypotheses for
the test are

Ho: pr—p2=0
Hi: pi—p2#0

The formulas for the test statistic are in Table 13.3. The numerical values are in
Table 13.4. The arithmetic, substituting the numerical values into the formulas, is
shown calculated in R in Table 13.5.

Table 13.3 The test statistic has the form z = (w — ) /6y, where w = (p1 — p2).

p1—p2)—0
Test statistic 7= (P1=p2) =0

Standard deviation O(p—py) = \/ﬁ (1-p) (% + %)
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Table 13.4 If p; and p, are the sample proportions of the subgroups under con-
sideration (smokers within males and smokers within females in our case), p is the
percentage of smokers in the whole group (females and males), and if n; and n, are
the group sizes (in this example, the number of females and males), then using the
above formula and data, we have z = —0.5960.

Computing the p-value of the two-sided z-test with z = —0.5960 results in the
same p = 0.5512 as the p-value Remdr computed for the chi-square test. This is no
coincidence. For a 2x2 contingency table, the value of the chi-square test is always
the square of the value of the z-test. Therefore, the p-value for the chi-square test
is the same as the p-value for the two-sided z-test. We show the arithmetic for the
z-test in Tables 13.5 and 13.6.

The z-test can also be used for one-sided hypotheses. The chi-square test can
be used only with two-sided tests. The chi-square test can be generalized for larger
contingency tables, for example, the 4 x4 table in Section 13.2, whereas the z-test is
applicable only for 2x2 tables.

Smoker Row Row proportion

Gender no  yes Count no yes

Female x; =229 107 n; =229+107= 336 pj= 33 =0.682 132 =0.318
Male x;=514261 n;=5144261= 775 py= 32 =0.663 35 =0.337

Both 743 368 n =743+368=1111 p =2 =0.669 & =0.331
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Table 13.5 Arithmetic for the z-test in Table 13.3 for the comparison of the pro-
portion of female nonsmokers and male nonsmokers using the data in Table 13.4.
Enter the code into the Script Window and click the Submit button. This will place the
calculations shown in Table 13.6 into the Output Window.

Remdr Script Window

x.1 <- 229

n.l <- 336
p.hat.1 <- x.1/n.1
p.hat.1

x.2 <- 514

n.2 <- 775
p.hat.2 <- x.2/n.2
p.hat.2

<- n.l + n.2
p.hat <- (x.1 + x.2) / (n.1 + n.2)
p.hat

sigma.sqg <- (p.hat*(l-p.hat)) * (1/n.1 + 1/n.2)
sigma.sqg

z <- (p.hat.1 - p.hat.2) / sgrt( sigma.sq )
z

p.value <- 2+pnorm(z, lower=FALSE)
p.value




13.1 Gender and Smoking 317

Table 13.6 Clicking the Submit button in Fig. 13.5 places the calculations shown
here into the Output Window. These computational statements are a direct translation
of the formulas in Table 13.3 into the R notation.

Remdr Output Window
> x.1 <- 229
> n.l <- 336
> p.hat.1 <- x.1/n.1
> p.hat.1l
[1] 0.6815476
>
> x.2 <- 514
> n.2 <- 775
> p.hat.2 <- x.2/n.2
> p.hat.2
[1] 0.6632258
>
> n <-n.l + n.2
> p.hat <- (x.1 + x.2) / (n.1 + n.2)
> p.hat
[1] 0.6687669
>

> sigma.sqg <- (p.hat*(l-p.hat)) * (1/n.1 + 1/n.2)
> sigma.sqg
[1] 0.0009451083

>
> z <- (p.hat.l - p.hat.2) / sgrt( sigma.sqg )
> z

[1] 0.5959744

>

> p.value <- 2xpnorm(z, lower=FALSE)
> p.value

[1] 0.5511923

>
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13.2 German and Math Grades

We now study the relationship between German-language grades and math grades
for the Austrian students. Grades in Austria vary from 1 (best grade) to 5 (not
passed). Since all the students in the sample have passed the final exam of high
school, grade 5 is impossible.

. Two-Way Table [:h:.[z J

Row variable (pick one) Column variable (pick one)

Compute Percentages
Row percentages |V
Column percentages v
Total percentages W
Hypothesis Tests

Chi-square test of independence ™
Print chi-square components r
Print chi components (residuals) W
Print expected frequencies ~
Fisher's exact test r

Subset expression

| <all valid cases> l

l OK J [ Cancel ] [ Help ]

Fig. 13.4 We perform a test for independence (or dependence) between grades in
math and grades in German. We select Statistics » Contingency tables » Two-way
table. .. (HH) as in the top of Fig. 13.2. We select Germangrade as the row variable
and Mathgrade as the column variable. From the options, we choose Chi-square test
of independence, Print chi components (residuals), and Print expected frequencies. This
dialog box specifies the output, which we have displayed in Tables 13.7-13.10.
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Table 13.7 The tables here are the beginning of the output specified by the dialog
box in Fig. 13.4. In this part, we display the cross-tabulated frequency table, the
row percentages (including counts for each row), the column percentages (includ-
ing counts for each column) from the Remdr Output Window, and the total percent-
ages (including marginal percentages for the rows and columns). The first table has
the counts of all possible grade combinations for the 862 students who had valid
recorded grades in both subjects. We see that there are 111 students with grade 1
in both subjects. The second table has the row percentages. We see that 53.9% of
the students with grade 1 in German also have grade 1 in math. Similarly, the third
table with the column percentages shows that 48.9% of the students with grade 1
in math also have grade 1 in German. The fourth table gives the overall (or total)
percentages and shows that 12.9% of all students have grade 1 in both German and
math.

> .Table <- xtabs(~“Germangrade+Mathgrade, data=StudentData)

> .Table
Mathgrade
Germangrade 1 2 3 4
1 111 49 32 14
2 46 71 72 38
3 51 79 78 60
4 19 40 55 47

> rowPercents(.Table) # Row Percentages

Mathgrade

Germangrade 1 2 3 4 Total Count
1 53.9 23.8 15.5 6.8 100 206
2 20.3 31.3 31.7 16.7 100 227
3 19.0 29.5 29.1 22.4 100 268
4 11.8 24.8 34.2 29.2 100 161

> colPercents(.Table) # Column Percentages

Mathgrade
Germangrade 1 2 3 4
1 48.9 20.5 13.5 8.8
2 20.3 29.7 30.4 23.9
3 22.5 33.1 32.9 37.7
4 8.4 16.7 23.2 29.6
Total 100.1 100.0 100.0 100.0
Count 227.0 239.0 237.0 159.0

> totPercents(.Table) # Total Percentages

1 2 3 4 Total
1 12.9 5.7 3.7 1.6 23.9
2 5.3 8.2 8.4 4.4 26.3
3 5.9 9.2 9.0 7.0 31.1
4 2.2 4.6 6.4 5.5 18.7
Total 26.3 27.7 27.5 18.4 100.0
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Table 13.8 The next section of the Recmdr Output Window contains the chi-square
test result. We see that value of the statistic, the degrees of freedom, and the p-
value. We have p < 2.2 x 10716, Therefore, the null hypothesis of independence is
rejected. Our data indicate that there is a relationship between the grade in German
and that in math. To further investigate the nature of the relationship, we study the
expected frequencies in Table 13.9 and then the residuals in Table 13.10.

> .Test <- chisqg.test(.Table, correct=FALSE)
> .Test
Pearson’s Chi-squared test

data: .Table
X-squared = 126.7532, df = 9, p-value < 2.2e-16
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Table 13.9 The next section of the Remdr Output Window contains the residuals,
and the last section contains the expected frequencies. Since we need the expected
frequencies to compute the residuals, we will look at the expected frequencies first.

The expected frequencies are the hypothetical frequencies one would anticipate
if the German grades were independent of the math grades. Independence means
that the percentage of students getting grade 1 in math would be the same for stu-
dents with grade 1 in German, for students with grade 2 in German, grade 3 in
German, and grade 4 in German. In other words, independence assumes that the
percentage distribution according to the math grades is the same for each of the four
groups defined by the German grades. Assuming independence, we can compute
the hypothetical number of students with any grade combination from the overall
percentages for the math grades and the German grades.

There are 862 students with valid values for both German grade and math grade.
The total percentages table in Table 13.7 shows 23.9% of these students have grade
1 in German, and 26.3% of them have grade 1 in math. Therefore, if the percent-
age of grade 1 math students among the German grade 1 students were equal to the
percentage of grade 1 math students among all students, the percentage of students
with grade 1 in math and in German would be 23.9% x 26.3% = 6.3%; 6.3% of
the 862 students is 54.25, which is the value displayed in the table for the expected
values. Using this method, we can compute expected counts for all combinations of
grades.

> round(.TestSexpected, 2) # Expected Counts
Mathgrade
Germangrade 1 2 3 4
1 54.25 57.12 56.64 38.00
2 59.78 62.94 62.41 41.87
3 70.58 74.31 73.68 49.43
4 42.40 44.64 44.27 29.70
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Table 13.10 The Rcmdr Output Window displays the residuals table just above the
expected frequency table. We discuss the residuals last.

Residuals measure the difference between the observed frequency and the ex-
pected frequency. Looking at the students with grade 1 in both subjects, we see that
the observed frequency is 111 (see Table 13.7) and the expected frequency is 54.25
(see Table 13.9). The ordinary difference of these two numbers is not the residual.
To standardize this residual to a standard normal distribution, we need to divide the
difference by the square root of the expected frequency. The result of this computa-
tion is (111 —54.25)/4/54.25 = 7.71. This table shows the residuals computed this
way for all grade combinations.

If the distribution of the grades for the two subjects were independent, all the
residuals would follow a standard normal distribution. The values in our residual
table definitely do not follow a standard normal distribution. Too many of these val-
ues lie outside the range between —2 and 2, which would contain about 95% of the
values if they were normal. The residual value for the combination {Germangrade
=1 and Mathgrade = 1} is 7.71. This indicates that the observed value is noticeably
higher than the expected value. Further inspection of the residuals table shows that
all the values on the main diagonal (equal grades in German and math) are high and
that all the values where the difference between the grades is 2 or more are low. This
indicates that there is a tendency that high marks in one subject more often than ex-
pected by pure chance occur simultaneously with high marks in the other subject.
Similarly, low grades also tend to occur simultaneously.

> round(.TestS$residuals, 2) # Chi Components (residuals)
Mathgrade
Germangrade 1 2 3 4
1 7.71 -1.07 -3.27 -3.89
2 -1.78 1.02 1.21 -0.60
3 -2.33 0.54 0.50 1.50
4 -3.59 -0.69 1.61 3.18




Appendix A
Installation of RExcel

Abstract

e Excel is the most prevalent software used for data storage, analysis, and interpre-
tation. Elementary and medium-quality mathematical and statistical functions
are included with Excel. Good statistical analysis in Excel with more advanced
methods than just frequency counts, however, requires an add-in package.

R is one of the best and most powerful statistics programs currently available.
RExcel integrates a menu system, based on the R Commander package, that puts
complete access to the full power of R onto the Excel menu bar. Results from the
analyses in R can be returned to the spreadsheet. Ordinary formulas in spread-
sheet cells can use functions written in R.

A.1 Basic Installation Procedures

The easiest way to install R, RExcel, and the additionally needed software mod-
ules and tools is to download the current version of RAndFriendsSetup from
http://rcom.univie.ac.at. Running this program will install everything needed for a
working configuration on your machine. A detailed description of the installation
is in Section A.3. You will need a working internet connection during the installa-
tion process because one module, statconnDCOY, is not under the GPL license
that covers most of R. statconnDCOM must be downloaded separately during the
installation. More information on the license is in Section A.8.

If you already have a working version of R (version 2.8.1 or later) on your ma-
chine, you can simply install the R packages RExcellnstaller and RthroughExcel-
WorkbookslInstaller (and the packages they require) from CRAN. Section A.4 gives
more details about this process.
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A.2 Supported Excel Versions

The RExcel add-in is supported for the following versions of MS Windows Excel:

e Excel 2002 (=Excel XP)
e Excel 2003
e Excel 2007

If Excel 2007 is found on your machine, the Excel add-in will be installed for
Excel 2007. If Excel 2002 or 2003 are found on your machine, the add-in will be
installed for the latest of these Excel versions. If you have Excel 2007 and an earlier
version of Excel on your machine, then the installer will install both versions of the
RExcel add-in.

If you do not have Excel, or if Excel is installed in an unusual location, then
the installer will still install R and Remdr. It will give information on how to install
RExcel at a later time when Excel becomes available. See step 3 in Section A.3.3 for
installing RExcel later. See Section A.6 for information on working without Excel.

The RExcel interface works only with MS Windows Excel. The material in this
book that uses the R Commander menu system (from the Rcmdr package available
on all platforms where R is available) will work on any R installation. For Macintosh
and Linux systems, see Section A.6. For the Open Office spreadsheet, see Section
AT

A.3 Download and Installation of R and RExcel for MS Windows

The home website for RAndFriends [Neuwirth, 2009] is http://rcom.univie.ac.at/.
Click on the Download tab on the website. You will find a download link to the latest
version of the RAndFriends installer. RAndFriends includes the current release of R
[R Development Core Team, 2008] and the

rcom [Baier, 2007],

RExcellnstaller [Neuwirth et al., 2008]

HH [Heiberger, 2008a],

RthroughExcelWorkbookslInstaller [Heiberger and Neuwirth, 2008],
Remdr[Fox et al., 2007],

RemdrPlugin.HH [Heiberger, 2008b],

packages, and other packages. This is a large file (approximately 150MB), so this is
best done with a fast internet connection.
Download the RAndFriendsSetup*.exe file to a temporary location.



A.3 Download and Installation of R and RExcel for MS Windows 325

A.3.1 Preparation

The installation requires Administrator access to your PC because the RExcel add-
in uses the Windows Registry to configure communication between Excel and R
through the. On Vista, the installation requires a user with Administrator privileges
to start RAndFriendsSetupx . exe by right-clicking the RAndFriendsSetup icon
and explicitly clicking the run-as-Administrator item. Once the program is installed,
Administrator privileges are no longer needed.

A.3.2 An Ancient Previous Version of RExcel Must Be Uninstalled

If you have an ancient installation of RExcel [from an earlier version of the RAnd-
Friends installer, the (D)COM package, or the RExcellnstaller package], you will need
to uninstall the Excel add-in and the (D)COM package before installing the newer
version. Ancient means an RExcel version older than 3.0.0. To find out: Open Excel
and click on the RExcel » About RExcel menu item. If the version is 3.0.0 or higher,
then you do not have to do the uninstall step.

If you determine that you must uninstall the ancient version, you have to do it in
the following way:

1. For Excel 2003 and earlier (with the add-in installed), start Excel and go to
Tools » Add-Ins
and uncheck the checkbox next to the entry RExcel. Close Excel.
2. For Excel 2007 (with the add-in installed), start Excel and go to
Office Button » Excel Options » Add-Ins » Go. ..
and uncheck the checkbox next to the entry RExcel2007. Close Excel.
3. Remove old programs using Control Panel.
a. Open the Windows XP Add or Remove Programs window with
Start » Control Panel » Add or Remove Programs.

b. Open the Windows Vista Programs and Features window with
Start » Control Panel » Programs and Features » Installed Programs.

Remove any of the following:

e RDACCSD
e R (D)COM Server
e R/Scilab...

This completes the uninstall. After this, you can install the current version of RAnd-
Friends.

If any version conflicts remain, particularly for a user other than the Administra-
tor, see the Wiki at http://rcom.univie.ac.at/ for suggestions.
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A.3.3 Installation

1. Close Excel and any previous version of R.

2. Execute installer. In Windows Explorer, double-click the downloaded file
RAndFriendsSetupx*.exe

The installer may take up to 15 minutes. It will install R with RExcel and R
Commander and will give you the option to install

e 'R through Excel’ book demo files. You MUST check 'R through Excel’ book demo
files, which contains the R through Excel book’s workbook files.

e Rggobi. Rggobi is a very powerful 3D graphing program. It is not discussed in
this book. You are invited to explore it yourself. Clicking Rggobi also installs
Glade and GTK+.

e Notepad++ and NppToR. Notepad++ is a text editing program; NppToR enhances
Notepad++ by adding an R mode. These programs are not used in this book. If
you choose to install them, we strongly recommend that you uncheck check-
marks for all file types (particularly . txt and .text files) for which you
are happy with the editor you are using. If you use Emacs with ESS for your
R programs, or any other editor with a special mode for R code, you probably
don’t need to install Notepad++ and NppToR.

The RAndFriendsSetup installer will install R and place an R icon on the
desktop of the user performing the installation. RAndFriendsSetup will install
the RExcel add-in to your installed version(s) of Excel if it finds Excel (if not,
see step 3 of Section A.3.3). It will install a digital certificate for RExcel (see
Section A.9). If it finds Excel 2007, it will pop up a message saying that RExcel
is installed for Excel 2007. If it finds an earlier version of Excel, it will pop up
a message saying that RExcel is installed for Excel 2003 or Excel 2002. The in-
staller will put an RExcel with RCommander icon on the desktop of the installing
user for whichever versions of Excel it finds. It also will put one or two items
on the Start » All Programs » R » RExcel Windows menu. These items “Acti-
vate RExcel Add-in” and/or ”Activate RExcel 2007 Add-in” allow other users to
make the RExcel add-in(s) available for themselves.

After RExcel is installed, the RAndFriends installer will start additional in-
stallers for the checked items and it will need to download statconnDCOM from
the internet. The ‘R through Excel” workbooks installer (which you must check)
will install a digital certificate for RthroughExcel (see Section A.9).

The other two installers (if you select them) pop up many boxes. Take the
defaults.

3. If Excel is present and the installer can’t find Excel. ..
This sometimes happens when an earlier version of RExcel is already on the
machine or when Excel 2007 has recently been installed and Excel 2003 re-
moved. In this case, start R from the R icon. On XP, just click the icon. On Vista,
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right-click the icon and click run-as-Administrator to run as Administrator. At the
R prompt, enter

library (RExcelInstaller)
installRExcel ()

Pop-up messages will ask for administrative privileges. RExcel needs administra-
tive privileges because it uses the Windows Registry for setting up communica-
tion between R and Excel. Follow the pop-up instructions precisely. The installer
needs a working internet connection.

4. Verify the installation of the RthroughExcel worksheets.

Click the RExcel with RCommander icon. When it finishes loading, the cursor
will be in Excel. In Excel 2007, click the Add-Ins tab (Fig. 1.2) to get the RExcel
menu (Fig. 2.1). In Excel 2003, the RExcel menu is on the main Excel menubar
(Fig. 2.2). Click the RExcel menu and verify that the RthroughExcel Worksheets
item is there (Fig. 2.4). This is the menu for the worksheets in the R through
Excel book.

If the RthroughExcel Worksheets item is missing, then there is one more step.
On the Windows taskbar, click the R R Console item. Type the following two
lines exactly into the R Console window. Punctuation and capitalization must be
correct.

library (RthroughExcelWorkbooksInstaller)
installRthroughExcel ()

The installer needs a working internet connection. Then close R and Excel.

5. The installation is now complete. Congratulations!
You now have a copy of one of the world’s best statistical software systems
fully integrated into your MS Excel.
The installer file RAndFriendsSetup»* . exe is no longer needed.

6. Using RExcel. Please see Chapters 1 and 2 for detailed information, including
screenshots, on how to use RExcel and Remdr.

A.4 Installing RExcel for MS Windows When R Is Already
Installed

RExcel is easily added to an already installed R. We recommend that you first update
your R installation to the most recent. See Section A.5.

Start R from the R icon. On XP, just click the icon. On Vista, right-click the icon
and click run-as-Administrator to run as Administrator.

You will need to install the RExcellnstaller, RthroughExcelWorkbooksInstaller,
Remdr, HH, and RemdrPlugin. HH packages and additional packages they require.

From the R command prompt, enter
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install.packages (c ("RExcelInstaller",
"RthroughExcelWorkbooksInstaller",

"RemdrPlugin.HH") ,

dependencies=TRUE")

At the R prompt, enter

library (RExcelInstaller)

installRExcel ()

library (RthroughExcelWorkbooksInstaller)
installRthroughExcel ()

Pop-up messages might ask for administrative privileges. RExcel needs administra-
tive privileges because it uses the Windows Registry to setup communication be-
tween R and Excel. Follow the pop-up instructions precisely. The installation needs
a working internet connection.

After the installation is complete, type

library (RcmdrPlugin.HH)

The Remdr window will open. Additional packages might be downloaded and in-
stalled.
Close R and reopen R from the RExcel with RCommander icon.

A.5 Upgrade an Existing R Installation

The best way to upgrade an existing R installation and add a new package is to
follow the recommendations of R-Core. Do not blindly copy packages from one
release of R to the next. See the “R for Windows FAQ” on this topic:

http://www.r-project.org/
Then click in the left panel:
FAQs » R Windows FAQ » "2.8 What’s the best way to upgrade?”

There is a Wiki page at the RExcel website expanding on the R-Core recommended
way to maintain the package selections in the next release.

http://rcom.univie.ac.at/
then click at the top

WIKI » "How to upgrade R with our packages installed”.
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A.6 R and Remdr Without Excel—Windows, Macintosh, Linux

The material in this book that uses the R Commander menu system (from the Remdr
package available on all platforms where R is available) will work on any R instal-
lation on Windows, Macintosh, or Linux systems.

On Windows, Excel is not free. On Macintosh, although Excel is available, it uses
a different protocol to communicate with the rest of the computer: hence, RExcel
doesn’t work.

See Section A.7 for information on R for Open Office.

Other spreadsheet programs may be available for data handling. They don’t com-
municate directly with R, but they usually permit you to save files in several formats,
most likely including the Excel .x1s format, and then you can read them into
Remdr as described in Section A.6.3.

A.6.1 Install the Rcmdr, HH, and RcmdrPlugin. HH packages

You will need to install the Remdr [Fox et al., 2007], HH [Heiberger, 2008a], and
RemdrPlugin. HH [Heiberger, 2008b] packages and additional packages they re-
quire. From the R command prompt, enter

install.packages (c("Rcmdr", "HH", "RcmdrPlugin.HH") ,
dependencies=TRUE)

After the installation is complete, type
library (RemdrPlugin.HH)

The Remdr window will open. Additional packages might be downloaded and in-
stalled. The installation needs a working internet connection.
Close R and reopen R.

A.6.2 Use the R Commander Directly

Start R. At the R prompt, enter
library (RemdrPlugin.HH)

You now have R and Remdr running and access to many examples in this book.

A.6.3 Data Input

There are several options to get data in:
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1. Use the Remdr Data » Import data » from Excel, Access, or dBASE data set... menu
item.

2. Use the read.x1s () function from the Rcmdr Script Window. Either

library (xlsReadWrite)
?read.xls ## see the help file
or

library (gdata)
?read.xls ## see the help file

The xIsReadWrite and/or gdata packages must be downloaded from CRAN and
installed.

3. Enter data manually with the Rcmdr Data » New data set... menu. This gives a
spreadsheet data entry screen. Close the data entry screen when ready, and the
dataframe will be saved and will be made the active dataset.

A.7 R and Open Office

A working prerelease of ROOo, R for Open Office, is currently available at
http://rcom.univie.ac.at/

in the Download section. The web site and the WIKI on the site discuss this add-in in
more detail. When fully released, ROOo will behave nearly identically on Windows,
Macintosh, and Linux.

A.8 License for statconnDCOM

Not all of the components installed by the RExcellnstaller package are licensed under
the GPL or LGPL, the licenses used by R and many of the packages on CRAN. The
critical module statconnDCOM, the module which interfaces with the MS COM in-
terprocess communication system, is not under GPL. Instead, it has a license that
permits free and unlimited use, but does not permit redistribution. Full details are in
the license distributed with the package. Other software developers who wish to use
the statconnDCOM software infrastructure should visit http://www.statconn.com
for information on negotiating a commercial license.

A.9 Digital Certificate

The RExcellnstaller and RthoughExcelWorkbooksInstaller packages each ask for
permission to install a digital certificate. You do not need to install either certifi-
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cate. Without the RExcel certificate, Excel, depending on your macro security set-
tings, might open pop-up message boxes asking for permission to run macros every
time an Excel session running RExcel is started. Similarly, without the RthroughEx-
celWorkbookslInstaller certificate, Excel might open pop-up message boxes asking
for permission to run macros every time one of the workbooks on the RExcel »
RthroughExcel Worksheets is started.



Appendix B
Nuisances—Installation, Startup, or Execution

Abstract This appendix collects various nuisance problems, with installation,
startup, or execution, that may appear.

B.1 Installation

1. Everything looks right, but it doesn’t work. This can happen if an older version
of the R(D)COM library is still on your machine. Uninstall the older version
from the Start » All Programs » R » (D)Com Server menu. You might also need to
uncheck RExcel from the Excel Add-Ins menu. See Section A.3.2 for details.

2. Excel is not found. One or both of the following messages may appear.

Setup x|

D RExcel Addin installed on your computer but no supported version of Excel was Found
\l) Please do a manual installation using Excel's menu [ToolsiAddins] to locate, load and install it.
Mare information can be found in RExcelReadme and on
http: ffrcom,univie.ac.at

setun x|

3 Mo version of Excel compatible with RExcel addin installed.
\l) IF Excel 2007 is already installed on this computer
see RExcelReadme and the Wiki at
http:{frcarn, univie.ac, at

If either appears, see step 3 in Section A.3.3.

3. Excel messages about conflicts with installation of previous versions of RExcel.
These are usually a complaint that it can’t find a file whose pathname begins with
something like c:/Program Files/R/(D)COM.... See Section A.3.2 for this situation.
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B.2 Startup

1. We recommend starting with one of the RExcel with RCommander icons illustrated
in Fig. 1.1. Things run more smoothly. Other options for starting—clicking the
Excel icon or double-clicking an x1s file—are more likely to have transient prob-
lems.

2. Missing RExcel with RCommander icon. The icon is initially placed on Desktop of
the user who ran the RExcellnstaller. If the icon is not visible for another user, it
can easily be made accessible. From the Start button, click All Programs » R »
RExcel » Activate RExcel Add-in.

3. “R Server not available” message. See Fig. B.1.

Microsoft Excel @

R Server not available

Fig. B.1 This is usually a spurious message. It usually means that Excel is looking
for R before R is ready. The program automatically tries again and succeeds. Just
click OK.

4. The RExcel menu item is either missing entirely or present and non-functional
on a machine that previously had RExcel working. In multi-user settings, for
example, a classroom computer used by several instructors, another instructor
may have unchecked the RExcel Add-In. You need to check it again. The details
depend on the version of Excel.

Excel 2007  Open Excel. Click the Office Button » Excel Options (at the bottom
of the window) » Add-Ins (in the left pane) » Go. .. (bottom) » RExcel2007 (make
sure it is checked). Then click OK all the way back.

Excel 2003  Open Excel. Click the Tools (main menu) » Add-Ins...» RExcel
(make sure it is checked) Then click OK all the way back.

B.3 Execution

1. When Excel gets scrambled, you can often (not always) fix it with
Ctrl-Shift-Alt-F9.
2. If the Remdr menu is scrambled or items are grayed out, then click the blue R
on the Rcmdr menu.
3. There are built-in inconsistencies in the Remdr menus. Read them closely.
The Recmdr scatterplot menu has x on the left, y on the right.
The Remdr linear regression menu has y on the left, x on the right.
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4. OLE actions. See Fig. B.2.

Microsoft Office Excel

! E Microsoft OFfice Excel is waiting for another application to complete an OLE action,

Fig. B.2 This means you are taking longer to fill in a dialog box than Excel is
comfortable with. Click OK and take your time filling out the dialog correctly.

5. The variable names are X followed by numbers in the range of the data values.
See Fig. B.3. This probably means that the dataset was transferred to R without
column names and that the first row of the data has been incorrectly interpreted
as column names. See Section 3.3.

b -4 -f@0 )+ Microsoft Excel

Home Insert Page Layout Formulas Data Review View Developer

RExcel ~ R File ~ Data ~ [Statistics =| Graphs ~ Models ~ Distributions ~ Tools = Help ~

Dataset: NoHeade Summaries ’ Active data set
Contingency tables  » Numerical summaries...
Menu Commands = Means 3
| NoHeader - - Proportions L4 Count missing observations
(i Variances 4
l{] MNoHeader.xism
a = q = Nonparametric tests  » Correlation matrix...
Dimensional analysis * Correlation test...
1 1 14 T
_2_ 5 2.7 Fit models Lg Shapiro-Wilk test of normality...
. > = Numerical Summaries
4 4 4.1
5 5 9.1 Variables (pick one or more)
6 6 72 1
£a 7 8.7 §1.4
8 8 8.01)
9 9 1115 Men e
10 10 9.87 Standard Deviation v
11 11 10.5 Quarties ¥ quanties: |0, .25, .5, .75, 1
12 12 11.2 Summarize by groups... I
13
T I QK I [ Cancel J |_ Help J
15
4> v sheetl . shillu] 0. ’

Fig. B.3 This usually means that the dataset was transferred to R without column
names. See Chapter 3, specifically Section 3.3, for a discussion of how to make the
transfer correctly.



336

6.

10.

B Nuisances—Installation, Startup, or Execution

Similar menu names: Excel 2003 has File, Data, Tools, and Help menu items.
So does the Rmcdr menu. Excel 2007 has a Data menu item on the main menu.
So does the Rmcdr menu.

. Excel, RExcel, and R are all frozen. This usually means you have an open

Remdr dialog box. Switch back to it, either with Alt-Tab or by clicking on the
Windows taskbar, and cancel or complete the dialog box.

. Hidden windows. When the R Commander window is hidden, it does not au-

tomatically come to the top when the Rcmdr menu in Excel writes to it. Simi-
larly, when a new graph is drawn, the Graphics window does not automatically
come to the top. Should a window be hidden, it is easily found with the Win-
dows taskbar or use of the Alt-Tab key. There is an option on RExcel » Options
to change the behavior. Check RCommander gets focus with output, and then
RExcel will bring either the Commander window or the Graphics window, as
appropriate, to the top.

The RExcel and Remdr menus have vanished in Excel 2007. That can happen
when you click another tab to get access to some other menus in the ribbon.
Just click on the Add-Ins tab as in Fig. 1.2.

Run-time error ‘13’: Type mismatch. See Fig. B.4.

Microsoft Visual Basic

Run-time error '13';

Type mismatch

Fig. B.4 This usually means you should close Excel and leave R running. Then
start RExcel again from the RExcel with RCommander icon.

11.

12.

Variables in the dialog box are not used. The Remdr dialog box’s variable se-
lection boxes may open with a variable highlighted. This happens when there
is only one variable that makes sense and it is needed. They may also open not
highlighted, for example, when there is more than one variable that would be
appropriate. They may also open not highlighted when they are optional. For
example, in the Graphs » Dotplot with stacked multiple hits. .. dialog box, the se-
lection boxes for both Factors and | Groups open not highlighted because they
are optional.

Excel quits and restarts by itself. When it comes back, the Remdr window is
present without the Remdr menu, and the RExcel menu item says R is running
but there is no Remdr menu on the Excel menu bar. The solution is to stop
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13.

14.

Remdr from the RExcel menu, then reopen Remdr with Excel menus from the
RExcel menu.

The Remdr menu is visible and working in Excel, but the RExcel menu item is
missing. Close Excel and reopen Excel.

Numbers are interpreted strangely in non-English Windows systems. This could
mean that Excel and R have been given different information about the operat-
ing system decimal notation and/or time conventions.

R (and therefore Rcmdr) uses the operating system’s information. In Ger-
man and Austrian Windows, for example, Excel typically uses “,” as the decimal
point, so numbers entered as “1.5” will be converted to something weird (e.g.,
the first of May, 2009). See the R help files ?1ocales and ?localeconv
for further information.

Excel uses information on the Windows Start » Control Panel » Regional
and Language Options » Regional Options » Customize... dialog boxes and on
the Excel Tools » International tab.

RExcel has a worksheet function RNumber which, when dealing with num-
bers as strings, always does the right thing in conversion.
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